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1.  Introduction 
 

1.1 New in RSTAB 8 
With RSTAB, Dlubal's structural analysis program for spatial frameworks (German: Räumliche 
STABwerke), you've got a powerful tool to cope with a variety of different tasks in civil engi-
neering. The program represents the basis for Dlubal's analysis software composed of various 
design modules: RSTAB determines internal forces, deformations and support reactions of 
general framework structures. Then, the results can be used in add-on modules for specific de-
signs and other analyses. 

The program version RSTAB 8 offers you several useful features and options emphasizing user-
friendliness and easy program handling when working on structural analysis projects. Once 
again, we would like to thank our customers for their valuable ideas and remarks. 

Please find the most important innovations in RSTAB 8 listed below: 

• Graphical user interface in French, Italian, Polish, Portuguese, Russian, Spanish 

• 32-bit and 64-bit program versions 

• Usage of template models 

• Member eccentricities from cross-section dimensions 

• Input option for hybrid timber cross-sections 

• Filter in cross-section library with favorites 

• Inserting a member to existing member 

• Adjustable stiffnesses for cross-sections and members 

• Shifting/copying in user-defined coordinate system 

• Import of files from Bentley ISM, SEMA, cadwork and Scia Engineer 

• Import of 3D objects 

• Graphical assignment of member properties 

• Color symbols in tables for cross-sections and member types 

• Input of inclination and precamber in absolute values 

• Member loads for pipe content full/partly filled 

• Load creation from multilayer structures such as ceiling and floor structures 

• Selection with ellipse, annulus or intersection line 

• Work planes defined by three points or surface axes 

• Grid lines in work plane 

• Color management for cross-section and member types as well as visibilities 

• Automatic creation of load and result combinations according to standard specification 

• Output of member coefficients and member slendernesses 

• User-defined settings for lighting 

• Results evaluation by means of clipping plane 

• Views navigator for user-defined and generated visibilities and angles of view 

• Configuration Manager for display properties, toolbars, printout report headers etc. 

• Mail merge of graphics 

• PDF export of printout report 

We hope you will enjoy working with RSTAB 8. 

Your team from DLUBAL ENGINEERING SOFTWARE 
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1.2 Program Capacities  
The following values represent the upper limits in the RSTAB data structure. Please note that 
complex structures require powerful hardware. 

Model data 
99,999 objects of each category (nodes, members, cross-sections etc.) 

Load data 
99,999 objects of each type of load per load case 

Load cases and combinations 

Load cases (linear calculation) 9,999 

Load combinations (non-linear calculation) 9,999 

Result combinations 9,999 

Super combinations 9,999 

Table 1.1: Program limits of RSTAB 

1.3 Company Profile 
Since its beginnings in 1987, DLUBAL ENGINEERING SOFTWARE has been involved in the develop-
ment of user-friendly and powerful programs for structural and dynamic analysis. In 1990, the 
company moved into its current location to Tiefenbach in Eastern Bavaria. A local branch exists 
since 2010 in Leipzig. 

When looking at our programs you can feel the enthusiasm of everybody involved in the soft-
ware development and you will notice the underlying philosophy of all our applications, which 
can be expressed in one word: user-friendliness. These two points combined with our exper-
tise in engineering are forming the base for the ever-growing success of our products. 

The software has been designed in such a way that even users with basic computer skills can 
handle the software successfully after a short while. With considerable pride, we now number 
more than 7000 engineering offices as well as construction companies from a variety of fields 
and places of higher education among our satisfied customers all over the world. To remain 
true to our objectives, there are more than 150 internal and external employees working con-
tinuously on the development and improvement of DLUBAL applications. For general questions 
and problems our customers can always rely on our qualified fax and email hotline. 

The perfect balance between price and performance combined with excellent customer ser-
vice provided by experienced civil engineers make DLUBAL programs an essential tool for any-
one working in the areas of structural engineering, dynamics and design. 
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1.4 The RSTAB Team 
The following people were involved in the development of RSTAB 8: 

Program coordination 
Dipl.-Ing. Georg Dlubal 
Ing. Pavel Bartoš 
Ing. Pavol Červeňák 
Dipl.-Ing. (FH) Matthias Entenmann 

Dipl.-Ing. (FH) Younes El Frem 
M.Eng. Dipl.-Ing. (BA) Andreas Niemeier 
M.Eng. Dipl.-Ing. (FH) Walter Rustler 

Programming 
Ing. Radek Brettschneider 
Ing. Michal Búzik 
Dipl.-Ing. Georg Dlubal 
Jan Fenár 
Ing. Jan Gregor 
Ing. Jiři Kubíček  
MSc. Olga Melnikova 
Ing. Jan Miléř 
Ing. Daniel Molnár 
Ing. Pavel Němeček 
Ing. Petr Novák 
Ing. Jan Otradovec 
Mgr. Petr Oulehle 
Mgr. Jiří Patrák 

Mgr. Andor Patho 
Mgr. Petr Pitka 
Ing. Jan Rybín, Ph.D. 
Ing. Fatjon Sakiqi 
Ing. Pavel Spilka 
Ing. Roman Svoboda 
RNDr. Stanislav Škovran 
Dis. Jiří Šmerák 
Ing. Jan Štalmach 
Lukáš Tůma 
RNDr. Miroslav Valeček 
Ing. Vítězslav Zajíc 
Michal Zelenka 

Programming - analysis core 
Dr.-Ing. Jaroslav Lain 
Ing. Martin Budáč 

Dipl.-Ing. Georg Dlubal 

Program design, dialog figures, icons 
Dipl.-Ing. Georg Dlubal 
MgA. Robert Kolouch 

Zdeněk Ballák 
Ing. Jan Miléř 

Blocks 
Ing. Tommy Brtek 
Ing. Dmitry Bystrov 

Ing. Evžen Haluzík 

Program supervision 
Ing. Alexandra Bayrak 
Ing. Tommy Brtek 
Ing. Ondřej Čížek 
Ing. Tomáš Ferencz 
Ing. Vladimír Gajdoš 
Ing. Jakub Harazín 
Ing. Martin Hlavačká 
Ing. Iva Horčičková 
Karel Kolář 
Ing. František Knobloch 

Ing. Ctirad Martinec 
Ing. Pavla Novotná 
Ing. Vladimír Pátý 
Ing. Evgeni Pirianov 
Ing. Václav Rek 
Ing. Jan Rybín, Ph.D. 
Mgr. Ph.D. Vítězslav Stembera 
Ing. Ondřej Šupčík 
Ing. Martin Vasek 
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Localization, manual 
Msc. Eliška Bartůňková 
Ing. Fabio Borriello 
Ing. Dmitry Bystrov 
Eng.º Rafael Duarte 
Ing. Jana Duníková 
Ing. Lara Freyer 
Bc. Chelsea Jennings 
Jan Jeřábek 
Ing. Ladislav Kábrt 
Ing. Aleksandra Kociołek 
Mgr. Michaela Kryšková 
Dipl.-Ing. Tingting Ling 

Ing. Roberto Lombino 
Eng.º Nilton Lopes 
Mgr. Ing. Hana Macková 
Ing. Téc. Ind. José Martínez 
Ing. Petr Míchal 
MA SKT Anton Mitleider 
Dipl.-Ü. Gundel Pietzcker 
Mgr. Petra Pokorná 
Ing. Zoja Rendlová 
Ing. Marcela Svitáková 
Dipl.-Ing. (FH) Robert Vogl 
Ing. Marcin Wardyn 

Technical support, quality management 
M.Eng. Cosme Asseya 
Dipl.-Ing. (BA) Markus Baumgärtel 
Dipl.-Ing. Moritz Bertram 
Dipl.-Ing. (FH) Steffen Clauß 
Dipl.-Ing. (FH) Matthias Entenmann 
Dipl.-Ing. Frank Faulstich 
Dipl.-Ing. (FH) René Flori 
Dipl.-Ing. (FH) Stefan Frenzel 
Dipl.-Ing. (FH) Walter Fröhlich 
Dipl.-Ing. Wieland Götzler 
Dipl.-Ing. (FH) Andreas Hörold 
Dipl.-Ing. (FH) Paul Kieloch 

Dipl.-Ing. (FH) Bastian Kuhn 
Dipl.-Ing. (FH) Ulrich Lex 
M.Sc. Dipl.-Ing. (FH) Frank Lobisch 
Dipl.-Ing. (BA) Sandy Matula 
Dipl.-Ing. (FH) Alexander Meierhofer 
M.Eng. Dipl.-Ing. (BA) Andreas Niemeier 
M.Eng. Dipl.-Ing. (FH) Walter Rustler 
M.Sc. Dipl.-Ing. (FH) Frank Sonntag 
Dipl.-Ing. (FH) Christian Stautner 
Dipl.-Ing. (FH) Lukas Sühnel 
Dipl.-Ing. (FH) Robert Vogl 

1.5 Using the Manual 
Many roads lead to Rome – this policy also applies to working with RSTAB: graphics, tables and 
navigators are on an equal footing. The descriptions in this manual follow the sequence and 
structure of the tables provided for model, load and results data. The individual tables are de-
scribed in detail column by column. Instead of presenting general Windows features, the 
manual often focuses on practical hints and tips. 

If you are new to the program, you should work with the introductory example first, describing 
step by step how to enter data. Please find the PDF document available for download on our 
website www.dlubal.com/downloading-manuals.aspx. In this way, you can get quickly familiar 
with the most important features of RSTAB. The example can also be performed within the re-
strictions of the demo version. 

The text of the manual shows the described buttons in square brackets, for example [Apply]. 
At the same time, they are shown in the left margin. In addition, expressions used in dialog 
boxes, tables and menus are set in italics to clarify the explanations. 

The index at the end of the manual helps you to find specific terms and subjects. However, if 
you don’t find what you are looking for, please check our website www.dlubal.com where you 
can go through our FAQ pages by selecting particular criteria. 

 

 

http://www.dlubal.com/downloading-manuals.aspx
http://www.dlubal.com/
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2.  Installation 
 

2.1 System Requirements 
In order to use RSTAB without any difficulties, the following system requirements are recom-
mended: 

• Operating system Windows XP/Vista/7/8 

• x86 CPU with 2 GHz 

• 2 GB RAM 

• DVD-ROM drive for installation (alternatively a network installation is possible) 

• 10 GB hard disk capacity, including approximately 2 GB required for installation 

• Graphic card with OpenGL acceleration and resolution of 1024 x 768 pixels. Onboard so-
lutions and shared-memory-technologies are not recommended. 

RSTAB is not supported by Windows 95/98/Me/NT/2000, Linux, Mac OS or server operating 
systems. 

No product recommendations are made, with the exception of the operating system, as RSTAB 
basically runs on all systems that fulfill the system requirements mentioned above. If RSTAB is 
used for intensive calculations, the guiding principle 'more is better' applies. 

When complex structural systems are calculated, huge amounts of data are produced. As soon 
as the main memory is not sufficient for taking the data, the hard drive will take over, which 
can slow down the computer significantly. Therefore, upgrading the main memory will usually 
speed up the calculation more than a faster processor. 

As the RSTAB analysis core supports several processor kernels, you can completely exploit the 
potential of 64-bit operating systems. For 32-bit systems the memory size used by the proces-
sor is limited to 2 gigabytes. Therefore, more memory can be used with the 64-bit technology. 
If you work with a computer having sufficient RAM memory using a 64-bit operating system, it 
is possible to calculate also big models. 

To calculate complex structural systems, we recommend to use the following configuration: 

• Quad-core processor 

• Windows 7 64-bit 

• 8 GB RAM 

2.2 Installation Process 
The RSTAB program family is delivered on DVD. In addition to the main program RSTAB, the 
DVD contains all additional modules that belong to the RSTAB program family, for example 
STEEL EC3, TIMBER Pro, RSBUCK etc. 

Before you install RSTAB, close all applications running in the background.  

Please make sure that you are logged on as administrator or to have administrator rights for 
installing the programs. When working with RSTAB later, user rights will be sufficient. Please 
find detailed instructions shown in the User Rights video available on our website . 

 

 

 

http://download.dlubal.com/?file=videos/allgemein/User_Rights.avi
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Select installation 

2.2.1 Installation from DVD  
On the back side of the DVD case you can find instructions for installation. 

• Insert the DVD into your DVD-ROM drive. 

• The installation process starts automatically. If it doesn't start, the autorun function may 
be inactive. In this case, start the file setup.exe on the DVD either in the Explorer or by 
entering the command ‚D‘:\setup.exe in the input field of the Start menu (‚D‘ refers to the 
drive letter of your DVD drive). 

• Select the language in the start dialog box. 

 
Figure 2.1: Select language 

• In the next dialog box, define the program version (64-bit or 32-bit). 

• Follow the instructions of the Installation Wizard. 

Connect the dongle to a USB port of your computer only after the installation is complete. The 
dongle driver will be installed automatically. 

The DVD also contains instructions for installation and the RSTAB manual in PDF format. To 
look at the manual, you need the Acrobat Reader that you can install from the DVD. 

RSTAB as full or trial version 
When you start the program for the first time after the installation has been completed success-
fully, you have to decide if you want to use RSTAB as a full version or a trial version for 30 days. 

To run the program as a full version, you need a dongle (hardlock) and an authorization file  
Author.ini. The dongle is a plug to be plugged in a USB port of your computer. The authoriza-
tion file contains coded information about your license(s). Usually, we send you the Author.ini 
file by e-mail. Also the Extranet to which you log in on our website www.dlubal.com provides 
access to your authorization file. Save the Author.ini file on your computer, a USB flash drive or 
in the network. 

Each work station requires the authorization file. The file can be copied as many times as re-
quired. However, if the content will be changed, it cannot be used anymore for authorization. 

It is also possible to run the RSTAB full version with a softlock licence without dongle. 
 

http://www.dlubal.com/extra/loginpage.aspx
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2.2.2 Network Installation 
Local licenses 

The installation can be started from any drive of your computer or server. First, copy the con-
tents of the DVD to the relevant folder. Then, start the file autostart.exe from the client. The fol-
lowing steps do not differ from the DVD installation. 

Network licenses 

First, install the program on the work stations as described. Then, the licenses will be approved 
by the SRM network dongle. Find detailed information about installing the network dongle in 
the instructions available on our website. 

2.2.3 Installing Updates and Other Modules 
The DVD contains the complete program package including all add-on modules. When pur-
chasing another add-on module, you will not necessarily receive a new DVD but always a new 
authorization file Author.ini. To update the authorization without reinstallation, select Load  
Authorization File on the Help menu in RSTAB. 

Old program files are removed and replaced by new ones while installing the update. Of 
course, your project data is preserved! 

If you use printout report headers that you have defined yourself, save them before installing 
the update. The headers are normally stored in the file DlubalProtocolConfig.cfg that you 
find in the general master data folder C:\ProgramData\Dlubal\Stammdat. The file won’t be 
overwritten during the update. Nevertheless, saving a backup file may be useful. 

We also recommend to save your report templates before you install an update. They are 
stored in the file RSTABProtocolConfig.cfg in the folder C:\ProgramData\Dlubal\RSTAB 8.01\ 
General Data. 

The projects linked in the Project Manager are managed in the ASCII file PRO.DLP which can 
normally be found in the folder C:\ProgramData\Dlubal\ProMan (see Figure 12.21, page 385). If 
you want to uninstall RSTAB before installing the update, you should save this file, too. 

2.2.4 Parallel Installation of RSTAB Versions 
The Dlubal applications RSTAB 6, RSTAB 7 and RSTAB 8 can be run parallel on the computer 
since the program files are stored in different directories. The default folders of these program 
generations are the following for a 64-bit operating system: 

• RSTAB 6: C:\Program Files (x86)\Dlubal\RSTAB6 

• RSTAB 7: C:\Program Files (x86)\Dlubal\RSTAB7 

• RSTAB 8: C:\Program Files\Dlubal\RSTAB 8.01 

All models created with the previous version RSTAB 7 can be opened and edited in RSTAB 8. 

Models from RSTAB 7 won’t be overwritten when saving them in RSTAB 8 as both programs 
use different file endings: RSTAB 7 saves model data in the format *.rs7, RSTAB 8 in *.rs8. 

Model files of RSTAB 8 are downward compatible with certain restrictions. When you open an 
RSTAB 8 model file in a previous version, a message appears telling you for example that com-
patibility problems for members with unsymmetric cross-sections may occur. 

 

http://ng.dlubal.de/files/53216.pdf
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3.  Graphical User Interface 
 

3.1 Overview 
When you open one of the examples included in RSTAB, your screen should look like shown in 
Figure 3.1. The graphical user interface corresponds to usual Windows standards. 

The following figure shows the most important areas of the program interface. 

 
Figure 3.1: RSTAB graphical user interface 
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3.2 Terminology 
This chapter explains important terms used in this manual relating to the user interface pro-
vided by Windows. 

Different terms are used to describe the elements of the user interface. This manual uses Eng-
lish expressions often referring to the Microsoft Manual of Style for Technical Publications. Some 
terms are summarized if their differentiation is not essential for the operation of RSTAB. 

The following table describes frequently used terms. 

Term Figure Synonym Explanation 

Menu 

 

Pull down 
menu 

Commands and 
functions below 
the title bar 

Context 
menu 

 

Pop-up 
menu 

Open the context 
menu by clicking 
an object with 
the right mouse 
button. 

Contains useful 
commands and 
functions for the 
selected object. 

Toolbar 

 

Button bar Collection of but-
tons below the 
menu bar 

Dialog 
box 

 

 Window used for 
data input in the 
main window 

Tabs 

 

Register Large dialog box-
es are subdivided 
into several tabs. 

Click a tab to 
open the corre-
sponding index 
card. 
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List button of toolbar 

Section 

 

Group, 
frame 

Elements in a 
dialog box that 
belong together 
logically 

Button 

 

Icon Click a button to 
start an action 
(for example to 
open a dialog box 
or to change da-
ta). 

The toolbar con-
tains list buttons: 
Click [] to open 
a list with similar 
functions. The 
recently selected 
button is dis-
played at top. 

Input 
field 

 

Text box, 
input box 

Field for entering 
text or numerical 
values 

Spin box 

 

Spin button Two tiny buttons 
next to an input 
field 

Numerical values 
can be changed 
gradually. 
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List 

 

List box,  
combo box 

Options for input 
fields 

Sometimes user-
defined specifi-
cations can be 
added. 

Check 
box 

 

Check box Yes/No decision 
by ticking or 
clearing the 
check box 

Selection 
field 

 

Option but-
ton 

Only one of the 
options can be 
selected. 

Table 3.1: Terms of user interface 
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3.3 Special Terms in RSTAB 
This chapter explains some important terms specific to RSTAB. 

Term Explanation 

Nodes In the 3D model, a node is defined by its coordinates (X/Y/Z). The ge-
ometry of the model is defined by nodes. 

Member The straight connection between two nodes represents a member. By 
properties for material and cross-section a certain stiffness is assigned 
to the member. A member is a 1D element. 

Set of members Members can be combined in a set of members. Continuous mem-
bers join members continuously like in a continuous beam. A group 
of members, consisting of connected members, can join more than 
two members on a single node. 

Nodal support The degrees of freedom are limited for the node. 

Nodal load Force or moment applied to a node. 

Member load A member is stressed by a linear or single load. The load distribution 
can be either uniform, linearly variable or parabolic. 

In addition to forces and moments, temperature actions and pre-
stresses are possible. 

Load case 
LC 

The loads of an action are managed in a load case, for example ‘self-
weight’ or ‘wind’. 

The loads should be defined as characteristic loads (which means 
without factors). Partial safety factors can be considered in load or re-
sult combinations. 

Usually, a load case is calculated according to linear static analysis, but 
a calculation according to second-order or large deformation analysis 
is also possible. 

Load combination 
CO 

A load combination is used to superimpose load cases, that means all 
loads of the load cases in question are summarized. 

Usually, a load combination is calculated according to second-order or 
large deformation analysis, but a calculation according to linear static 
analysis is also possible. 

Result combination 
RC 

A result combination sums up the results of the contained load cases. 

It is also possible to determine the extreme internal forces and defor-
mations from different load cases, load or result combinations by an Or 
combination. 

However, the additive principle of superposition does not apply for 
results calculated according to second-order analysis. 

Super combination 
SC 

A super combination superimposes the results of load cases, load 
combinations or result combinations from different RSTAB models. 
Super combinations can be used to analyze different stages of con-
struction. 

The add-on module SUPER-RC is required. 

Table 3.2: RSTAB-specific terms 
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List button of toolbar 

3.4 RSTAB User Interface 
This chapter describes the individual control elements of RSTAB (see Figure 3.1, page 13). The 
program follows the general standards for Windows applications. 

3.4.1 Menu bar 
Below the title bar you see the menu bar. All functions of RSTAB can be accessed in the menu 
bar.  The functions are organized in logical blocks. 

Open a menu by a single click on the left mouse button. You can also use the keyboard by 
holding down the [Alt] key in combination with the underlined letter of the menu title. Then, 
the menu opens and you can see its menu items. Select the entries by mouse-click or by press-
ing the underlined letter. You can also select an item by using the cursor keys [↑] and [↓] and 
finally pressing the [↵] key. 

When a menu list is opened, you can switch between the menus or subentries by using the 
[→] and [←] keys. 

For some menu items a keyboard shortcut is additionally shown. These key combinations fol-
low the Window standards. Use shortcuts to start the functions directly with keyboard keys (for 
example [Ctrl] + [S] saves data). 

3.4.2 Toolbars 
Below the menu bar you see the toolbars with various buttons. Use these buttons to access the 
most important functions directly by mouse-click. A short information of the button function 
appears when you point to a button using the mouse pointer (ToolTip, ScreenTip). 

Some buttons provide subentries like a menu: These list buttons contain topic-related func-
tions. Click [] next to the button symbol to access the functions. The recently selected button 
is preset at the top of the list. 

To change the position of a toolbar, grab the bar in its front area with the left mouse-button. 
Then move it to the desired position. 

 
Figure 3.2: Docked position of View toolbar 

When you drag the toolbar into the workspace, it becomes a „floating” toolbar. 

 
Figure 3.3: Floating position of View toolbar  

To re-dock the floating toolbar, move it to the window frame with the mouse button. You can 
also double-click its headline. 

On the View menu, click Arrange Toolbars Customized to open a dialog box for changing 
the content and look of toolbars (see Figure 3.4). Customizing toolbars follows Windows 
standards. 
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Context menu of a button  

or menu item 

 
Figure 3.4: Customize dialog box, tab Commands 

All commands of RSTAB are sorted by Categories. Select an entry of the list to see the buttons 
of all associated Commands to the right. Click a button to get an explanation of the button 
function shown in the dialog section below. All buttons can be moved to any place in the 
toolbar by using the drag-and-drop function. It is recommended to place such additional 
buttons in a new toolbar (see Figure 3.6) because the remaining toolbars may be reset to the 
default entries when an update is done. 

To remove a button from the toolbar, the Customize dialog box must be open. Then, you can 
drag and drop the button from the toolbar to the workspace. It is also possible to use its con-
text menu shown on the left to Delete the button. 

In addition to dragging commands into the toolbar, you can shift them into menus. In this 
way, you can create user-defined menus. Menu items can be deleted or adjusted by user speci-
fications as described for toolbars. 

The option Button Appearance available in the context menu opens the following dialog box: 

 
Figure 3.5: Dialog box Button Appearance 

The dialog box helps you to change the Text of the button or menu item. Moreover, you can 
replace the default symbol by a user-defined icon. 
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All available toolbars are listed in the Toolbars tab of the Customize dialog box. You can switch 
off toolbars or create new ones by using the [New] button. 

 
Figure 3.6: Creating a new toolbar 

Enter the Name of the new toolbar in the Toolbar dialog box and click [OK]. The new bar will 
appear in a floating position on the display. You can shift the toolbar to an appropriate posi-
tion and fill it with buttons by using the Commands tab (see above). 

The button [Reset All User-defined Toolbars] resets the initial toolbar state. When the list con-
tains a customized toolbar, the toolbar will be removed. The default toolbars of RSTAB cannot 
be removed, but switched off only. 

In the tab Menu Items, you can create user-defined pull-down menus. Proceed as described for 
creating new toolbars (see above). 

Use the final dialog tab Options to change the appearance of the RSTAB user interface. The fol-
lowing Designs can be selected: 

 
Figure 3.7: Available designs for the user interface 

The new setting will be active immediately. 

 

 

 



3  Graphical User Interface 

 21 Program RSTAB © 2013 Dlubal Engineering Software 

 

3.4.3 Project Navigator 
To the left of the work window you see a navigator that looks like the Windows Explorer. To 
display or hide the Project Navigator, open the View menu and select Navigator, or use the 
corresponding toolbar button. 

 
Figure 3.8: Navigator button in the Default toolbar 

The navigator shows the model data of opened files in a tree structure. Click [+] to open a 
branch of the tree, click [-] to close it. You can also double-click the entry. 

Similar to toolbars, you can use the mouse to "grab" the navigator in its title bar and move it to 
the workspace. To dock it again, double-click the title bar or move the navigator to the win-
dow frame. When moving the navigator, directional buttons shown on the left will additionally 
appear, facilitating the docking to one of the four sides of the work window. Drag the naviga-
tor to the arrow button of your choice and release the left mouse button as soon as the pointer 
is placed on the button. 

If you do not want the navigator to be docked to the window frame, clear the corresponding 
selection in the context menu of the navigator. 

When the menu item Synchronized Selection is ticked, RSTAB shows an object that is selected in 
the navigator also highlighted with colors in the model graphic. 

The context menu option Auto Hide allows you to minimize a docked navigator: As soon as you 
click into the work window, the navigator slides to the edge and becomes a thin bar (see Fig-
ure 3.9). You can also use the pin button on the top right of the navigator to select this func-
tion (see Figure 3.10, page 22). 

The navigator opens in full size when you move the pointer across the Project Navigator field 
highlighted in the docked navigator bar. 

 
Figure 3.9: Navigator, tables and panel in auto hide mode 

 

 

 
 

Context menu of navigator 
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At the bottom edge of the navigator you see three tabs (four after calculations). Use the tabs to 
switch between Data, Display, Views and Results navigators. 

  
Figure 3.10: Tabs for Data and Display in Project Navigator 

Data navigator 
This navigator manages model and load data as well as calculated results. Double-click an en-
try (a “leaf” of the tree structure) to open a dialog box for changing the selected object. When 
you right-click an entry, a context menu appears with helpful functions used to create or modi-
fy the object. 

Incorrectly defined objects are displayed in red, unused objects are displayed in blue letters. 

Display navigator 
This navigator controls the graphic display in the work window. When you clear the check box 
of an entry, the corresponding object will be hidden in the graphics. 

Use the context menu of the navigator shown on the left to save or import user-defined set-
tings. You can also apply saved settings as default for new models. 
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Figure 3.11: Tabs for Views and Results in Project Navigator 

Views navigator 
This navigator manages user-defined views as well as user-defined and automatically created 
visibilities of objects (used to be "partial views" and "groups" in RSTAB 7). Buttons are available 
to create user-defined views, to set visibilities, to integrate objects into user-defined visibilities 
etc. 

Working with views and visibilities is described in chapter 9.7.1 on page 212. 

Results navigator 
With the last navigator you control the results displayed in the graphic. Available entries de-
pend on whether results of RSTAB or an add-on module are displayed. 
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3.4.4 Tables 
At the bottom edge of the RSTAB window you see tables. On the Table menu, click Display to 
switch the tables on and off, or use the corresponding button. 

 
Figure 3.12: Button Table on/off in the Default toolbar 

There are four groups of tables. To switch between them, use the first four buttons displayed 
in the toolbar of the table, or point to Go To on the Table menu. 

 

 
Table 3.3: Buttons for control of table groups 

The tables manage all model and load data numerically. Several powerful functions allow for 
an efficient data input (see chapter 11.5 on page 321). 

By working through the tables successively RSTAB ensures that all data is captured. The tables 
represent the internal organization of RSTAB data. Descriptions of input and output to be 
found in chapters 4, 5, 6 and 8 are based on the structure of these tables. 

Similar to toolbars, you can use the mouse to "grab" tables in their title bar and move them in-
to the workspace. To dock a table, double-click its title bar, or move the table to the window 
frame or one of the directional buttons shown on the left. 

Docked tables can be minimized when the context menu option Auto Hide is set. As soon as 
you click into the work window, they slide to the edge (see Figure 3.9, page 21). You can also 
use the pin button on the top right of the table to select the minimize function. The tables 
open in full size again when you move the pointer over the docked bar. 

 

Table menu → Go To → Model Data 

Tables for model data 

 

Table menu → Go To → Load Cases and Combinations 

Tables for load cases and 
combinations 

 

Table menu → Go To → Loads 

Tables for loads 

 

Table menu → Go To → Results 

Tables for results 
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When selecting a table row by mouse click, related objects are highlighted with colors in the 
graphic. Reciprocally, when an object is selected in the work window, the corresponding table 
row is displayed and highlighted, too. To control the settings for the "synchronization of selec-
tion", point to Settings on the Table menu. You can also use the table toolbar buttons shown 
on the left (see chapter 11.5.4, page 327). 

3.4.5 Status Bar 
At the bottom of the RSTAB work window you see the status bar.  

On the View menu, click Status Bar 

to switch the bar on and off. 

The status bar consists of three areas. 

Left area 

 
Figure 3.13: Left area of status bar 

The displayed text varies depending on the program function that is active. When the pointer 
moves across the work window, information appears about the object indicated by the point-
er. 

If you are an RSTAB beginner, keep an eye on this section of the status bar: You may find useful 
hints and descriptions for toolbar buttons and dialog boxes. 

Center area 

 
Figure 3.14: Center area of status bar 

Its functionality is similar to the one of a toolbar, controlling the display of the work window. 

SNAP  

The button enables or disables the snap function of the grid. Use the context menu to access 
the dialog box with specific settings for grid parameters (see chapter 11.3.2, page 278). 
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Figure 3.15: Dialog box Work Plane and Grid/Snap 

GRID 

Click the button to switch the grid on and off.  Select Edit in the context menu to open the dia-
log box shown in Figure 3.15. 

In addition, the context menu offers the possibility to maximize or minimize grid spacings 
gradually. 

ORTHO / CARTES / POLAR 

Use this button to select the orthogonal, Cartesian or polar grid. With the context menu you 
can open the dialog box shown in Figure 3.15. In addition, you can enlarge and reduce grid 
spacings gradually. 

OSNAP 

The button activates or deactivates the object snap (see chapter 11.3.3, page 279). 

GLINES 

The button controls the display of guidelines (see chapter 11.3.7, page 290). 

DXF 

This button switches the display of background layers on and off (see chapter 11.3.10, page 297). 

Right area 

 
Figure 3.16: Right area of status bar 

The right area of the status bar shows the following information about graphically entered data: 

• Visibility mode (if active) 

• Coordinate system CS 

• Work plane 

• Coordinates of current pointer position 
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3.4.6 Control Panel 
As soon as internal forces or deformations are displayed graphically, the panel appears in the 
work window, offering different possibilities for display and control. To switch the panel on 
and off, 

select Control Panel (Color Scale, Factors, Filter) on the View menu 

or use the button shown on the left. 

Similar to a toolbar, you can use the mouse to "grab" the panel in its title bar and shift it into 
the workspace. To dock the panel, double-click its title bar, or move it to the window frame or 
one of the directional buttons shown on the left. 

The docked panel can be minimized when the context menu option Auto Hide is set. As soon 
as you click into the work window, it slides to the edge (see Figure 3.9, page 21). You can also 
use the pin button on the top right of the panel to select the minimize function. The panel 
opens in full size again when you move the pointer over the docked bar. 

The control panel consists of the following tabs: Color scale, Factors and Filter. 

Color scale 

 
Figure 3.17: Control panel, tab Color scale with active Options dialog box 

When a multi-color results display is set, the first tab shows the color spectrum with assigned 
ranges of values. Eleven color zones are set by default, covering the range between extreme 
values in equally spaced intervals. 

To adjust the color spectrum, double click one of the colors. You can also use the [Options] 
button available in the panel. The Options dialog box opens (Figure 3.17) where you can click 
the [Edit] button to access another dialog box for changing the ranges of colors and values. 
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Figure 3.18: Dialog box Edit Isoband Value and Color Spectra 

Use the vertical sliders to the right of the values to reduce the number of color ranges at both 
ends of the color spectrum. 

You can change colors individually by double-clicking a color field. 

Furthermore, you can adjust spectrum values manually. Please take care to follow a strictly as-
cending or descending order. Use the buttons in the dialog section Value Spectrum to assign 
values. The buttons are defined as follows: 

Button Function 

Standard The eleven color zones will be set to default. 

Empty All values in the input fields will be deleted. 

Fill 
The values will be equidistantly intercalated between maximum and 
minimum depending on the number of color zones. 

Fill Max/Min 
For a reduced color spectrum, the interpolated values are calculated in 
relation to the absolute or manually entered extreme values. 

Save The value spectrum will be saved as a global sample. 

Table 3.4: Buttons in the dialog section Value Spectrum 

Tick the check box in front of Apply to all result diagrams to use the current color spectrum for 
the results display of all load cases, load and result combinations. The value spectrum remains 
unaffected because a global assignment for deformations, forces, moments and stresses 
would be difficult. Click [Save] to save the modified color spectrum as user-defined. 

Use the [Options] button as shown in Figure 3.17 to select further options in the Options dialog 
box.  
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Figure 3.19: Dialog box Options, option Limits +/- 

The reference to limit values allows you to evaluate results accurately within a defined zone. 
Exceedings of the upper and lower limits are represented by different colors. With the values 
set in Figure 3.19 you can see the moments My displayed in a fine gradation within the range 
of ± 30 kNm/m. Values beyond the defined zone appear in red or blue color. 

Tick the check box for Smooth color transition in the Options dialog box to make the distinct 
color zones disappear. The smoothed color spectrum can be set independently, no matter 
which one of the three reference options is selected for the result values. 

Factors 

 
Figure 3.20: Control panel, tab Factors  

Use the second panel tab to control the scaling factors for the graphic display. Depending on 
the currently set results graphic, you can access input fields for scaling Deformations, Member 
diagrams (internal forces) and Reaction forces. 
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Filter 

 
Figure 3.21: Control panel, tab Filter 

With the Color scale tab you can filter result values in general. Use the Filter tab to control the 
results display with regard to particular members. 

You have to enter the numbers of the relevant members into the input field Show diagrams for. 
Then, with a click on the [Apply] button, you set the filter in the graphic. 

It is also possible to take object numbers from the graphic: First, select the members (multiple 
selection via window or by holding down the [Ctrl] key). Then, click the button [Import from 
Selection]. 

The filter settings of the panel also affect the objects in the results tables: For example, when 
you restrict the results display in the panel to two members, table 4.1 Members - Internal Forces 
will also list only the results of those two members. 
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3.4.7 Default Buttons 
Buttons are used in many dialog boxes. When you place the pointer on a button, its function 
will be displayed as short description after a moment. 

The following overview describes frequently used default buttons. 

Button Description Function 

 New Opens a dialog box to define an object 

 Edit Opens a dialog box to modify an object 

 Delete Deletes an object or entry 

 Select Graphical selection 

 Apply Import from the current selection 

 Library Opens a collection of stored data 

 Help Opens the help function 

 Use Applies changes without closing the dialog box 

 Settings Opens a dialog box for detailed settings 

 Comments 
Access to default text modules 
 chapter 11.1.4, page 262 

 
Units and  
Decimal Places 

Settings for units and decimal places 
 chapter 11.1.3, page 261 

 Standard Restores default dialog settings 

 Set as Default Saves the current settings as default 

 Font Option to set fonts and font sizes 

 Colors Option to set colors 

 Info Displays information about an object 

 Transfer Selection Transfers selected items from one list to another 

 Transfer All Transfers all items from one list to another 

 Save Stores user-defined entries 

 Import Imports stored entries 

 Select Selects certain or all objects 

 Deselect Deletes or cancels all entries 

Table 3.5: Default buttons 
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3.4.8 Keyboard Functions 
Often required functions in tables and graphical user interface can be accessed with the key-
board. 

[F1] Help 

[F2] Next table 

[F3] Previous table 

[F4] Plausibility check for current table 

[F5] Plausibility check for all tables 

[F7] Selection function in tables 

[F8] Copies the table cell above, or shows whole model on screen 

[F9] Calculator 

[F10] Menu bar 

[F12] Saves the model under a new name 

[Alt] Menu bar 

[Ctrl]+[2] Copies a row of the table to the next row 

[Ctrl]+[A] Redo function 

[Ctrl]+[C] Copies to the clipboard 

[Ctrl]+[E] Exports data 

[Ctrl]+[F] Searches within the table 

[Ctrl]+[G] Generates entries in the table 

[Ctrl]+[H] Finds entries in the table and replaces them 

[Ctrl]+[I] Inserts a row in the table, or imports data 

[Ctrl]+[L] Jumps to a specific row number in the table 

[Ctrl]+[N] Creates a new model 

[Ctrl]+[O] Opens an existing model 

[Ctrl]+[P] Prints the graphic 

[Ctrl]+[R] Deletes a row in the table 

[Ctrl]+[S] Saves data 

[Ctrl]+[U] Clears selection in the table 

[Ctrl]+[V] Inserts from the clipboard 

[Ctrl]+[X] Cuts items in the table 

[Ctrl]+[Y] Deletes the content of a row in the table 

[Ctrl]+[Z] Undo function 

[+] [-]  NumPad Zoom 

Table 3.6: Keyboard functions 

Provided that no dialog box is open, the [Enter] key calls up the last used function. Thus, reap-
plication of data is easier, for example placing model or load objects again in the work window.  
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3.4.9 Mouse Functions 
The mouse functions follow general standards for Windows applications. To select an object 
for editing, simply click it with the left mouse button. Double-click the object when you want 
to open its dialog box for editing. You can apply these functions to objects of the work win-
dow as well as to entries in the Data navigator. 

Model and load objects can be shifted in the work window by drag-and-drop. To copy objects, 
hold down the [Ctrl] key additionally. The drag-and-drop function can be switched on and off 
in the general context menu (see Figure 11.52, page 287). 

When you click an object with the right mouse button, its context menu appears, providing 
object-related commands and functions. 

Context menus are available in the graphic, the tables and the navigator. 

 
Figure 3.22: Context menu of nodal support in the graphic 

By scrolling the wheel button you can maximize or minimize the current model representa-
tion. The pointer position is always assumed as center of the zoom area. 

Press the wheel button to move the model directly within the workspace, which means with-
out previously activating the toolbar button [Move, Zoom]. When you press the [Ctrl] key addi-
tionally, you can rotate the model. Rotating the model is also possible by using the wheel but-
ton and holding down the right button of the mouse. The pointer symbols shown on the left 
are indicating the selected function. 

To rotate the view about a particular node, select the node first. Now, hold down the [Alt] key 
and press the wheel button additionally to rotate the model about the selected node. 

The options offered by a 3D mouse can also be used for working with the graphical user inter-
face of RSTAB. 

Furthermore, RSTAB offers a useful function to display selected objects quickly in maximized 
view: First, select the objects in the work window. Now, hold down the shift key [] and click 
one of the buttons available in the View toolbar shown on the left. The work window will show 
you a maximized partial view of the object in the selected viewing direction. 
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3.4.10 Configuration Manager 
The Configuration Manager provides access to all settings available for display properties, 
fonts, toolbars, print headers etc. To open the Configuration Manager, select Configuration 
Manager on the Options menu, or use the toolbar button shown on the left. 

 
Figure 3.23: Dialog box Configuration Manager 

Available configurations 
This dialog section lists all configurations that have been user-defined or created during instal-
lation. The setting currently used by the program is shown in bold and indicated as current. 

The Standard configuration is preset, it cannot be deleted. 

The buttons below the dialog section are reserved for the following functions: 

Button Function 

 
Sets the entry selected above as new current configuration 

 
Creates a new configuration from current settings (see Figure 3.24) 

 
Renames the selected configuration 

 
Exports the selected configuration in a file 

 
Imports a configuration from a file 

 
Resets the default values 

 
Deletes the selected configuration (not possible for Standard and current) 

Table 3.7: Buttons for Available Configurations 



3  Graphical User Interface 

 35 Program RSTAB © 2013 Dlubal Engineering Software 

 

Use the [New] button to save the current settings as a new configuration. A dialog box opens 
where you have to enter a Description. An optional Comment makes it easier to select among 
various user-defined configurations later. 

 
Figure 3.24: Dialog box New Configuration 

Settings 
The buttons available in the dialog section Settings provide access to different dialog boxes 
with configuration parameters. They are described in the following table. 

Button Description Function 

 
Display properties Opens the dialog box Display Properties 

 chapter 11.1.2, page 258 

 
Program options Opens the multi-tab dialog box Program Options 

 chapter 7.2.3, page 183 
 chapter 9.8, page 222 
 chapter 11.1.1, page 257 
 chapter 11.1.4, page 263 

 
Toolbars  
and menus 

Opens the dialog box Customize 
 chapter 3.4.2, page 19 

 
Margins and 
stretch factors 

Opens the dialog box Display Margins and Stretch Factors 
 chapter 11.3.11, page 300 

 
Table colors Opens the dialog box Colors for the table colors 

 chapter 11.5.4, page 327 

 
Table fonts Opens the dialog box Font for the table fonts 

 chapter 11.5.4, page 327 

 
Header and footer 
of printout report 

Opens the dialog box Printout Report Header 
 chapter 10.1.4, page 233 

Table 3.8: Function of buttons in the dialog section Settings 
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4.  Model Data 
Starting RSTAB 
To start the program, use the Windows Start menu or the Dlubal icon on the desktop. 

To enter data, a model must be created or opened (see chapter 12.2, page 386). 

RSTAB offers different options to enter data: You can define objects in a dialog box, a table 
and often directly in the graphic. All input is interactive, which means that graphical input is 
immediately reflected in the table and vice versa. 

For first steps with RSTAB we recommend to try the introductory example that may be helpful 
for beginners. You find the corresponding manual available for download on our website 
www.dlubal.com/downloading-manuals.aspx 

Open the input dialog box 
You can access the input dialog boxes and the graphical input in various ways. 

Menu Insert 

 

Figure 4.1: Menu Insert → Model Data 

Toolbar Insert 

 
Figure 4.2: Toolbar Insert 

 

http://www.dlubal.com/downloading-manuals.aspx
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Context menu in Data navigator 

 
Figure 4.3: Context menu of model data objects in the Data navigator 

Context menu or double-click in table 

 
Figure 4.4: Context menu in model data tables 

The input dialog box can be accessed by means of the context menu (or by double-click) of the 
row number. 
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Open the edit dialog box 
RSTAB provides different possibilities to open a dialog box for editing model objects. 

Menu Edit 

 

Figure 4.5: Menu Edit → Model Data 

Context menu or double-click in graphic 

 
Figure 4.6: Context menu of a node in the work window 
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Context menu or double-click in Data navigator 

 
Figure 4.7: Context menu of model data objects in the Data navigator 

Context menu or double-click in table 

 
Figure 4.8: Context menu in model data tables 

The edit dialog box can be accessed by means of the context menu (or by double-click) of the 
row number. 
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Table input 
Input and modifications carried out in the graphical user interface are immediately shown in 
the tables, and vice versa. To open the model data tables, use the leftmost button in the table 
toolbar shown on the left. 

 
Figure 4.9: Button [Table 1. Model Data] 

Input in the form of spreadsheet data entered in tables can be quickly edited and imported 
(see chapter 11.5, page 321). 

Unused objects are highlighted in blue in the tables and the Data navigator. 

In each dialog box and table, it is possible to add a Comment specifying the object. You can al-
so use predefined comments (see chapter 11.1.4, page 262). Moreover, comments are part of 
ScreenTips for graphical objects. 

 
Figure 4.10: ScreenTip of a nodal support 
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4.1 Nodes 
General description 
The geometry of the model is defined by nodes. They are essential for creating members. Eve-
ry node is specified by its coordinates (X,Y,Z). The coordinates usually refer to the origin of the 
global coordinate system, but it is also possible to define them in relation to another node. 

 
Figure 4.11: Dialog box New Node 

 
Figure 4.12: Table 1.1 Nodes 

The node number is assigned automatically in the dialog box New Node but can be modified in 
the input field. The order of the node numbering is not important and gaps are permitted. 

To adjust the order of node numbers subsequently, select Renumber on the Tools menu (see 
chapter 11.4.16, page 318). 

Furthermore, RSTAB provides a special function to create a node on the connection line of two 
nodes already existing (see chapter 11.4.12, page 315). 
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Reference node 
In general, coordinates of a node refer to the origin of the global coordinate system. You do 
not need to define the node (0/0/0) because RSTAB recognizes the origin automatically. 

Any node can be defined as reference node. Even a node with a higher number is allowed to 
be used as reference node. Referring to another node may be useful to define for example a 
new node in a certain distance to an already known position. The table list with its option "Pre-
vious node" is especially useful in this case. 

In the dialog box New Node, you can enter the reference node directly, select it from the list or 
define it graphically by using the [] button. 

Coordinate system 
The coordinates of a node always refer to a coordinate system that describes the position of 
the node in the workspace. Depending on the model geometry you can select between differ-
ent coordinate systems. All coordinate systems are clockwise-oriented. 

Cartesian 

The global axes X, Y and Z describe a translational expansion (linear). All directions of coordi-
nates are on an equal footing. 

 

Figure 4.13: Cartesian coordinate system 

In most cases, nodes can be defined in the Cartesian coordinate system. 

X-cylindrical 

The X-axis describes a translational expansion. The radius R defines the distance of the node to 
the X-axis. The angle θ defines the rotation of the coordinates about the X-axis. 

The X-cylindrical coordinate system will be applied to represent for example tubular models 
whose central axis is the X-axis. 

 

Figure 4.14: X-cylindrical coordinate system 

Y-cylindrical 

This coordinate system is similar to the X-cylindrical system, but now the longitudinal axis is 
represented by the Y-axis. 

 

Figure 4.15: Y-cylindrical coordinate system 
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Z-cylindrical 

The coordinate system is similar to the X-cylindrical system, but now the longitudinal axis is 
represented by the Z-axis. 

 

Figure 4.16: Z-cylindrical coordinate system 

Polar 

In the polar coordinate system, the node position is described by a radius defining the distance 
to the point of origin and the angles θ and Φ. 

 

Figure 4.17: Polar coordinate system 

If possible, organize the model input with regard to the global coordinate system in such a 
way that the X-,Y-, and Z-axes of the coordinate system are in line with the principal directions 
of the modeled framework. This allows for an easier definition of coordinates, conditions and 
loads. 

To define nodes directly in the workspace, open the floating dialog box New Node for graphical 
input by clicking the toolbar button shown on the left. Usually, nodes snap on grid points 
which are aligned with the active user-defined or global coordinate system (CS). 

 
Figure 4.18: Floating dialog box New Node 

For more information about user-defined coordinate systems, see chapter 11.3.4 page 283. 

When the coordinate system is changed in the table, it is possible to convert node coordinates 
automatically to the new system. The following query will be displayed. 
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Figure 4.19: RSTAB query 

In the same way, you can convert node coordinates with the Previous reference node in rela-
tion to the origin. 

Node coordinates 
Node coordinates are defined in the coordinate system that you have previously set. When 
you model a 3D structure, the node is clearly defined by the coordinates X, Y and Z or the radi-
us and angles. Coordinate parameters and table column titles are changing depending on the 
coordinate system. 

When the model type has been restricted to a planar 2D system or a continuous beam in the 
General Data dialog box, you cannot access all three input fields or table columns. 

To adjust Lengths and Angles, select Units and Decimal Places on the Edit menu, or use the 
corresponding button in the dialog box. 

With the following procedure you can check if all nodes are placed in one plane: Select the rel-
evant nodes and double click one of them to open the dialog box Edit Node. Only those input 
fields are filled with coordinates data whose values are conform for all selected nodes. If this is 
not the case, you can assign a uniform plane coordinate to the selected nodes now. 

It is possible to import node coordinates from Excel spreadsheets (see chapter 11.5.6, page 
329). Furthermore, you can determine node coordinates with the Formula Editor of RSTAB (see 
chapter 11.6, page 332). In addition, you can take advantage of several model generators facili-
tating the input (see chapter 11.7.2, page 341). 
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To enter accurate, unrounded coordinates, select Full Precision in the dialog box New Node. 

 
Figure 4.20: Context menu in the dialog box New Node and dialog box Full Precision 

Comment 
You can enter user-defined notes. Use the button [Apply Comment] to import saved com-
ments (see chapter 11.1.4, page 262). 
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4.2 Materials 
General description 
Materials are required to define cross-sections. The material properties affect the stiffnesses of 
members. 

A Color is assigned to each material. Colors are used by default in the rendered model for the 
representation of objects (see chapter 11.1.9, page 268). 

For new models RSTAB presets the two materials that were last used. 

 
Figure 4.21: Dialog box New Material 

 
Figure 4.22: Table 1.2 Materials 

Material description 
Any name can be chosen for the Description of the material. When the entered name corre-
sponds to an entry of the library, RSTAB will import the material properties. The import of ma-
terials from the library is described later. 

Modulus of elasticity E 
The modulus of elasticity describes the ratio between normal stress and strain. 

To adjust the settings for Materials, click Units and Decimal Places on the Edit menu, or use 
the corresponding button.  
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Shear modulus G 
The shear modulus G is the second parameter used to describe the elastic behavior of a linear, 
isotropic and homogenous material. 

The shear modulus of the materials listed in the library is calculated according to Equation 4.1 
from the modulus of elasticity E and the Poisson's ratio ν. Thus, a symmetrical stiffness matrix is 
ensured for isotropic materials. The shear modulus values determined in this way may slightly 
deviate from the specifications in the Eurocodes. 

Poisson's ratio ν 
The following relation exists between elastic and shear modulus and the Poisson's ratio ν. 

( )ν+= 1G2E  

Equation 4.1 

When you define the properties of an isotropic material manually, RSTAB will determine auto-
matically the Poisson's ratio from the values of elastic and shear modulus (respectively shear 
modulus from modulus of elasticity and Poisson's ratio). 

Generally, the Poisson's ratio of isotropic materials is between 0.0 and 0.5. Therefore, for a val-
ue higher than 0.5 (for example rubber) we assume that the material is not isotropic. Before 
the calculation starts, a query appears asking if you want to use an orthotropic material model. 

Specific weight γ 
The specific weight γ describes the weight of the material per volume unit. 

The specification is especially important for the load type 'self-weight'. The model's automatic 
self-weight is determined by the specific weight and the cross-sectional areas of the members 
used. 

Coefficient of thermal expansion α 
The coefficient describes the linear correlation between changes in temperature and axial 
strains (elongation due to heating, shortening due to cooling). 

The value is important for the load types 'temperature change' and 'temperature differential'. 

Partial safety factor γM 

The value describes the safety factor for the material resistance. Therefore the index M is used. 
Use the factor γM to reduce stiffness for calculations according to second-order and large de-
formation analysis (see chapter 7.2.1, page 172). 

Do not confuse the factor γM with the safety factors for the determination of design internal 
forces. The partial safety factors γ on the action side take part in combining load cases for load 
and result combinations. 
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Material model 
Two material models are available for selection in the list. The parameters of the material 
model Isotropic Thermal-Elastic can be defined in another dialog box that you access with a 
click on the [Details] button. 

Standard 

The linear-elastic stiffness properties of the isotropic material do not depend on directions.  
The following conditions are valid: 

• E > 0 

• G > 0 

• – 1 < ν 

Isotropic thermal-elastic 

Temperature-dependent stress-strain properties of an elastic isotropic material can be defined 
in a diagram or imported from [Excel]. These properties will be considered for member and 
surface elements subjected to thermal load (changes or differences in temperature). 

 
Figure 4.23: Dialog box Material Model - Isotropic Thermal-Elastic 

The Reference temperature defines the stiffnesses for those members that do not bear any 
temperature loads. For example, when a reference temperature of 300 °C is set, RSTAB applies 
to all members the reduced modulus of elasticity of this point of the temperature curve. 

With the setting in the dialog section Options you decide if identical Poisson's ratios are applied 
to the complete temperature diagram. Remove the checkmark to access the table column 
Poisson's Ratio when you want to enter individual entries. 

Click the [Save] button in the dialog box to save the stress-strain diagram so that you can use it 
for other models. Use the [Load] button to import user-defined diagrams (see Figure 4.24). 
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Figure 4.24: Dialog box Load Dialog Box Data 

Material Library 
The properties of many materials are stored in a comprehensive database that can be extend-
ed. 

Open the library 

To access the library, click the [Material Library] button (cf. Figure 4.21, page 46) in the dialog 
box New Material. You can open the database also in table 1.2 Materials (cf. Figure 4.22, page 
46): Place the cursor into table column A and click the button [...] shown on the left, or use the 
function key [F7] on the keyboard. 

 
Figure 4.25: Dialog box Material Library 
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Select a material from the list Material to Select and check the corresponding parameters in the 
lower part of the dialog box. Click [OK] or [↵] to import it to the previous dialog box or table. 

Library filter 

As the material library is very large, you find various selection options available in the dialog 
section Filter. You can filter the material list according to Material category group, Material cate-
gory, Standard group and Standard. In this way, you can reduce offered data. 

  
Figure 4.26: Filter for Material category group and Material category 

Create favorites 

Often, the use of a few materials is already sufficient for daily engineering work. You can mark 
these materials as your favorites. Use the button [Edit Favorites] (see Figure 4.28) to open the 
dialog box for defining preferred materials. 

 
Figure 4.27: Dialog box Material Library - Favorites (dialog section) 

The dialog box looks like the material library. You can use the filter options described above. In 
the dialog section Material Library - Favorites, you can select your preferred materials by ticking 
their check boxes. To change the sequence of materials, use the buttons [] and []. 
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After closing the dialog box, the material library presents a clear favorites overview as soon as 
you activate the option Favorites only. 

 
Figure 4.28: Dialog box Material Library with option Favorites only 

With the check box for Include invalid in the Filter dialog section you can decide if materials of 
'old' standards also appear in the library. 

Add materials to library  

The Material Library can be extended. When a new material is added, it can be used for all 
available models. 

Click the [New] button in the library (to the right of the [Favorites] button, see Figure 4.28). The 
dialog box New Material opens (see Figure 4.29). You can see that parameters of the entry se-
lected in the list Material to Select are preset. So creating a new material is easier when you 
choose a material with similar properties before you access the dialog box. 
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Figure 4.29: Dialog box New Material 

Enter the Material Description, define the Material Properties, and assign the material to the ap-
propriate categories for Filter functions. 

Use the buttons shown on the left to create and edit categories. 

 
Figure 4.30: Dialog box Edit Material Category 

To adjust the sequence of entries, use the buttons [] and []. 

Saving user-defined materials 

If you use customized materials, you should save the file Materialien_User.dbd before in-
stalling an update. You can find it in the master data folder of RSTAB 8 C:\ProgramData\Dlubal\ 
RSTAB 8.01\General Data. 
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4.3 Cross-sections 
General description 
Before you can enter a member, a cross-section must be defined. The cross-section properties 
and material characteristics that are assigned determine the stiffness of the member. 

Each cross-section has its own Color that can be used in the model to represent different pro-
files. Colors are controlled in the Display navigator with the option Colors in Rendering Accord-
ing to (see chapter 11.1.9, page 268). 

You do not have to use each defined cross-section for input in the model. Thus, when model-
ing the structure, it is possible to make experiments without deleting cross-sections. Please 
note, however, that the cross-sections cannot be renumbered. 

To represent a tapered beam, you have to define different start and end cross-sections for the 
member. RSTAB determines the variable stiffnesses along the member automatically. 

 
Figure 4.31: Dialog box New Cross-Section, tab Cross-Section Properties 

 
Figure 4.32: Table 1.3 Cross-Sections 
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You do not need to enter the cross-section properties manually. RSTAB provides an extensive 
and extendable cross-section library as well as import options. 

Cross-section description 
The Cross-Section Description can be selected freely. When the entered cross-section name cor-
responds to an entry of the cross-section library, RSTAB will import the cross-section parame-
ters. In this case, it is not possible to change the values for the Moments of Inertia and the area 
Axial A. For user-defined cross-section descriptions you can enter constants and cross-section 
areas manually. 

The characteristic values of parameterized cross-sections are also imported automatically. For 
example, when you enter "Rectangle 80/140", the cross-section parameters of this cross-
section will appear. 

The selection of cross-sections from the library is described later. 

It is also possible to use a rigid dummy cross-section to model couplings. RSTAB applies stiff-
nesses to this cross-section type like for a coupling member. Enter the name Dummy Rigid as 
description for the cross-section without defining the cross-section values in detail. In this way, 
you can use members with a high degree of stiffness, taking account of releases or other mem-
ber properties. A new variant in RSTAB 8 is the member type Rigid Member (see page 75), so 
the definition of a Dummy Rigid is no longer necessary. 

Material no. 
The cross-section's material can be selected from the list of already defined materials. The as-
signment is made easier by material colors that are used by default for the rendered graphical 
representation. 

In the dialog box New Cross-Section, you can see three buttons below the material list. Use 
these buttons to access the material library, to create a new material or to edit materials. 

For more detailed information about materials, see chapter 4.2, page 46. 

The option Hybrid available in the dialog box for rectangular timber cross-sections can be ac-
cessed only for parameterized timber profiles. Use this option to assign specific material prop-
erties to cross-section elements if different material grades are provided (for example timber of 
low class for webs). 

With a click on the [Edit] button you can open the dialog box Edit Hybrid Material. 

 
Figure 4.33: Dialog box Edit Hybrid Material 
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Assign materials to the single cross-section parts according to the graphical scheme. They can 
be selected from the list. One of the materials must be defined as Reference Material used to 
determine the ideal cross-section properties. 

Moments of inertia 
The moments of inertia are required for the cross-section stiffness: The torsional constant J de-
scribes the stiffness against rotation about the longitudinal axis. The second moments of area 
Iy and Iz describe the stiffnesses against bending about the local axes y and z. Axis y is consid-
ered to be the “strong” axis. The local cross-sectional axes are shown in the dialog graphic of 
the dialog box New Cross-Section. 

The moments of inertia for unsymmetrical sections are displayed about the cross-section's 
principal axes u and v. 

Moments of inertia as well as cross-sectional areas can be adjusted with the help of factors in 
the dialog tab Modify. In the table, you can access the tab with the [...] button that appears 
when you click into the table cell. 

 
Figure 4.34: Dialog box New Cross-Section, tab Modify 

With the entry in Figure 4.34, RSTAB considers the torsional constant only with 5 %. 

Cross-sectional areas 
The cross-section parameters of the cross-sectional areas are subdivided into the total area  
Axial A and the shear areas Shear Ay and Az. 

Shear area Ay relates to the moment of inertia Iz, shear area Az relates to Iy. Using a correction 
factor κ we see the following correlation existing between the shear areas Ay and Az as well as 
the total area A. 
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where A Total area of cross-section 
   Iz/y Moments of inertia of cross-section 

   Qz/y(x) Statical moments of cross-section at location x 
   t(x) Width of cross-section at location x 
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Shear areas Ay and Az affect the shear deformation which should be taken into account espe-
cially for short, massive members. When the shear areas are set to zero, the influence of shear 
will not be considered. Parameters can also be controlled in the dialog tab Global Calculation 
Parameters of the dialog box Calculation Parameters (see Figure 7.14, page 176). If extremely 
low values are set for shear areas, numerical problems may occur because the shear areas are 
contained in the denominator of equations. 

Select the values for cross-section areas realistically. Extreme differences in the cross-sectional 
areas of cross-sections involve significant differences in stiffness that may lead to numerical 
problems when solving the equation system. 

Angle of principal axes α 
The principal axes are described with y and z for symmetrical sections, and with u and v for un-
symmetrical sections (see above). The rotation angle of principal axes α describes the position 
of the principal axes in relation to the standard system of coordinates for symmetrical sections. 
For unsymmetrical sections it is the angle between the y-axis and the u-axis (see graphic in the 
left margin above). This angle is defined clockwise as a positive angle. When symmetrical 
cross-sections are set, angle α is 0. The inclination of principal axes for sections from the library 
cannot be edited. 

The angle of rotation for the principal axes is determined by the following equation: 

yz

yz
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−

⋅
=α  

Equation 4.4 

When you work with 2D models, only 0° and 180° are allowed to be set as cross-sectional an-
gles of rotation. 

Cross-section rotation α' 
The angle of rotation α' describes the angle about which the sections of all members using 
that cross-section are rotated. This angle represents a global cross-sectional angle of rotation. 
In addition, each member can be rotated separately about a member rotation angle β. 

Moreover, the dialog tab Rotation provides the option to Mirror nonsymmetrical cross-
sections. Use this option for example to put an L-section into the correct position. 

 
Figure 4.35: Dialog box New Cross-Section, tab Rotation 

When you import a cross-section from the cross-section library or SHAPE-THIN, you do not 
need to take care of the angle α'. RSTAB imports this angle in the same way as the other cross-
sectional values. For user-defined sections, however, you have to determine the angle of prin-
cipal axes yourself and to adjust it manually by means of the cross-section rotation. 

 

 



4  Model Data 

 57 Program RSTAB © 2013 Dlubal Engineering Software 

 

 

Overall dimensions 
Width b and Depth h of the cross-section are relevant for temperature loads. 

Cross-section library  
Numerous cross-sections are already available in the cross-section data base. 

Open the library 

In the dialog box New Cross-Section and in table 1.3 Cross-Sections, you have direct access to 
frequently used cross-section tables: 

 
Figure 4.36: Buttons of frequently used cross-sections in table (above) and dialog box (below) 

Use the button [Import Cross-Section from Library] to access the complete cross-section data-
base. When you work in the table, place the cursor into table column A to enable the [...] but-
ton which you can use like the function key [F7] to open the cross-section library. 

 
Figure 4.37: Cross-Section Library 

The cross-section library is divided into several sections which are described on the following 
pages. 

Rolled cross-sections 

The table values of many rolled cross-sections are stored in a database. 

First, click one of the ten buttons to define the Cross-Section Type. Another dialog box opens 
where you select the Table. Then, select an appropriate Cross-Section (see figure below). 
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Filter for  
Manufacturer/Standard group 

 
Figure 4.38: Selecting a rolled cross-section 

In the dialog section Filter, you can filter library entries by different criteria: Manufacturer/Stan-
dard group, Manufacturer/Standard, Cross-section shape and Cross-section note. In this way, it is 
easier to overview the offered tables and cross-sections. Displayed data can be sorted by click-
ing the headings of table columns. 

If cross-sections of old standards are needed, tick the checkbox for Inclusive invalid in the dia-
log section Filter to display also such sections. 

Create favorites 
Preferred cross-sections can be set as favorites. To access the dialog box for creating favorite 
cross-sections, use the button [Create New Favorites Group] in the right corner of the Filter dia-
log section. 

 
Figure 4.39: Dialog box Rolled Cross-Sections - I-Sections - Favorites 
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The dialog box looks like the cross-section library. You can use the filter options described 
above. In the dialog sections Select Favorites, you can choose preferred tables and cross-
sections with a check mark. 

After closing the dialog box, the cross-section library presents a clear overview of favorites as 
soon as you activate the option Favorites group. 

Built-up cross-sections 

Rolled cross-sections can be combined by specifying parameters. 

 
Figure 4.40: Dialog box Combined Cross-Sections - I-Sections 

Use the [Save] button to save a combined cross-section. RSTAB stores it with its accurate de-
scription (for example 2IK HE B 300 + UB 178x102x19 in the figure above) in the category User-
Defined from where you can reimport it later. 

Parametric cross-sections - thin 

With the offered input fields you can freely define parameters for a cross-section composed of 
sheets. The cross-section values will be calculated according to the theory for thin-walled 
cross-sections. The theory applies only to cross-sections whose element thickness is clearly 
smaller than the respective element length. If this condition is not fulfilled, define the cross-
section in the Massive category (see Figure 4.42), if possible. 

Parameter a represents the weld root, not the fillet radius (see figure below). 
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Figure 4.41: Input dialog box of a parameterized, thin-walled cross-section 

Use the button shown on the left to import the parameters of a rolled cross-section. By using 
the selection function you can avoid entering lots of parameters. 

Use the [Save] button to save a parametric cross-section with its exact name, for example  
IS 330/160/8/12/0 in the figure above. Click the [Load] button shown on the left to import it. 

Parametric cross-sections - massive 
With these input fields you can freely define the parameters of massive cross-sections (for ex-
ample reinforced concrete sections). The cross-section values will be calculated according to 
the theory for massive cross-sections provided for elements with distinctive wall thicknesses. 

 
Figure 4.42: Input dialog box of a massive cross-section 
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Parametric cross-sections - timber 

With the offered input fields you can freely define parameters for timber cross-sections. The 
cross-section values of both solid and combined cross-sections will be calculated according to 
the theory for massive cross-sections. 

 
Figure 4.43: Input dialog box of a timber cross-section 

Ticking the option Coefficient of compliance allows you to determine the effective stiffnesses 
for composite structural components from semi-rigidly connected cross-section elements, for 
example according to DIN 1052:2008-12, 8.6.2 (3). In this case, specify the reduction factors γ. 

When you work with a material of the type Hybrid, use the [Edit] button to assign the proper-
ties of the cross-section parts (see Figure 4.33, page 54).  
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User-defined cross-sections 

Import saved cross-section 

Click the [Load] button shown on the left to open a dialog box where all cross-sections created 
with the help of the Save function are displayed. 

 
Figure 4.44: Dialog box Properties of User-Defined Cross-Sections 

Create a user-defined cross-section 

Click the [Create] button shown on the left to create user-defined cross-sections. 

 
Figure 4.45: Dialog box Create User-Defined Cross-Section 

Enter the Table to define the place where the cross-section is managed. Specify also the Name 
to describe the new cross-section. Then, enter the cross-section parameters and define the 
buckling curves. 
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Cross-sections from cross-section program 

It is also possible to import cross-sections from the DLUBAL cross-section programs SHAPE-
THIN and SHAPE-MASSIVE. 

Please note that the cross-sections must be calculated and saved in SHAPE-THIN or SHAPE-
MASSIVE before the cross-sectional values can be imported. 

Import cross-section table from ASCII file 

Use the button in the bottom left corner of the library to import a complete cross-section table 
from a file. The file must be a comma separated values file (CSV). Any Excel file can be saved in 
this format. Make sure that the syntax of the ASCII table corresponds to the definition parame-
ters of the corresponding RSTAB cross-section table. 

Example: Import of double symmetrical I-sections 

The cross-sections are managed in the IS table (cf. Figure 4.41). For IS cross-sections, the fol-
lowing parameters are required: h, b, s, t, a. The table in Excel is structured as shown below 

 
Figure 4.46: Excel spreadsheet with cross-section parameters 

In the import dialog box, specify the directory of the CSV file. Then, use the list to select the 
cross-section table where you want to manage the imported cross-sections. 

 
Figure 4.47: Dialog box Import Cross-Sections from ASCII File 

Finally, you find the imported cross-sections available in the category User-Defined cross-
sections (see Figure 4.44). 

When importing cross-sections, RSTAB calculates the cross-section values and stress points so 
that stress designs can be performed as well. 
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4.4 Member End Releases 
General description 
Member releases limit the internal forces transferred from one member to others. Releases are 
assigned only to member ends (nodes). They can never be assigned to other locations, for ex-
ample to the middle of the member. 

Some member types are already provided with releases. A truss, for example, does not transfer 
moments. A cable neither transfers moments nor shear forces. When entering data, keep in 
mind that the assignment of releases is blocked for members of such member types. 

 
Figure 4.48: Dialog box New Member End Release 

 
Figure 4.49: Table 1.4 Member End Releases 
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Member context menu 

Reference system 
A member release can be related to one of the following axis systems: 

• Local member axis system x,y,z 

• Global coordinate system X,Y,Z 

• Global rotated coordinate system X',Y',Z' 

Use the Display navigator or the member context menu shown on the left to display the local 
member axes (see Figure 4.72, page 80). 

For detailed information about the orientation of local member axes in the global coordinate 
system X,Y,Z, see chapter 4.7 on page 80. 

Normally, releases are related to the local axis system x,y,z. Scissors releases (see release 3 in 
Figure 4.51), however, must be related to the global coordinate system. Spring constants and 
non-linearities must be defined in relation to the local member axis system. 

Axial/shear release or spring 
To define an axial or shear force release, tick the check box of the respective internal force in 
the dialog box or table. The check mark means that the corresponding internal force is blocked 
at the member end because a release has been set. Look at the Member End Release dialog box: 
A zero value is shown for the constant of the translational spring in the input field to the right 
of the check mark. 

You can always change the spring constant to represent for example a semi-rigid connection. 
In the table, enter the constant directly into the table column. The stiffnesses of the springs are 
considered as design values. 

Moment release or spring 
Define releases for torsion or bending moments like releases for forces. Again, the check mark 
means that the corresponding internal force is not transferred. 

Elastic connections can be modeled by means of spring constants that you can enter directly. 
Pay attention not to use extreme stiffness values because otherwise numerical problems may 
occur during the calculation. Instead of very big or small constants, apply rigid connections (no 
check mark) or releases (check mark). 

The option for defining non-linear release properties is described at the end of this chapter. 

Assign releases graphically 
To assign releases in the work window graphically, 

select Model Data on the Insert menu, point to Member End Releases and select  
Assign to Members Graphically or 

open the Edit menu, point to Model Data and Member End Releases, and then select 
Assign Graphically to Members. 

First, select a release type from the list or create a new one. After clicking [OK], members are 
divided graphically at one-third division points. 

 
Figure 4.50: Assigning member end releases graphically 
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Now, you can click the member sides to which you want to apply the selected release. To  
assign the release to both member ends, click the member in its center area. 

Scissors release 
With scissors releases you can represent crossing of beams. For example: You have four mem-
bers connected in one node. Each of the two member pairs transfers moments in its 'continu-
ous direction', but they do not transfer any moments to the other pair.  Only axial and shear 
forces are transferred in the node. 

 
Figure 4.51: Beam crossing 

 
Figure 4.52: Dialog box New Member End Release 

In this case, the release must be assigned either to members 1 and 2 or to members 3 and 4.  
The other crossing member pair will be modeled as bending-resistant without release. 



4  Model Data 

 67 Program RSTAB © 2013 Dlubal Engineering Software 

 

 
 

  

Non-linearities 
Non-linear properties can be assigned to member end releases. In this way, you can control 
the transfer of internal forces in detail. The list of non-linearities offers the following options: 

• Failure if internal force negative 

• Failure if internal force positive 

• Partial activity 

• Diagram 

 
Figure 4.53: List of nonlinear properties 

In the table, release types with non-linear properties are marked in blue. 

Failure if internal force negative or positive 
Use the two options to control the release activity for each internal force depending on the  
direction. For example, setting an axial force release with the nonlinearity Failure if positive N 
makes the release effective only for negative axial forces. Thus, only tensile forces (positive) are 
transferred at the member end, but no compressive forces (negative). 

The remaining entries of the Nonlinearity list offer detailed modeling options for release prop-
erties. To access the options, use the [Edit] dialog buttons to the right of the list or the [] but-
ton in the table (see Figure 4.49, page 64). 

Partial activity 

 
Figure 4.54: Dialog box Nonlinearity - Partial Activity 
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The activity of the release can be defined separately for the positive and negative zone. In addi-
tion to full effectiveness or failure, the release can loose its effect when a certain displacement 
or rotation is reached. Then, it begins to act as a fixed or rigid connection. Also Tearing (no in-
ternal force will be transferred anymore after exceeding a certain value) and Yielding (internal 
forces will be transferred only up to a certain value also in case of larger deformations) are pos-
sible in combination with a Slippage. 

The limit values can be defined in the input fields below. In the dialog section Activity Diagram, 
the release properties are shown in a dynamic graphic. 

Diagram 

 
Figure 4.55: Dialog box Nonlinearity - Diagram 

The activity of the release can be defined separately for the Positive and Negative Zone. First, 
enter the Number of steps (that means definition points) represented in the diagram. Then, you 
can enter the abscissa values of the internal forces with the assigned displacements or rota-
tions into the list to the right. 

You find several options for the Diagram after last step: Tearing for failure of the release (no  
internal force will be transferred any longer), Yielding for restricting the transfer to a maximum 
allowable internal force, Continuous as in the last step or Stop for restricting to a maximum al-
lowable displacement or rotation followed by a fixed or rigid release activity. 

In the dialog section Diagram, the release properties are shown in a dynamic graphic. 
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Example: rafter roof 

X

Y

Z

1

2

3

1

2

4

3

5
4

5

 
Figure 4.56: Rafter roof 

A planar system is used. The release must be defined as follows: 

 
Figure 4.57: Table 1.4 Member End Releases 

Now, the release type can be assigned to the members. 

 
Figure 4.58: Graphic and table 1.7 Members 

 
Figure 4.59: Moment diagram in load case Self-weight 
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4.5 Member Eccentricities 
General description 
The length of a member in RSTAB corresponds to the distance between two nodes defining 
the member. However, in some modeling situations (connections of cross-sections or down-
stand beams), reality is represented only to a certain degree. With member eccentricities you 
can connect members eccentrically due to special member end sections. In this way, you can 
reduce for example design moments on horizontal beams for frames with big column cross-
sections. Member eccentricities are taken into account by a transformation of the degrees of 
freedom in the local element stiffness matrix of the respective member. 

To check the entered eccentricities, use the photo-realistic imaging of the 3D rendering. 

 
Figure 4.60: Dialog box New Member Eccentricity 

 
Figure 4.61: Table 1.5 Member Eccentricities 

Reference system 
A member eccentricity can be related to one of the following axis systems: 

• Local member axis system x,y,z 

• Global coordinate system X,Y,Z 

Use the Display navigator or the context menu of the member to display the local member  
axes x,y,z (see Figure 4.72, page 80). 
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Eccentricity for member start/member end 
In the dialog section Absolute Offset, respectively in table columns B to G, you define the ec-
centricities for the Member start i and the Member end j. The distances are related to the select-
ed axis system indicated by the upper- and lower-case indexes which are also shown in the di-
alog graphic. 

In the dialog box, you can use the buttons [] and [] to transfer the values from one side to 
the other. 

Cross-section alignment 
In the dialog section Relative Automatically Offset, use the nine selection options to define the 
cross-section point relevant for the determination of the eccentricity. In the table, specify the 
position of the point in columns H and I. The point defines the distance by which the cross-
section is shifted on the start or end node. 

By defining the point in the middle of the top flange, as shown in the picture on the left, you 
can attach for example a horizontal beam with its top edge to a column by flush connection 
(without extension). 

Transverse offset from cross-section of other member 
With a Transverse offset you can arrange a member parallel to another member in a particular 
distance. Select the number of the relevant member from the list. You can also use the [] 
function to select it in the work window. The eccentricity is determined from the Cross-section 
alignment defined above and the Axis offset as a result of the cross-sectional geometry that you 
define by the nine check boxes. In the table, define the axis offset in columns L and M. 

For example, when the points are defined on the top cross-section border and in the cross-
section center as shown in the figures on the left, a horizontal beam cross-section is connected 
with its upper chord to the head of a column by flush connection. 

Axial offset from adjoining members at 
The last option in the dialog section Relative Automatically Offset allows you to connect easily 
for example a member eccentrically to a flange of a column. The offset can be arranged sepa-
rately for Member start and Member end. The eccentricity is determined automatically from the 
cross-section geometry of the adjacent members. In the table, assign the axial offset in col-
umns N and O. 

The dialog graphic Axial Offset is interactive with the input, illustrating the effectiveness of the 
selected check boxes. 

You may prefer the input in the dialog section Relative Automatically Offset because you can di-
rectly adjust the eccentricities when cross-sections are changed. RSTAB takes into account 
modified cross-section dimensions automatically. 

Assign eccentricities graphically 
Furthermore, eccentricities can be assigned to members graphically in the work window. To 
open the corresponding dialog box, 

select Model Data on the Insert menu, point to Member Eccentricities and select  
Assign to Members Graphically or 

open the Edit menu, point to Model Data and Member Eccentricities, and then select 
Assign Graphically to Members. 

First, define the reference system and the eccentricities. 

After clicking [OK], members are divided graphically at one-third division points. Now, you can 
click the member sides to which you want to apply the eccentricity (see Figure 4.50, page 65). 
To assign an eccentric connection to both member ends, click the member in its center area. 
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4.6 Member Divisions 
General description 

Member divisions are used to define points on members for which internal forces and defor-
mations are displayed later in the results tables and the numerical printout. A member division 
has neither influence on the determination of extreme values nor on the graphical results dia-
gram (RSTAB internally uses a more refined partition). Therefore, in most cases, member divi-
sions are not required. 

 
Figure 4.62: Dialog box New Member Division 

 
Figure 4.63: Table 1.6 Member Divisions 

Number of points 
You can enter a maximum number of 99 division points in the dialog box. An entry divides the 
member into the desired number of equidistant points. 

Relative distance of point from member start 
When you create a new division in the dialog box, the distances of three intermediate points 
are preset. They represent the relative distances in the interval of 0 (member start) to 1 (mem-
ber end). 

It is also possible to define irregular divisions for the specified points as you can enter the rela-
tive distances freely. Only make sure that you follow the correct order of intervals: x1 < x2 < x3 ... 

Moreover, any x-location on the member can specifically evaluated graphically (see chapter 
9.5, page 208). Thus, in most cases entering member divisions manually with troublesome de-
termination of relative distances is unnecessary. 
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4.7 Members 
General description 

The geometry of the model is defined by members. Every member is defined by a start and an 
end node. By assigning a cross-section (by which also a material is defined), the member re-
ceives a stiffness. 

Members can be connected with each other only on nodes. When members cross each other 
without sharing a common node, no connection exists. No internal forces are transferred on 
such crossings. 

Graphically, you can apply members as Single or Continuous. The option Inserted Member is  
described in chapter 11.4.13 on page 316. 

 
Figure 4.64: Dialog box New Member, tab General 

 
Figure 4.65: Table 1.7 Members 
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Figure 4.66: Dialog box New Member, tab Options 

Member type 
With the member type you define the way how internal forces are absorbed or which proper-
ties are assumed for the member. 

Different options are available for selection in the Member Type list. Each member type has its 
own Color that can be used in the model to represent different kinds of members. Colors are 
controlled in the Display navigator with the option Colors in Rendering According to (see chap-
ter 11.1.9, page 268). 

Member type Short description 

Beam Bending-resistant member that can transmit all internal forces. 

Rigid Coupling member with rigid stiffness 

Truss Beam with moment releases at both ends 

Truss (only N) Member with stiffness E · A only 

Tension Truss (only N) with failure in case of compression force 

Compression Truss (only N) with failure in case of tension force 

Buckling Truss (only N) with failure in case of compression force > Ncr 

Cable Member transferring tension forces only. Calculation is performed 
according to large deformation analysis. 

Definable stiffness Member with user-defined stiffnesses 

Coupling rigid-rigid Rigid coupling with bending-resistant connections at both ends 

Coupling rigid-hinge Rigid coupling with bending-resistant and hinged connection 

Coupling hinge-hinge Rigid coupling with hinged connections at both ends (only axial 
and shear forces are transmitted, but no moments). 

Coupling hinge-rigid Rigid coupling with hinged and bending-resistant connection 

Null Member that will be ignored in the calculation 

Spring (in preparation) Member with spring stiffness, definable activity zones and damping 
coefficients 

Table 4.1: Member types 
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Beam 

A beam does not have any releases defined on its member ends. When two beams are con-
nected with each other and no release has been defined for the common node, the connec-
tion is bending-resistant. Beams can be stressed by all types of loads. 

Rigid member 

It couples the displacements of two nodes by a rigid connection. Thus, it corresponds to a 
coupling member in principle (see page 77). Use a rigid member to define members with high 
stiffness taking into account releases which may also have spring constants and nonlinearities. 
Hardly any numeric problems will occur as stiffnesses are adjusted to the system. RSTAB shows 
internal forces also for rigid members. 

The following stiffnesses are assumed (applies also to couplings and Dummy Rigids): 

• Longitudinal and torsional stiffness E · A = G · IT = 1013 · l (l = member length) 

• Flexural resistance E · I = 1013 · l3 

• Shear stiffness (if activated) GAy = GAz = 1016 · l3  

Due to this type of member it is no longer necessary to define a Dummy Rigid (see page 54) 
which is assigned as cross-section. 

Truss (only N) 

This type of a truss member absorbs axial forces in the form of tension and compression. A 
truss member has internal moment releases on its member ends. Therefore, an additional re-
lease definition is not allowed. RSTAB shows you only node internal forces (which are trans-
ferred to the connecting members). The member itself shows a linear distribution of internal 
forces. An exception is the concentrated load on the member, which means that no moment 
diagram will be visible as a result of self-weight or a line load. The boundary moments are zero 
because of the release. A linear distribution is assumed along the member. The nodal forces, 
however, are calculated from the member loads, which guarantees a correct transmission. 

The reason for special treatment is that a truss girder, as it is commonly understood, transfers 
only axial forces. Moments are not of interest. Therefore, they are deliberately neither shown in 
the output nor calculated as a part of the design. To get and see moments from the member 
loads, use the member type Truss. 

Tension member / Compression member 

A tension member can absorb only tension forces and a compression member only compres-
sion forces. The calculation of a framework structure with these types of members is carried 
out iteratively. In the first iteration, RSTAB determines the internal forces of all members. If ten-
sion members have negative axial forces (compression), or if compression members have posi-
tive axial forces (tension), an additional iteration step is started in which the rigidity of these 
members won't be considered anymore - they have failed. This iteration process continues as 
long as tension or compression members are failing. Depending on modeling and loading, the 
system may become unstable due to failure of tension or compression members. 

A failed tension or compression member can be considered again in the stiffness matrix if it is 
reactivated in a later iteration step due to redistributions in the system. You can control the 
Reactivation of Failing Members in the dialog tab Global Calculation Parameters of the  
Calculation Parameters dialog box that you open by selecting Calculation Parameters on 
the Calculate menu. Details can be found in chapter 7.2, page 176. 
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Buckling member 

A buckling member absorbs unlimited quantities of tensile forces. Compressive forces, howev-
er, can be absorbed only until the critical Euler load is reached. 

2
cr

2

cr
l

IE
N

⋅⋅π
=   where  llcr =  

Equation 4.5 

With this type of member you can often avoid instabilities occurring in calculations according 
to second order or large deformation analysis due to buckling of truss members. If you replace 
trusses − close to reality − by buckling members, the critical load is increased in many cases. 

Cable 

Cable members absorb only tension forces. They are used to analyze cable chains with longi-
tudinal and transversal forces by iterative calculations taking into account the cable theory 
(large deformation analysis - see chapter 7.2.1, page 170). It is required to define the complete 
cable as cable chain consisting of several cable members. 

To create catenaries quickly, point to Generate Model on the Tools menu and select Arc 
(chapter 11.7.2, page 351). The more accurately the starting shape of the catenary corresponds 
to the real cable chain, the more stable and faster you can perform the calculation. 

It is recommended to prestress cable members in order to prevent compression forces result-
ing in failure. Furthermore, cables should be used only if deformations have a considerable 
part in changes of the internal forces, that means when large deformations occur. For simple 
straight riggings like transverse bracings (projecting roof), tension members are completely 
sufficient. 

When evaluating deformations of cable members, set the scaling factor in the control panel 
(see Figure 3.20, page 29) to “1“ so that tightening effects are represented realistically. 

Stiffnesses 

The member stiffnesses can be directly specified in a dialog box that you open with the [Edit] 
button. Thus, the assignment of a cross-section is unnecessary. 

 
Figure 4.67: Dialog box Edit Member Stiffness 

To look at the definition of the stiffness matrix, use the [Info] button. 
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Coupling 

A coupling member is a virtual, very stiff member with definable rigid or hinged properties. It 
is possible to couple the degrees of freedom of the start and end nodes in four different ways. 
The axial and shear forces, respectively torsional and bending moments, are transferred direct-
ly from one node to the other. Couplings can be used to model special situations for the trans-
fer of forces and moments. 

RSTAB calculates stiffnesses of couplings depending on the model in order to exclude numeri-
cal problems. 

With the alternative Rigid member (see page 75) you can define coupling members consider-
ing also springs and nonlinearities of releases. 

To control the display of coupling results, use the Display navigator. 

 
Figure 4.68: Activating the display for results of coupling members in the Display navigator 

Null (dummy member) 

Neither a dummy nor its loads will be considered for the calculation. Use dummies to analyze, 
for example, changes in structural behavior if certain members are not effective. You do not 
need to delete these members, loading will be kept as well. 
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Spring (in preparation) 

If Spring non-linearities are set, you can open a new dialog box by using the [Edit] dialog but-
ton or the [...] button in the table. 

 
Figure 4.69: Dialog box Edit Parameters for Member of Type 'Spring' 

Define the spring properties by Parameters or in a Diagram. The spring constant C1,1 describes 
the stiffness of the member in its local x-direction according to the following relation: 

l
AE

k
⋅

=  

Equation 4.6 

The Slippage specifies a zone of the deformation where the spring does not absorb any forces. 

Furthermore, you have two options to define the spring Limits: 

• Deformation: The values umin and umax define the geometric activity zone of the spring. The 
spring will act as a rigid member (stop) for deformations beyond the specified zone. 

• Force: The values Nmin and Nmax define the activity zone for the forces that can be absorbed 
by the spring. If the axial force is beyond the defined limits, the spring fails. 

When the Diagram option is set, you can define spring properties even more precisely. The set-
tings are largely identical with the options available for nonlinear member releases (see chap-
ter 4.4, page 68). 
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Node no. start / end 
Every member is geometrically defined by a start and an end node. With this definition the 
member orientation is defined, which affects also the member coordinate system. The nodes 
can be entered manually, graphically selected or redefined (see chapter 4.1, page 41). 

The display of member orientations can be activated in the Display navigator. 

 
Figure 4.70: Activating Member Orientations in the Display navigator 

The member orientation can be changed quickly in the graphic: Right-click the member and 
select Reverse Member Orientation in the context menu. The numbers of the start and end node 
will be interchanged. 

Member rotation 
The member-related coordinate system x,y,z is defined clockwise by right angles. The local axis 
x represents always the centroidal axis of the member, connecting the start node with the end 
node of the member (positive direction). Member axes y and z, respectively u and v for unsym-
metrical cross-sections, represent the principal axes of the member. 

 

Figure 4.71: Member rotation and local member axes x,y,z (any spatial position) 

The position of the local axes y and z is set automatically. Axis y runs perpendicular to the lon-
gitudinal axis x and, as far as possible, parallel to the global plane XY. The position of axis z is 
determined by the right-hand rule. The z' component of the z-axis always shows downwards 
(which means in direction of the gravity) - irrespective of whether or not the global axis Z is 
oriented downward or upward. 
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Member context menu 

To check the member position, use the 3D rendering. You can also use the Display navigator or 
the member context menu to display the Member Axis Systems x,y,z. 

 
Figure 4.72: Selecting the local member axis systems in the Display navigator 

Table column O informs you about the global axis running parallel to the member or indicates 
the plane spanned by the global axes where the member is lying. If there is no entry, the mem-
ber is in an arbitrary spatial position. 

If a member is aligned parallel to the global axis Z, which means in vertical position, the local 
axis z, of course, has no Z-component. In this case, the following rule applies: The local axis y 
will be aligned parallel to the global axis Y. Then, the position of the z-axis is determined by 
the right-hand rule. 

 

Figure 4.73: Vertical member position for members with different member orientations (β = 0°) 

When a member located in a continuous set of column members is not exactly in vertical posi-
tion (because of minor deviations of the nodal coordinates X or Y), the axes of the member can 
change their orientation. RSTAB classifies the position of a member that is slightly inclined as 
"general". If you want to classify members in general position still as vertical, select Regenerate 
Model on the Tools menu (see chapter 7.1.3, page 167). 

Member rotations can be applied in two ways: 

Member rotation via angle β 

You define an Angle β about which the member is rotated. If the rotation angle β is positive, 
axes y and z are rotated clockwise around the longitudinal member axis x. 

Please note that the member rotation angle β and the cross-section rotation angle α' (see 
chapter 4.3, page 56) are summed up. 

In 2D models, only member rotation angles of 0° and 180° are allowed. 
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Member rotation via help node 

The member axis system is directed to a particular node. First, select the axis (y or z) that you 
want to be affected by the help node. Accordingly, the help node determines the plane x-y or 
x-z of the member. Then, enter the help node. It is also possible to select it graphically or to 
create a new one. However, make sure that the node does not lie on the straight line that is de-
fined by the x-axis of the member. 

The following example shows columns that are aligned towards the center point. 

 
Figure 4.74: Member rotation via help node 

Changes of the local member axis system may affect the signs of internal forces. The following 
figure illustrates the general sign rule. 

 
Figure 4.75: Positive definition of internal forces 

The bending moment My is positive if tensile stresses occur on the positive member side (in di-
rection of the z-axis). Mz is positive if compressive stresses occur on the positive member side 
(in direction of the y-axis). The sign definition for torsional moments, axial forces and shear 
forces conforms to the usual conventions. These internal forces are positive if they act in a pos-
itive direction. 
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Cross-section no. start / end 
The two input fields or table columns are used to define the cross-sections for the member 
start and end. The numbers of the cross-sections refer to the entries in table 1.3 Cross-Sections 
(see chapter 4.3, page 53). Assignment is made easier by colors related to different cross-
sections. 

When you enter different numbers for the start and end cross-sections, a taper is created. 
RSTAB interpolates the variable stiffnesses along the member according to polynomials of 
higher grade. Input of nonsense like a taper consisting of an IPE cross-section and a round 
steel will be identified by the plausibility check before the calculation starts. 

The internal determination of tapered cross-section values is controlled by the Taper Shape set 
in the Options tab of the New Member dialog box, respectively the table column (see 82). 

Member release no. start / end 
In these two table columns or input fields of the New Member dialog box, you can define re-
leases controlling the transfer of internal forces on nodes. The release numbers refer to the en-
tries in table 1.4 Member End Releases (see chapter 4.4, page 64). 

For some of the member types, entries are not possible because internal releases already exist. 

Member eccentricity 
In this table column or input field of the Options dialog tab (see Figure 4.66), you can assign an 
eccentric connection to the member. The numbers of the eccentricities refer to table 1.5 Mem-
ber Eccentricities (see chapter 4.5, page 70). A connection type determines the eccentricities of 
both the member start and the member end. 

Member division 
Member divisions control the numerical output of internal forces and deformations along the 
member (see chapter 4.6, page 72). Use the settings in the table column or the input field of 
the Options dialog tab to assign divisions or to create new ones. The numbers of the divisions 
refer to the entries in table 1.6 Member Divisions. 

A member division has neither influence on the determination of extreme values nor on the 
graphical results diagram (RSTAB internally uses a more refined partition). As member divi-
sions are not required in most cases, the default setting is 'None' or '0'. 

Taper shape 
If different cross-sections are defined for the member start and member end, this table column 
or input field in the Options tab offers you the choice between Linear and Quadratic taper lay-
out. In this way, it is possible to describe the taper geometry for the determination of the in-
terpolated cross-section values. 

In most cases, a linear taper course is existent: The height of the cross-section is changing 
evenly from the start to the end cross-section, the width remains more or less constant. How-
ever, if also the width of the cross-section is changing distinctly along the member (for exam-
ple taper made of solid sections), it is recommended to use a square function for the interpola-
tion of cross-section values. 

Length 
This table column indicates the absolute length of the member as distance between start and 
end node. Eccentricities are taken into account. 

You can read the member length also in the work window: Place the mouse pointer on a mem-
ber and wait a moment until the ScreenTip of the member appears. 

 

Tapered member 
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Weight 
The mass of a member is determined from the product of the cross-sectional area A and the 
specific weight of the material. RSTAB applies g = 10 m/s2 for gravitational acceleration. 

Position 
Table column O informs you about the global axis running parallel to the member, or it indi-
cates the plane spanned by the global axes where the member is lying. If there is no entry, the 
member is in an arbitrary spatial position. 

When a member located in a continuous set of column members is not exactly in vertical posi-
tion (because of minor deviations of the nodal coordinates X or Y), the axes of the member can 
change their orientation. RSTAB classifies the position of a member that is slightly inclined as 
"general". If you want to classify members in general position still as vertical, select Regenerate 
Model on the Tools menu (see chapter 7.1.3, page 167). 

Member elastic foundation 
With this input field of the Options tab (see Figure 4.66) you can assign an elastic foundation to 
the member. The numbers of the elastic foundations are managed in table 1.9 Member Elastic 
Foundations (see chapter 4.9, page 91). 

Member nonlinearity 
This input field in the Options dialog tab makes it possible to provide the member with nonlin-
ear properties (see Figure 4.66, page 74). The numbers of the non-linearities refer to the entries 
in table 1.10 Member Nonlinearities (see chapter 4.10, page 93). 

Effective lengths 
The dialog tab Effective Lengths manages the Effective Length Factors kcr,y and kcr,z. 

 
Figure 4.76: Dialog box Edit Member, tab Effective Lengths 

The effective length factors can be adjusted separately for both member axes. The dialog fields 
to the right show the Effective Lengths resulting from the entered factors and the member 
length. 
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Effective length factors are significant for add-on modules like STEEL EC3 where stability anal-
yses are performed, but they play a secondary role for RSTAB as for example buckling lengths 
for buckling members are determined internally from the boundary conditions, and then they 
are applied exactly. 

In the dialog section Critical Buckling Load, you can decide if the flexural buckling load of the 
member will be checked during the calculation. The check box is ticked by default for truss, 
compression and buckling members. The dialog tab Global Calculation Parameters of the Cal-
culation Parameters dialog box (see Figure 7.14, page 176) offers a global setting option for this 
kind of control. 

Modify stiffness 
The dialog tab Modify Stiffness allows you to have an influence on the member stiffnesses. 

 
Figure 4.77: Dialog box Edit Member, tab Modify Stiffness 

RSTAB presets a Multiplier factor of 1.00 for the torsional, flexural, axial and shear stiffness of 
the member: All stiffness components are taken into account by the calculation as they stand. 
If required, it is possible to define a reduction or increase factor in the input fields so that you 
can adapt the member stiffnesses. 

In case changes have also been made for the cross-section stiffnesses (see chapter 4.3, page 
55), they are additionally taken into account by the calculation. 

Double members 
Generally, overlapping members in the model are not desired. So when you define a new 
member on the nodes of an already existing member, RSTAB will delete the old member  
automatically. 

To prevent RSTAB from deleting already defined members, select Allow Double Members on 
the Edit menu. RSTAB will consider the stiffnesses of both members in the calculation.  
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4.8 Nodal Supports 
General description 
Supports are used to transfer loads applied on a structural system into the foundations. With-
out any supports all nodes would be free and could be displaced or rotated. If you want a node 
to act as a support, at least one of its degrees of freedom must be blocked or restricted by a 
spring. In addition, the node must be part of a member. The boundary conditions of a member 
must be considered as well to exclude a double release on the supported node. 

Nodal supports are required in order to apply imposed deformations. 

It is possible to provide nodal supports with nonlinear properties (failure criteria for tensile or 
compressive forces, working and stiffness diagrams). 

 
Figure 4.78: Dialog box New Nodal Support 

 
Figure 4.79: Table 1.8 Nodal Supports 
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Context menu of nodal support 

To open the following dialog box, open the Insert menu, point to Model Data and Nodal 
Supports, and then select Graphically, or use the toolbar button shown on the left: 

 
Figure 4.80: Dialog box New Nodal Support 

The following support types are predefined and can be selected from the list: 

• Hinged (YYY NNY) 

• Rigid (YYY YYY) 

• Sliding in X‘ (NYY NNY) 

• Sliding in Y‘ (YNY NNY) 

After clicking the [OK] button you can assign the selected support type to nodes in the graphic. 

Use the [New] button to create another type of support. The dialog box shown in Figure 4.78 
appears. 

On nodes 
Singular supports can be defined only on nodes. Enter the node number into the table column 
or the input field of the dialog box. You can select it also graphically. 

Support rotation 
Each nodal support has a local coordinate system which is oriented parallel to the global axes 
X, Y and Z by default. Use the context menu of the nodal support to activate the display for the 
support coordinate systems. 

It is possible to rotate the support's local axis system. First, select the Sequence that determines 
the order of the local support axes X', Y' and Z'. Then, enter the angle of rotation for the global 
axes X, Y and Z into the input fields below Rotated about. You can use the dialog buttons [] 
to define the support rotation also graphically (see Figure 4.81). 
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Figure 4.81: Dialog box New Nodal Support with options for support rotation 

The entered support rotation is shown in the interactive dialog graphic. 

When the calculation is complete, you can evaluate the support reactions of a rotated nodal 
support in relation to the global as well as the local axis system. 

Support or spring 
To define a support, select the corresponding option in the dialog box or table. The check 
mark indicates that the corresponding degree of freedom is blocked and the node displace-
ment in the corresponding direction is not possible. 

If you don't want to define supports, clear the corresponding check box. Then, RSTAB sets the 
constant of the translational spring to zero in the Nodal Support dialog box. It is always possi-
ble to modify the spring constant in order to represent an elastic support of the node. In the 
table, enter the constant directly into the table column. 

The spring stiffnesses must be entered as design values. 

Assigning nonlinear support properties is described below. 

Restraint or spring 
Restraints are defined in a similar way as supports. Again, the check mark indicates that the 
corresponding degree of freedom is blocked and the node displacement in the corresponding 
direction is not possible. The constants for rotational springs can be defined as soon as the 
check boxes are cleared. In the table, enter the spring constant directly into the corresponding 
table column. 
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The dialog box New Nodal Support (see Figure 4.78, page 85) provides buttons for different 
support types, making the definition of degrees of freedom easier. 

 
Figure 4.82: Buttons in the dialog box New Nodal Support 

The buttons are reserved for the following support properties: 

Button Support type 

 
Rigid 

 
Hinged with restraint about Z' 

 
Sliding in X' and Y' with restraint about Z' 

 
Sliding in X' with restraint about Z' 

 
Sliding in Y' with restraint about Z' 

 
Sliding in Z' and Y' with restraint about Z' 

 
Free 

Table 4.2: Buttons in Nodal Support dialog box 

Non-linearities 
To control in detail the transfer of internal forces, it is possible to provide nodal supports with 
nonlinear properties. The list of non-linearities includes the following options: 

• Failure of component if support force or moment is negative or positive 

• Complete failure of support if support force or moment is negative or positive 

• Partial activity 

• Diagram 

• Friction depending on remaining support forces 

The non-linear properties can be accessed in the dialog box and table by using the list (see 
Figure 4.78 and Figure 4.79). In this way, you can define for each support's degree of freedom 
whether and which forces or moments are transferred at the supported node. 

Nonlinear effective supports are displayed with a different color in the graphic. In the table, 
support elements having non-linear properties are indicated by a blue check box. 

Failure if support force/moment is negative or positive 

Both options control easily for each support component whether only positive or negative 
forces/moments are transferred on the supported node. If this condition is not fulfilled, the 
relevant component of the support fails. The remaining retentions and restraints are still effec-
tive. 

Positive or negative refers to the forces or moments that are introduced to the nodal support 
with regard to the respective axes (they do not refer to the reaction forces of the support). So 
signs are resulting from the direction of the global axes. If the global Z-axis is oriented down-
wards, the load case 'Self-weight' results in a positive support force PZ. 

Failure all if support force/moment is negative or positive 

In contrast to the failure of a single component described above, the support fails completely 
as soon as the component is ineffective. 
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To access the following dialog boxes, use the buttons [Edit Nonlinearity] or [] to the right of 
the list available in the dialog box and table. 

Partial activity 

 
Figure 4.83: Dialog box Nonlinearity - Partial Activity 

The support's effect can be defined separately for the Positive and Negative Zone. The sign rule 
is described in the previous paragraph. In addition to Complete activity or complete Failure, the 
support can be set to be effective only when it is displaced or rotated to a certain degree. In 
this case, a translational or rotational spring should be defined before. 

Furthermore, Tearing (failure of support when exceeding a certain force or moment) as well as 
Yielding (effective only until force or moment is reached) can be set in combination with a Slip-
page. 

Look at the dynamic dialog graphic called Activity Diagram to check the support properties. 
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Diagram 

 
Figure 4.84: Dialog box Nonlinearity - Diagram 

The support's effect can be defined separately for the Positive and Negative Zone. First, define 
the Number of steps (that means definition points) for the working diagram. Then, enter abscis-
sa values of the displacements or rotations with corresponding support forces or moments in-
to the list to the right. 

You find different options for the Diagram after last step: Tearing for support failure when ex-
ceeding, Yielding for restricting the transfer to a maximum allowable support force or moment, 
Continuous as in the last step, or Stop for restricting to a maximum allowable displacement or 
rotation followed by a rigid or restrained support activity. 

Friction depending on support force 

Use the four friction options to set the transferred support forces in relation to the compres-
sive forces acting in another direction. Depending on your selection, the friction depends on 
only one support force or on the total force of two support forces acting simultaneously. 

Click the [Edit] dialog button to open a dialog box where you can define the Friction Coefficient 
μ. 

 
Figure 4.85: Dialog box Friction in uX' (dialog section) 

The following relation exists between axial force and friction force of the support: 

forceAxialSupport PP ⋅µ=  

Equation 4.7 
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4.9 Member Elastic Foundations 
General description 
While nodal supports represent a support on both member ends, member elastic foundations 
provide an elastic support of the member along its entire length. Use elastic member founda-
tions to model for example foundation beams considering soil properties. If the elastic founda-
tion is not effective in case of tensile or compressive stresses, it is possible to take into account 
nonlinear effects in the calculation. 

 
Figure 4.86: Dialog box New Member Elastic Foundation 

 
Figure 4.87: Table 1.9 Member Elastic Foundations 

On members 
Member elastic foundations can only be defined for the member type Beam. Enter the number 
of the member into the table column or input field. You can also define it graphically. 

Spring constants 

Translational spring 

You have to specify the parameters of translational springs in direction of the local member 
axes x, y and z. 

The stiffness moduli ES of Table 4.3 serve as reference values. Please note that input in RSTAB 
refers to the foundation module to be determined by taking into account the form factor. 

 



4  Model Data 

 

 

92 Program RSTAB © 2013 Dlubal Engineering Software 

 
 

Member context menu 

Soil type ES (static loading) ES (dynamic loading) 

Sand, compact 40 – 100 200 – 500 

Gravel sand, compact 80 – 150 300 – 800 

Clay, semi-solid to solid 8 – 30 120 – 250 

Clay, stiff-plastic 5 – 20 70 – 150 

Mixed soil, semi-solid to solid 20 – 100 200 – 600 

Table 4.3: Stiffness moduli of selected soil types in [N/mm2] 

The values of Table 4.3 represent area-related characteristic values: They describe the area 
force in [N/mm2] that is required to compress the soil by 1 mm. Thus, the unit would be inter-
preted in a solid-related way as [N/mm3]. 

For foundation beams used for example to model strip foundations, you have to determine 
the spring coefficient taking into account the cross-section width. In this way, you get a trans-
lational spring in [N/mm2] that is related to the member. The spring indicates the member 
force in [N/mm] that is required to compress the soil by 1 mm - therefore the unit [N/mm2] for 
the input. The result must be entered as translational spring C1,z: For strip foundations (mem-
bers in horizontal position) the local z-axis is usually directed downwards. 

The spring stiffnesses are considered as design values. 

Use the Display navigator or the context menu of the member to display the local member  
axes (see Figure 4.72, page 80). 

Shear spring 

Shear springs are used to determine the shear capacity of the soil. The spring constants C2 are 
determined from the product of ν · C1,z, with the Poisson’s ratio ν to be assumed between 
0.125 and 0.5 for sand and gravely soil, and between 0.2 and 0.4 for clayey soil. 

Rotational spring 

Enter the constant of a rotational spring into the dialog input field or table column. The con-
stant hinders the member rotating about its longitudinal axis. 

Ineffective foundation 
If the elastic foundation is not effective in case of tensile or compressive stresses, assign the 
nonlinear property Failure to the foundation type. 

Please note that the failure criterion Failure if negative or positive contact stress in z only refers 
to the local member axis z. The nonlinearity does not apply to the translational springs in di-
rection of the local axes x or y! Thus, a biaxially effective failure of foundation members is not 
possible. 

An ineffectivity in case of a negative contact stress has the following meaning: The foundation 
is without effect if a member element moves in opposite direction of the local axis z. 

When failure criteria is applied, it is recommended to check position and orientation of the lo-
cal z-axes (see Figure 4.72, page 80). It might be necessary to rotate members. 

The member division of members with elastic foundations can be adjusted in the dialog tab 
Global Calculation Parameters of the dialog box Calculation Parameters (see chapter 7.2, page 
176). 
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4.10 Member Nonlinearities 
General description 
Member non-linearities are used to represent non-linear relations between force (or moment) 
and strain in members. 

Some non-linear properties can be set already when defining the member type. A tension 
member, for example, is a truss for which the strain is increasing proportional to the tension 
force, but whose strain may rise under compression without needing a verifiable force for it. 

In principle, member non-linearities can be assigned to any type of member. Of course, com-
binations have to make sense. A compression member with the design criterion "Failure under 
compression" would cause problems during the calculation. Therefore, member nonlinearities 
are not allowed for the member types tension, compression, buckling and cable member as 
well as for members with cross-sections of the type Dummy Rigid (see page 54). 

 
Figure 4.88: Dialog box New Member Nonlinearity 

 
Figure 4.89: Table 1.10 Member Nonlinearities 
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Nonlinearity Diagram Description 

Failure under  
tension 

 

The member cannot absorb tensile forces. 

Failure under 
compression 

 

The member cannot absorb compressive forces. 

Failure under ten-
sion with slippage 

 

The member cannot absorb tensile forces. 

Compressive forces are not absorbed until the 
slippage ux is overcome. 

Failure under 
compression with 
slippage 

 

The member cannot absorb compressive forces. 

Tensile forces are not absorbed until the slip-
page ux is overcome. 

Slippage 

 

The member absorbs axial forces only after  
having exceeded a strain or shortening by the 
value ux. 

Tearing under  
tension 

 

The member absorbs compressive forces with-
out limitation but fails if tensile forces exceed 
Nto. 

 



4  Model Data 

 95 Program RSTAB © 2013 Dlubal Engineering Software 

 

Yielding under 
tension 

 

The member absorbs compressive forces with-
out limitation, but only a maximum tensile force 
of Nto. 

If the strain increases, the tensile force remains 
constant in the member. 

Tearing under 
compression 

 

The member absorbs tensile forces without limi-
tation but fails if compressive forces exceed 
Nfrom. 

Yielding under 
compression 

 

The member absorbs tensile forces without limi-
tation, but only a maximum compressive force 
of Nfrom. 

If the strain increases, the compressive force 
remains constant in the member. 

Tearing 

 

The member fails when reaching the compres-
sive force Nfrom or the tensile force Nto.  

Yielding 

 

The member starts to yield if the compressive 
force Nfrom or the tensile force Nto are reached: If 
the strain increases, the force remains constant. 

Plastic hinge 

 

If a plastic design force is reached on a location 
of the member, a plastic hinge is formed there 
for the internal force. 

The internal forces must be entered as absolute 
values. For components of internal forces not 
resulting in plastifications, you have to enter 
high values. 

Table 4.4: Member nonlinearities 
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4.11 Sets of Members 
General description 

Sets of members must be understood as combined members. Use a set of members to treat 
several members like a single member as it may be preferable for some locations in the struc-
tural system (for example for lateral-torsional buckling analysis, design of continuous beams, 
load application). 

 
Figure 4.90: Continuous members with trapezoidal load 

The figure above shows a linearly variable load acting on the complete length of a set of 
members. 

 
Figure 4.91: Dialog box New Set of Members 

 
Figure 4.92: Table 1.11 Sets of Members 

Description 
You can enter any name for the set of members. You can also use the list to select a name. 
Manually entered descriptions are saved in the list and are instantly available for selection. 
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Type 
There are two different types of member sets: continuous members and groups of members. 

Continuous members are created by connected members that are not branching out. They 
could be drawn with a pencil without interrupting the continuous line. 

 
Figure 4.93: Continuous members 

A group of members consists of connected members that may branch out. 

 
Figure 4.94: Group of members 

In some add-on modules it is possible to design sets of members. Often, the design can be per-
formed only for continuous members because parameters such as buckling lengths must be 
clearly defined. 

Members 
In the input field of the dialog box or the column in the table, enter the numbers of the mem-
bers that form the set of members. You can also use the [] function to select them graphically 
in the work window. Use the button [Reverse Orientation of Members] to change the order of 
member numbers and thus the direction of the member set. 

The quickest way to define a set of members is the following: Select the relevant members in 
the work window by using the pointer drawing an enclosing window. You can also use the 
multiple selection by holding down the [Ctrl] key. Then, right-click one of the selected mem-
bers. The context menu of the member opens where you point to Member and select Create 
Set of Members (for member groups) or select Create Set of Members (for continuous mem-
bers). The dialog box New Set of Members opens and presets the numbers of the selected 
members. 

Length 
The total length of the set of members represents the sum of the individual member lengths. 

Weight 
The mass of the set of members is determined from the sum of the individual member masses. 
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5. Load Cases and Combinations 
Loads acting on the model are managed in different load cases. It is possible to superimpose 
these load cases, either manually or automatically, in load and result combinations (see chap-
ter 12.2.1, page 388). 

Before you can define loads (see chapter 6), you have to create a load case. 

5.1 Load Cases 
General description 

The loads from a particular action are stored in a load case (LC). Load cases are for example: 
self- weight, snow or live load. 

The loads in the load case should be defined as characteristic actions, that means without fac-
tors. The partial safety factors can be considered later when the load cases are superimposed 
in load or result combinations. 

For each load case you can separately define which calculation method (linear static, second-
order or large deformation analysis), approach and calculation parameters (load increment  
factor, stiffness reduction by partial safety factor of material) you want to use. 

Create a new load case 

There are several possibilities to open the loading dialog box for creating a new load case: 

• On the Insert menu, click Load Cases and Combinations and select New Load Case. 

• Use the toolbar button [New Load Case] shown on the left. 

 
Figure 5.1: Button New Load Case in the toolbar 

• Use the context menu of the navigator entry Load Cases. 

 
Figure 5.2: Context menu of Load Cases in the Data navigator 
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The dialog box Edit Load Cases and Combinations appears. A new load case is preset in the dia-
log tab Load Cases. 

 
Figure 5.3: Dialog box Edit Load Cases and Combinations, tab Load Cases 

• It is also possible to enter a new load case in an empty row of table 2.1 Load Cases. 

 
Figure 5.4: Table 2.1 Load Cases 

Load case 
The number of the new load case is preset but can be modified in the dialog input field LC No.  
If the entered number has already been assigned, RSTAB displays a warning when closing the 
dialog box. 

The creation of load cases should be well organized. Gaps in the numbering are allowed so 
that you can insert additional load cases later. The order of load cases can be changed subse-
quently by means of the [Renumber] dialog button (see Table 5.1 and chapter 11.4.16, page 
320). 
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Load case description 
You can enter any name manually. You can also choose a name from the list to describe the 
load case shortly. 

To solve 
Use the check box to decide if the load case is considered as independent load case in the cal-
culation. In this way, it is possible to exclude load cases from the calculation which do not oc-
cur in isolation (for example wind without considering self-weight) or whose results are not 
relevant for a preliminary design. 

Action category 
Standards mention different action categories controlling the superposition of load cases as 
well as the partial safety factors and combination coefficients. Each load case must be assigned 
to a category. 

The list of the dialog box and table provides several categories for selection. They depend on 
the standard that is set in the dialog box Model - General Data (see chapter 12.2.1, page 388). 

 
Figure 5.5: Action categories according to EN 1990, British annex 

These categories are significant for combining load cases manually or automatically. The classi-
fication of the load case determines which factors are applied when creating load and result 
combinations. 

Self-weight 
When you want to take into account the construction's self-weight as load, tick the Active 
check box. The laod's direction of action can be defined in one of the three input fields by 
means of the self-weight factor. The default setting is 1.00 in direction Z, respectively –1.00 if 
the global axis Z points upwards. 

When the automatic self-weight is applied in several load cases, you have to consider this for 
the combination of load cases. 

Comment 
Enter a user-defined note or select an entry from the list to describe the load case in detail. 

Calculation parameters 
The tab Calculation Parameters in the loading dialog box offers different options for controlling 
the calculation. Find a detailed description of these parameters in chapter 7.2.1 on page 169. 

 

 
 

Standard settings in the dialog 
box Model - General Data 
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Edit general data of a load case 
There are several possibilities to change the general data of an existing load case: 

• On the Edit menu, point to Load Cases and Combinations, and then select  
Load Case - General Data (current load case). 

• On the Edit menu, point to Load Cases and Combinations, and then select  
Load Cases (selection from all load cases). 

• In the Data navigator, right-click a load case to open its context menu, or double-click the 
load case itself. 

 
Figure 5.6: Context menu of a load case 

• Use the button [Edit load cases] in the toolbar of the loads tables (current load case). 

 
Figure 5.7: Button [Edit load cases and combinations] in the toolbar of the loads tables 
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Buttons 
In the dialog box Edit Load Cases and Combinations, several buttons are available below the 
load case list (see Figure 5.3, page 99). They are reserved for the following functions: 

 
Creates a new load case 

 
Creates a new load case as copy of the selected load case (see below) 

 
If several load cases are selected, all contained loads are copied to a new load case 
(see below). 

 
Assigns a new number to the selected load case. Specify the number in a separate 
dialog box. It is not allowed to enter a number that has already been assigned. 

 
Selects all load cases 

 
Cancels the selection in the list 

 
Inverts the selection of load cases 

 
Deletes the selected load case 

Table 5.1: Buttons in the tab Load Cases 

Copy and add load cases 

You can use already existing load cases to create new load cases. 

To copy a load case, select the relevant load case in the list Existing Load Cases. By clicking the 
[Copy] button you create a copy of the load case with the next available free number. Then, 
you can adjust the description of the new load case and the loads. 

When adding load cases RSTAB copies the loads of several load cases into a new load case. 
First, select the relevant load cases in the list Existing Load Cases (multiple selection by holding 
down the [Ctrl] key). Use the [Add] button to copy the loads into a new load case. 
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5.2 Actions 
General description 
When using the latest standards, for example EN 1990 or DIN 1055-100 (Germany), it is often 
time-consuming to take into account all load situations coming into question and to select the 
decisive situations for the designs. In the dialog box Model - General Data, you have the possi-
bility to create combinations automatically (see Figure 12.23, page 386). 

The load cases defined in table 2.1 (see previous chapter 5.1) represent the base data for the 
automatic superpositioning. RSTAB distinguishes between two load case categories: standard 
load cases and load cases of the type Imperfection. Moreover, for combining load cases it is im-
portant to know in which action category the standard load cases have been organized. 

Standards provide rules for the combination of independent actions in various design situa-
tions. Actions are independent of each other if they arise out of different origins and if the cor-
relation existing between them may be neglected with regard to the reliability of the structural 
system. 

In accordance with this concept, Actions to which load cases are assigned must be defined for 
the automatic superposition in RSTAB. The action type defined for the load cases (see chapter 
5.1, page 100) controls the assignment to action categories conforming to standards. 

 
Figure 5.8: Dialog box Edit Load Cases and Combinations, tab Actions 

 

 
 

Check box in dialog box 
Model - General Data 
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Figure 5.9: Table 2.2 Actions 

Action 
Actions are created already when defining load cases. They are consecutively numbered. The 
sequence is not important but can be modified, if necessary, by means of the [Renumber] but-
ton available in the dialog box. 

In the table you can add actions manually for example to assign load cases by user-defined 
specifications when huge models are designed. 

Action description 
The description of the action is derived from the action type that has been selected for the 
load cases. The preset description can be changed, if necessary. 

Action category 
Standards mention different action categories controlling the partial safety factors and combi-
nation coefficients (see chapter 5.1, page 100). 

The list of the dialog box and table provides only the categories which have been used for the 
definition of the single load cases. Therefore, in order to create a new category, a new action 
type must be assigned in the general data of a load case. 

Acting 
Two or more load cases can be defined as Simultaneously or Alternative acting. That means that 
these load cases occur either always or never together in a load or result combination. 

For example, load cases with wind from different directions are "alternative" acting. 

Load cases in action 

Load cases are assigned according to the specifications of the LC action type, so assignment is 
largely automatic. 

To remove a load case from an action, select the load case in the dialog section Load Cases in 
Action. Use the [] button or double-click the entry to transfer it to the dialog section Unas-
signed Load Cases. In the table, it is also possible to set a load case inactive: Select the empty 
entry in the list of the relevant table cell. 

Manually removed load cases, taking into account the action type, are transferred to the list 
Unassigned Load Cases. This also means that only load cases of the same action type can be in-
cluded in an action category. It is not possible for example to select load cases of the type "live 
loads" for actions of "snow", neither in the dialog box nor in the list of the table (see picture on 
the left). Therefore, type-different load cases are not visible in the list Existing Actions. Use the 
button [Show Unused] below the dialog section to display load cases of other categories. They 
are shown as locked and cannot be selected. 

Load cases not assigned to any action are not taken into account when generating combina-
tions. 
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Comment 
Enter a user-defined note or select an entry from the list. 

The buttons in the Actions tab of the dialog box Edit Load Cases and Combinations are reserved 
for the following functions: 

 
Creates a new action 

 
Renumbers the selected actions 

 
Selects all actions 

 
Cancels the selection in the list 

 
Assigns unassigned load cases to actions automatically 

 
Deletes the selected actions 

Table 5.2: Buttons in the tab Actions 
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5.3 Combination Expressions 

General description 
Standards describe how to combine actions. For example, EN 1990 requires the design of the 
ultimate and the serviceability limit states. Ultimate limit states for load bearing capacity 
have to be designed in four design situations for which particular combination rules must be 
applied: 

1. Permanent situations involving common conditions of use of a structural system as well as 
temporary situations referring to time-limited stages of the structure (for example construc-
tion stage, repairs) 

As combination rule for permanent and temporary situations (basic combination) you have 
to apply either 

i,ki,0
1i

i,Q1,k1,QkPj,k
1j

j,G QQPG ⋅ψ⋅γ+⋅γ+⋅γ+⋅γ ∑∑
>≥

 

Equation 5.1 

or the more unfavorable combination with Equation 5.2 and Equation 5.3 for the limit 
states STR and GEO. 
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Equation 5.2 
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Equation 5.3 

2. Extraordinary situations referring to extraordinary actions of the structural system or its  
environment (for example fire, explosion, collision) 
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Equation 5.4 

3. Situations in case of earthquakes 
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Equation 5.5 
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According to EN 1990, you have to design serviceability limit states in three design situations 
for which the following combination rules must be applied. 

1. Characteristic situations with irreversible (lasting) effects on the structural system 

i,k
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Equation 5.6 

2. Frequent situations with reversible (non-lasting) effects on the structural system 

i,k
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Equation 5.7 

3. Quasi-permanent situations with long-term effects on the structural system 
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Equation 5.8 

 
Figure 5.10: Dialog box Edit Load Cases and Combinations, tab Combination Expressions 

 
Figure 5.11: Table 2.3 Combination Expressions 
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Combination expression 
When you access the dialog box or table, RSTAB presets the combination rules of the following 
design situations: 

• STR (ULS)  ultimate limit state for permanent or temporary situation 

• S Ch (SLS)  serviceability limit state for characteristic situation 

• S Fr (SLS)  serviceability limit state for frequent situation 

• S Qp (SLS)  serviceability limit state for quasi-permanent situation 

You can create a new combination rule in another table row or in the dialog box by using the 
[New] button. The design situations described below are available for selection. 

Combination rules marked in the dialog list can be deleted with the [Delete] button. 

Description of combination expression 
The brief description of combination rules can be changed subsequently. The list provides 
some suggestions for selection. 

Use 
Use the check box to decide if the selected combination rule is considered when creating re-
sult combinations. In this way, it is possible to reactive or exclude design situations from the 
generation. 

Design situation 
Standards describe the situations for which designs of structural systems must be performed. 
These design situations determine the conditions expected during the construction and use of 
the building. 

The following design situations for EN 1990 are available for selection in the list: 

 
Table 5.12: Design situations according to EN 1990 

Use the [Info] button to check the combination rule of the current design situation. A dialog 
box opens explaining the equation with relevant parameters (see figure below). 
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Figure 5.13: Dialog box Info About Design Situation 

Favorable permanent actions 
Due to this option, RSTAB can distinguish between favorable and unfavorable acting perma-
nent actions during the generation. They are considered with different partial safety factors in 
the superpositioning. Additional combinations are generated. 

Settings of the check box affect only design situations for load bearing capacity. The distinc-
tion between favorable and unfavorable acting permanent actions is done automatically for 
the design situation "static equilibrium", whereas permanent actions for the design situation 
"serviceability" are not differentiated. 

Imperfection load cases 
RSTAB distinguishes between two load case categories: standard load cases and load cases of 
the type Imperfection. Due to the special treatment of imperfections, it is possible to form any 
possible load combination once with imperfection and once without. 

Imperfection load cases are taken into account only for generating load combinations. More-
over, settings of the check boxes are globally valid: Imperfections can be considered either 
consistently for all combination rules or not at all. It is not possible to apply imperfections sep-
arately for individual combination expressions. 

When the check box is ticked, the [Settings] button or the button [...] is enabled. Use the but-
tons to access a dialog box with specific settings for imperfection load cases. 
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Figure 5.14: Dialog box Settings with dialog box Select Load Cases for selecting load cases 

The dialog section Use Load Cases of Type 'Imperfection' lists all load cases that have been 
classified as action type "imperfection" (see chapter 5.1, page 100). Use the check boxes in the 
Use column to control the load cases in detail and to decide which one is included in the gen-
eration of load combinations. 

The columns Only with Load Cases and Never with Load Cases are shown if the imperfection 
load cases are Subject to specific load cases (see description below). 

With settings in the dialog section Options you determine how imperfection load cases are 
taken into account. When All imperfection load cases act as alternative, RSTAB applies only one 
imperfection load case for each load combination.  

If at least one imperfection load case is activated, any possible load combination will be creat-
ed once with imperfection and once without. In case you want to create only load combina-
tions with imperfection, tick the check box for Remove co-existence of the same load combina-
tion with and without imperfection. 

With the option Subject to specific load cases you can further reduce the number of generated 
load combinations. If the option is ticked, the two additional columns Only with Load Cases and 
Never with Load Cases are shown in the dialog section above. Click into a cell to enable the [...] 
button that you can use to access the dialog box Select Load Cases where you can define a rela-
tion between the imperfection load case and one or more belonging respectively alternative 
load cases (see Figure 5.14). 
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Exclusive/inclusive load cases 
To further reduce the number of created load combinations, it is possible to classify load cases 
to be mutually exclusive or occurring only together. 

Ticking the check box enables the dialog button [Settings] or the table button [...] that you can 
use to open a dialog box with detailed settings for the application of load cases. 

 
Figure 5.15: Dialog box Settings, tab Exclusive/Inclusive Load Cases with dialog box Select Load Cases 

First, enter a load case into the column Select Load Cases in the dialog section Exclusive Load 
Cases. You can also use the [...] button to open the dialog box Select Load Cases where you can 
select the case. Then, in the column Not to combine with load cases, define which load case(s) 
you never want to take into account together with the case in the load combination. In this 
way, it is possible to avoid for example the combination of snow with human load cases. 

In the dialog section Inclusive Load Cases, you can specify settings analogously for load cases 
that you want to appear always together in every load combination. However, these relations 
are only effective if the option Reduce number of generated combinations due to Examine results 
(see below) is not activated. 

Specifications in the dialog section Inclusive Load Cases are taken into account only for the 
generation of load combinations, not of result combinations. 
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Reduce number of generated combinations due to 
The complexity of the structural system as well as the number of actions and load cases have a 
significant influence on the generated combinations. RSTAB offers three possibilities for reduc-
ing the number of constellations with great effect. The first two procedures are only available 
for the generation of load combinations but not for result combinations. 

Reduce number of load cases 

With this option you can generally limit the number of load cases occurring in the load combi-
nations. Access to the check box is available in the General tab of the Combination Expressions 
(see Figure 5.10, page 107). RSTAB finds out which load cases provide positive respectively 
negative internal forces and deformations. Then, all positively acting and all negatively acting 
load cases are combined. Thus, combinations will take into account only those load cases 
which are relevant for the maximum or minimum values. 

The advantage of this method is the possibility to reduce the number of combinations consid-
erably, which has a positive effect on the speed of calculation as well as the evaluation. A dis-
advantage may be the fact that there is a certain factor of uncertainty for the reduction to find 
the extreme values in case of unfavorable load arrangements and specifications. 

When you tick the check box, an additional dialog tab appears called Reduce - Number of Load 
Cases where you can specify in detail which load cases, internal forces and objects you want to 
be considered for the creation of governing combinations. 

 
Figure 5.16: Dialog tab Reduce - Number of Load Cases for combination expressions 

The load cases can be selected Manually or determined Automatically on the basis of relevance 
criteria. Clicking the button [Determine automatically] starts a calculation to determine the 
maximum and minimum internal forces, deformations and support reactions in the load cases. 
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When the automatic determination is selected, define which Results (deformations, member 
internal forces, support reactions) and Objects (nodes, members) you want to consider for the 
evaluation of the load cases. The nodes and members can be selected graphically with the [] 
function as soon as the check box All is clear. Above, you can use the check box Assign sepa-
rately for each object to assign specific result types to nodes and members for the analysis. 

The number of load cases contained in a Group after calculating load case data depends on 
settings defined in the dialog section Choice of Load Cases: 

• When the option Maximum number of the most relevant load cases is selected, a 
group provides either the specified maximum number of load cases or only positively  
respectively negatively acting load cases in a smaller number. 

• It is possible to Neglect load cases which have only a very small share in the maximum 
and minimum values. The percentage refers to the internal forces, deformations and sup-
port forces of the load cases respectively providing the extreme values. 

Imperfection load cases are not considered when the automatic creation of groups is set. 

Examine results 
RSTAB creates only the governing load combinations (this option is not available for result 
combinations). 

When ticking the check box, the new tab Reduce - Examine Results is added to the dialog box. 

 
Figure 5.17: Tab Reduce - Examine Results for combination rules 

With the first Reduction Method you can evaluate generated temporary result combinations 
automatically. Temporary result combinations include all load cases created in the model and 
consider all relations existing among them. By means of results available on the x-locations 
RSTAB can analyze which of the simultaneously acting load cases produce a maximum or min-
imum on the corresponding locations. The reduction method is based on the assumption that 
only those combinations can be governing which contain exactly these simultaneously acting 
load cases. 

Alternatively, it is possible to use the results of a user-defined result combination for the results 
reduction. 
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In the dialog section Examining Results to the right, you can define which deformations, inter-
nal forces or support reactions you want to take into account for the determination of extreme 
values. 

The dialog section Examining Results of Objects provides an option to restrict the extreme value 
analysis to results of selected members. Use the [] function to select the members graphical-
ly. 

Select leading variable actions 

The third possibility to reduce the number of generated combinations is to classify only select-
ed actions as leading actions. This option is available for the generation of load and result 
combinations. 

When ticking the check box, the new tab Reduce - Leading Varialbe Actions is added to the dia-
log box. 

 
Figure 5.18: Tab Reduce - Leading Variable Actions for combination rules 

The list of leading actions contains only variable actions. 

When you remove the check mark of an entry in the column Leading Actions, the correspond-
ing action will be superimposed only as accompanying variable action. 

Numbering of generated combinations 
Entering data in this section of the dialog box Edit Load Cases and Combinations (see Figure 
5.10, page 107) affects the First number of generated Load combinations or Result combinations 
that are created in RSTAB. 

Result combinations 
Optionally, you can Generate additionally an Either/Or result combination (results envelopes). This 
result combination superimposes the extreme values of all load or result combinations accord-
ing to the following scheme: 

"CO1/permanent or CO2/permanent or CO3/permanent etc." 

If several combination expressions are specified for the generation, it is possible to Generate 
additionally a separate Either/Or result combination for each combination expression. 

Method of analysis 
Use the list to decide which method of calculation you want to apply to analyze combinations 
(see chapter 7.2.1.1, page 169). RSTAB presets the non-linear calculation according to second-
order analysis (P-Delta) for load combinations. 

Generated action combinations 
The dialog section, respectively table column, is filled during the generation starting automati-
cally when closing the dialog tab or table. The dialog field shows you a short overview of the 
number of generated combinations. 
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With the data entered in the dialog box or table, RSTAB creates so-called "action combina-
tions" (AC). They are described in the following chapter. You can use the entries shown in the 
current dialog box to estimate the way how combination rules affect the number of combina-
tions. 

In the example shown on the left, a total of 47 action combinations is generated for the four 
specified design situations: 

• ULS (STR/GEO): AC1 to AC13 

• SLS - characteristic: AC14 to AC26 

• SLS - frequent: AC27 to AC39 

• SLS - quasi-permanent: AC40 to AC47 

When jumping to the next dialog tab with the dialog button [], RSTAB determines the action 
combinations automatically. The first action combination created with the current combina-
tion expression is selected in the subsequent dialog tab. 

Comment 
Enter a user-defined note or select an entry from the list. 
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5.4 Action Combinations 
General description 
When you open the dialog tab or table 2.4, actions are superimposed automatically according 
to the combination rules and identified as so-called "action combinations". This overview is 
sorted by actions, and thus corresponds to the way how actions are described in standards. 
Now, you can define which action combinations will finally come into question for the genera-
tion of load or result combinations. 

An action combination includes all possibilities how load cases can be combined in the action. 
Therefore, do not confuse it with a load or result combination representing only a single vari-
ant of these possibilities. 

 
Figure 5.19: Dialog box Edit Load Cases and Combinations, tab Action Combinations 

 
Figure 5.20: Table 2.4 Action Combinations 
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Action combination 
The combinations generated from actions are consecutively numbered. An action combina-
tion includes all possibilities how load cases contained in the action can be considered. These 
possibilities depend on the action category and the combination expressions. 

In the dialog box Edit Load Cases and Combinations below the list Existing Action Combinations, 
it is possible to filter generated combinations by design situation or relevance. 

 
Figure 5.21: Filter option in the dialog box Edit Load Cases and Combinations 

Description of action combination 
RSTAB assigns automatically brief descriptions based on the safety factors and symbols of ac-
tions, expressing combination rules. You can change the descriptions, if necessary. 

Click the dialog button [] to jump to the previous dialog tab where RSTAB shows you the 
combination expression by which the current action combination was created. 

Use 
Use the check box to decide if the selected action combination is considered for creating load 
or result combinations. In this way, it is possible to reactive or exclude action combinations 
from the generation. 

If RSTAB creates an action combination twice because of special constellations, one of them is 
automatically deactivated. 

Design situation 
The design situation of the current action combination is again indicated so that you can 
check data. Use the [Info] button to look at the combination rule of the design situation. A dia-
log box with explanations opens (see Figure 5.13, page 109). 

Actions in action combinations 
The columns inform you about actions including corresponding partial safety factors and 
combination coefficients. 

If an action is assumed to be Leading in the combination, it is marked accordingly in the dialog 
box. In this case, it is inserted as action Qk,1 in Equation 5.1 to Equation 5.7 (see page 106). 

The values indicated in the table column Factor are based on coefficients depending on the se-
lected standard. For EN 1990 they are the partial safety factors γ, the combination factors ψ, 
the reduction factors ξ and, if applicable, the reliability factors KFl of each action resulting from 
design situation and action category. 

Use the buttons [Settings] or [...] to check and, in case of a user-defined standard, adjust the 
partial safety factors and combination coefficients. The factors are organized in several tabs of 
the dialog box Coefficients. The first tab Partial Safety Coefficients is shown in Figure 12.27 on 
page 388. The tab Combination Coefficients manages the factors ψ and ξ. 
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Figure 5.22: Dialog box Coefficients, tab Combination Coefficients 

The dialog section Actions in Action Combination lists the Load Cases contained in the actions 
with all possibilities how they can be taken into account in the action. The possibilities depend 
on the action type and the defined action (simultaneous or alternative). It is precondition that 
all assigned load cases are always used together for the action types "permanent loads" and 
"prestress" unless the relation is defined as "alternative". In case of variable, extraordinary and 
seismic actions, assigned load cases can be superimposed in all relevant combinations. 

Generated load or result combinations 
The dialog section, respectively table column, is filled during the generation starting automati-
cally when closing the dialog tab or table. The dialog field shows you a short overview about 
the number of generated load or result combinations. 

Load and result combinations are described in the following chapters 5.5 and 5.6. 
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Example 
In the example shown on the left, a total of 47 load combinations is generated for the design 
situation ULS. For the action combination AC12 (penultimate row) the four load combinations 
CO40 to CO43 occur with the following background: 

The first action A1 has been categorized as action category "permanent loads" and provided 
with the factor γ = 1.35 in the generated load combinations. The contained load cases 1 and 2 
occur together in all load combinations. 

As second action A2 we have the action category "snow" included in the load combination 
with the factor γ * ψ = 1.50 * 0.50 = 0.75. 

The third action A3 doubles the number of the generated load combinations because the cat-
egory "wind" is available with the two load cases 4 and 5 acting alternatively. This action is 
multiplied with the factor γ * ψ = 1.50 * 0.60 = 0.90 in the load combinations. 

The fourth action A4 is classified as action type "imposed load category B" and provided with 
the factor γ = 1.50 in all four load combinations. This action is a leading action. 

 
Figure 5.23: Actions in action combination AC12 

In addition, we have to take into account the two imperfection load cases 7 and 8 which are 
coupled with the directions of both wind load cases. We want to create load combinations 
once with imperfections and once without. 

With these specifications RSTAB forms the following load combinations for AC12: 

• CO40: 1.35*LC1 + 1.35*LC2 + 0.75*LC3 + 0.9*LC4 + 1.5*LC6 

• CO41: 1.35*LC1 + 1.35*LC2 + 0.75*LC3 + 0.9*LC4 + 1.5*LC6 + LC7 

• CO42: 1.35*LC1 + 1.35*LC2 + 0.75*LC3 + 0.9*LC5 + 1.5*LC6 

• CO43: 1.35*LC1 + 1.35*LC2 + 0.75*LC3 + 0.9*LC5 + 1.5*LC6 + LC8 

Click the dialog button [] to jump to dialog the tab Load Combinations where the first combi-
nation created from the current action combination is selected. 

Comment 
Enter a user-defined note or select an entry from the list. 
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5.5 Load Combinations 
General description 

Load cases can be superimposed in a load combination (CO) and in a result combination (RC). 

Taking into account partial safety factors, a load combination combines the loads of the con-
tained load cases in "one big load case" that will be calculated. In a result combination (see 
chapter 5.6, page 128) all included load cases are calculated first. Then, results will be superim-
posed, taking into account the partial safety factors. 

Load cases can be combined manually (see chapter 5.5.1) or superimposed automatically by 
RSTAB (see chapter 5.5.2), depending on your settings in the dialog box Model - General Data 
(see Figure 12.23, page 386). Settings affect also the appearance of the dialog tab Load Combi-
nations in the loading dialog box. 

When you want to calculate combined load cases according to second-order or large defor-
mation analysis, you generally have to create load combinations. The same applies to models 
with nonlinear elements. The following example is used to demonstrate the subject. 

A beam with an elastic foundation is stressed by two different load cases: In load case 1, the 
member load acts on the entire beam. In load case 2, the load acts only on a part of the mem-
ber. The self-weight is not taken into account. The member elastic foundation is ineffective in 
case of tension. Therefore, no lifting forces are absorbed. 

 

Figure 5.24: Load and deformation in LC 1 

The foundation in load case 1 is effective for the entire length of the member. 

 

Figure 5.25: Load and deformation in LC 2 

In load case 2, the elastic foundation is effective only for the left part of the member. The right 
part of the member is lifted. 

 

Difference between 

load and result combination 

 
 

Check box in dialog box 
Model - General Data 
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When combining both load cases in a result combination, RSTAB will show you a warning be-
cause adding results would be unacceptable due to nonlinear effects: Deformations in both 
load cases are based on different structural systems. In a result combination, the lift of the right 
part resulting from load case 2 would be visible. 

Therefore, it is correct to superimpose the two load cases in a load combination. In the figure 
below, we see that the elastic foundation is effective for the added loads without failure. 

 

Figure 5.26: Load and deformation of the load combination 

5.5.1 User-defined Combinations 

Create a new load combination 
There are several possibilities to open the dialog box Edit Load Cases and Combinations for cre-
ating a load combination: 

• point to Load Cases and Combinations on the Insert menu, and select Load Combination 

• use the toolbar button [New Load Combination] shown on the left 

 
Figure 5.27: Button New Load Combination in the toolbar 

• context menu of navigator entry Load Combinations 

 
Figure 5.28: Context menu for Load Combinations in the Data navigator 
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The dialog box Edit Load Cases and Combinations appears. A new load combination is preset in 
the dialog tab Load Combinations. 

 
Figure 5.29: Dialog box Edit Load Cases and Combinations, tab Load Combinations 

The following description refers to the tab General. The dialog tab Calculation Parameters is  
described in chapter 7.2.1 on page 169. 

• It is also possible to enter a new load combination in an empty row of table 2.5 Load 
Combinations. 

 
Figure 5.30: Table 2.5 Load Combinations 

Load combination 
The number of the new load combination is preset but can be modified in the dialog input 
field CO No.. The order of load combinations can be adjusted subsequently by means of the 
[Renumber] dialog button (see Table 5.3 and chapter 11.4.16, page 320). 
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Description of load combination 
You can enter any name manually. You can also choose a name from the list to describe the 
load combination shortly. As manually entered descriptions are stored in the list, they are also 
available for all other structures. 

To solve 
Use the check box to decide if the load combination is considered in the calculation. In this 
way, it is possible to active or exclude load combinations from the calculation. 

Load cases in load combination 
The columns inform you about the load cases together with corresponding factors. 

The values indicated in the table column Factor are based on coefficients depending on the se-
lected standard. For EN 1990 they are the partial safety factors γ, the combination factors ψ, 
the reduction factors ξ and, if applicable, the reliability factors KFl of each action resulting from 
design situation and action category. 

To check and adjust the partial safety factors and combination coefficients, use the dialog but-
ton [Factors] or the table button [...]. The dialog box Coefficients opens where you find various 
factors organized in several tabs. The first tab Partial Safety Coefficients for EN 1990 is shown in 
Figure 12.27 on page 388. The tab Combination Coefficients manages the factors ψ and ξ (see 
Figure 5.22, page 118). The reliability factor KFI can be defined in an input field of the dialog tab 
Consequences Class, but you can also enter a user-defined value. 

Combining load cases 

In the dialog box Edit Load Cases and Combinations, you can assimilate load cases in combina-
tions as follows: Select the relevant load cases in the list Existing Load Cases by clicking. You 
can press the [Ctrl] key (as usual in Windows) to apply the multiple selection. Use the button 
[] to transfer selected load cases to the right in the list Load Cases in Load Combination, at the 
same time partial safety factors and combination coefficients are added automatically. 

 
Figure 5.31: Multiple selection of load cases and load combination created according to EN 1990 

The factors are created in accordance with the standard set in the dialog box Model - General 
Data (see chapter 12.2.1, page 388). 

 

 

 

 
 

Standard settings in the dialog 
box Model - General Data 
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The preset factors can be checked in the Coefficients dialog box that you open with the button 
[Factors]. Furthermore, you can adjusted them for user-defined standards (see Figure 5.22, 
page 118 and Figure 12.27, page 388). 

To modify the factor of a load case that has been transferred into a load combination, select 
the load case in the list Load Cases in Load Combination. Now, you can enter an appropriate 
factor into the input field below. You can also select the factor from the list. Finally, click the 
button [Set Factor] to apply the new factor to the load case. 

To remove a load case from a load combination, select the load case in the dialog section Load 
Cases in Load Combination. Use the [] button or double-click the entry to return it to the dia-
log section Existing Load Cases. 

Several filter options are available below the list Existing Load Cases. With the help of the op-
tions it is easier to assign load cases sorted by action categories or to select from load cases not 
yet assigned. The buttons are described in Table 5.3 on page 125. 

To define load combinations manually, use the [Edit] button in the bottom right corner of the 
loading dialog box. 

 
Figure 5.32: Dialog box Load Combination for definition via editing field 

A dialog box opens offering the input field Load Cases in Load Combination where load cases 
can be added (or subtracted if necessary) by any factor. However, nesting of the input is not 
permitted. 

Example: LC1 + 0.5*LC3 

  To the simple load of load case 1 half the load of load case 3 is added. 

Use the button [Set Input] to transfer the entry to the list Load Cases in Load Combination of the 
initial dialog box. 

Comment 
Enter a user-defined note or select an entry from the list to describe the load combination in 
detail. 

Calculation parameters 
The tab Calculation Parameters in the loading dialog box offers different options for controlling 
the calculation. Find a detailed description of these parameters in chapter 7.2.1 on page 169. 
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Edit a load combination 
There are several possibilities to change load combinations subsequently: 

• point to Load Cases and Combinations on the Edit menu, and then click Load Combi-
nations 

• use the context menu or double-click a load combination in the Data navigator 

 
Figure 5.33: Context menu of a load combination 

In the dialog box Edit Load Cases and Combinations (see Figure 5.29, page 122), select the CO 
by clicking. Then, you can edit the definition criteria. 

Buttons 
In the dialog box Edit Load Cases and Combinations, you see different buttons below the lists 
Existing Load Combinations and Existing Load Cases. They are reserved for the following func-
tions: 

 
Creates a new load combination 

 
Creates a new load combination as copy of the selected combination 

 
Assigns a new number to the selected load combination. Specify the number in a 
separate dialog box. It is not allowed to enter a CO number that has already been 
assigned. 

 
Deletes the selected load combination. 

 
The list shows only the load cases that are not yet contained in the load combination. 

 
Selects all load cases in the list 

 
Inverts the selection of load cases 

Table 5.3: Buttons in the dialog tab Load Combinations 
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5.5.2 Generated Combinations 
When switching to the dialog tab Load Combinations or to table 2.5, RSTAB creates the combi-
nations automatically. As the load cases are not superimposed manually, the General tab looks 
differently (see Figure 5.29, page 122 for user-defined combinations). 

 
Figure 5.34: Dialog box Edit Load Cases and Combinations, tab Load Combinations 

Load combination 
Load combinations generated from action combinations are consecutively numbered. 

You can filter the generated combinations by particular criteria, using the selection field in the 
bottom left corner below the dialog section Existing Load Combinations. 

Description of load combination 
RSTAB assigns brief descriptions based on the safety factors and load case numbers, express-
ing combination rules. You can change these descriptions, if necessary. 

Click the dialog button [] to jump back to the dialog tab Action Combinations (see chapter 
5.4, page 116) where the action combination is selected by which the current load combina-
tion has been created. 

To solve 
The check box controls the result determination for the selected load combination(s). 

Load cases in load combination 
The columns inform you about the load cases including corresponding partial safety factors 
and combination coefficients. It is not possible to modify the factors of generated combina-
tions. 

If a load case is assumed to be Leading in the combination, it is marked accordingly in the  
dialog box. 
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To check and, if necessary, to adjust the partial safety factors and combination coefficients, use 
the dialog button [Info about Factors]. The dialog box Coefficients is subdivided into several 
tabs (see Figure 12.27, page 388 and Figure 5.22, page 118). 

Add a load combination 
The generated load combinations cannot be edited but only deleted or excluded from the cal-
culation by using the check box To Solve. 

With the [New] button in the left bottom corner below the dialog section Existing Load Combi-
nations you can add a user-defined combination. To enable the manual definition, the dialog 
tab General changes its appearance. 

 
Figure 5.35: Adding a user-defined load combination 

The previous chapter 5.5.1 describes in detail how load combinations can be created manually. 
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5.6 Result Combinations 
General description 

Load cases can be superimposed in a result combination (RC) and in a load combination (CO). 

In a result combination, included load cases are calculated first. Then, the results are superim-
posed, taking into account the partial safety factors. A load combination (see chapter 5.5, page 
120) combines the loads of contained load cases in "one big load case" first, taking into ac-
count the partial safety factors. Then, the big case is calculated. 

Load cases can be combined manually (see chapter 5.6.1) or superimposed automatically by 
RSTAB (see chapter 5.7), depending on your settings in the dialog box Model - General Data 
(see Figure 12.23, page 386). Settings affect also the appearance of the dialog tab Result Com-
binations in the dialog box Edit Load Cases and Combinations. 

Result combinations are not appropriate for non-linear calculations because they lead to falsi-
fied results: In most cases, failure of nonlinear elements (for example tension members, foun-
dations) happens unequally in the individual load cases. Redistribution effects occur so that 
the internal forces would be combined from different models (see example in chapter 5.5 on 
page 120). 

In a result combination, you can superimpose the results of load cases and load combinations 
as well as results of other result combinations. 

Usually, the internal forces are summed up. In principle, subtractions are also possible. Please 
note, however, that in this case signs of the internal forces will be reversed: Tensile forces be-
come compressive forces etc. Therefore, as an alternative, it is recommended to copy the load 
case (see chapter 5.1, page 102) and to set the load factor to –1.00 for the load case copy in the 
dialog tab Calculation Parameters. Then, the load case can be added in a result combination. 

5.6.1 User-defined Combinations 

Create a new result combination 

There are several possibilities to open the loading dialog box for creating a result combination: 

• point to Load Cases and Combinations on the Insert menu, and then select Result 
Combination 

• click the button [New Result Combination] in the toolbar 

 
Figure 5.36: Button New Result Combination in the toolbar 

 

Difference between 

result and load combination 

 
 

Check box in dialog box 
Model - General Data 
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• use the context menu of the navigator entry Result Combinations 

 
Figure 5.37: Context menu of Result Combinations in Data navigator 

The dialog box Edit Load Cases and Combinations appears. A new result combination is preset 
in the dialog tab Result Combinations. 

 
Figure 5.38: Dialog box Edit Load Cases and Combinations, tab Result Combinations 

The following description refers to the tab General. The dialog tab Calculation Parameters with 
settings for the square addition is described in chapter 7.2.2 on page 175. 
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• It is also possible to enter a new result combination in an empty row of table 2.6 Result 
Combinations. 

 
Figure 5.39: Table 2.6 Result Combinations 

Result combination 
The number of the new result combination is preset but can be modified in the dialog input 
field RC No.. The order of result combinations can be adjusted also subsequently by means of 
the [Renumber] dialog button (see Table 5.4 and chapter 11.4.16, page 320). 

Description of result combination 
You can enter any name manually. You can also choose a name from the list to describe the re-
sult combination shortly. As manually entered descriptions are stored in the list, they are also 
available for all other structures. 

To solve 
Use the check box to decide if the result combination is considered in the calculation. In this 
way, it is possible to reactive or exclude result combinations specifically from the calculation. 

Loading in result combination 
The columns inform you about the load cases, load and result combinations including related 
factors. 

The values indicated in the table column Factor are based amongst others on coefficients that 
depend on the selected standard. For EN 1990 they are the partial safety factors γ, the combi-
nation factors ψ, the reduction factors ξ and, if applicable, the reliability factors KFl of each ac-
tion resulting from design situation and action category. 

To check and adjust the partial safety factors and combination coefficients conforming to 
standards, use the dialog button [Factors] or the table button [...]. The dialog box Coefficients 
opens where you find various factors organized in several tabs. The tab Partial Safety Coeffi-
cients for EN 1990 is shown in Figure 12.27 on page 388. The tab Combination Coefficients man-
ages the factors ψ and ξ (see Figure 5.22, page 118). The reliability factor KFI can be defined in 
an input field of the dialog tab Consequences Class, but you can also enter a user-defined value. 

Combining loadings 

In the dialog box Edit Load Cases and Combinations, you can superimpose load cases, load and 
result combinations in a combination as follows: Select the relevant entries in the list Existing 
Loading by clicking. You can press the [Ctrl] key (as usual in Windows) to apply the multiple se-
lection (see the figure below). Use the dialog buttons [+] and [∞] to transfer the selected en-
tries in the list Loading in Result Combination to the right. 
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Figure 5.40: Multiple selection for alternative analysis of two load cases 

The load case factors are applied according to the standard set in the dialog box Model - Gen-
eral Data. If required, you can adjust the preset partial safety factors (see chapter 12.2.1, page 
388) by using the dialog button [Factors]. 

To remove a loading from a result combination, select the relevant entry in the dialog section 
Loading in Result Combination. Use the [] button or double-click the entry to return it to the 
dialog section Existing Loading. 

The load cases, load and result combinations contained in the result combination can be su-
perimposed in accordance with their effect: 

• Loading criteria 

Permanent effect 

If you want to apply the loading permanently or unconditionally, the criterion Permanent or  
/p must be added to the loading. 

Variable effect 

A loading with the criterion Variable is considered in the superposition only if its internal 
forces make an unfavorable contribution to the result. 

• Criteria for superposition 

Additive combination 

The results of loadings are combined additively with the criterion "+". Use the button [+] 
available in the dialog box to transfer the marked load cases, load and result combinations 
to the definition list of the result combination. 

Alternative combination 

For the alternative analysis using the "or" criterion, respectively the abbreviation "o", RSTAB 
treats the results of particular loadings as mutually exclusive. RSTAB will consider only val-
ues of the loading making the maximum unfavorable contribution. Use the dialog button 
[∞] to transfer selected loadings to the definition list of the result combination. 

Loadings acting alternatively are marked with the same number in the table column Group. 

The criterion "orto" (or to) combines a list of alternative loadings from the first to the last 
object. Objects lying in between are not listed. 

All loadings listed in the alternative superposition must be marked consistently as 'Perma-
nent' or 'Variable'. Thus, it is not allowed to enter for example "LC1/p or LC2. 

It is possible to adjust the factors of transferred loadings individually: Select the loading(s) in 
the list Loading in Result Combination, and then enter an appropriate factor into the input field. 
You can also use the list to select a factor. Finally, click the button [Set Factor] to apply the new 
factor to the loading(s). 

 
 

Standard settings in the dialog box 
Model - General Data 
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Analogously, you can subsequently change the loading criteria (permanent or variable effect) 
or the group membership of an alternative loading. To assign the new criterion to the selected 
loading, use the dialog button [Set]. 

Several filter options are available below the list Existing Loading. With the help of the options 
it is easier to assign loadings sorted by load cases, load and action combinations as well as ac-
tion categories. In addition, it is possible to restrict the listing to loadings not yet assigned. The 
buttons are described in Table 5.4 on page 133. 

You can define result combinations manually in a separate dialog box. To open it, use the [Set] 
button in the bottom right corner of the dialog box Edit Load Cases and Combinations. 

 
Figure 5.41: Dialog box Result Combination for definition via string box 

A dialog box opens offering the input field Loading in Result Combination where load cases can 
be added by any factor or combined with the "or" criterion. However, nesting of the input is 
not permitted. 

Examples: 

• LC1/p + LC2/p + LC3 

 Load cases 1 and 2 are superimposed as permanent, load case 3 as variable. 

• LC1/p + CO2 + LC3 or LC4 or LC5  (corresponds to LC1/p + CO2 + LC3 orto LC5) 

 Load case 1 is considered as permanent in the superposition, load combination 2 as vari-
able. The most unfavorable case of the load cases 3, 4 or 5 is also superimposed with the 
'variable' criterion (that means only one of them is effective - if it increases the result val-
ues). 

• 1.2*CO1/p + 0.2*RC1 or -0.2*RC1 

 The 1.2-fold of load combination 1 is superimposed as permanent with the most unfavor-
able contribution of the positive or negative 0.2-fold result combination 1. 

• RC1/p o RC2/p o RC3/p o RC4/p  (corresponds to  RC1/p orto RC4/p) 

 Result combinations 1 to 4 are compared among each other as permanent acting. The 
enveloping is determined as the most unfavorable result. 

Use the [Set] button to transfer the entry to the list Loading in Result Combination of the initial 
dialog box. 

 

 

 

 



5  Load Cases and Combinations 

 133 Program RSTAB © 2013 Dlubal Engineering Software 

 

Comment 
Enter a user-defined note or select an entry from the list to describe the result combination in 
detail. 

Calculation parameters 
The tab Calculation Parameters in the loading dialog box offers different options for controlling 
the calculation. Find a detailed description of these parameters in chapter 7.2.1 on page 169. 

Edit a result combination 
There are several possibilities to change result combinations subsequently: 

• point to Load Cases and Combinations on the Edit menu, and then click  
Result Combinations 

• use the context menu or double-click a result combination in the Data navigator 

 
Figure 5.42: Context menu of a result combination 

In the dialog box Edit Load Cases and Combinations (see Figure 5.38, page 129), select the RC by 
clicking. Then, you can edit the definition criteria. 

Buttons 
In the dialog box Edit Load Cases and Combinations, several buttons are available below the lists 
Existing Result Combinations and Existing Loading. They are reserved for the following functions: 

 
Creates a new result combination 

 
Creates a new result combination as copy of the selected combination 

 
Assigns a new number to the selected result combination. Specify the number in a 
separate dialog box. It is not allowed to enter a RC number that has already been 
assigned. 

 
Deletes the selected result combination 

 
The list shows only load cases not contained in the result combination. 

 
Selects all load cases in the list 

 
Inverts the selection of load cases 

Table 5.4: Buttons in the tab Result Combinations 
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5.6.2 Generated Combinations 
When switching to the dialog tab Result Combinations or to table 2.6, RSTAB creates the com-
binations automatically. As the load cases are not superimposed manually, the General tab 
looks differently (cf. Figure 5.38, page 129 for user-defined combinations). 

 
Figure 5.43: Dialog box Edit Load Cases and Combinations, tab Result Combinations 

Result combination 
The result combinations generated from action combinations are consecutively numbered. 

You can filter the generated combinations by different criteria, using the selection field in the 
left dialog corner below the dialog section Existing Result Combinations. 

Description of result combination 
RSTAB assigns brief descriptions based on the safety factors and load case numbers, express-
ing combination rules. You can change these descriptions, if necessary. 

Click the dialog button [] to jump back to the dialog tab Action Combinations (see chapter 
5.4, page 116) where the action combination is selected by which the current result combina-
tion has been created. 

To solve 
The check box controls the result determination for the result combination(s) selected to the 
left. 
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Load cases in result combination 
The columns inform you about the load cases including corresponding partial safety factors 
and combination coefficients. It is not possible to modify the factors of generated combina-
tions. 

If a load case is assumed to be Leading in the combination, it is marked accordingly in the dia-
log box. 

To check and, if necessary, to adjust the partial safety factors and combination coefficients, use 
the dialog button [Factors]. The dialog box Coefficients is subdivided into several tabs (see Fig-
ure 12.27, page 388 and Figure 5.22, page 118). 

Add a result combination 
The generated result combinations cannot be edited but only deleted or excluded from the 
calculation by using the check box To Solve. 

With the [New] button in the left bottom corner below the dialog section Existing Result Com-
binations you can add a user-defined combination. To enable the manual definition, the dialog 
tab General changes its appearance. 

 
Figure 5.44: Adding a user-defined result combination 

The previous chapter 5.6.1 describes in detail how result combinations can be created manual-
ly. 
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5.7 Combination Scheme 
Load case constellations can be saved as combination schemes and reused for similar applica-
tions. To open the corresponding dialog box, 

select Combination Scheme on the Tools menu. 

 
Figure 5.45: Dialog box Combination Scheme 

In the dialog section Description, you can select a combination scheme from the list. You can 
also use the [New] button to create a new scheme. 

When load cases have already been defined in the model, they are entered in the dialog sec-
tion Load Cases. Load cases can be added by confirming the last row of the list with the [Enter] 
or [Tab] key. In the dialog column LC Description, you can select predefined descriptions from a 
list. 

The dialog sections Load Combinations and Result Combinations manage the conditions of su-
perpositioning for load combinations (see chapter 5.5) and result combinations (see chapter 
5.6). 

To save the combination scheme, click the [Save] button shown on the left. Confirm the dialog 
box with the [OK] button so that RSTAB can create the load cases, load and result combinations. 

Do not forget to enter the loading: The combination scheme generates only a frame of load 
cases, loads and result combinations! 

For models based on the same load scheme you can generate all load cases, load and result 
combinations without entering any more data. Open the scheme dialog box, select the com-
bination scheme from the Description list and import it by clicking [OK]. 
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5.8 Super Combinations 
General description 
Super combinations can only be used when the add-on module SUPER-RC has been licensed. 

A super combination (SC) is similar to a result combination (see chapter 5.6.1, page 128). In a 
super combination, however, it is possible to superimpose also load cases and combinations 
that come from different models. In this way, it is possible to determine construction phases 
with variable system and loading conditions as they occur for example in bridge construction. 

In the modeling process, you have to create an initial model first. Then, you can adjust the 
model to the progress of construction and save it each time as a copy. Make sure to have a  
coherent numbering of nodes and members so that internal forces are determined correctly 
when superimposing loads in a super combination later. It might be helpful to use dummy or 
divided members already applied in the initial model. 

Only the results of models stored in the same project folder can be superimposed. If results of 
some models are not yet available, they are determined automatically before the superposi-
tioning starts. It is also possible to superimpose the results of a super combination in another 
super combination. 

The internal forces of super combinations can be used in a lot of RSTAB add-on modules for 
subsequent designs. 

Create a new super combination 
There are several possibilities to open the loading dialog box for creating a super combination: 

• point to Load Cases and Combinations on the Insert menu, and then select  
Super Combination. 

• Use the toolbar button [New Super Combination]. 

 
Figure 5.46: Button New Super Combination in the toolbar 

• Use the context menu of the navigator entry Super Combinations. 

 
Figure 5.47: Context menu Super Combinations in the Data navigator 

 

 

 



5  Load Cases and Combinations 

 

 

138 Program RSTAB © 2013 Dlubal Engineering Software 

 

The dialog box New Super Combination appears. 

 
Figure 5.48: Dialog box New Super Combination 

SC No. 
The number of the new super combination is preset but can be modified in the input field SC 
No.. Use the button [Index of All Available Super Combinations] to check which super combi-
nations are already available. 

Super combination description 
You can enter any name manually. You can also choose a name from the list to describe the 
super combination shortly. As manually entered descriptions are stored in the list, they are also 
available for other models. 

Combination criteria 
In this input field, you can add load cases and combinations from different models with any 
factor. You can also combine them with the "or" criterion. Each model name must be set in 
square brackets. 

The way how you can create a super combination is described for the dialog section Loading in 
Super Combination explained below. The combination criteria is automatically entered when 
the load cases and combinations are transferred. 

The Square Addition is deactivated by default. Thus, internal forces are superimposed by addi-
tive superposition. This default setting is appropriate for most application cases. However, a 
square addition of internal forces is relevant for dynamic analyses, for example for the combi-
nation of load cases occurring due to centrifugal forces (see chapter 7.2.2 on page 175). The 
[Settings] button can be used to adjust the treatment of signs for the square addition. 

If you define the combination criteria manually, you can use the button [Set in Table] to trans-
fer the entries to the dialog section Loading in Super Combination. 
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Standard 
The list contains a selection of rules and standards describing the principles for the ultimate 
limit state, serviceability and resistance of structural systems. The selected standard deter-
mines the rules by which the super combination is created. The standard also decides which 
partial safety factors γ, combination coefficients ψ, reduction factors ξ etc. are applied (see 
chapter 5.4, page 116). 

The factors can be adjusted in the dialog box Edit Standard that you can access with the [Edit] 
button shown on the left. 

 
Figure 5.49: Dialog box Edit Standard 

To create a user-defined standard, use the [New] button. 

Models of current project 
This dialog section lists all models existing in the current project. To the right you see a 
thumbnail picture of the selected model, which makes the selection easier. 

Existing LC, CO, RC and SC 
All load cases and combinations available in the model selected above are shown. Use both 
[Add] buttons to transfer the entries to the list Loading in Super Combination to the right (see 
the following). 

Loading in super combination 
The table contains all load cases and combinations contained in the super combination. SU-
PER-RC shows for each entry the model where the load case comes from as well as the super-
position criteria and factors that are are applied. 

Combining loadings 

• First, in the dialog section Models of Current Project, select the model whose results are con-
sidered for the superposition. Then, you can select the relevant load cases and combina-
tions in the dialog section Existing LC, CO, RC and SC. A multiple selection is possible with 
holding down the [Ctrl] key (see Figure 5.40, page 131). 

• Use the dialog buttons [Add with "+"] or [Add with "OR"] to transfer the selected entries to 
the list Loading in Super Combination to the right. SUPER-RC applies the factors according to 
the Standard set in the dialog section above. Load cases of the action category Permanent 
loads (see Figure 5.5, page 100) are automatically taken into account with the Criterion 
Permanent. 

If you click the [Add with "+"] button, results are combined additively with the criterion "+". 
If you click the [Add with "OR"] button, results are treated as mutually exclusive (see also 

 

 
 

 
 

 
 

 
 



5  Load Cases and Combinations 

 

 

140 Program RSTAB © 2013 Dlubal Engineering Software 

examples in chapter 5.6.1 User-defined Combinations, page 132). All load cases considered 
in an "Or"-superposition must be defined uniformly as Permanent or Conditional. 

It is possible to adjust the factors or criteria for transferred load cases individually: Select the 
load case in the list Loading in Super Combination, and then enter an appropriate Factor into 
the input field below. You can also use the list to select a factor. The appropriate Criterion 
can also be defined below the dialog section Loading in Super Combination. Finally, click the 
[Set] button to apply the new specifications to the loads. 

To remove a load case or combination from a super combination, select the relevant entry 
in the dialog section Loading in Super Combination. Use the [] button or double-click the 
entry to return it to the dialog section Existing LC, CO, RC and SC. 

• When you have entered the load cases and combinations of one model into the super 
combination, select the next model in the dialog section Models of Current Project. Now, you 
can select all relevant load cases and combinations of this model to transfer them to the 
super combination as described above. 

Examples: 

• CO4<Model A>/Permanent or CO4<Model B>/Permanent 

 The load combinations 4 of two different models are compared as permanently acting. 

• 1.35*LC1<A>/p + 1.50*LC2<A> + 1.35*LC1<B>/p + RC6<C> or RC67<D> 

 In the superposition, load cases 1 of models A and B are taken into account as perma-
nently acting with the factor 1.35. Load case 2 of model A, however, is considered with 
the factor 1.50 only if it has an unfavorable effect. Finally, only the higher contribution of 
result combinations 6 of models C and D is taken into account and considered respective-
ly with a factor of 1.00. 

Edit a super combination 
There are several possibilities to change super combinations subsequently: 

• point to Load Cases and Combinations on the Edit menu, and then click  
Super Combinations. 

• On the Data navigator, right-click a super combination to open its context menu, or dou-
ble-click the super combination itself. 

 
Figure 5.50: Context menu of a super combination 

Then, you can adjust the definition criteria in the dialog box Edit Super Combination. 
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Buttons 
The buttons in the dialog box New Super Combination are reserved for the following functions: 

 Opens a list with already available super combinations 

 
Assigns the Factor or Criterion to marked loading 

 
Removes marked entry from the list Loading in Super Combination 

 
Empties complete entries list of Loading in Super Combination 

Figure 5.5: Buttons in the dialog box New Super Combination 
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6.  Loads 
RSTAB offers different possibilities to enter loads: You can define loads in a dialog box, a table 
and often directly in the graphic. 

Open the input dialog box 
You can access the input dialog boxes and the graphical input in different ways. 

Menu Insert 

 

Figure 6.1: Menu Insert → Loads 

Toolbar Insert 

 
Figure 6.2: Toolbar Insert 

Context menu in Data navigator 

 
Figure 6.3: Context menu of load objects in the Data navigator 
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Context menu or double-click in table 

 
Figure 6.4: Context menu in load tables 

The input dialog box can be accessed by means of the context menu (or by double-click) of the 
row number. 

Open the edit dialog box 
RSTAB provides different possibilities to open a dialog box for editing a load object. 

Menu Edit 

 

Figure 6.5: Menu Edit → Loads 

When selecting the Dialog Box option, it is necessary to define a load object before the dialog 
box appears. 
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Context menu or double-click in graphic 

 
Figure 6.6: Context menu of a load in work window 

Context menu or double-click in Data navigator 

 
Figure 6.7: Context menu of load objects in the Data navigator 

Context menu or double-click in table 

 
Figure 6.8: Context menu in load tables 

The edit dialog box can be accessed by means of the context menu (or by double-click) of the 
row number. 
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Table input 
Input and modifications carried out in the graphical user interface are immediately shown in 
the tables and vice versa. To access the load tables, use the third button from the left available 
in the table toolbar. 

 
Figure 6.9: Button [Table 3. Loads] 

Input in the form of spreadsheet data entered in tables can be quickly edited and imported 
(see chapter 11.5, page 321). 

In each dialog box and table, it is possible to add a Comment specifying the load. You can also 
use predefined comments (see chapter 11.1.4, page 262). 

To control whether loads are either listed row by row or summarized in the current table, re-
spectively in all tables, select Optimize Load Data on the Table menu. You can also use the 
buttons in the table toolbar shown on the left to activate the settings. You find the buttons to 
the right of the load case list. 
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6.1 Nodal Loads 
General description 

Nodal loads are forces and moments that act on nodes (see chapter 4.1, page 41). 

To apply a nodal load, a node must have been previously defined. 

 
Figure 6.10: Dialog box New Nodal Load 

 
Figure 6.11: Table 3.1 Nodal Loads 

The number of the nodal load is assigned automatically in the dialog box New Nodal Load but 
can be changed in the input field. The numbering order is not important. 

On nodes no. 
In this input field, define the numbers of the nodes on which the load is acting. In the dialog 
box New Nodal Load, you can select nodes also graphically by using the [] function. 

When you have selected the graphical input by clicking the toolbar button, the input field is 
disabled and you have to enter load data first. After clicking [OK] you can select the relevant 
nodes one after the other in the work window. 

Force PX / PY / PZ 
Nodal forces represent vectors referring to the global coordinate system. If a force does not act 
parallel to one of the global axes, its components X, Y and Z must be determined and entered 
in the corresponding input fields. 

When the model type has been restricted to a planar system in the General Data dialog box, 
you cannot access all three input fields or table columns. 
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Moment MX / MY / MZ 
Nodal moments refer to the global coordinate system X,Y,Z as well. Therefore, a moment act-
ing in a sloping way must be split in its X, Y and Z-components which can then be entered in 
the respective input fields. 

A positive moment acts clockwise about the corresponding positive global axis. Input is made 
clearer by the global axes of coordinates represented in the RSTAB graphic. 

In addition to vectors, moments can be represented as arcs. To control the display properties 
(see chapter 11.1.2, page 258), 

point to Display Properties on the Options menu, and select Edit. 

The dialog box Display Properties opens where you set Category → Loads → Nodal Loads → 
Nodal Moments. Then, the display option Arc is available for selection in the tab to the right. 

 
Figure 6.12: Dialog box Display Properties (dialog section): Nodal Moments with display option Arc 

It is also possible to import nodal loads from Excel spreadsheets (see chapter 12.5.2, page 401). 
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6.2 Member Loads 
General description 

Member loads are forces, moments, temperature actions or imposed deformations that act on 
members. 

To apply a member load, a member must have been previously defined. 

 
Figure 6.13: Dialog box New Member Load 

 
Figure 6.14: Table 3.2 Member Loads 

The number of the member load is assigned automatically in the dialog box New Member Load 
but can be changed in the input field. The numbering order is not important. 
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Reference to 
Define the objects to which you want to apply the member load. The following options can be 
selected: 

Members 

The load acts on one single member or on each member of several members. 

List of members 

The load acts on the union of members that are defined in the list. Thus, when trapezoidal 
member loads are used, load parameters are not applied to each member individually but as 
total load to all members of the member list. The load effects of a trapezoidal member load on 
single members in contrast to a member list are shown in Figure 6.15. 

Take advantage of a member list to apply loads over all members without defining continuous 
members. Moreover, it is possible to change the load reference to individual members quickly. 

Sets of members 

The load acts on a set of members or on each set of several sets of members. Similar to the 
member list described above, load parameters are applied to the union of members included 
in the member set. 

Sets of members are subdivided into continuous members and groups of members (see chap-
ter 4.11, page 96). Loads on sets of members can be applied to continuous members without 
problems. Member groups, however, need to be handled with care: The reference to a mem-
ber group is usually problematic for trapezoidal loads. 

 

Figure 6.15: Trapezoidal load with reference to members (left) and to a list of members (right) 

On members no. 
In the input field, enter the numbers of the members or sets of members on which the load is 
acting. In the dialog box, you can select nodes also graphically by using the [] function. 

When you have selected the graphical input by clicking the toolbar button, the input field is 
disabled and you have to enter load data first. After clicking [OK] you can select the relevant 
members or sets of members one after the other in the work window. 

For trapezoidal or variable loads with load reference to a member list, you can adjust the 
member numbers by using the button [Reverse Orientation of Members] shown on the left. 
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Load type 
In this dialog section you define the load type. Depending on your selection, certain parts of 
the dialog box, respectively columns of the table, are disabled. The following load types can be 
selected:  

Load type Short description 

Force Concentrated load, distributed load or trapezoidal load 

Moment Concentrated moment, distributed moment or trapezoidal moment 

Temperature Temperature load uniformly distributed over member cross-section, 
or temperature difference between top and bottom side of member 

Load applied as uniform or trapezoidal over member length, or trape-
zoidal over cross-section. A positive load value means that the mem-
ber or the upper side is heating. 

Axial strain Imposed tensile or compressive strain ε of member 

A positive load value means that the member is extended. Thus, a 
prestress as member contraction must be entered negatively. 

Use the dialog button shown on the left to determine the strain due 
to shrinkage from the parameters for contraction and drying shrink-
age (see description in Figure 6.16). 

Axial displacement Imposed tensile or compressive strain ∆l of member 

Precamber Imposed curvature of member 

Initial prestress Prestressing force acting on member before calculation 

A positive load value means that the member is extended. 

Pipe content - full Uniform load due to complete filling of pipe 

Specify weight density γ of pipe content. 

Pipe content - partial Uniform load due to partial filling of pipe 

In addition to weight density γ of pipe content, specify filling height d. 

Table 6.1: Load types 

The graphic in the right corner of the dialog box shows the selected load type including influ-
ence of signs set for forces and strains. 

The parameters for member loads due to shrinkage can be defined in a separate dialog box 
(see the following figure). 
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Figure 6.16: Dialog box Generate Member Load Due to Shrinkage 

Shrinkage as a time-dependent change in volume without external load action or effects of 
temperature can be classified in drying shrinkage, autogenous shrinkage, plastic shrinkage 
and carbonation shrinkage. 

Based on essential influence values of the shrinkage process (relative humidity RH, effective 
component thickness h, concrete strength fcm, type of cement CType, age of concrete at begin-
ning of shrinkage ts), RSTAB determines the shrinkage εcs(t,ts) at the moment of the considered 
concrete age t. 

Click [OK] to transfer the value as axial strain ε to the dialog box New Member Load. 

Load distribution 
The dialog section Load Distribution offers different options to represent the effect of the load. 
The dialog graphic in the top right corner may help you to understand. 

Load distribution Diagram Description 

Concentrated  
P 

 

Concentrated load, concentrated moment 

In the dialog section Load Parameters, speci-
fy the size of the concentrated load or mo-
ment and the distance of the point of load 
application in relation to the member start. 

Concentrated  
n x P 

 

Multiple concentrated loads or moments 

The list offers several arrangement options 
for load pairs or multiple concentrated 
loads such as axle loads. 

The option shown on the left is appropriate 
for single forces that are equal in size and 
acting in a uniform spacing. In the dialog  
section Load Parameters, define the size of 
the concentrated load, the distance be-
tween first load and member start, and the 
spacing of loads among each other. 

 

Multiple loads 
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Uniform 

 

Uniformly distributed load, uniformly dis-
tributed moment 

In the dialog section Load Parameters, speci-
fy the size of the uniform member load or 
moment.  

Trapezoidal 

 

Trapezoidal load, trapezoidal moment 

In the dialog section Load Parameters, de-
fine both load values and distances for a 
linearly variable load distribution as shown 
in the dialog graphic. A triangular load is 
created by setting one load value to zero. 

When the check box Relative distance in % is 
ticked, you can specify the distances rela-
tively to the member length.  

Tapered 

 

Triangular-trapezoidal load, triangular-
trapezoidal moment 

In the dialog section Load Parameters, speci-
fy the load values and distances for a linear-
ly variable load distribution as shown in the 
dialog graphic. 

Parabolic 

 

Parabolic load, parabolic moment 

The load acts as a parabolic load on the 
entire member. The load values at the 
member start and member end as well as  
in the member center must be entered in 
the dialog section Load Parameters. 

Varying 

 

Polygonally distributed load 

Click the button [Edit Varying Load] shown 
on the left to open the dialog box shown in 
Figure 6.17 where you can enter or import 
the parameters of the load distribution. 

Table 6.2: Load distributions 

If you want to represent a variable load, you can freely define the x-locations on the member 
with the corresponding load ordinates p in another dialog box (see the following figure). Make 
sure that the x-locations are defined in an ascending order. Use the interactive graphic to 
check your input immediately. 
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Figure 6.17: Dialog box Edit Varying Load 

The buttons in this dialog box are reserved for the following functions: 

Button Function 

 Table export to MS Excel 

 Table import from MS Excel 

 Inserts a blank line above pointer 

 Deletes active row 

 Deletes all entries 

Table 6.3: Buttons of the dialog box Edit Varying Load 

Load Direction 
The load can be effective in direction of the global axes X, Y, Z or the local member axes x, y, z 
or u, v (see chapter 4.3, page 56). For the calculation, it makes no difference whether a load is 
defined as local or as equivalently global. RSTAB treats all loads conservatively, i.e. they are  
applied independently of the member deformations that may occur in geometrically nonlinear 
calculations. Therefore, the direction of local loads is always related to the undeformed model. 

When the model type has been reduced to a planar system in the General Data dialog box, you 
cannot access all load directions. 

Local 

The orientation of member axes is described in chapter 4.7, section Member rotation on page 
79. The local axis x represents the longitudinal axis of the member. Axis y represents for sym-
metrical sections the so-called 'strong' axis, axis z accordingly the 'weak' axis of the member 
cross-section. In case of unsymmetrical sections, loads can be related to the principal axes u 
and v or the standard input axes y and z. 

Examples for loads defined as local are wind loads acting on roof structures, temperature loads 
or prestresses. 
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Global 

The position of the local member axes is irrelevant for the load input if the load acts in direc-
tion of an axis of the global coordinate system XYZ. 

Examples for loads defined as global are snow loads acting on roof constructions and wind 
loads on wall and gable columns. 

The load impact can be related to different reference lengths: 

• related to true member length 

The load is applied to the entire member length. 

• related to projected member length in X / Y / Z 

The reference length of the load is converted to the projection of the member in one of 
the directions of the global coordinate systems. Select this option to define for example a 
snow load on the projected ground-plan area of a roof. 

RSTAB applies member loads always in the shear center. An intended torsion originating from 
the cross-sectional geometry (centroid unequal shear center) is not considered. Therefore, 
when unsymmetrical cross-sections are used, an additional torsional moment determined 
from for example load · distance to the shear center must be applied if the load acts in the cen-
troid. 

Load parameters 
In this dialog section, respectively table columns, the load values and, if applicable, additional 
parameters are managed. The input fields are labeled and accessible depending on the selec-
tion fields previously activated. 

Load p1 / p2 

Enter load values into the fields. Adjust the signs to the global or local orientations of axes.  
A positive load value for prestresses, temperature changes and axial strains means that the 
member is strained and consequently extended. 

When a trapezoidal load is selected, specify two load values. The dialog graphic in the upper 
right corner shows the load parameters. 

Distance A / B 

In these two fields, enter the distances from the member start for concentrated and trapezoi-
dal loads. It is also possible to define the distances also relative to the member length by tick-
ing the check box Relative distance in % (see below). 

The dialog graphic in the upper right corner helps you when entering parameters. 

Load of multi-layer structure 

It is possible to create loads from area weights of materials acting as laminated layers. In this 
way, you can easily determine for example the structure of floorings or floor coverings. 

Find the corresponding function in the dialog box New Member Load (Figure 6.13) where you 
click the button [] displayed to the right of the load value's input field. In the context menu, 
select Multilayer Structure. 

The Multilayer Library opens where you can enter user-defined material layers. 
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Figure 6.18: Dialog box Multilayer Library 

The concept of the multilayer database is similar to the material library (see chapter 4.2, page 
49). Use the library buttons [New] and [Edit] to create or modify multi-layer structures. 

 
Figure 6.19: Dialog box New Multilayer, dialog section Layers 

The Layers can be composed individually. Moreover, you can use the button [...] to access the 
material library (see chapter 4.2, page 49). 

RSTAB determines the area weight (table column D) from Thickness and Specific Weight. An ar-
row shown in the dialog graphic indicates the current layer. 

After confirming the dialog box another dialog box appears: Convert Area Load into Line Load 
where you have to specify the Influence width of the load (see the following figure). 
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Figure 6.20: Dialog box Convert Area Load into Line Load 

Confirm all dialog boxes with [OK] to import the member weight to the initial dialog box. A 
green triangle appears in the input field (see graphic shown in the margin on page 154), indi-
cating the parameterized input value. Click the triangle to access again the input parameters 
for modifications. 

Relative distance in % 
Tick this check box if you want to define the distances for concentrated and trapezoidal loads 
relative to the member length. Otherwise, the entries in the input fields A and B described 
above represent absolute ranges. 

Load over total length of member 
The check box can only be activated for trapezoidal loads. Select this option to arrange the 
application of the linearly variable load from the member start to the member end. The input 
fields Load Parameters A / B are no longer relevant and therefore disabled. 

Example: 
In our example, member loads are defined for a planar framework. You can see that the mem-
bers do not need to be divided by intermediate nodes to apply concentrated loads. 

 
Figure 6.21: Framework with uniform load on upper chord and concentrated loads on diagonals 
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6.3 Imposed Nodal Deformations 
General description 
An imposed nodal deformation is the displacement of a supported node, for example due to a 
column settlement. 

Imposed nodal deformations can only be applied to nodes that have a support in the direction 
of the deformation. 

 
Figure 6.22: Dialog box New Imposed Nodal Deformation 

 
Figure 6.23: Table 3.3 Imposed Nodal Deformations 

The number of the load is assigned automatically in the dialog box New Imposed Nodal Defor-
mation but can be changed in the input field. 

On nodes no. 
In this input field, define the numbers of nodes on which the imposed deformation is acting.  
In the dialog box, you can select nodes also graphically by using the [] function. 

When you have selected the graphical input by clicking the toolbar button, the input field is 
disabled and you have to enter the deformations first. After clicking [OK] you can select the 
relevant nodes one after the other in the work window. 

Imposed displacement uX’ / uY’ / uZ’ 
Imposed displacements refer to the global coordinate system. If a displacement of a supported 
node does not act parallel to one of the global axes, its components X, Y and Z must be deter-
mined and entered in the corresponding input fields. 

The graphic in the dialog box explains how displacements and signs are effective. 
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Imposed rotation ϕX’ / ϕY’ / ϕZ’ 
Node rotations refer to the global coordinate system X,Y,Z as well. Therefore, a skew imposed 
rotation requires the division in X, Y and Z components. 

A positive imposed rotation acts clockwise about the corresponding positive global axis. 

6.4 Imperfections 
General description 
There are two ways how imperfections can be represented in RSTAB: 

• equivalent loads for members and sets of members 

• predeformed equivalent model from the add-on module RSIMP 

This chapter describes imperfections in the form of equivalent loads. For more information 
about generating equivalent models with RSIMP, see the RSIMP manual. 

Imperfections represent manufacturing deviations in model geometry and material properties. 
In EN 1993-1-1, clause 5.3, the application of imperfections is organized as precamber (deflec-
tion) and inclination (sway). Thus, imperfections are taken into account by equivalent loads. 

 

Figure 6.24: Equivalent loads according to EN 1993-1-1 

Equivalent loads are also taken into account by RSTAB when calculations are performed ac-
cording to linear static analysis. Please note, however, that a pure imperfection load case will 
not produce any internal forces. The model must additionally have some “real” loads inducing 
axial forces in the imperfect member. 

It is recommended to manage loads and imperfections in separate load cases. They can be 
combined appropriately in load combinations. Load cases with pure imperfections must be 
categorized as action type Imperfection in the base data for load cases (see Figure 5.3, page 
99). Otherwise, the plausibility check would display a message because of missing loads. 

Generally, imperfections must be set affine with the lowest buckling eigenvalue in the most 
unfavorable direction. 
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Figure 6.25: Dialog box New Imperfection 

 
Figure 6.26: Table 3.4 Imperfections 

The number of the imperfection is assigned automatically in the dialog box New Imperfection 
but can be changed in the input field. The numbering order is not important. 

Reference to 
Define the objects to which you want to apply the imperfection. The following options can be 
selected: 

Members 

The imperfection acts on one single member or on each member of several selected members. 

List of members 

The imperfection acts on the union of members that are defined in the list. Thus, pre-deforma-
tions and inclinations are not applied to each member individually but as total imperfection to 
all members of the member list. Load effects of an imperfection on single members in contrast 
to a member list are shown in Figure 6.27. 

Take advantage of a list of members to apply imperfections over all members without defining 
continuous members. 
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Sets of members 

The imperfection acts on a set of members or on each set of several sets of members. Similar to 
the member list described above, parameters are applied to the union of members included in 
the member set. 

Sets of members are subdivided into continuous members and groups of members (see chap-
ter 4.11, page 96). Imperfections for sets of members can only be applied to continuous mem-
bers lying on one line. They are not adequate for member groups or continuous members 
which are buckled. 

 

Figure 6.27: Imperfection with reference to members (left) and to a list of members (right) 

On members no. 
In the input field, enter the numbers of members or sets of members on which the imperfec-
tion is acting. In the dialog box, you can select nodes also graphically by using the [] function. 

When you have selected the graphical input by clicking the toolbar button, the input field is 
disabled and you have to enter all imperfection data first. After clicking [OK] you can select the 
relevant members or sets of members one after the other in the work window. 

For imperfections referring to a list of members it is possible to arrange member numbers ap-
propriately by using the dialog button [Reverse Member Orientation], for example to reverse 
the inclination for the graphic display. However, the sequence is irrelevant for calculations be-
cause of the identical equivalent loads. 

Direction 
The imperfection can only be applied in direction of the local member axes y or z. When un-
symmetrical cross-sections are used, the principal axes u and v are additionally available for  
selection (see chapter 4.3, page 56). It is not possible to define a globally acting inclination or 
precamber. 

The orientation of member axes is described in chapter 4.7, section Member rotation on page 
79. For symmetrical sections, axis y represents the so-called 'strong' axis, axis z accordingly the 
'weak' axis of the member cross-section. 

When the model type for plates or walls was selected in the General Data dialog box, only the 
direction z can be selected. 
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Reference 
The values for inclination and precamber can be defined in two ways: 

Relative allows for entering the reciprocal values of ϕ0 and w0 in relation to the member length, 
Absolute allows for specifying geometric dimensions directly. 

Inclination 1/ϕ0 
ϕ0 indicates the degree of inclination as it is described for example in EN 1993-1-1, clause 5.3.2. 
Enter the reciprocal value of ϕ0, respectively the absolute value, into the input field. An illustra-
tion of parameters can be displayed in the dialog box by using the [Info] button. 

In addition, the dialog box offers you the button [Calculate inclination] to determine inclina-
tions according to different standards in a separate dialog box. 

 
Figure 6.28: Dialog box Calculate Value of Inclination 

Depending on the setting selected in the dialog section According to Standard, different input 
fields are available in the dialog section Inclination Parameters. Based on the values entered in 
the dialog input fields, reduction factors and inclinations are calculated conforming to stand-
ards. Click [OK] to transfer the values to the initial dialog box. 

Precamber w0/L 
The precamber w0 defines the degree of deflection to be applied according to the standard 
(for example DIN 18800 part 2, el. (204) or EN 1993-1-1, clause 5.3.2). The precamber depends 
on the buckling stress curve of the cross-section and is related to the member length L or en-
tered as absolute value. 

Activity criterion 
The following options are available for selection to define how precambers are handled in in-
teraction with member inclinations: 

• Always 
Precamber is taken into account in all cases. 

• EN 1993-1-1 (5.8) 
The influence of the precamber e0,d is applied to members with a slenderness λ  deter-
mined according to EN 1993-1-1:2005, clause 5.3.2 (6), eq. (5.8). 

• DIN 18800-2 (207) 
w0 is applied only if the member coefficient ε exceeds a certain value. This regulation  
refers to DIN 18800, part 2, el. (207). 

• Manually 
The activity criterion can be user-defined. 
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To display the criteria in the dialog graphic, use the [Info] button. 

Apply w0 from ε0 

A precamber is considered in addition to inclination if the member coefficient ε is higher than 
the value defined in this input field. DIN 18800 part 2 el. (207) specifies ε > 1.6 for most cases. 

6.5 Generated Loads 
RSTAB offers several generators that you can use to create loads easily (see chapter 11.8 on 
page 354). Generated member loads are reflected in table 3.5 and in the Data navigator. 

 
Figure 6.29: Data navigator for Generated Loads 

 
Figure 6.30: Table 3.5 Generated Loads 

The original generator dialog boxes are stored as specific load objects which can also be ac-
cessed for modifications: Double-click a navigator item or use the table button [...] to open the 
initial dialog box again (see for example Figure 11.176, page 364) where you can adjust the pa-
rameters of load generation. 
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7.  Calculation 
 

7.1 Checking the Input Data 
Before you start the calculation, it is recommended to check model and load data as well as 
the modeling. RSTAB checks if data for each model and load object is completely available, if 
references of data sets are alright and if the modeling is correct. 

Possible input errors can be corrected quickly as you can directly access the table row with the 
relevant problem (see Figure 7.2). 

7.1.1 Plausibility Check 
You can check model as well as load data for its coherent input. To open the dialog box for the 
plausibility check, 

select Plausibility Check on the Tools menu 

or use the toolbar button shown on the left. 

A dialog box opens where you define the input data that you want to check. 

 
Figure 7.1: Dialog box Plausibility Check 

In the dialog section Type of Check, you can choose between three options: 

• Normal 

The standard option checks the completeness of input parameters and the correctness of 
data records. 

• With warnings 

Select this option to carry out a detailed check of input data, finding also nodes with identi-
cal coordinates or releases with unlimited degrees of freedom. 

When a mismatch is detected, a message appears with detailed information about the 
problem. You can interrupt the check in order to eliminate the mistake. 

 
Figure 7.2: Plausibility check with warning 
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• None, only statistic 

Only a summary of input data is reported (dimensions, total mass, number of nodes, mem-
bers, supports, member loads etc.). 

When the plausibility check was successful, the check result appears showing you a summary 
of input data. 

 
Figure 7.3: Result of plausibility check, tab Model Data 

7.1.2 Structure Check 
In addition to the general plausibility check, you can use the structure check to search specifi-
cally for discrepancies produced during the modeling. To open the corresponding dialog box, 

point to Structure Check on the Tools menu 

and select one of several check options. 

Identical nodes 
RSTAB filters all nodes with identical coordinates. They are combined in groups shown in a  
dialog box. 

 
Figure 7.4: Results of structure check for identical nodes 
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In the dialog section What is to happen with Identical nodes?, you can decide how double nodes 
are treated. In the dialog section Apply action to, you define whether your selection applies to 
all groups listed above or only to the selected row. 

In the dialog section Tolerance, a kind of fine tuning is available to define the zone where co-
ordinates are evaluated as identical. This function is especially useful for models imported 
from CAD programs where lines are often short because of nodes lying closely together. If 
such nodes are filtered with an appropriate tolerance and then unified, it is possible to avoid 
numerical problems due to short members. 

Overlapping members 
Use this option to filter all members overlapping partially or entirely in their lengths. 

If overlapping members are detected, they are shown in a dialog box where they are sorted by 
groups. The current group is indicated by an arrow displayed in the work window. After click-
ing the [OK] button you can fix the problem. 

Crossing not connected members 
The check searches for members which are crossing but do not have a common node at the 
point of intersection. 

 
Figure 7.5: Results of structure check for crossing members 

The check results are shown in the dialog section Groups of Crossing Not Connected Members. 
The crossing members are listed in groups. The group that is currently selected is indicated by 
an arrow in the graphic. 

In the dialog section What is to happen with, you decide what you want to do with the crossing 
members. The option Connect members is useful for actual possibilities of internal force trans-
fer but not for example ordinary diagonal crossings with ties. 
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Independent systems 
There is no connection between particular members of a model consisting of independent 
substructures. RSTAB is able to calculate such subsystems provided that they are considered to 
be individually stable. Often, however, substructures are generated unintentionally during the 
modeling process or when data is imported from CAD programs. 

With this option you can check if the model is contiguous. 

 
Figure 7.6: Results of structure check for independent systems 

After the check you can see the groups of the independent systems listed in a dialog box. The 
current group is indicated by its selection color shown in the work window so that input errors 
can be detected quickly. 

When you want to clean the model, the structure check for Identical Nodes (described above) is 
helpful, too. 

Buttons 
The buttons in the dialog boxes of the structure check are reserved for the following functions: 

 
Applies changes of dialog section What is to happen with 

 
Jumps to RSTAB work window to adjust the view 

 
Exports listed objects to Excel table 

 
Creates a new partial view for each object group 

Table 7.1: Buttons in dialog boxes of structure check 
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      Menu Tools → Delete Loads 

7.1.3 Regenerate Model 
RSTAB revises automatically small inconsistencies existing in the model produced during the 
modeling process or arising from data exchange with CAD programs. To access the corre-
sponding function, 

select Regenerate Model on the Tools menu. 

 
Figure 7.7: Dialog box Regenerate Model 

In the dialog section Unite Close Lying Nodes, define a threshold for the distances of nodes: 
When values fall below the Tolerance, nodes are considered to be identical and will be com-
bined in a single node. As redundant nodes will be deleted, a renumbering of objects may be 
the result. 

In the dialog section Consider Members as Vertical, you can control the position of the local 
member axes. The orientation of axes for members in vertical position differs essentially from 
members in general (inclined) position (see chapter 4.7, page 80). To impose a vertical position 
for a general position, you can use the input field Tolerance. In this way, you prevent the mem-
ber axes from "switching", which is also favorable for load input and output of internal forces. 

Finally, you have the option to Round Node Coordinates. When the check box is ticked, you can 
define the relevant number of decimal places. 

7.1.4 Delete Not Used Loads 
Loads can only be defined on objects existing in the model. However, during the modeling 
process it may happen that members or nodes with assigned loads are removed from the sys-
tem. Normally, RSTAB deletes their loads, too. If the plausibility check still finds loads on non-
existing objects, it is possible to remove them. To find unused loads, 

point to Delete Loads on the Tools menu, and then select Not Used Loads. 

Use the menu shown on the left to select also other load objects for specific removal. 
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7.2 Calculation Parameters 
Dialog box Edit Load Cases and Combinations 

When creating a load case or load combination, it is already possible to define calculation pa-
rameters. Settings can be specified in the respective dialog section tab Calculation Parameters 
of the dialog box Edit Load Cases and Combinations. 

 
Figure 7.8: Dialog box Edit Load Cases and Combinations, tabs Load Cases and Calculation Parameters 

In addition to an offered overview about all load cases and combinations, the dialog box Edit 
Load Cases and Combinations controls the calculation parameters for each load case, load 
combination and result combination. 

Dialog box Calculation Parameters 
Moreover, you can access the calculation parameters in a separate dialog box. 

To open the dialog box Calculation Parameters, 

select Calculation Parameters on the Calculate menu 

or use the toolbar button shown on the left. 

 
Figure 7.9: Button [Calculation Parameters] 

The dialog box Calculation Parameters consists of four dialog tabs. The first three tabs manage 
the calculation parameters of each load case, respectively load and result combination. In the 
fourth tab Global Calculation Parameters (see Figure 7.14, page 176), you can check and, if nec-
essary, adjust specifications that are universally valid. 
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7.2.1 Load Cases and Load Combinations 

 
Figure 7.10: Dialog box Calculation Parameters, tab Load Combinations 

The dialog section Existing Load Cases respectively Existing Load Combinations lists all created 
or generated load cases and combinations. You can adjust the Calculation Parameters of the 
selected entry in the dialog section to the right. 

The button [Apply settings] assigns the current specifications to all load cases and combina-
tions. 

The dialog tab Load Combinations is subdivided into the tabs Calculation Parameters and, if 
applicable, Modify Stiffness (see page 173) and Extra Options (see page 174). 

7.2.1.1 Dialog Tab Calculation Parameters 

Method of analysis 
In this dialog section, you decide whether the load case/combination is calculated according 
to the linear static, Second-order or Large deformation analysis. Select the option Postcritical 
analysis to carry out a stability analysis according to large deformation analysis with regard to 
postcritical failure of the entire structure. 

RSTAB presets the linear calculation according to linear static analysis for load cases, and the 
nonlinear calculation according to second-order analysis for load combinations. 

When the model includes cable members, a large deformation analysis is suggested in all cas-
es. Cable members are always calculated according to large deformation analysis, the remain-
ing members according to the selected method of calculation. 

Second order analysis 

The common "structural" second-order analysis is used to determine the equilibrium on the 
deformed system. Deformations are assumed to be small. If axial forces are available in the  
system, they will lead to an increase of bending moments. Thus, the calculation according to 
second-order analysis will be applied only if the axial forces are considerably higher than the 
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shear forces. The additional bending moment ∆M results from the axial force N and the elastic 
lever eel. 

eleNM ⋅=∆  

Equation 7.1 

For structural systems subjected to pressure there is an overlinear relation between loading 
and internal forces. Normally, you have to calculate also with γ-fold actions. 

The approaches according to second-order analysis are based on trigonometric functions. 
RSTAB applies the analytical solution of the differential equation for the displacement of the 
member by taking into account the axial force. The interaction between bending and torsion is 
not taken into account. If the influence of the second-order analysis for torsional buckling is 
relevant, you can use the add-on module FE-LTB. 

RSTAB checks the member coefficient ε: 

IE

N
L

⋅
⋅=ε  

Equation 7.2 

To avoid numerical problems, the RSTAB calculation uses series approaches for small member 
coefficients. 

The axial force difference in the iterations serves as a break-off criterion. The stiffness-modify-
ing axial force that is decisive for the second-order analysis is assumed to be constant along 
the entire member. The calculation stops as soon as a particular value of the axial force differ-
ence falls below the limit. It is possible to control this threshold in the dialog section Precision 
and Tolerance of the dialog tab Global Calculation Parameters. 

For non-linear calculations according to second-order analysis, assumptions of the linear elas-
tic analysis are the same with the following additions: 

• No plastic deformations occur. 

• The external forces stay true to the direction. 

• For members with non-constant axial force (for example columns) the mean value of 
the axial force N is applied for determining the member coefficient ε. 

In the course of the calculation according to second-order analysis, the shear forces Vy and Vz 
are transformed in relation to the deformed member axis systems. 

Large deformation analysis 

The large deformation analysis ("third order theory", "cable theory") takes into account longi-
tudinal and transversal forces during the analysis of internal forces. If the calculation according 
to large deformation analysis is selected, all types of members will be calculated according to 
this analysis approach. 

The procedure according to NEWTON-RAPHSON is used. The non-linear equation system is solved 
numerically by means of iterative approximations with tangents. You can influence the per-
formance of convergence by the number of load increments to be set in the dialog tab Global 
Calculation Parameters. 

After each iteration step the complete deformation of the model is corrected, and the stiffness 
matrix and the right side of the equation system is created for the deformed system. The right 
side contains the external loads and the internal forces of the deformed members (thus the 
complete equilibrium vector). The internal forces are transformed by the deformed member 
axis systems. If a globally defined load acts on a member, the load keeps its direction if the 
member axis is being deformed. A locally defined member load is treated "conservatively" as 
well: It is acting with constant size and constant load direction like on the undeformed system 
- regardless of the deformation. 
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Post-critical analysis 

A stability analysis with regard to postcritical failure is performed. The method represents a 
modified calculation according to large deformation analysis by NEWTON-RAPHSON where the in-
fluence of axial forces is considered for changes occurring in shear and bending stiffness. The 
tangential stiffness matrix is saved in each iteration step. In case of singularities (which means 
instability), the stiffness matrix of the previous iteration will be used for new geometric, incre-
mental iterations until the tangential stiffness matrix of the current setting becomes regular 
(stable). 

Options 

Consider favorable effects due to tension 

Tensile forces have a favorable effect on pre-deformed structural systems. Thus, the pre-
deformation is reduced and the structure is stabilized. 

There are different opinions on how to consider tensile forces acting in a favorable way. Stand-
ards contain regulations according to which relieving actions must be considered with a 
smaller partial safety factor than unfavorable effects. 

Partial safety factors that are varying from one member to the other cannot be realized with an 
acceptable computing time. Therefore, RSTAB offers you the option to set tensile forces gen-
erally to zero for calculations according to second-order analysis. With this approach you will 
be definitely on the safe side. If you want to use this option, clear the check box. 

On the other hand, one can say that standards refer to actions and not to internal forces. 
Therefore, it is necessary to decide for the action as a whole whether it is favorable or unfavor-
able. Thus, if an unfavorable action has a favorable effect in certain zones of the model, it can 
definitely be considered. So, if you want to take account of the axial forces without any chang-
es in the calculation according to this approach, the check box must be ticked (default setting). 

The favorable effect of tensile forces should be considered in the majority of cases, for example 
for halls with bracings or structural systems affected by bending. But please keep in mind that 
relief due to tension force effects for beams with supporting cables may result in an unwanted 
reduction of deformations and internal forces.  

Modify loading by factor 

After ticking the check box, you can enter a factor into the input field by which all loads con-
tained in the load case or combination will be multiplied. The factor is also reflected in the load 
vectors and values of the graphic. Generally, also negative factors are permitted. 

Older standards claim to multiply loads globally by a certain factor in order to increase effects 
according to second-order analysis for stability designs. On the other hand, design must be 
carried out with the characteristic loads. Both requirements can be fulfilled by entering a factor 
larger than 1.00 and ticking the check box Divide results by loading factor. 

When analyzing structures according to current standards, loading should not be edited with 
any factors. Instead, partial safety factors and combination coefficients must be applied for the 
superposition in the load and result combinations. 

Refer internal forces to deformed structure 

The option enables output for non-linear calculations showing axial and shear forces as well as 
bending and torsion moments of members in relation to the rotated coordinate systems of the 
deformed system. There are three check boxes available for the internal force types Normal 
forces, Shear forces and Moments. 
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Calculate critical load factor 

When calculating according to second-order or large deformation analysis, you can determine 
the critical load factor of a load case or combination iteratively. Based on the Initial load factor, 
the loading is increased continuously according to the Load increment until the model be-
comes unstable. 

Make sure that the initial load factor is not too high and the load increment is not too wide so 
that the first eigenmode is not skipped. Furthermore, make sure to have set a sufficient num-
ber of possible iterations (see Global Calculation Parameters). 

Determining the critical load factor has an unfavorable effect on the computing time because 
of the high number of load steps. Therefore, it is recommended to use this option only for spe-
cial stability analyses. 

Use separate number of load increments for this load case 

You can define an individual number of load increment steps for each load case and each load 
combination. Thus, the number specified in the dialog tab Global Calculation Parameters is no 
longer valid (see 7.2.3, page 176). 

Divide stiffness (E, G) by partial safety factor γM 

When the check box is ticked, RSTAB divides stiffnesses on the basis of the moduli of elasticity 
and shear by the partial safety factors γM for material. The factor γM must be defined for each 
material separately (see chapter 4.2, page 46). 
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7.2.1.2 Dialog Tab Modify Stiffness 
The dialog tab is displayed only when the check box for advanced options is ticked in the  
Options tab of the dialog box General Data (see Figure 12.31, page 391). 

 
Figure 7.11: Dialog tab Modify Stiffness 

Settings entered in this dialog tab affect only the load case or load combination that is select-
ed in the list to the left. The button [Apply settings] transfers the current parameters to all load 
cases, respectively combinations. 

Materials and cross-sections / supports / releases 

With specifications defined in the three dialog sections you can decide how stiffnesses of the 
different model parameters are taken into account in the calculation. 

In general, the standard requires that material stiffnesses are divided by partial safety factors 
γM. Factors are stored with the material properties (see chapter 4.2, page 46). If a reduction by 
the provided factors is not wanted, individual specifications are possible: 

• All with multiplier factor 

Specify a factor by which the stiffness of all materials (moduli of elasticity and shear) are 
globally multiplied. 

• Individually 

Use the [Modify] button to open a new dialog box where you can assign a specific stiff-
ness factor to each material.  

Both selection fields are available for Cross-Sections, Supports and Releases. In this way, you can 
influence the calculation specifically. 

Deactivate 

You can define the Members which are not affected by the defined stiffness modifications, that 
means which are considered with the factor 1.0 in the calculation. You can select the members 
also graphically with the [] function. 
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7.2.1.3 Dialog Tab Extra Options 
The dialog tab is displayed only when the check box for advanced options is ticked in the  
Options tab of the dialog box General Data (see Figure 12.31, page 391). 

 
Figure 7.12: Dialog tab Extra Options 

Initial strain from other load case/combination 
Select a load case or load combination whose deformations you want to consider as initial de-
formation in the calculation. The nodes are shifted accordingly before the calculation starts. If 
results are not yet available for the selected load case or combination, they will be calculated 
automatically. 

Specify the factor by which you want to scale the deformations: 

• All with multiplier factor 

Deformations of the members are globally multiplied with the specified factor. 

• Individually 

Use the [Edit] button to open a new dialog box where you can assign a specific scaling 
factor of deformation to each member.  
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7.2.2 Result Combinations 
For basic information about superpositioning load cases in result combinations, see chapter 
5.6 Result Combinations on page 128. 

 
Figure 7.13: Dialog box Calculation Parameters, tab Result Combinations 

In the dialog section Existing Result Combinations, you find a list of all created or generated re-
sult combinations. You can edit the Calculation Parameters of the selected entry in the dialog 
section to the right. 

Options 
The Quadratic Combination is deactivated by default. Thus, internal forces are superimposed 
by additive superposition: 

n21 A...AAB +++=  

Equation 7.3 

The default setting is appropriate for most application cases. A square addition of internal 
forces is relevant for dynamic analyses, for example when combining load cases due to cen-
trifugal forces. In this case, the Pythagorean sum is created as follows: 

2
n

2
2

2
1 A...AAB +++=  

Equation 7.4 

When the square addition is activated, you can use the Positive/Negative options to decide 
which extreme values of the load cases will be considered in the super combination, and if you 
want to Preserve signs. In this way, the extreme values of the modal internal forces and defor-
mations as well as the results belonging to the governing component can be determined con-
forming to signs. 
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7.2.3 Global Calculation Parameters 
The dialog tab Global Calculation Parameters manages settings generally applied to all load 
cases and load combinations. To open the corresponding dialog box, 

select Calculation Parameters on the Calculate menu 

or use the toolbar button shown on the left. 

 
Figure 7.14: Dialog box Calculation Parameters, tab Global Calculation Parameters 

Settings 
Maximum number of iterations 

When using second-order or large deformation analysis as well as objects that are nonlinearly 
effective, you have to calculate iteratively. The value of the input field defines the highest pos-
sible number of calculation runs. The specification has nothing to do with the iterative method 
set for the system of equations described for the dialog section Options. 

When the calculation reaches the maximum number of iterations without achieving an equi-
librium, RSTAB displays a corresponding message. The results can be displayed anyway. 

 
Figure 7.15: Message displayed in case of converging problems 

Number of load increments 

Specifications of the input field take effect only for calculations according to second-order or 
large deformation analysis. Finding an equilibrium is often difficult when large deformations 
are considered. Instabilities can be avoided by applying the load in several steps. 
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For example, when two load increments are specified, half of the load will be applied in the 
first step. Iterations will be carried out until the equilibrium is found. Then, in the second step, 
the complete load will be applied to the already deformed system and iterations will be run 
again until the state of equilibrium is reached. 

Please keep in mind that load increments have an unfavorable effect on the computing time. 
Therefore, the value 1 (no gradual load increment) is preset in the input field. 

Moreover, you can define for each load case and combination how many load increments you 
want to apply (see chapter 7.2.1.1, page 172). Then, the global specifications will be ignored. 

Number of divisions of members for result diagrams 

This input field has an influence on the graphical result diagram of members. If a division of 10 
is set, RSTAB divides the length of the longest member in the system by 10. Based on such a 
system-related division length, RSTAB determines for each member the graphical result distri-
butions on the division points. 

Number of divisions of members for special types of members (elastic foundation,  
taper, nonlinearity) 

In contrast to the previous division option, a real division of the member is now defined by in-
ternal intermediate nodes. The specification affects foundation members (contact stresses), 
tapered members (interpolation of cross-section values) and members with plastic properties 
(yielding zones). 

Number of divisions of members for determination of max/min values 

The value specifies the internal division by which the maximum and minimum internal forces 
of members are determined. Thus, the division (default setting: 10) represents the basis for the 
extreme values shown in the results tables and graphic. 

Options 

Activate shear stiffness of members (cross-sectional areas Ay, Az) 

Considering shear stiffnesses leads to an increase of deformations due to shear forces. As the 
shear deformation is almost irrelevant for rolled and welded cross-sections, the check box is 
clear by default. For solid and timber cross-sections, however, it is recommended to consider 
the shear stiffnesses for the deformation analysis. 

Shear deformations have an effect only on the end nodes of members. Therefore, a single-
span beam must be divided by intermediate nodes so that the increase becomes effective. 

Activate member divisions for large deformation or post-critical analysis 

Beams can be divided by intermediate nodes for the calculation according to large defor-
mation analysis to calculate such members with a higher accuracy. The number of divisions is 
taken from the input field for cable and foundation members. 

Activate entered stiffness modifications (members, materials and cross-sections) 

With the check box you can control if adjustments of the stiffnesses for members (see chapter 
4.7, page 84) and cross-sections (see chapter 4.3, page 55) are considered in the calculation. 
The member and cross-section dialog boxes preset factors each with 1.00. Thus, the check 
mark in the check box usually involves no reduction or increase of the stiffnesses. 

Check of critical forces of members 

Often, exceeding the critical load already in the first iteration leads to an instability message. 
Use this check box to control if the critical load is checked for trusses, compression and buck-
ling members. The defined effective lengths of members will be taken into account. 
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Precision and tolerance 
It is only rarely necessary to adjust the preset convergence parameters. Tick the check box 
Change standard settings to enable the input field below. 

If non-linear effects are involved, or if data is calculated according to second-order or large de-
formation analysis, you can influence the calculation by means of the Precision of convergence 
criteria. 

The change of axial forces of the two last iterations is compared member by member. As soon 
as the change reaches a specific fractional amount of the maximum axial force, the calculation 
stops. It is possible, however, that axial forces are swinging between two values during the it-
eration process instead of converging. With the factor entered in the input field you can define 
a certain sensitivity in order to prevent this oscillation effect. 

The accuracy also effects the convergence criterion for deformation changes in calculations 
according to large deformation analysis where geometric non-linearities are considered. 

The default value is 1.0. The minimum factor is 0.01, the maximum value is 100.0. The higher 
the factor is, the less sensitive the break-off limit will be. 

Nonlinearities 
When nonlinearly acting elements are used in the model, you can deactivate the effect of the 
following elements for the calculation: 

• Failing supports ( chapter 4.8, page 88) 

• Failing members due to member type ( chapter 4.7, page 75) 

• Member end releases ( chapter 4.4, page 64) 

• Member elastic foundations (chapter 4.9, page 92) 

• Member nonlinearities ( chapter 4.10, page 93) 

• Material nonlinearities ( chapter 4.2, page 47) 

It is recommended to disable the nonlinear effects only for test purposes, for example finding 
the cause of an instability. The options in this dialog section help you to find errors: Some-
times, inaccurately defined failure criteria is responsible for calculation break-offs. 

Reactivation of failing members 
Settings in this dialog section concern member elements that may fail (for example tension, 
compression or foundation members). Take advantage of the options to solve problems of in-
stability caused by failing members: A structure for example is stiffened by ties. Because of 
post shortenings due to vertical loads, the tension members receive small compressive forces 
in the first calculation step. They will be removed from the system. Then, in the second calcula-
tion run, the structure is unstable without the ties. 

Check deformation of failing members and reactivate where appropriate 

When the check box is ticked, RSTAB analyzes the nodal displacements in each iteration. If 
member ends of a failed tie move away from each other, the member is reactivated. 

In some cases, reactivating members may be problematic: A member is removed after the first 
iteration, but reactivated after the second one, removed again after the third iteration etc. The 
calculation would run this loop until reaching the maximum number of iterations without 
converging. This effect can be avoided by defining a Maximum number of reactivations specify-
ing how often a member element is permitted to be reactivated before it will be definitely re-
moved from the stiffness matrix. 
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Exceptional handling 

After ticking the check box two methods for handling failing members are available for selec-
tion. They can be combined with the reactivation options described above. 

• Failing members to be removed individually during successive iterations 

After the first iteration RSTAB does not remove for example all tension members with a com-
pression force but only the tie with the greatest compressive force. Then, in the second itera-
tion, only one member is missing in the stiffness matrix. In the next step, RSTAB removes again 
the tie with the greatest compressive force. Often, a better convergence behavior can be 
achieved in this way for the system because of redistributing effects. 

This calculation option requires more time because the program must run through a larger 
number of iterations. Furthermore, you have to make sure that a sufficient number of possible 
iterations is set in the Settings dialog section above. 

• Assign reduced stiffness to failing members 

Members which have failed are not removed from the stiffness matrix. Instead, RSTAB assigns a 
very small stiffness to them. Specify it in the input field Reduction factor of stiffness: Factor 1000 
means a reduction of stiffness to 1/1000. 

Please keep in mind for this calculation option that RSTAB displays on members small internal 
forces which can actually not be absorbed by the member due to its definition. 
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7.3 Start Calculation 
You can select between several options for the calculation start. Before you start the calcula-
tion, it is recommended to carry out a short plausibility check of input data (see chapter 7.1.1, 
page 163). 

Calculate all 
To start the corresponding function, 

select Calculate All on the Calculate menu, 

or use the toolbar button shown on the left. 

 
Figure 7.16: Button [Calculate All] 

The command starts the calculation of all load cases, load combinations and result combina-
tions as well as of all additional modules where input data is available. 

Please use the function [Calculate All] with care: 

• Many load cases cannot occur isolated. Wind loads, for example, act always together with 
the self-weight. For structural systems with failing supports for tension, instabilities may 
occur during the batch calculation of the single load cases. 

• If many load combinations and module design cases are available, RSTAB may need a lot 
of computing time. 

Calculate selected load cases 
To open the dialog box for selecting the load cases which are relevant for calculation, 

select To Calculate on the Calculate menu. 

 
Figure 7.17: Dialog box To Calculate 
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In the dialog section Not Calculated on the left, RSTAB lists all load cases, load combinations 
and result combinations as well as analysis cases of add-on modules for which no results exist. 
Use the button [] to transfer the selected entries to the list Selected for Calculation. You can 
also double-click the items. To transfer the complete list to the right, use the button []. 

If result combinations or module cases are selected which require results from load cases, the 
relevant load cases will be calculated automatically. 

Load items can be sorted by filter options available below the list according to the following 
criteria: 

• Load cases 

• Load combinations 

• Result combinations 

• Add-on modules 

The button [Calculation Parameters] shown on the left opens the dialog box Calculation Pa-
rameters (see chapter 7.2, page 176) where settings can be checked and adjusted for the calcu-
lation. 

The dialog tab Result Tables of the To Calculate dialog box controls the availability of tables 
shown after the calculation. 

 
Figure 7.18: Dialog box To Calculate, tab Result Tables 

More filter options are available for some results tables. They are described in chapter 8 Results 
together with the respective output tables (see for example Figure 8.4, page 186). 

Calculate current load case 
It is possible to start the calculation of an individual load case directly: Select the load case, 
load or result combination in the toolbar list, and then click the button [Show Results]. 

 
Figure 7.19: Calculating the load case directly by using the button [Show Results] 
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The calculation can be started after a message has been displayed that no results have been 
found. 

 
Figure 7.20: Query before calculation 

Calculate selected results 
The toolbar menu Calculate offers you additional options for selecting results to be calculated: 

• RSTAB results only 

• Modules results only 

• All results of all open models 

• RSTAB results only of all open models 

• Modules results only of all open models 

The calculation starts immediately after calling the corresponding function. 

Calculation process 
The calculation process is shown in the Calculation window. When nonlinear calculations are 
performed, you can observe the graphs of the maximum axial forces in a diagram in addition 
to the calculation steps through which RSTAB is running. 

 
Figure 7.21: Calculation process 

The green vertical bar on the right in the window visualizes the convergence behavior during 
the calculation: Each load increment takes a part of the column, for example 4/5 in the figure 
above represents the fourth of five load increments. 

It is necessary for the calculation to make sure that the swap file is large enough respectively 
the file size is assigned automatically by Windows. With a swap file that is too small, program 
crashes may occur. 
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In the toolbar menu Options, select Program Options, or use the toolbar button shown on 
the left to open the dialog box Program Options. In the dialog tab Help Assistant you can check 
if the control of the RAM disk space is activated. 

 
Figure 7.22: Dialog box Program Options, tab Help Assistant  
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8.  Results 
The numbering of this manual chapter follows the numbering of results tables, which makes it 
easier to find the respective descriptions of the tabs. 

When data has been calculated, the additional tab Results appears in the navigator (see chap-
ter 3.4.3, page 22) for controlling the graphical results display. The results are listed numerically 
in separate tables (see chapter 3.4.4, page 24). 

Colored relation scales in tables 

The result columns of tables are partly highlighted in red or blue (see Figure 8.10, page 191. 
The colored bars represent result values graphically. They are scaled to the extreme values of 
the internal forces or deformations of all objects. Negative values are symbolized by red bars, 
positive ones by blue bars. Thus, the table allows also for a visual result evaluation. 

To switch the colored bars on and off, 

select View on the Table menu, and then click Colored Relation Scales, 

or use the button in the table toolbar shown on the left. 

Table filter 

The displayed tables depend on the selections set in the dialog tab Result Tables of the dialog 
box To Calculate (see chapter 7.3, page 181).  

8.0 Results Balance 
Table 

Table 4.0 Summary represents a summary of the calculation process, sorted by load cases and 
combinations. 

 
Figure 8.1: Table 4.0 Summary 

This overview shows you the check sums of loadings and support forces. The deviations in 
each direction should be less than 1 %. If this is not the case, numerical problems have oc-
curred because of considerable differences in stiffness. It may also be possible that the model 
has an insufficient stability, or the calculation has reached the maximum number of iterations 
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without convergence. The overview informs you also about the resulting support reactions 
that are effective in an idealized way in the centroid of the model. 

Moreover, the summary shows the maximum displacements and rotations related to the glob-
al axes X, Y and Z as well as the largest total displacement. Due to the check of deformations, 
reliability of results can be evaluated. 

The summary that is listed by load cases is completed by the used calculation parameters. The 
Number of iterations required to obtain the results is of special interest here. 

The table ends with a Summary of selected parameters of the analysis core as well as globally 
valid specifications of calculation (see Figure 7.14, page 176: dialog box Calculation Parameters, 
tab Global Calculation Parameters). 

8.1 Members - Internal Forces 
To control the graphical display of member internal forces, tick the check box for Members in 
the Results navigator. Table 4.1 shows the internal forces and moments in numerical form. 

If the structure is a 2D model, RSTAB displays only the table columns of internal forces that are 
relevant for a planar structural system. 

 
Figure 8.2: Results navigator: Members → Internal Forces 

 
Figure 8.3: Table 4.1 Members - Internal Forces 

To display the internal forces of a particular load case, select the load case from the list in the 
main toolbar or the toolbar of the tables.  
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Location x 
The table lists the internal forces of each member on the following locations: 

• Start and end node 

• Division points according to defined member division (see chapter 4.6, page 72) 

• Extreme values (Max/Min) of internal forces 

To adjust the default setting of the x-locations shown in the results table, 

select View on the Table menu and click Result Filter, 

or use the button in the table toolbar shown on the left. 

 
Figure 8.4: Dialog box Table Filter 

The check boxes in the dialog box Table Filter control the type and amount of numerical out-
put (see chapter 11.5.5, page 328). 

The diagram graphic for internal forces is based on the result values available in the member 
divisions that have been defined in the dialog tab Global Calculation Parameters of the dialog 
box Calculation Parameters (see chapter 7.2.3 page 177). 

Forces / moments 
The member internal forces have the following meanings: 

N Axial force in member 

Vy / Vu Shear force in direction of local member axis y or u (see page 55) 

Vz / Vv Shear force in direction of local member axis z or v 

MT Torsional moment 

My / Mu Bending moment about axis y or u 

Mz / Mv Bending moment about axis z or v 

Table 8.1: Internal forces of members 
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Member context menu 

 

The local member axes y and z or u and v are the principal axes of the cross-section. Axis y or u 
represents the "strong" axis, the "weak" axis is represented by axis z or v (see chapter 4.7, page 
79). When asymmetric cross-sections are used, you can select if internal forces refer to the 
principal axes u and v (see graphic on page 55) or to the standard input axes y and z. To set the 
results display, use the Results navigator as shown on the left. This display setting affects both 
the graphical results output and the output of results in the tables. 

When a non-linear analysis is performed, internal forces can also be related to the deformed 
member axis systems. The reference of the internal forces is set in the dialog section Options of 
the dialog box Calculation Parameters (see chapter 7.2.1, page 171). 

To check the member position, use the 3D rendering. You can also use the Display navigator 
where you select Model and Members, and then tick the check box for Member Axis Systems 
x,y,z (see figure below). 

 
Figure 8.5: Selecting the local member axis systems in the Display navigator 

The display of member axes can also be activated in the member context menu shown on the 
left. 

The local member axis system affects the signs of internal forces. 

 
Figure 8.6: Positive definition of internal forces 

The bending moment My is positive if tensile stresses occur on the positive member side (in di-
rection of the z-axis). Mz is positive if compressive stresses occur on the positive member side 
(in direction of the y-axis). The sign definition for torsional moments, axial forces and shear 
forces conforms to the usual conventions: These internal forces are positive if they act in a pos-
itive direction. 
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Extreme values 

If the table display of extreme values is activated (see Figure 8.4, page 186), RSTAB shows you 
the maximum positive (Max) and the minimum negative (Min) internal forces for each mem-
ber. In the results table, extreme values are highlighted in bold. The values in the remaining 
columns of the respective table row represent the internal forces related to the extreme value 
(see also chapter 11.5.5, page 328). 

Cross-section / corresponding load cases 
The final table column informs you about the cross-sections used in the members. 

Result combinations 

When you look at the results of result combinations, the column is entitled with Corresponding 
Load Cases (see Figure 8.3). The table shows the numbers of the load cases or combinations 
that have been used to determine the maximum or minimum internal forces of the respective 
table row. Load cases classified as Permanent appear always in this table column. Variable load 
cases are only displayed if their internal forces have an unfavorable effect on the result (see 
chapter 5.6, page 131). 

At the same time, the table is extended by a new table column which is the third column C. At 
the end of the internal force list of a member you can read the maximum positive (Max) and 
the minimum negative (Min) values. 

It is possible to reduce the amount of data in the result combination tables by using specific  
filter functions available in the dialog box Table Filter (see Figure 8.4, page 186). To open the 
dialog box, 

select View on the Table menu and click Result Filter, 

or use the button in the table toolbar shown on the left. 

 

 



8  Results 

 189 Program RSTAB © 2013 Dlubal Engineering Software 

 

8.2 Sets of Members - Internal Forces 
Table 4.2 shows the internal forces sorted by sets of members (see chapter 4.11, page 96). 

 
Figure 8.7: Table 4.2 Set of Members - Internal Forces 

The table's structure is similar to the one of table 4.1 Members - Internal Forces described in 
chapter 8.1. Now, the results are sorted by continuous members or member groups. The de-
scriptions of member sets remain fixed in the top row of the table so it is easier to overview re-
sults data when scrolling. 

The table includes the member-by-member results of all members contained in the set of 
members. The results list of a set of members ends with the color-highlighted table rows: They 
show the total extremes MAX and MIN of each internal force type in the member set. The ex-
treme values are highlighted in bold. The values in the remaining table columns of the respec-
tive table row represent the internal forces related to the extreme value. 

It is possible to reduce the amount of data in the table by using specific filter functions availa-
ble in the dialog box Table Filter (see chapter 11.5.5, page 328). To open the dialog box, 

select View on the Table menu and click Result Filter, 

or use the button in the table toolbar shown on the left. 

 



8  Results 

 

 

190 Program RSTAB © 2013 Dlubal Engineering Software 

8.3 Cross-sections - Internal Forces 
Table 4.3 shows the internal forces sorted by cross-sections. 

 
Figure 8.8: Table 4.3 Cross-Sections - Internal Forces 

The table's structure is similar to the one of table 4.1 Members – Internal Forces described in 
chapter 8.1. Now, the results are sorted by cross-sections. The descriptions of cross-sections 
remain fixed in the top row of the table so that it is easier to overview results data when scroll-
ing. 

The table includes the member-by-member results of all members that use the relevant cross-
section. The results list for a cross-section ends with the color highlighted table rows: They 
show the total extremes MAX and MIN of each internal force type in the cross-section. The ex-
treme values are highlighted in bold. The values in the remaining table columns of the respec-
tive table row represent the internal forces related to the extreme value. 

It is possible to reduce the amount of data in the table by using specific filter functions availa-
ble in the dialog box Table Filter (see chapter 11.5.5, page 328).  
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8.4 Nodes - Support Forces 
With the entries under Support Reactions in the Results navigator you decide which compo-
nents are displayed graphically in the work window. They can be related to the local axes of  
rotated supports or to the global axis system XYZ. Table 4.4 shows the support forces and 
moments in numerical form. 

If the structure is a 2D model, RSTAB displays only the table columns of support forces and 
moments that are relevant for a planar structural system. 

 

Figure 8.9: Results navigator: Support Reactions → Nodal Supports 

 
Figure 8.10: Table 4.4 Nodes - Support Forces 

To display the support reactions of a particular load case, select the load case from the list in 
the main toolbar or the toolbar of the table. 

Support forces PX / PY / PZ 

The support forces are listed in three table columns where they are sorted by nodes. Usually, 
the forces refer to the axes X, Y and Z of the global coordinate system. To display the forces  
related to the local support axes X', Y' and Z' (rotated supports) in the graphic as well as in the 
table, go to the Results navigator and set Support Reactions → Nodal Supports → Local. 

Nodes with support rotations are marked by an asterisk (*) as shown in Figure 8.10. Forces are 
put out in relation to the selected axis system. In the final table column, the support's rotation 
angle is indicated. 

The table shows the forces which are introduced into the support. Thus, with regard to signs, 
the table does not show the reaction forces on the part of the support. The signs result from 
the direction of the global axes. If the global axis Z is directed downwards, then the load case 
self-weight for example results in a positive support force PZ, and a wind load against the glob-
al axis X has a negative support force PX. Thus, the support forces shown in the table represent 
foundation loads. 
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In contrast, the green vectors displayed in the graphic of the work window show the reaction 
forces on the part of the supports. The components of the support reactions are visualized by 
the size and direction of the vectors. 

You can also display in the work window the signs of the forces that are transferred into the 
support. Select Results in the Display navigator and tick the corresponding check box. 

 

Figure 8.11: Display navigator, Results → Support Reactions → With sign 

The signs in the graphic refer to the global axis system XYZ or the rotated local axis system 
X’Y’Z’ which is rotated. It is advisable to activate these signs only for visualizing the transferred 
forces because otherwise they lead to misinterpretations. 

Support moments MX / MY / MZ 
The support moments are listed in three table columns where they are sorted by nodes. Usual-
ly, the moments refer to the axes X, Y and Z of the global coordinate system. Use the Results 
navigator to display the moments related to the local support axes X', Y' and Z' in the graphic 
as well as in the table. 

The table shows the moments which are introduced into the support. With regard to signs, like 
for support forces, the table does not show the reactions on the part of the support. The signs 
result from the direction of the global axes. Thus, the support moments shown in the table 
represent foundation loads. 

In the work window, however, reaction moments are shown on the part of the support. 

Signs for support moments can be displayed in the graphic as well (see Figure 8.11). A positive 
support moment acts clockwise about the corresponding positive global axis. Similar to the 
vectors for support forces, vectors are already signed, and indications of value have to be con-
sidered independently: The signs indicate the directions of the moments in relation to the 
global axes. 
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In the graphic, support moments can be represented as vector or arc. To change the display 
type, 

point to Display Properties on the Options menu, and select Edit. 

 
Figure 8.12: Dialog box Display Properties: nodal moments with display option Arc 

In the dialog section Category on the left, set Results, Support Reactions and Nodal Moments, 
and then select the Display option Arc to the right. 

Rotated nodal supports 
In the final table column, the rotation angles of rotated nodal supports are shown (see Figure 
8.10, page 191). The corresponding nodes are marked by an asterisk (*). 

Check sums 
For load cases and load combinations RSTAB displays check sums of loads and support reac-
tions at the end of the table. Differences will occur between Σ Forces and Σ Loads if the model 
has also members with elastic foundations. Therefore, the Σ Forces of table 4.5 must also be 
considered for the total summary. 
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Filtering support forces of result combinations 
For result combinations it is possible to adjust the default setting for the extreme values 
shown in the results table. To open the corresponding dialog box, 

select View on the Table menu and click Result Filter, 

or use the button in the table toolbar shown on the left. 

 
Figure 8.13: Dialog box Table Filter (dialog section) 

The check boxes in the dialog box Table Filter control the type and amount of numerical out-
put for support forces. 

Resultant of support reactions 
The resultants of support reactions for load cases and load combinations are shown in numeri-
cal form in table 4.0 Summary for each global direction (see Figure 8.1, page 184). Use the Results 
navigator to visualize the resultant forces also on the model. 

 

Figure 8.14: Results navigator: Support Reactions → Resultant 

In addition to the total resultant P, it is possible to display the individual Components that are 
effective in an idealized way in the model's centroid. Thus, you can check the position and size 
of the resulting support forces at a glance. 
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8.5 Members - Contact Forces 
When members with elastic foundations exist in the model (see chapter 4.9, page 91), the con-
tact forces and moments are shown numerically in table 4.5. To control the graphical display of 
results, tick the check box for Members in the Results navigator. 

 

Figure 8.15: Results navigator: Members → Contact Forces 

 
Figure 8.16: Table 4.5 Members - Contact Forces 

Node no. 
In the first two table rows, the numbers of the start and end node are displayed for each foun-
dation member. The remaining rows inform you about the types of extreme values available 
for contact forces and moments. 

To adjust the default settings for the output of extreme values, 

select View on the Table menu and click Result Filter, 

or use the button in the table toolbar shown on the left. 

Location x 
The table lists the contact internal forces of each member on the following locations: 

• Start and end node 

• Division points according to defined member division (see chapter 4.6, page 72) 

• Extreme values (Max/Min) of contact forces and moments 
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Contact forces px / py / pz 
Contact forces that are effective in direction of the local member axes x, y and z are shown in 
relation to a standard length. When asymmetric cross-sections are used, you can select if con-
tact forces refer to the principal axes u and v (see graphic on page 55) or to the standard input 
axes y and z. To set the results display, use the Results navigator. 

To check the position of the local axes, select Model and Members in the Display navigator and 
activate Member Axis Systems x,y,z (see Figure 8.5). The signs comply with the usual definitions 
explained in chapter 8.1 on page 187 describing the internal forces of members. 

When you want to determine soil contact pressures on the basis of the table values, you addi-
tionally have to divide the results by the respective cross-section widths. 

Moments mx 
The contact moments about the longitudinal member axis x also refer to a standard length. 
The moments mx are influenced by the rotational spring constant Cϕ. 

Cross-section / corresponding load cases 
The final table column informs you about the cross-sections used in members. When a result 
combination is set, you see the load cases and combinations that have been used to deter-
mine the maximum or minimum contact forces in the respective table row. 

Check sums 
For load cases and load combinations RSTAB displays check sums of loads and support reac-
tions at the end of the table. Differences will occur between Σ Forces and Σ Loads if the model 
has also nodal supports. Therefore, the Σ Forces of table 4.4 must also be considered for the  
total summary. 

The contact forces are determined with the member divisions which apply to the Result dia-
grams and max/min values. Find the divisions shown in the dialog tab Global Calculation Pa-
rameters of the Calculation Parameters dialog box (see Figure 7.14, page 176). The entry for 
Special types of members has only an effect if a foundation member is used with an asymmetric 
cross-section. 
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8.6 Nodes - Deformations 
To control the graphical display of nodal displacements and nodal rotations, tick the check box 
for Global Deformations in the Results navigator. Table 4.6 shows the deformations of nodes in 
numerical form. 

 
Figure 8.17: Results navigator: Global Deformations 

 
Figure 8.18: Table 4.6 Nodes - Deformations 

The displacements and rotations are listed by nodes. 

Displacements / rotations 
The deformations have the following meanings: 

u Total displacement 

uX Displacement in direction of the global axis X 

 uY Displacement in direction of the global axis Y 

uZ Displacement in direction of the global axis Z 

ϕX Rotation about the global axis X 

ϕY Rotation about the global axis Y 

ϕZ Rotation about the global axis Z 

Table 8.2: Nodal deformations 
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8.7 Members - Local Deformations 
To control the graphical display of member displacements and member rotations, tick the 
check box for Members in the Results navigator. When asymmetric cross-sections are used, you 
can select if results refer to the principal axes u and v (see graphic on page 55) or to the stand-
ard input axes y and z. Table 4.7 shows the members' local deformations in numerical form. 

 

Figure 8.19: Results navigator: Members → Local Deformations 

 
Figure 8.20: Table 4.7 Members - Local Deformations 

To display the deformations of a particular load case, select the load case from the list in the 
main toolbar or the toolbar of the table. 

Node no. 
The numbers of the start and end node are displayed for each member in the first two tables 
rows so that you can read the nodal values. In the subsequent rows, you see information about 
the deformation maximum or minimum shown in table columns D to I. 

Location x 
The table lists the deformations of each member on the following locations: 

• Start and end node 

• Division points according to defined member division (see chapter 4.6, page 72) 

• Extreme values (Max/Min) of displacements and rotations 
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Member context menu 

To adjust the default setting of the displayed x-locations, 

select View on the Table menu and click Result Filter, 

or use the button in the table toolbar shown on the left. 

 
Figure 8.21: Dialog box Table Filter (dialog section) 

The check boxes in the dialog box Table Filter control the type and amount of numerical out-
put. 

Displacements / rotations 
The member deformations have the following meanings: 

u  Absolute total displacement (not for result combinations) 

 ux Displacement of member in direction of its longitudinal axis 

uy / uu Displacement of member in direction of local axis y or u (see page 55) 

uz / uv Displacement of member in direction of local axis z or v 

ϕx Rotation of member about its longitudinal axis 

ϕy / ϕu Rotation of member about local axis y or u 

ϕz / ϕv Rotation of member about local axis z or v 

Table 8.3: Member deformations 

To check the position of the local member axes, select Model and Members in the Display navi-
gator and activate Member Axis Systems x,y,z (see Figure 8.5, page 187). You can also use the 
member context menu shown on the left. 

Furthermore, the local member axis system has an impact on the signs of deformations. A  
positive displacement follows the direction of the positive local axis, a positive rotation acts 
clockwise about the positive member axis. 

Cross-section 
The final table column informs you about the cross-sections used in members or about the 
corresponding load cases (for result combinations). 

In the work window, deformations of members can be represented with a two- or multi-color 
display as well as in the rendering mode (see chapter 9.3, page 206). 

Moreover, member deformations can be visualized as animation of the deformation process 
(see chapter 9.8, page 221). 
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8.8 Members - Global Deformations 
To control the graphical display of member displacements and member rotations related to 
the global axes X, Y and Z, tick the check box for Global Deformations in the Results navigator. 
Table 4.8 shows the global deformations of members in numerical form. 

 
Figure 8.22: Results navigator: Global Deformations 

 
Figure 8.23: Table 4.8 Members - Global Deformations 

The table columns Node No. and Location x correspond to the columns of the previous results 
table 4.7 Members - Local Deformations. 

Displacements / rotations 
The member deformations have the following meanings: 

u  Absolute total displacement (not for result combinations) 

uX Displacement of member in direction of global axis X 

uY Displacement of member in direction of global axis Y 

uZ Displacement of member in direction of global axis Z 

ϕX Rotation of member about global axis X 

ϕY Rotation of member about global axis Y 

ϕZ Rotation of member about global axis Z 

Table 8.4: Global member deformations 
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8.9 Members - Member Coefficients for Buckling 
When you calculate member models subjected to pressure according to second-order analysis, 
the member coefficient ε is important (see chapter 7.2.1, page 170). Each member has its own 
coefficient that is determined from compressive force, member length and member stiffness. 

Members with member coefficients higher than 1 have to be analyzed, where applicable, ac-
cording to second-order analysis. Also standards of some countries such as the USA have rules 
where member coefficients must be limited. 

Table 4.9 shows the member coefficients which are governing for buckling. There is no graph-
ical output option. 

 
Figure 8.24: Table 4.9 Members - Coefficients for Buckling 

The listed member coefficients are sorted by member numbers. 

Member type 
The member types are indicated for information (see chapter 4.7, page 74). RSTAB determines 
member coefficients only for members that are able to absorb compressive forces. 

Material 
Characteristics of the material affect the member stiffness. 

Cross-section 
The cross-section's second moments of area are required to determine the member stiffnesses. 

Length L 
Table column D shows you the member lengths. 

Axial force N 
The column lists the axial forces used for determining the member coefficient. Here, the forces 
are the axial forces which are available in the member center (x = L/2). 

Member coefficients are determined only for members that have compression forces in at least 
one portion of the member (truss girder) or along the entire member (compression member, 
buckling member etc.). 

Member coefficients εy / εz 
The member coefficient depends on the member length L, the compressive force N and the 
stiffness E · I. 

IE

N
L

⋅
⋅=ε  

Equation 8.1: Member coefficient ε 
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Table columns F and G show the member coefficients referring to the local member axis sys-
tem y and z. When asymmetric cross-sections are used, columns H and I appear where also the 
member coefficients are shown in relation to the principal axes u and v. 

8.10 Member Slendernesses 
Table 4.10 shows you the slenderness ratios of members. They are significant for the evalua-
tion of the buckling behavior of members subjected to pressure. There is no graphical output 
option. 

 
Figure 8.25: Table 4.10 Member Slendernesses 

The listed member slendernesses are sorted by member numbers. 

Cross-section 
The cross-section's radii of gyration are required to determine the slendernesses. 

Length L 
The member lengths are indicated in table column B. 

Effective length factors kcr,y / kcr,z 
The buckling length coefficients describe the ratio of buckling length and member length. 

L

L
k cr

cr =   

Equation 8.2: Buckling length coefficient kcr 

The buckling length Lcr refers to the buckling behavior perpendicular to the 'strong' member 
axis y, respectively the 'weak' member axis z. If no buckling lengths have been defined manual-
ly (see chapter 4.7, page 83), the EULER buckling mode 2 is assumed: The buckling length is 
consequently equal to the member length. More accurate analyses can be performed with the 
add-on module RSBUCK or in various design modules such as STEEL EC3. 

Slendernesses λy / λz 
The slenderness ratio represents a pure geometric value. It is determined from the effective 
length factor kcr, the member length L and the radius of gyration i. 

i

Lk cr ⋅=λ   

Equation 8.3: Slenderness λ 

Table columns E and F show the slendernesses referring to the local member axis system y and 
z. When asymmetric cross-sections are used, columns G and H appear where also the slender-
ness ratios are shown in relation to the principal axes u and v. 
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9. Results Evaluation 
 

9.1 Available Results 
To open the corresponding dialog box,  

select Available Results on the Results menu. 

A dialog box with an overview about all calculated load cases and combinations appears. 

 
Figure 9.1: Dialog box Available Results - Settings 

In the list you can see which load cases, load and result combinations were calculated. Any 
reasons for problems that may have occurred during the calculation process are indicated in 
the table column Calculation Errors. To view error details, select the relevant load case and click 
the [Details] button shown on the left. 

To display a particular result in the graphic, select it in the dialog box and click the [Show] but-
ton. You can also double-click the entry. Results that are not required can be deleted by means 
of the button [X]. 

It is also possible to select load cases, load or result combinations in the load case list of the 
main toolbar or the toolbar of the results tables. Results graphic and table display are updated 
automatically if the synchronization of selection is active (see chapter 11.5.4, page 327). 
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9.2 Results Selection 
Use the Results navigator to control the display for deformations, internal forces, contact forces 
and/or support reactions. 

 
Figure 9.2: Results navigator 

You can also select results by using the Results toolbar. 

 
Figure 9.3: Buttons in the Results toolbar 

To switch the display for the results graphic on and off, use the toolbar button [Show Results] 
shown on the left. To display the result values, use the toolbar button [Show Result Values] to 
the right. 

For results of a result combination (RC) the additional entry Result Combinations is offered in 
the navigator. 

 
Figure 9.4: Results navigator for a result combination 
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You can select between three options affecting the graphical results display of deformations, 
internal and support forces: The Max-values and Min-values can be displayed separately. To 
display both envelopes from all extreme values at the same time, select Max and Min-values. 

9.3 Results Display 
The way results are represented is set in the Display navigator. 

 
Figure 9.5: Display navigator: Results 

In the Results navigator, you specify which results are displayed. The Display navigator defines 
the way how results are represented. 

The internal forces of members are displayed Two-Colored by default. Positive internal forces 
are represented by light blue lines, negative internal forces by red lines. Member deformations 
are shown as single-colored Lines by default. 

The graphical result diagram is controlled by the number entered into the input field Number 
of divisions of members for Result diagrams in the dialog tab Global Calculation Parameters of the 
Calculation Parameters dialog box (see Figure 7.14, page 176). If a division of 10 is set, RSTAB 
divides the length of the longest member in the system by 10. With the system-related division 
length RSTAB determines for each member the graphical result distributions on the division 
points. 

If the member internal forces are represented with colors using the display options With Dia-
gram and Without Diagram, colors for the graphical results are assigned according to the spec-
trum shown in the control panel. Find notes for adjusting value and color spectra in chapter 
3.4.6 on page 27. 

The internal forces can also be displayed as Cross-Sections: A photorealistic representation of 
members appears showing color-coordinated diagrams of internal forces on the rendered 
members. 
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Analogously, you can display the deformation of Cross-Sections (3D rendering of deformation) 
or Cross-Sections Colored (rendering of deformation with color gradation). 

 

Figure 9.6: Scaled imaging of member deformations in 3D rendering 

You can control the scaling of deformations and internal forces by settings in the control panel 
tab Display Factors (middle or left). The Filter tab (right) is used for a specific selection of mem-
bers whose results you want to display (see Figure 9.24, page 221). Both panel tabs are de-
scribed in chapter 3.4.6, page 29. 
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9.4 Info about Member 
RSTAB offers a special output function for member results. To open the corresponding dialog 
box, 

select Info About Member on the Tools menu 

or use the info button in the toolbar. 

 

Figure 9.7: Dialog box Info About Member 

An Info window appears. When you move the pointer across a member, the window informs 
you in addition to material and member cross-section about the deformation values or internal 
forces available on the current pointer position (location x of the member). 
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9.5 Result Diagrams 

9.5.1 Result diagram 

The result diagram makes it possible to see in detail the result distribution of members and 
sets of members. 

First, select the members or sets of members (multiple selection by holding down the [Ctrl] 
key) in the work window. Then, to access the corresponding function, 

select Result Diagrams for Selected Members on the Results menu, 

use the toolbar button shown on the left or the context menu of the corresponding member 
or set of members. 

A new window opens showing the result diagrams of the selected objects. 

 
Figure 9.8: Dialog box Result Diagram on Member 

The Results navigator on the left manages the deformations, internal forces and contact forces 
appearing in the result diagram. Use the list in the toolbar to choose a particular load case, 
load combination or result combination. 

The numbers of the selected members or sets of members are listed in the upper left corner of 
the window. It is also possible to enter member numbers manually into the input field Members 
No. In this way, you can extend, reduce or completely reorganize the selection. 

When you move the mouse along the member displayed in the result diagram, you can see 
the "moving" result values for the current x-location. The location x is related to the member 
start and is indicated in the upper right corner of the window. It is also possible to enter a spe-
cific location x manually into the input field. The check box Fixed pins the pointer to the indi-
cated location. 

In the right window section, the result values are listed numerically, representing results on 
edge nodes as well as on locations of the extreme values and division points. The latter corre-
spond to the member divisions according to specifications set in the dialog tab Global Calcula-
tion Parameters of the Calculation Parameters dialog box (see Figure 7.14, page 176). 
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The buttons in the toolbar User operations, in particular the smoothing options for internal 
forces (see chapter 9.5.2), help you to evaluate results for civil engineering purposes. 

 
Figure 9.9: Floating toolbar User operations 

The buttons have the following meanings:  

Button Function 

 Prints result diagrams 

 Removes all displayed result diagrams 

 Maximizes result diagrams 

 Minimizes result diagrams 

 Access to control parameters shown in Figure 9.10 

 Saves smoothed result diagrams 

 Opens dialog box Export table (see Figure 11.122, page 330) 

 Reverses direction x of member 

 Switches on and off ordinates with maximum values 

 Switches on and off display of average values 

 Opens dialog box for defining smooth ranges (see Figure 9.11, page 210) 

 Switches on and off display of smooth ranges 

Table 9.1: Buttons of toolbar User operations 

Use the button [Result Diagram Settings] to open a dialog box offering several options to ad-
just the Result Diagram window. 

 
Figure 9.10: Dialog box Result Diagram Settings 
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9.5.2 Smoothing Results 
In the Result Diagram dialog box, you can create smooth ranges to prepare results for civil en-
gineering purposes. To use this function, click the diagram toolbar button shown on the left. 
The following dialog box opens: 

 
Figure 9.11: Dialog box Smooth Ranges of Result Diagrams 

In the table columns on the left, define the Smooth Ranges. Please note that entries for Start, 
End and Length are interactive. Each range can be separately set to Active. In the dialog section 
Use for Results to the right, you decide for which deformations and internal forces you want to 
apply a smoothing.  

The smoothing can be defined as Constant distribution (as shown in the figure above) or as 
Linear for all smooth ranges. 
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9.6 Multiple Windows View 
On the screen, several windows showing different deformations or internal forces can be dis-
played together. To open the corresponding dialog box, 

select Arrange Results Window on the Results menu 

or use the toolbar button shown on the left. 

A dialog box with a navigator tree opens where you can tick the result types that you want to 
be displayed in the single windows. 

 
Figure 9.12: Dialog box Show Results in Multiple Windows 

The multiple windows view can also be used for the printout (see chapter 10.2.1, page 250). 
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9.7 Filter Results 
Various filter functions are available which are especially useful in case of complex structural 
systems for evaluating and documenting results. 

9.7.1 Views 
User-defined views (angles of view, zoom settings etc.) make the results evaluation easier. By 
using "visibilities" you can subdivide the model into user-defined and generated partial views 
fulfilling certain criteria. Thus, it is possible for example to activate for the display only the 
members of a particular plane or members with a particular cross-section. Of course, you can 
use these possibilities for both evaluation of results and input of model or load data. 

You can access the different functions in an independent navigator (chapter 9.7.1.1) and by 
using list buttons or menu functions (chapter 9.7.1.2). 

9.7.1.1 Views Navigator 
The Views tab of the Project Navigator allows you to create user-defined views of the model 
which you can use for input and evaluation. The tab manages also the visibilities which can be 
user-defined or automatically created. 

 
Figure 9.13: Tab Views of Project Navigator 
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User-defined views 
In contrast to object-oriented Visibilities (see below), User-defined views allow you to save and 
import particular viewing angles, zoomed views as well as settings in the Display navigator. 

The currently set view will be saved as display setting - no matter which filter specifications are 
effective in the Visibilities list: RSTAB uses always the current visibilities settings for the object 
representation of a User-defined view. A user-defined view manages only the viewing angle, 
the zoom factor and the specifications set in the Display navigator. 

Use the [View] buttons to set the following standard angles of view quickly: 

 View against axis X 

 View against axis Y 

 View against axis Z 

     
View in direction or against axis U of work plane (see chapter 11.3.1, page 275) 

     View in direction or against axis V of work plane 

     View in direction or against axis W of work plane 

Table 9.2: [View] buttons 

The buttons below the Views list are reserved for the following functions: 

 Creates a new User-defined view from current view (Figure 9.14) 

 Redefines the active User-defined view by current view 

 Restores the active User-defined view after modifications 

 Deletes the entry selected in the list User-defined views 

 Deletes all User-defined views 

Table 9.3: Buttons in the navigator section User-defined views 

Creating user-defined views 

The currently set view can be saved by using the [New] button shown on the left. A dialog box 
appears where you have to enter the Name of the new display setting. 

 
Figure 9.14: Dialog box New User-Defined View 
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Visibilities 
With the so-called "visibilities" it is possible to display partial views of the model or groups of 
objects such as members lying in one plane or columns of a particular story. 

Visibility buttons 

The buttons above the Visibilities list (see Figure 9.13, page 212) allow you to select the objects 
for representation by particular criteria. They are reserved for the following functions: 

 Displays objects selected in work window as partial view 

 Hides objects selected in work window 

 Creates a visibility by drawing a window (see page 216) 

 Defines a new visibility by means of object numbers (see page 216) 

 Restores previous visibility 

 Reverses current display (new visibility: hidden objects) 

 Quits visibility mode. All objects are displayed again. 

Table 9.4: Buttons above Visibilities list 

The Visibilities list contains user-defined and generated visibilities. 

User-defined visibilities 

With the graphical or numerical selection of objects (see chapter 11.2, page 271) you can cre-
ate a visibility. 

Use the button [Create New User-Defined Visibility] (below the Visibilities list) to save the cur-
rent partial view. The dialog box New User-Defined Visibility opens where you define a name 
and the Group (see Figure 9.18, page 217). 

The buttons below the Visibilities list are reserved for the following functions: 

 The dialog box New User-Defined Visibility appears (see Figure 9.18, page 217). 

 Adds objects selected in work window to group marked in list above (see page 217) 

 
Removes objects selected in work window from group marked in list above  
(see page 217) 

 Reassigns selected objects to group marked above 

 Reverses current display (new visibility: hidden objects) 

 Shows all objects activated in Visibilities list 

 Shows only objects available in each active Visibilities entry 

 Shows objects available in each active Group 

Table 9.5: Buttons below Visibilities list 
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With the check box Add new objects into visibility you can decide how you want to treat new 
nodes, members, supports etc. when you work in a user-defined visibility. If the option is 
ticked, you can define the relevant group in the list below. 

A color symbol is assigned automatically to each user-defined visibility. The colors can be used 
as well in the Display navigator for graphical representation of objects (see chapter 11.1.9, 
page 269). In this way, you can detect the customized visibilities quickly in the model. To set 
the display for groups, use the Views navigator. 

Generated visibilities 

RSTAB generates automatically visibilities for nodes and members according to particular  
criteria. 

 
Figure 9.15: Generated visibilities in Views navigator 

Those generated visibility types help you to have a quick overview about the model as you can 
take the list to filter objects specifically. In this way, you can easily check both input and results 
in RSTAB.  

In addition to the multiple selection of generated views (default), the list allows for creating an 
intersecting set. Use the navigator buttons shown on the left to set the intersection. You find 
them below the list. The functions are described in Table 9.5 above. 

With the check box User-defined / generated on the top of the list you can decide if the filter 
function is effective for the work window. All objects will be displayed again after removing 
the check mark. 

   



9  Results Evaluation 

 

 

216 Program RSTAB © 2013 Dlubal Engineering Software 

9.7.1.2 Visibility Buttons and Menu 

To access the different visibility functions, 

point to Visibility on the View menu 

or use the corresponding list button of the pull-down menu in the toolbar. 

 
Figure 9.16: List buttons for Visibility 

Visibility by window 
Partial views can be created graphically by using the mouse and drawing a window. 

When you open the window from the left to the right, the visibility includes only objects that 
are completely contained within the window. When opening the window from the right to the 
left, the partial view additionally includes objects that are cut by the window. 

Visibility by numbering 
Enter the numbers of Nodes or Members relevant for the partial view in a dialog box. 

 
Figure 9.17: Dialog box Visibility by Numbering 

Cancel visibility mode 
Use this function to restore the view of all objects. 
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Create a user-defined visibility 
Before you access the function, select the objects that you want to save as Visibility in the work 
window (see chapter 11.2.1, page 271 and chapter 11.2.2, page 274). The following selection 
function is useful: Point to Select on the Edit menu, and then select Special. 

Only the objects that are selected in the work window will be integrated in a Visibility. There-
fore, when you use the function [Visibility by Hiding Selected Objects], you have to select the 
displayed objects once again by drawing a window across them. 

After a click on the [New] button shown on the left the following dialog box appears. 

 
Figure 9.18: Dialog box New User-Defined Visibility 

Define the Name and Group. If you want to use more visibility groups, click the [New] button to 
create another group. 

 
Figure 9.19: Dialog box New Group for Visibilities 

Click the [OK] button to save the group of objects as new visibility. 

The user-defined visibilities are managed in the Views navigator where they can be switched 
on and off individually (see Figure 9.13, page 212). 

Change objects in visibilities 
Objects can be integrated subsequently into existing visibilities: Quit the visibility mode by 
clicking the button shown on the left. You can also point to Visibility on the View menu where 
you select Cancel Visibility Mode. Now, select the objects that you want to add. 

In the Views navigator, click the relevant entry in the User-defined list . RSTAB enables the but-
ton [+] so that you can integrate the selected objects into the user-defined visibility. 

In the same way, you can use the [-] button to remove selected objects from a user-defined vis-
ibility. 

Click the button [=] to overwrite the objects available in the marked visibility of the Views nav-
igator with the selection in the work window. Thus, existing visibilities can be redefined but 
the name is kept. 
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Transparency for hidden objects 
When you use visibilities, it is possible to display hidden objects with minor intensity in the 
background. The degree of visibility is set individually in the Graphics tab of the dialog box 
Program Options (see Figure 9.25, page 222). 

The display of background objects can be turned on and off in the Display navigator. 

 
Figure 9.20: Display navigator: Option General → Show Hidden Objects in Background 

9.7.2 Clipping Plane 
You can define any section plane cutting through the model. The zone in front of (or behind) 
the plane will be hidden in the display. In this way, it is possible to represent for example the 
results of a closed or curved model more clearly. 

RSTAB places the clipping plane through the center of the geometric total dimensions. Thus, 
the plane is related to the model geometry. In the work window, the clipping plane is enclosed 
by a frame. 

To access the corresponding function, 

select Clipping Plane on the Insert menu. 

The following dialog box appears: 

 
Figure 9.21: Dialog box Clipping Plane 
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You can arrange the Plane parallel to one of the planes spanned by the axes of the global co-
ordinate system XYZ. In addition, you can place the plane into the current work plane. You can 
also select three points in the work window by clicking the [] button shown on the left. 

The value entered into the input field Offset results in a parallel displacement of the plane in 
direction of the positive or negative axis that is perpendicular to the plane. Both directions are 
indicated by gray arrows in the work window. The offset can be entered directly or set with the 
spin box. The input field Step controls the interval of spacings by which the plane is shifted 
every time you click a button of the spin box. 

In the dialog section Options, you have the possibility to change the active side of the clipping 
plane. Moreover, you can switch on and off the result diagrams available on the clipping bor-
ders. 

Furthermore, it is possible to rotate the clipping plane by a Rotation about the angle α (about 
the last named axis of the plane) and angle β (about the first named axis). The graphic is inter-
active with the input. 

When the dialog box Clipping Plane is open, you can use all edit and view functions in the work 
window, but there are no options for storage and printing. Quit the function with the [Close] 
button. 

The following example shows a clipping plane cutting through a container construction. 

 
Figure 9.22: Clipping plane cutting through a container 
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Settings in Display navigator for 
multi-color member results 

9.7.3 Filter Functions 
The grouping options described in chapter 9.7.1 Views refer to the objects of the model. Addi-
tionally, you can use internal forces and deformations as filter criteria.  

Filtering results 
Results are filtered by means of the control panel. If the panel is not displayed, 

select Control Panel (Color Scale, Factors, Filter) on the View menu 

or use the toolbar button shown on the left. 

The control panel is described in chapter 3.4.6 on page 27. 

The filter settings for results must be defined in the panel tab Color Spectrum. As the tab is not 
available for the two-colored display of member internal forces, you have to switch to the Dis-
play navigator and set the display options With/Without Diagram or Cross-Sections (see figure 
shown on the left). 

You can set specific displays in the panel, for example compressive forces displayed only if 
they exceed a particular value, or bending moments within the range of ± 30 kNm using a fine 
gradation (see Figure 3.19, page 29). 

In the following example of a hall, only compression forces between -160 kN and -320 kN are 
displayed on the model. 

 
Figure 9.23: Filtering axial forces with adjusted color spectrum 

The color spectrum has been modified in such a way that a color range covers exactly 20 kN. 
RSTAB does not show any results for members whose internal forces are beyond the defined 
range of values. 

To represent the hidden diagrams of internal forces with dotted lines, go to the Display naviga-
tor and select Results → Members → Display Hidden Result Diagram. 
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Filtering objects 
In the Filter tab of the control panel, you can enter the numbers of selected members to show 
their result diagrams in a filtered display. The function is described in chapter 3.4.6 on page 30. 

In contrast to the visibility function, the model is displayed completely in the graphic. 

The following figure shows the bending moments available in the horizontal beams of a tim-
ber hall. The columns are shown in the model but displayed without internal forces. 

 

Figure 9.24: Filtering members: moments of horizontal beams 

The filter settings of the panel also affect the objects in the results tables: When you restrict the 
results display in the panel for example to two members, table 4.1 Members - Internal Forces 
will also list only the results of those two members. 

9.8 Animation of Deformations 
Normally, deformations of objects are displayed in their final state. 

But it is also possible to show the deformation process as a motion. To open the correspond-
ing dialog box, 

select Animation on the Results menu 

or use the toolbar button shown on the left. To close the animated view, click the button 
again. You can also use the [Esc] key. 

To define detailed settings for the animation process, use the Program Options dialog box. 

Select Program Options on the Options menu, 

and then open the dialog tab Graphics. 
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Figure 9.25: Dialog box Program Options, tab Graphics 

The animation of deformations can be saved as video file. Set the animated graphic appropri-
ately on the screen, and then select 

Create Video File on the Tools menu. 

You may see a message about OpenGL settings before the corresponding dialog box appears 
where you can define different settings for creating the video file. 

 
Figure 9.26: Dialog box Create Video File 

Click the [Browse] button to define the name of the video file in a separate dialog box. 

The red button [Record] starts the recording, and the blue button [Stop] stops it. 
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10.  Printout 
 

10.1 Printout Report 
Normally, input and results data of RSTAB are not sent directly to the printer. Instead, a so-
called printout report is generated first to which you can add graphics, explanations, scans and 
other elements. In the printout report you define the data that will finally appear in the print-
out. 

It is possible to create several printout reports for the model. When your structure is quite 
complex, it is recommended to split data into several small reports instead of creating a single 
report that is rather comprehensive. For example, you can create a report for input data, an-
other one for support forces and one for member and cross-section results. In this way, you 
can reduce time of waiting. 

It is also possible to create different printout reports in one RSTAB model. Depending on the 
required data, the test engineer and the design engineer may receive different printout re-
ports. 

A printout report can only be called up if a default printer has been installed in Windows. The 
preview in the printout report uses the printer driver. 

10.1.1 Create or Open Printout Report 
To create a new printout report 

select Open Printout Report on the File menu 

or use the toolbar button shown on the left. You can also use the context menu of the corre-
sponding entry in the Data navigator. 

 
Figure 10.1: Button and context menu of Printout Report 

The following dialog box appears: 

 
Figure 10.2: Dialog box New Printout Report 
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The No. of the report is preset but can be changed. In the input field Description, you can enter 
a name for the report making the selection in the lists easier later. This description does not 
show up in the printout. 

Furthermore, you can select a particular report template from the list in the dialog section 
Printout Report Template (see chapter 10.1.7, page 240). 

The buttons in the dialog box are reserved for the following functions: 

 
Creates a new report template 

 
Edits selection of report ( chapter 10.1.3, page 227). 

Table 10.1: Buttons in the dialog box New Printout Report 

When a printout report is already available, and you select Open Printout Report on the File 
menu, the Printout Report Manager appears. 

 
Figure 10.3: Dialog box Printout Report Manager 

You can select the relevant report from the list. 

The buttons in the dialog box are reserved for the following functions: 

 
Creates a new printout report 

 
Deletes selected printout report 

Table 10.2: Buttons in the dialog box Printout Report Manager 
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10.1.2 Working in the Printout Report 

 
Figure 10.4: Printout report with context menu 

When the printout report is open, you see the report navigator on the left. On the right, the 
page view with the preview of the printout is presented. 

The individual chapters of the report can be shifted anywhere in the navigator by using the 
drag-and-drop function. 

Context menu 
The context menu offers more options for adjusting the printout report. As common for Win-
dows applications, multiple selections are possible by using the [Ctrl] and [] keys. 

Remove from printout report 

The selected chapter will be deleted. If you want to reinsert it, use the selection: Click Selection 
on the Edit menu to open a dialog box where you can choose data for display in the printout 
report. 

Start with new page 

The selected chapter starts on a new page. It is marked by a red pin in the navigator (like chap-
ter Results - Summary shown in the figure above). 

Selection 

You have access to the global selection that is described on the following pages. The selected 
chapter is preset. 

Properties 

Some general properties of the selected chapter can be modified. 
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Figure 10.5: Dialog box Properties 

It is possible to change the Title of the chapter and to enter an Additional Explanation which 
will appear in the left margin of the report. The additional text can be enabled and disabled for 
display like the info pictures of the chapter (for example drawings of cross-sections or loading).  

Navigation in the printout report 
To look at a particular section in the printout report, click the corresponding chapter entry in 
the navigator. 

The View menu provides further functions for navigation. You can also use the buttons in the 
report toolbar to access the corresponding function. 

 Go to previous page in the page preview. 

 Go to next page 

 Go to first page in the page preview 

 Go to last page 

 Specify the number of a particular page in a dialog box. 

 Zoom in 

 Zoom out 

 List button for Zoom to adjust display size 

 Grab mode: Use the mouse for navigation within the report. 

 Select mode: Select and edit chapters by mouse click. 

Table 10.3: Navigation buttons in the toolbar of the printout report 
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10.1.3 Define Contents of Printout Report 
In the global selection, you can select the chapters that you want to appear in the printout re-
port. To open the corresponding dialog box, 

select Selection on the Edit menu, 

or use the toolbar button shown on the left. You can also use the context menu of the Printout 
Report navigator item. 

 
Figure 10.6: Open the global selection via the Printout Report context menu 

The following dialog box appears: 

 
Figure 10.7: Dialog box Printout Report Selection, tab Global Selection 

The list in the dialog section Program / Modules contains all add-on modules where input data 
is available. When a program is selected in the list, you can choose the chapters to be printed 
in the tabs to the right. 

The Global Selection tab manages the main chapters of the report. If you clear a check box, the 
corresponding detail tab disappears. 

Use the three check boxes in the dialog section Display (bottom left) to decide if a Cover sheet, 
a table of Contents and small Info pictures will be displayed in the report margin. 
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10.1.3.1 Selecting Model Data 

 
Figure 10.8: Dialog box Printout Report Selection, tab Model Data 

With the check boxes in the Display column you decide which chapters appear in the printout 
report. 

For some tables you find subchapters. When you click for example into the table field 1.3 Cross-
Sections, the button [...] is enabled and you can open another dialog box where it is possible to 
select sections for which also cross-section details will be shown. To define the types and 
amount of details, use the [Details] button shown on the left. 

 
Figure 10.9: Dialog box Printout Report Selection - Cross-Section Details 
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The printout report is based on the input tables described in chapter 4. With the check boxes 
in the third column All you decide if all rows of the selected table will be included in the print-
out. When a check box is cleared, you can specify the numbers of selected objects (table rows) 
in the column Number Selection. 

Again, it is recommended to use the button [...] becoming available at the end of the input 
field because in this way you can select nodes, members and sets of members graphically in 
the work window. For the remaining objects a list with table rows appears. 

10.1.3.2 Selecting Load Case and Combination Data 

 
Figure 10.10: Dialog box Printout Report Selection, tab Load Cases and Combinations 

With this dialog tab you decide which information about load cases and combinations appear 
in the printout report. Data is selected as described in the previous chapter. Use the [...] buttons 
to access the individual subtables. 
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10.1.3.3 Selecting Load Data 

 
Figure 10.11: Dialog box Printout Report Selection, tab Loads 

Tables are selected as described in chapter 10.1.3.1. 

Additional selection options are available in this tab: In the dialog section Load Cases to Display, 
you can decide whether the input data of All or only of particular load cases will appear in the 
printout. When the selection field Selected is activated, you can use the enabled [Details] button 
to open a new dialog box where you can select the load cases. 

 
Figure 10.12: Selection of load cases 
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10.1.3.4 Selecting Results Data  

 
Figure 10.13: Dialog box Printout Report Selection, tab LC/CO Results 

Selecting results data which is usually comprehensive is done in two dialog tabs: The tab 
LC/CO Results manages the selection for load cases and load combinations, the tab RC Results 
controls the printout for the results of result combinations as well as the results of super com-
binations. 

Results data can be prepared like load data (see previous chapter 10.1.3.3): Use the selection 
field Selected to restrict the printout data to results of particular load cases or combinations. In 
the dialog section Tables to Display, you can select the tables and table rows as described in 
chapter 10.1.3.1. The column Number Selection allows you to specify particular objects or to se-
lect objects graphically by means of the button [...] that you can access at the end of the table 
row. 

In the Table column, you see some table rows showing three dots at the end of the row. The 
dots indicate the button [...] that you can activate by clicking into the table row.  Use this but-
ton to access more selection criteria, for example for member internal forces. 

 
Figure 10.14: Dialog box Details - Internal Forces by Member 

 

  
 

 



10  Printout 

 

 

232 Program RSTAB © 2013 Dlubal Engineering Software 

 

The printout report lists the results of each member on the following locations: 

• Start and end node 

• Division points according to defined member division (see chapter 4.6, page 72) 

• Extreme values (Max/Min) of results (see chapter 8.1, page 188) 

The selection is connected with the Table Filter settings (see Figure 11.118, page 328). 

You can considerably reduce the printout extent by restricting output data to results that are 
indispensable for your documentation. 

10.1.3.5 Selecting Data of Add-on Modules 
The data of all add-on modules is also managed for printing in the RSTAB printout report. You 
can summarize data of modules together with the RSTAB data in a single report, or you organ-
ize it in separate reports. For complex structural systems with many design cases, it is recom-
mended to split data into several printout reports which makes data arrangement clearer. 

 

Figure 10.15: Dialog box Printout Report Selection, tab Global Selection of add-on module STEEL EC3 

In addition to RSTAB, the list in the dialog section Program / Modules contains all add-on mod-
ules where entries have been made. When you select a module in the list, you can choose the 
chapters for printing in the tabs to the right. 

The dialog tab Global Selection manages the main chapters of the add-on module data. When 
you clear a check box, the respective detail tab disappears as well. 

In the dialog section Cases to Display, the option Display all cases is ticked by default. If you 
want to include only particular design cases in the printout report, clear the check box. Now, 
you can move the cases that you do not need from the list Cases to display to the list Existing 
cases. 

The selection in the detail tabs of input data and results is similar to the selection described in 
chapters 10.1.3.1 Selecting Model Data and 10.1.3.4 Selecting Results Data . 
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10.1.4 Adjust Printout Report Header 
During the program installation a printout report header is created from the customer data. To 
change specifications, 

select Header on the Settings menu in the printout report 

or use the toolbar button in the printout report shown on the left. 

 

Figure 10.16: Button Header Setup 

The following dialog box appears: 

 
Figure 10.17: Dialog box Printout Report Header 
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Header default setting 
In case several report headers are available, you can select the appropriate header in the list. 

Furthermore, you can use the button [Header Library] to access different report headers. In 
addition, you can create, modify or delete headers in the library. 

 
Figure 10.18: Dialog box Header Library 

The buttons in the Header Library have the following meanings:  

 
A new header is created. Enter the specifications in another dialog box whose struc-
ture is similar to the one of the Header dialog box (see Figure 10.17). 

 
It is possible to edit the properties of the selected printout report header. 

 
The header that is selected in the list will be deleted. 

Table 10.4: Buttons of the dialog box Header Library 

The headers of the printout report are normally stored in the file DlubalProtocolConfig.cfg 
that you find in the general master data folder C:\ProgramData\Dlubal\Stammdat. The file 
won’t be overwritten during an update. Nevertheless, saving a backup file may be useful. 

Display 
Settings in this dialog section determine the header elements or the page layout shown. 

The option Info row below header activates and deactivates the display of project and model 
data, with or without date (see below). The project description is taken from the project's gen-
eral data filed in the Project Manager (see chapter 12.1.1, page 378). The model description is 
taken from the base data of the model (see chapter 12.2, page 386). The default settings can 
be adjusted for the printout in the dialog sections Change Project Name/Description and Change 
Model Name/Description (see below). 

The Footer can be switched on and off as well as the Black circles in the points of intersection of 
boundary line with header and footer line. 

Date 
RSTAB provides automatic default settings and a User-defined specification option for display-
ing the date in the printout report header. 

Page and sheet numbering 
If Page and Sheet have the same initial numbers and the Display check boxes are ticked, there 
is no difference in numbering. But if you want to assign several pages to a sheet, it is possible 
to enter detailed specifications for the numbering by means of the [Settings] button shown on 
the left. 
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Figure 10.19: Dialog box Page and Sheet Numbering 

Use this dialog box to decide if a Prefix is applied in front of the Page Numbering. The prefix 
may be an abbreviation that is defined by chapter, indicating for example all model data in the 
numbering by a prefixed "MO". In addition, you can decide if the End number is included, for 
example "Page: MO2/446". 

Use the two check boxes Automatically increasing in the dialog sections to the right to define a 
continuous numbering. Moreover, you can specify the First number for the page and sheet 
numbering. The table column Result shows the result of all specifications dynamically. 

Company address 
This dialog section of the dialog box Printout Report Header contains information from custom-
er data that can be adjusted. A separate input field is available for each of the three rows of the 
report header. Use the [A] button shown on the left to change font and font size. The Align-
ment of rows can also be defined separately. 

The left zone in the header is reserved for the company logo. The image must be available in a 
bitmap file format (MS Paint for example saves graphics as *.bmp). 

To save the modified settings, click the button [Set Header as default] at the bottom of the dia-
log box. The dialog box Header Template Name opens where you have to enter a description. 
Then, the new report header will appear as Header Default on the top of the printout. 

 
Figure 10.20: Dialog box Header Template Name 

Project name/model name/description 
In both dialog sections, the project and the model name including user-defined descriptions 
are preset. To modify the presettings, tick the check boxes in front of the relevant name. In this 
way, the input fields become accessible for new entries that appear in the printout later. 
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10.1.5 Insert RSTAB Graphics 
Every picture displayed in the work window can be integrated into the printout report. Fur-
thermore, it is possible to include result diagrams of members and sets of members as well as 
cross-section details in the report by using the [Print] button in the respective dialog boxes. 

To print the currently displayed graphic,  

select Print Graphic on the File menu 

or use the toolbar button shown on the left. 

 
Figure 10.21: Button Print Graphic in the toolbar of the work window 

 
Figure 10.22: Button Print in the toolbar of the Result Diagram window 

The following dialog box appears: 

 
Figure 10.23: Dialog box Graphic Printout, tab General 

In the dialog section Graphic Picture, select the option To a printout report. If several printout 
reports are available, you can select the number of the target report in the list to the right. 

Options 
Standard of RSTAB is the generation of dynamic graphics: When model or results are modified, 
the graphics in the printout report will be updated automatically. If problems of performance 
occur in the report because of the graphics, you can stop the dynamic adjustment by ticking 
the check box for Lock graphic picture (without update) in the dialog section Options. 
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Of course, it is possible to unlock a graphic in the printout report: Right-click the graphic item 
in the report navigator to open its context menu (see Figure 10.4, page 225). Select Properties 
to access again the dialog box Graphic Printout for the picture. You can also mark the graphic 
in the report navigator and select Chapter Properties on the Edit menu. 

The lock buttons in the toolbar of the printout report provide more functions to classify 
graphics as static or dynamic (see Figure 10.4, page 225). They are reserved for the following 
functions: 

 
Refreshes all graphics 

 
Unlocks all graphics which can then be updated dynamically 

 
Locks all graphics which are then fixed in the printout report 

Table 10.5: Graphic buttons in the printout report 

OK 
The [OK] button of the dialog box is a list button. 

 
Figure 10.24: List button [OK] 

With the default setting Open the Printout Report RSTAB opens the printout report and shows 
you the integrated graphic after clicking [OK]. This may be annoying, for example when you 
want to take several graphics one after the other to the printout report. The option Print with-
out opening Printout Report allows you to print pictures without waiting time when creating 
the printout report. 

The remaining functions and tabs of the dialog box Graphic Printout are explained in chapter 
10.2 on page 248. 
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10.1.6 Insert Graphics and Texts 
External graphics and texts can be integrated as well into the printout report of RSTAB. 

Graphics 
To insert a picture that is not an RSTAB graphic, you need to open the graphic file in an image 
editor first (for example MS Paint). Then, copy it to the clipboard with the keyboard keys 
[Ctrl]+[C]. 

To insert the graphic from the clipboard into the printout report, 

select Image from Clipboard on the Insert menu. 

You have to enter a chapter name for the new graphic before it is inserted. 

 
Figure 10.25: Dialog box Insert image from the Clipboard 

The graphic will appear as a single chapter in the printout report. 

Texts 
Short user-defined notes can also be added to the printout report. To open the corresponding 
dialog box, 

select Text Block on the Insert menu. 

 
Figure 10.26: Dialog box Import Text 

Enter the Title and the Text in the dialog box. After clicking [OK] the chapter will be inserted at 
the end of the printout report. Then, you can use the drag-and-drop function to move the 
chapter to an appropriate place in the printout report. 

In the selection mode (see Table 10.3, page 226) you can modify the text subsequently by dou-
ble-click. Alternatively, right-click the header in the report navigator, and then select Properties 
in the context menu. 
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Text and RTF files 
It is possible to integrate text files available in ASCII format as well as formatted RTF files in-
cluding embedded graphics into the printout report. Thus, you can save recurring texts in files 
to use them in the report. 

Moreover, this function allows you to integrate analysis data from other design programs into 
the printout report, provided that the results are available in ASCII or RTF format. 

To insert text and RTF files, 

select Text File on the Insert menu. 

First, the Windows dialog box Open appears where you can select the file. After clicking the 
[Open] button, the chapter will be added to the end of the printout report. Then, you can use 
the drag-and-drop function to move the chapter to an appropriate place in the printout re-
port. 

In the selection mode (see Table 10.3, page 226) you can modify the text subsequently by 
right-click. The dialog box Import Text appears for user-defined adjustments. 

 
Figure 10.27: Dialog box Import Text 
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10.1.7 Printout Report Template 
The selection described in chapter 10.1.3 is rather time-consuming. It is possible to save such a 
selection including graphics as template which you can use also for other models. Creating 
printout reports becomes more efficient on the basis of templates. 

An existing printout report can be saved as template, too. 

Create a new template 
To define a new template, 

point to Printout Report Template on the Settings menu of the printout report,  
and then select New or 

point to Printout Report Template on the Settings menu of the printout report,  
and then select New from Current Printout Report. 

New 

First, the selection dialog box described in chapter 10.1.3 on page 227 opens. 

Use the tabs to select the chapters that you want to print. When the selection is complete, click 
[OK] and enter a Description for the new report template. 

 
Figure 10.28: Dialog box New Printout Report Template 

New from current printout report 

The selection of the currently shown printout report is used for the new template. Enter the 
Description of the new report template in the dialog box (see Figure 10.28). 

Apply a template 
When a printout report is already open, you can apply the selected contents of a template to 
the current report. To open the corresponding dialog box, 

point to Printout Report Template on the Settings menu, and then click Select. 

A dialog box opens where you can select the template from the list Available Printout Report 
Templates. 

 
Figure 10.29: Dialog box Printout Report Template 

Details to the buttons in this dialog box can be found in Table 10.6. 
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After confirming the dialog box and the subsequent security query, the current selection will 
be overwritten by the template. 

Now, when you create a new printout report, you can select a template from the list Printout 
Report Template to apply specific settings to the new report. 

 
Figure 10.30: Dialog box New Printout Report with list of templates 

Managing templates 
All templates are managed in the dialog box Printout Report Template. To open the dialog box, 

select Printout Report Template on the Settings menu, and then click Select. 

The dialog box shown in Figure 10.29 appears. The functions of the buttons are enabled only 
for user-defined templates. 

 The name of the selected template can be changed. 

 The selected template will be deleted. 

Table 10.6: Buttons in the dialog box Printout Report Template 

The printout report templates are stored in the file RSTABProtocolConfig.cfg that can be 
found in the master data folder for RSTAB 8 C:\ ProgramData\Dlubal\RSTAB 8.01\General Data. 
The file won’t be overwritten during an update. Nevertheless, saving a backup file may be use-
ful. 

10.1.8 Adjust Layout 
The layout of a printout report can be adjusted concerning its fonts and font colors, margin 
settings and table design. 

To open the dialog box where you can edit the page layout, 

select Cover on the Settings menu in the printout report or 

use the toolbar button in the printout report shown on the left. 

 
Figure 10.31: Dialog box Page Setup 
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The default fonts for table contents and table headers are relatively small. However, you should 
be careful with changing the default settings Arial 5, 6 or 8: Larger fonts do not always fit in the 
columns. 

The layout settings also apply to the printout reports of the RSTAB add-on modules. 

10.1.9 Create Cover 
The printout report can be provided with a cover sheet. To open the dialog box where you can 
enter the cover data, 

select Cover on the Settings menu in the printout report or 

use the toolbar button in the printout report shown on the left. 

 
Figure 10.32: Dialog box Cover Sheet 

When the input is complete, click [OK] to create the cover in the report. 

 

 



10  Printout 

 243 Program RSTAB © 2013 Dlubal Engineering Software 

 

 

Figure 10.33: Cover sheet in the printout report 

The contents of the cover sheet can be modified once again by a double-click in the selection 
mode (see Table 10.3, page 226). Alternatively, right-click the cover sheet in the report naviga-
tor and select Properties in the context menu. 
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10.1.10 Print the Printout Report 
To start the printing process, 

select Print on the File menu 

or use the button in the printout report toolbar shown on the left. 

 
Figure 10.34: Button Print Printout Report 

The dialog box for the printer set by default in Windows opens. Select the printer and deter-
mine the pages that you want to print. 

 
Figure 10.35: Dialog box Print 

If you choose another printer than the default printer, the page break and therefore the page 
numbers printed on the paper might be different from the print preview in RSTAB. 

When you select the option Print to file, you can create a print file in PRN format that can be 
sent to the printer via the copy command. 

10.1.11 Export Printout Report 
The printout report can be exported in different file formats. It is also possible to export it di-
rectly to VCmaster. 

RTF export 
All common word processing programs support the RTF file format. To export the printout re-
port including graphics as RTF document, 

select Export to RTF on the File menu. 

The Windows dialog box Save As opens. 

 



10  Printout 

 245 Program RSTAB © 2013 Dlubal Engineering Software 

 

 

 
Figure 10.36: Dialog box Save As 

Enter the storage location and the file name. If you tick the check box for Export selected blocks 
only, only the chapter(s) previously selected in the navigator will be exported instead of the 
entire report. 

PDF export 
The PDF print device integrated in RSTAB makes it possible to put out report data in a PDF file. 
To open the corresponding dialog box, 

select Export to PDF on the File menu. 

The Windows dialog box Save As opens (see Figure 10.36) where you enter the storage loca-
tion and the file name. In the dialog section Description below, you can enter notes for the PDF 
file. 

Moreover, the PDF file is created with bookmarks facilitating the navigation in the digital doc-
ument.  

VCmaster export 
VCmaster from the VEIT CHRISTOPH company (formerly BauText) is a word processing program 
with specific extras for structural calculations. 

To start the direct export to VCmaster, 

select Export to RTF on the File menu 

or use the button [Export to VC-Master] in the printout report toolbar shown on the left. 

The dialog box shown in Figure 10.36 appears where you have to tick the check box for Direct 
Export to Program VC-Master. 

It is not necessary to enter a file name, but VC-Master should run in the background. To start 
the import module of VC-Master, click [OK]. 
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10.1.12 Language Settings 
The language in the printout report can be set independently of the language used in the 
graphical user interface of RSTAB. Thus, you can create for example a German or Italian print-
out report though you are working with the English program version. 

Changing the language for printout 
To change the language used in the printout report, 

select Language on the Settings menu of the printout report. 

A dialog box opens where you can select the report language from the list. 

 
Figure 10.37: Dialog box Languages 

Adding a language to the list 
The expressions used in the printout report are stored in strings. Thus, adding new languages 
is rather easy. 

First, open the dialog box Languages by 

selecting Language on the Settings menu of the printout report. 

In the lower part of the dialog box (Figure 10.37), you see some buttons used to manage the 
languages. 

Create a new language 

Click the button shown on the left to open the dialog box below. Specify the Name of the new 
language and select the Language group from the list so that the character set will be inter-
preted correctly. 

 
Figure 10.38: Dialog box Create New Language 
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Click [OK] to confirm the dialog box. The new language is now available in the list Existing  
Languages. 

 
Figure 10.39: Dialog box Languages, button Edit Selected Language 

Use the [Edit] button to enter the strings of the new language. 

 
Figure 10.40: Dialog box Edit Printout Report Texts 

Only user-defined languages can be edited. 
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Copy a language 

 
Figure 10.41: Dialog box Languages, button Create New Language via Copy 

This function is similar to the creation of a new language. The difference is that you do not cre-
ate an "empty" language column (see Figure 10.40, column Swedish) since the terms of the se-
lected language are already preset. 

Rename or delete a language 

Use the remaining buttons of the Languages dialog box to rename or delete a language. The 
two functions cannot be accessed for the preset default languages but only for user-defined 
languages. 

10.2 Direct Graphic Printout 
Each graphic of the work window can be printed immediately without embedding in the print-
out report (see chapter 10.1.5, page 236). Result diagrams of members and sets of members as 
well as cross-section details can also be sent directly to the printer by using the [Print] button 
offered in the respective windows. 

To print the currently displayed graphic directly, 

select Print Graphic on the File menu 

or use the respective button in the toolbar. 

 
Figure 10.42: Button Print Graphic in the toolbar of the main window 

 
Figure 10.43: Button Print in the toolbar of the Result Diagram window 

A dialog box with several tabs appears which are described in the following chapters. 
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10.2.1 General 

 
Figure 10.44: Dialog box Graphic Printout, tab General 

Graphic picture 
You have three options for graphical output: You can send the picture 

• directly to a printer 

• to a printout report (see chapter 10.1.5, page 236) 

• to the clipboard. 

The Clipboard makes the graphic available to other programs where it can usually be imported 
by selecting Insert on the Edit menu. 

The option Directly to a printer results in the direct printout. It is possible to adjust the printout 
report header directly by using the button [Edit Printout Header] that opens the dialog box 
Printout Report Header (see chapter 10.1.4, page 233). 

Window to print 
The dialog section Window To Print is used for defining the printout settings of multiple win-
dows views. Select Current only to print the graphic of the window that is currently active (for 
example the right window in Figure 10.45). 

Please note when printing several graphic windows (see chapter 9.6, page 211) that you can 
only print graphics of one and the same model. A cross-model printout is not possible. 
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Figure 10.45: Display with two windows of same model 

Select More to enable the button [Edit Window Arrangement] that opens a dialog box with 
control options for the print arrangement of graphics. 

 
Figure 10.46: Dialog box Window Arrangement 

Select As on Current Screen to arrange the windows on the printout sheet according to the 
proportions displayed on the screen. Then, the overall picture on the page will usually be  
wider than high − as it is presented on the screen. Select Page Filling to use the entire sheet 
size for the display of the windows. 

With the Mass print option you can transfer default graphics simultaneously to the printout  
report. When the option is selected, three additional tabs become available where you can  
define the parameters (see chapter 10.2.4, page 255). 

Graphic size 
The dialog section in the upper right corner of the dialog box Graphic Printout (Figure 10.44) 
manages the image scale of the graphic on the sheet.  

If you want to use the same image size as displayed on the monitor, select As screen view. Take 
advantage of this option to print zoomed areas or special views. 
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The option Window filling prints the overall graphic on the sheet. The currently set angle of 
view is used to represent the whole model in the specified graphic picture size (see next dialog 
section). 

With the option To scale the graphic will be printed with the scale that is selected in the list or 
entered manually into the input field. Again, the currently set angle of view is used. A perspec-
tive view is not suitable for the scale printout. 

Graphic picture size and rotation 
Settings in this dialog section define the size of the graphic on the sheet. 

If the check box for Use whole page width is ticked, the left margin beyond the vertical separa-
tion line is additionally used for the graphic as shown in the figure below. 

 

Figure 10.47: Graphic printout in landscape format: result of options All windows and Use whole page width 

If you don't want to use the complete page size for the graphic, you can define the Height of 
the graphic area in percentage. 

The rotation angle in the input field Rotation rotates the graphic for the printout. 

Options 
This dialog section is irrelevant for the direct printout of a work window graphic. 

When printing result diagrams, you can use the check box for Show results for selected x-location 
in result diagram to decide if values appearing on the position of the vertical line will be printed 
(see Figure 9.8, page 208). 

Header of graphic picture 
When you open the dialog box Graphic Printout, a title is preset for the graphic. It can be modi-
fied in the input field. 
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10.2.2 Options 

 
Figure 10.48: Dialog box Graphic Printout, tab Options 

Script / Symbols 
In most cases, it is not necessary to change the default settings in both dialog sections. How-
ever, for printing with plotters using large formats, it may be required to adjust the factors. 

The size of font and graphic symbols (nodes, supports, members etc.) depends on the printer 
driver. If you are not satisfied with the printed results, scaling factors can be defined separately 
for Script and Symbols. 

Frame 
The graphic can be printed with or without frame around the graphic. 

Furthermore, you have the option to add a title box to the printout. Click the button [Edit Title 
Box Settings] shown on the left to open the following dialog box where layout and contents of 
the title box can be defined. The lower part of the dialog box shows a preview. 
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Figure 10.49: Dialog box Title Box Settings 

Print quality 
In most cases, it is not necessary to change the default settings in the dialog section Print Qual-
ity (Figure 10.48). Select Standard to print the graphic as a bitmap file in a size of maximum 
1000 x 1000 pixels. The Maximum size of up to 5000 x 5000 pixels together with a 32-bit color 
depth results in a data amount of about 100 MB. As this may cause problems for some printer 
drivers, be careful to select such a high resolution. 

Color 
When you direct the printing to a monochrome printer, you can print Texts and lines in black 
instead of gray scales to improve readability. Please note that some elements such as isobands 
and support symbols are not affected by the setting and therefore appear colored in the print-
out. 

The conversion from colored result diagrams to gray scales is always done by the printer driv-
er. Corresponding setting options do not exist in RSTAB. 
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10.2.3 Color Spectrum 

 
Figure 10.50: Dialog box Graphic Printout, tab Color Spectrum 

The tab is only available when results are shown in a multicolor display (see chapter 9.3, page 
205). 

Position 
The color spectrum of the control panel is usually printed into the printout. If you don't want 
to print it, tick the check box for No color spectrum. 

When the panel lies In the graphic picture, the color spectrum overlaps a part of the picture. It 
is possible to specify the position of the panel: You can define it either for one of the four cor-
ners or as User-defined arrangement. 

The option Out of graphic picture cuts off a strip of the graphic window and uses it only for the 
color spectrum. You can define the Spectrum width in the lower part of the dialog box. 

Size 
The size of the color spectrum can be defined either in absolute dimensions or relatively to the 
picture size. 

Options 
The color-value assignment in the work window can be user-defined (see chapter 3.4.6, page 
28). 

You can determine whether the default color spectrum referring to the extreme values 
(max/min) or the user-defined color spectrum is used for the printout.  
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10.2.4 Mass Print 
The button [Mass Print Settings] is enabled when the option Mass print has been selected in 
the General tab. Use mass print settings to decide which default graphics of the model, loads 
and results are integrated automatically into the printout report. 

 
Figure 10.51: Dialog box Mass Print, tab Mass Print - Model 

Seven different default Views are available for selection. Furthermore, you can activate a 3D 
Perspective for the model display. 

 
Figure 10.52: Dialog box Mass Print, tab Mass Print - Loads 

In the Loads dialog section, decide if automatic load graphics are created. Then, in the dialog 
section Load Cases / Combinations, specify the relevant load cases. Use the [Select] button 
shown on the left to define Selected load cases in the dialog box Load Cases / Load Combina-
tions (see Figure 10.54, page 256). 
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Finally, in the dialog section Views, decide which angles of view are used for the default 
graphics. 

 
Figure 10.53: Dialog box Mass Print, tab Mass Print - Results 

In the dialog section Results, you can select the relevant deformations and internal forces in 
the tree structure by ticking the check boxes. 

With the settings in the dialog sections Loading and Load Cases / Combinations, you decide if 
graphics are created with or without load representations and which load cases are relevant 
for the printing. Click the [Select] button shown on the left to define Selected load cases in a 
separate dialog box. 

 
Figure 10.54: Dialog box Load Cases / Load Combinations 

The graphics' angle of view is defined in the dialog section Views. 
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11.  Tools 
In the following, you find descriptions of functions for graphical and table input such as CAD 
tools for designing or generating model and load objects, edit options, operations in spread-
sheets or parameterized input. 

11.1 General Functions 
This chapter describes program functions which are generally useful or provided in many dia-
log boxes of RSTAB. 

11.1.1 Language Settings 
The language that has already been selected for installation is preset. Materials and cross-
section tables in the libraries have also been set up by country-specific arrangements. 

To change the graphical user interface of RSTAB, 

select Program Options on the Options menu 

or use the toolbar button shown on the left. 

In the dialog tab Program, you can select another Program Language in the list. 

 
Figure 11.1: Changing the Program Language in the dialog box Program Options 

The changed language settings will be effective after restarting the program. 

When you change the language, please note the following: 

• Some characters are only displayed correctly if the corresponding fonts are available in 
the operating system. 

• The new language affects the arrangement of cross-section tables in the libraries. 
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11.1.2 Display Properties 
The display properties determine the way how a graphical object is represented on the screen 
and in the printout. The Display navigator is the place to decide whether an object is repre-
sented or not (see chapter 3.4.3, page 22). 

Adjust the display 
To open the dialog box for adjusting the graphical display, 

point to Display Properties on the Options menu, and then select Edit 

or use the Configuration Manager (see chapter 3.4.10, page 34). 

It is also possible to access the display properties of each graphical object (model, load or re-
sult symbol) directly: Right-click the object to open its context menu and select the menu item 
Display Properties. Now, you can immediately adjust the object's display properties in the dia-
log box Display Properties (Figure 11.3). 

 
Figure 11.2: Context menu of nodal support 

 
Figure 11.3: Dialog box Display Properties (for category Nodal Supports) 

The settings for display on the Screen and in the Printout Report are managed in two dialog 
tabs. In this way, it is possible to define adjustments separately for the monitor graphic (for  
example size of support symbols with black background) and for the printout. 
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If you want to define Identical Settings For screen and printout report, use the check box below 
the tabs to synchronize the display properties for screen and printout report. If it is ticked, the 
following settings that are defined subsequently are also enabled in the other dialog tab 
(Screen or Printout Report) of the current category. Settings that have already been defined 
cannot be transferred subsequently with this function. 

The Category navigator shows the graphical objects listed in a directory tree. To change the 
display properties of an object, select the relevant entry. Then, adjust the object-specific dis-
play parameters in the dialog section to the right: color, line display, size in work window, type 
and arrangement of numbering, font, size of load vector etc. 

RSTAB offers additional [Details] buttons for some parameters. 

 
Figure 11.4: Dialog box Distance for Nodal Forces 

The buttons are used to open new dialog boxes where you can scale for example the distance 
or size of the object to the dimensions of the total structure. 

The buttons below the parameters are reserved for the following functions: 

 
Opens the Font dialog box for changing type, size and color of font 

 Goes to display parameters of axes of current object 

 Returns to base data of object 

 Opens the dialog box Relative Positions (Figure 11.5) for arranging descriptions 

 Restores default settings 

Table 11.1: Buttons in dialog box Display Properties 
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For objects that are relevant for members it is possible to arrange the description or symbol by 
user-defined settings. A dialog box opens where you can define the position of the information 
by means of a relative distance to the member start. 

 
Figure 11.5: Dialog box Relative Positions of Member Information 

Save display configuration 
The dialog box Display Properties allows you to adjust the display configuration to the given 
requirements. So it is possible to create for example different settings for the screen with col-
ored background and for the monochrome printer with specific settings. 

However, modifications cannot be saved in the dialog box Display Properties. The Configuration 
Manager described in chapter 3.4.10 on page 34 is responsible for managing display configu-
rations. 

Therefore, proceed as follows when you want to create a new display profile based on your 
modifications: 

• Confirm the modifications in the dialog box Display Properties with [OK]. 

• Open the Configuration Manager (see chapter 3.4.10, page 34). 

• Create a [New] configuration. 

• Enter a description in the dialog box New Configuration, and then confirm the input  
with [OK]. 
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11.1.3 Units and Decimal Places 
The units and decimal places for RSTAB and all add-on modules are managed in one dialog 
box. The settings can be modified as required for modeling or evaluation. All numerical values 
will be converted or adjusted. 

Changing units and decimal places 
Many dialog boxes provide the button shown on the left that you can use to access the dialog 
box for changing units and decimal places (see Figure 11.4 for dialog box Display Properties). 

To open the dialog box Units and Decimal Places, you can also 

select Units and Decimal Places on the Edit menu. 

 
Figure 11.6: Dialog box Units and Decimal Places 

First, select the module in the dialog section Program / Module for which you want to adjust 
the units or decimal places. Depending on the selection, the right side of the dialog box is 
changing. 

Four dialog tabs are offered for RSTAB so that you can specify settings separately for Model, 
Loads and Results data as well as Dimensions. For some add-on modules the right part of the 
dialog box is also subdivided into several tabs. The units and decimal places are summarized in 
groups. 

When the dialog box has been opened from another dialog box (for example the New Member 
box), the relevant units and decimal places are marked with a red triangle on the right as 
shown the figure above. 

Saving and import of units as user profile 
The settings in the dialog box Units and Decimal Places can be saved and reused in other mod-
els. Thus, creating specific unit profiles for models consisting of steel and reinforced concrete, 
for example, is possible. 

The button shown on the left opens a dialog box where you specify the Name of the new units 
user profile. 
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Figure 11.7: Dialog box Save Profile 

To use this profile as default setting for new models, tick the check box Save profile as default. 

A user profile can be imported with the button shown on the left. A dialog box opens where 
several profiles are available for selection. A metric and an imperial (Anglo-american) unit pro-
file are preset as default settings. 

 
Figure 11.8: Dialog box Load Profile 

11.1.4 Comments  
This chapter describes the comment fields available in dialog boxes and tables (see for exam-
ple Figure 4.12, page 41). The comments that you can insert graphically are described in chap-
ter 11.3.6 on page 288. 

Using comments 
You can enter any kind of text into the comment fields. With the button [Import Comment] 
shown on the left you can take advantage of predefined text modules which are stored by 
cross-model management. 

A dialog box appears showing a list of stored text modules. 

 
Figure 11.9: Dialog box Import Comment 
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The List of Default Comments contains all comments that are suitable for the category. Click the 
[Import] button to insert the selected comment into the comment field of the dialog box. If the 
comment field already contains a text, it will be overwritten. Then, you may continue to edit 
the comment in the comment field. 

Use the button shown on the left to add the selected comment to a comment field text that is 
already available. 

Creating and managing comments 
In the dialog box Import Comment (Figure 11.9), you can create new text modules by means  
of the button shown on the left. Alternatively, you can use the Comments tab in the Program 
Options dialog box where all comments are managed. To open the dialog box, 

select Program Options on the Options menu 

or use the toolbar button shown on the left. 

 
Figure 11.10: Dialog box Program Options, tab Comments 

In the left dialog section Category, you determine the group (which means input table or input 
dialog box) to which you want to assign the comment text. 

The right dialog section Comments for Default offers four buttons which are reserved for the 
following functions: 

Button Description 

 Creates a new comment within the marked Category. Enter the text in the list. 

 Deletes the comment that is selected in the list. 

 Moves the selected comment upwards. 

 Moves the selected comment downwards. 

Table 11.2: Buttons in the dialog box Program Options, tab Comments 
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When the special selection is used (see chapter 11.2.2, page 274), you can filter data by user-
defined comments. 

 
Figure 11.11: Dialog box Special Selection (dialog section) for nodes filtered by comment 

11.1.5 Measure Functions 
In order to check entered data, distances and angles can be measured. To access the corre-
sponding function, 

point to Measure on the Tools menu. 

The following measure functions are available for selection: 

• Distance between 2 nodes 

• Angle between 3 nodes 

• Angle between 2 members 

Click the objects for measurement one after the other in the work window. Then, Distance and 
Deformation of the nodes are shown in a dialog box. 

 
Figure 11.12: Dialog box Distance Between Two Nodes/Points 
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11.1.6 Search Functions 

Selection with table 

To find an object in the graphic, you can use the tables. Click into a table row and you see the 
relevant object highlighted with colors in the work window. Take advantage of this function 
for rather simple models to detect objects fast and easily in the graphic. 

The graphical selection with the table works only if the synchronization of the selection is ac-
tive (see chapter 11.5.4, page 327). 

Searching by object number 
In RSTAB you can also search for objects specifically, which is especially recommended for ra-
ther large and complex structures. To access the search function, 

select Find via Number on the Edit menu. 

The following dialog box appears: 

 
Figure 11.13: Dialog box Find Object with Number 

In the dialog section Object, use the list to define the object category for searching: node, 
member or set of members. Then, enter the No. of the object directly into the input field to the 
right, or use the list to select a number. 

Click [OK] to confirm the dialog box. Then, you see a big arrow indicating the object in the 
work window. The arrow will still be displayed when you adjust the area around the object  
appropriately by zooming or rotating the model. The arrow will disappear by a click into the 
workspace. 
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11.1.7 Viewpoint and View Angle 
RSTAB offers the standard views [in X/Y/Z] direction and [in Reverse X/Y/Z] direction as well as 
the [Isometric View] that can be selected by means of the buttons shown on the left. Addition-
al buttons for user-defined coordinate systems and angles of view are available in the list but-
ton of the toolbar and in the Views navigator (see chapter 9.7.1.1, page 213). 

If these views including rotating option (use toolbar button [Move] and hold down [Ctrl] key) 
do not result in the display view that you want to set, you can use the extended options of the 
dialog box Edit Viewpoint. 

To open the dialog box, 

select Viewpoint on the View menu. 

 
Figure 11.14: Dialog box Edit Viewpoint 

Click into the preview windows on the right and move the mouse to set viewpoint and view 
angle. In addition, you can adjust the factor for the Perspective. 
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11.1.8 Determination of Centroid 
The centroid of the overall model is displayed automatically when the option Center of gravity 
is ticked in the Display navigator under the navigator item General. Color and size can be ad-
justed in the dialog box Display Properties: Click Colors → Other → Center of Gravity (see chap-
ter 11.1.2, page 258).  

Moreover, it is possible to determine the centroid of particular objects: Select the relevant 
members, for example by multiple selection or by opening a selection window (see chapter 
11.2, page 271). Activate the context menu shown on the left by right-clicking one of the se-
lected members. Then, click the menu item Centroid and Info to open a dialog box with infor-
mation about the selected objects. 

 
Figure 11.15: Dialog box Centroid and Info about Selected Objects 

The dialog box shows you the Centroid Coordinates in relation to the origin of the global axis 
system XYZ. In the work window, the centroid is indicated by an arrow. Optionally, you can 
Create a new node in the centroid. 

In addition to the global dimensions of the selected objects (Envelope Size), the following Addi-
tional Info is displayed: 

• Length of members 

• Surface area of visible surfaces of all members 

• Net volume 

• Total mass 



11  Tools 

 

 

268 Program RSTAB © 2013 Dlubal Engineering Software 

11.1.9 Rendering 
The model's representation in the work window can be set by user-defined control. Use the list 
button in the toolbar shown on the left to switch quickly between the display types Wireframe, 
Solid and Solid Transparent Display Model. 

Detailed settings can be specified in the Display navigator under the navigator item Rendering. 

 
Figure 11.16: Display navigator with options for Rendering of model and load objects 

RSTAB provides control options for the Solid Model representation of members as well as the 
display of supports and loads. 

Textures 
When Textures are activated, RSTAB shows the surface textures in the rendered model. To ac-
cess detail settings for the textures, 

point to Display Properties on the Options menu, and then select Edit. 

The dialog box Display Properties opens where you select Materials in the category Objects by 
Color. Then, you see the materials listed with assigned colors and textures to the right. Double-
click into a field of the table row to open the dialog box Edit Material Color and Texture. 
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Figure 11.17: Dialog box Edit Material Color and Texture 

Use the dialog box to adjust Color and Texture of the selected material. RSTAB provides a color 
palette and a comprehensive library with textures (see dialog buttons). 

Color control 
The Display navigator item Colors in Rendering According to (see Figure 11.16) contains sev-
eral selection fields. An activated field controls the assignment of colors for the objects in the 
rendering. By default, RSTAB uses the material colors defined for the individual construction 
materials (see chapter 4.2, page 46). With the remaining options it is possible to check graph-
ically also cross-sections, member types, etc. based on the assigned colors. 

 
Figure 11.18: Option Colors in Rendering According to Cross-Sections for checking cross-section types 

 
 

 



11  Tools 

 

 

270 Program RSTAB © 2013 Dlubal Engineering Software 

11.1.10 Lighting 
Lightness and light effects of the rendered model can be adjusted individually. To manage the 
lighting in the Display navigator, 

select Lighting under Rendering. 

Six different light sources are available for selection: Light 1 to 4 light the model from its side, 
light 5 and 6 from below and above. Each Light can be switched on and off individually. 

Tick the check box for Display light positions to display the light sources in the work window. 
Active lights are represented in gold, inactive lights are shown in gray. 

 
Figure 11.19: Display of light positions using the Display navigator 

It is also possible to use the light effects for Results. 
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11.2 Selection 
With the selection functions, you can define objects for subsequent editing: nodes, members, 
sets of members, supports, etc. But it is possible to select also loads and guide objects (dimen-
sion lines, comments) graphically. 

To select (or find) an object in the work window, you can use the tables, too: Click into a table 
row and you see the corresponding object highlighted with colors in the graphic. However, 
this type of selection works only if the synchronization of the selection is set active (see chap-
ter 11.5.4, page 327). 

Using the Data navigator is another option to select objects: Right-click the relevant navigator 
entry, and then select the menu item Select in the context menu. 

 
Figure 11.20: Context menu in Data navigator 

11.2.1 Selecting Objects Graphically 

Selecting with mouse 
Every object can be selected in the work window by a simple click of your mouse. Once select-
ed, it is highlighted in the graphic with another color. Always, only the last clicked object re-
mains selected provided that the default setting New Selection is not changed. 

If you want to select more than one object by clicking, hold down the [Ctrl] key additionally. 
Another possibility is to switch to the setting Add to Selection by using the toolbar button 
shown on the left. You can also point to Select on the Edit menu where objects can be clicked 
separately to select them one after the other. 

The so-called preselection allows you to locate relevant objects before clicking. If selecting 
objects proves to be difficult for complex structural systems, you can exclude non-required 
model objects from the graphical pre-selection in the Display navigator category Preselection. 

Selecting with window 
Use the window selection to mark a lot of objects in one single step: Hold the left mouse but-
ton down and draw a window across the relevant objects. If you open the window from the 
left to the right, all objects that are completely covered by the window are selected. If you 
open the window from the right to the left, you select also those objects that are only cut by 
the window. 
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Selecting with rhomboid 
In the isometric view, it is sometimes difficult to select an object with a rectangular window. 
Then, it is recommended to use the function Selection via Rhomboid. 

Point to Select on the Edit menu, and then click Rhomboid 

or use the toolbar button shown on the left. 

 
Figure 11.21: Button Selection via Rhomboid 

 
Figure 11.22: Selecting with rhomboid 

Selecting with ellipse/circular ring 
The possibilities to select objects by an ellipse or circular ring represent alternatives to the 
rhomboid selection and can be used for example for circular models. To access the corre-
sponding functions, 

point to Select on the Edit menu, and then select Ellipse or Circular Ring 

or use the corresponding toolbar buttons. 

 
Figure 11.23: Buttons Selection via Ellipse or Circular Ring 

The elliptical or annular selection zone can be set by mouse-click defining the center point and 
both radii. 
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Selecting with section line 
You can select objects by means of a line running anywhere through the model. To access the 
function, 

point to Select on the Edit menu, and then click Section Line. 

The section line can be defined in the work window as a simple line or as polygon. Click rele-
vant points one after the other by mouse click to define the line. The points are independent 
of the work plane: The selection includes all objects that are cut by the intersection line dis-
played in the current view. 

After setting the endpoint of the section line, click it once again (alternative: double-click the 
last point). Make sure to place this point in an empty area of the work window. 

 
Figure 11.24: Selecting all columns with a section line 

Selecting in plane 
Objects lying in one plane (for example roof surfaces) can be selected easily by the selection 
function In Plane. To open the corresponding dialog box, 

point to Select on the Edit menu, and then click In Plane. 

A dialog box appears with detailed settings for selecting the objects and the plane. 

 
Figure 11.25: Dialog box Select In Plane 

After clicking the [OK] button you can define the selection plane graphically: Click 3 Nodes, or 
draw a Polygonal chain freely or with the help of nodes in the work plane. 

Selecting free nodes 
To select nodes which are not used for the definition of members, 

point to Select on the Edit menu, and then click Free Nodes. 

The easiest way to delete selected free nodes is to use the [Del] key. 
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Selecting related objects 
When you select a member by clicking, the nodes belonging to the member are not included 
in the selection. To select also the components of objects, 

point to Select on the Edit menu, and then click Related Objects. 

Use this function for example to integrate the supports of members quickly into the selection 
and to save them as related objects in a user-defined visibility (see chapter 9.7.1.2, page 217). 

11.2.2 Selecting Objects by Criteria 
The function allows you to select objects by particular criteria. Moreover, specific objects can 
be added to or removed from an existing selection. 

To open the dialog box used for the special selection, 

point to Select on the Edit menu, and then click Special 

or use the toolbar button shown on the left. 

 
Figure 11.26: Dialog box Special Selection 

The dialog section Category on the left lists the objects defined in the model. Settings in the 
right part of the dialog box depend on the selected object. Determine a selection criterion and 
specify detailed settings, if necessary. 

Example: 

With the settings shown in Figure 11.26 all column members that are modeled Parallel to 
member 1 are selected. You can also use the [] button in the dialog box to define the tem-
plate member graphically. 
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Figure 11.27: Selection of parallel members 

11.3 Work Window 
Special CAD functions such as work planes, snap options, guidelines and user-defined coordi-
nate systems help you to model graphical objects in the work window. 

11.3.1 Work Planes 
Although a model is defined spatially, it can be displayed only in two dimensions on the 
screen. Therefore, defining objects graphically is a problem because it must be organized in 
which plane objects are created when clicking into the graphic window. The work plane de-
termines which coordinate is always "fixed". 

The axes of coordinates of the currently set work plane are represented by two green, orthog-
onal lines. The lines' point of intersection is called “origin of the work plane". 

 
Figure 11.28: Work plane represented in the graphic 

Normally, a work plane runs parallel to one of the global planes XY, YZ or XZ that are spanned 
by two axes of the global coordinate system. But it is also possible to specify a work plane di-
rectly as a plane with any inclination, or to define it by means of member axes. 
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To open the dialog box Work Plane and Grid/Snap with the parameters of the work plane, 

select Work Plane, Grid/Snap, Object Snap, Guidelines on the Tools menu 

or use the toolbar button shown on the left. 

 
Figure 11.29: Button Settings of Work Plane 

The dialog box shown in Figure 11.34 on page 278 appears. 

Parallel to global plane XY / YZ / XZ 
The work plane can be aligned parallel with one of the following global planes. 

Plane Selection in Work Plane dialog box Selection in toolbar 

XY 

 

 

YZ 

 

 

XZ 

 

 

Table 11.3: Selection of work plane 

To find more options for defining work planes, 

point to Select Work Plane on the Tools menu 

or use the corresponding toolbar buttons. 

3 points plane 
In the work window, you can select three points defining a new work plane with the axis sys-
tem UVW. The points must not be defined on a straight line. 

Plane with member axis xy / xz 
The planes of the member axes xy ("weak axis") or xz ("strong axis") are used for defining the 
work plane (see chapter 4.7, page 80). The relevant member must be defined graphically in the 
work window. The zero point of the new work plane is placed into the start node of the mem-
ber. Axis U shows in direction of member axis x (see the following figure). 
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Figure 11.30: Work plane in roof inclination of member axis xz 

Offset of work plane 
Use this function to shift the work plane perpendicular to the current plane. Specify the dis-
tance in the dialog box Offset Workplane. 

 
Figure 11.31: Dialog box Offset Workplane 

The offset remains active until the function is canceled on the menu. 

Zero point of work plane 
The Work Plane dialog box (Figure 11.34) manages the zero point (origin) settings of the work 
plane. Use the [] function to select a node in the work window. Click the [New] button to de-
fine a new node. It is also possible to enter the coordinates of any point directly. 

 
Figure 11.32: Dialog box Work Plane, dialog section Origin of Work Plane 

The zero point of the work plane can also be defined graphically. 

Point to Select Work Plane on the Tools menu, and then select Define Origin 

or use the toolbar button shown on the left. 

 
Figure 11.33: Button Set Origin of Grid/Work Plane 
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11.3.2 Grid 
Grid points are used to help you with the graphical input in the work plane. When nodes are 
defined graphically, the pointer snaps on the grid points. 

The properties of grid points are managed in the dialog box Work Plane and Grid/Snap. To 
open the dialog box, 

select Work Plane, Grid/Snap, Object Snap, Guidelines on the Tools menu 

or use the toolbar button shown on the left (see Figure 11.29, page 276).  

 
Figure 11.34: Dialog box Work Plane and Grid/Snap 

The setting options relevant for the grid are available in the dialog tab Grid/Snap. 

Show 
To display the grid in the work window, tick the Grid check box. The snap function can be 
turned on and off independently of the grid by means of the Snap check box. Thus, the snap 
function on the grid points can be effective while the grid is invisible. 

To switch both functions on and off quickly, use the buttons [SNAP] and [GRID] in the status 
bar. 

Type 
The grid points can be arranged in the Cartesian or the polar coordinate system. Depending on 
the selection, contents of the displayed dialog sections are changing. 

Alternatively, you can select the coordinate system by means of the buttons [CARTES], [POLAR] 
or [ORTHO] in the status bar. 

Number of grid points 
When the Cartesian grid is set, you can define the number of grid points for both axis directions 
separately. 

When the polar grid is set, you have to specify the number of concentric grid circles. 
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When the option Dynamically according to size of model is ticked, the grid will automatically be 
adjusted to the dimensions of the model. Thus, a sufficient number of grid points will always 
be available around the model. However, the required grid points will be recalculated after 
each input, which may slow down the speed for creating the graphic when you work on com-
plex models. 

Grid point spacing 
When you use the Cartesian grid, you can define the spacing of grid points separately for the 
directions 1 and 2. 

For the polar grid you have to specify the radial spacing R for the grid circles. The angle α con-
trols the spacing of grid points on the circles. 

Optionally, the Cartesian and the polar grid can be rotated about the rotation angle β. 

If needed, the number of pixels controlling the snap Distance (see dialog section Show) can be 
adjusted. 

11.3.3 Object Snap 
The object snap facilitates the CAD-like modeling when defining members. In addition to 
nodes, several snap points along the members can be activated. 

The settings for the object snap are defined as well in the Work Plane dialog box. To open the 
dialog box,  

select Work Plane, Grid/Snap, Object Snap, Guidelines on the Tools menu 

or use the toolbar button shown on the left (see Figure 11.29, page 276).  

 
Figure 11.35: Dialog box Work Plane and Grid/Snap 

The dialog tab Object Snap manages the different snap functions. 

To make the functions of the object snap effective, make sure that the button [OSNAP] is  
activated in the status bar. 
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Nodes 

 

Figure 11.36: Snapping a node 

When defining new members, the existing nodes will be captured. Snap points are symbolized 
by squares. 

Perpendicular 

 

Figure 11.37: Connecting a member perpendicularly 

When you define a new member, the pointer will be snapped if you move the mouse pointer 
near the perpendicular point of an existing member. The snap point is symbolized by a per-
pendicular symbol. 

Centers 

 

Figure 11.38: Connecting a member in center 

If you move the pointer near the center (middle) of a member, it will be snapped. The center 
symbol appears on the snap point. 
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Intersections 

 
Figure 11.39: Snapping members at the intersection point 

The pointer will be captured at the intersection point of two crossing members that have no 
node in common. The snap point is symbolized by the intersection symbol shown on the left. 

Parallel 

 
Figure 11.40: Snapping a parallel member 

Use this function to set parallel members: Define the start node of the new member, and then 
move the pointer over a template member. Now, if you move the pointer near a possible end 
node of the new member running parallel to the template, the parallel symbol shown on the 
left appears on both members. 

Partition points 

 
Figure 11.41: Snapping a member at the partition point (example: 2/3) 

Use this option to enter a number of n member divisions. Then, when you move the pointer 
along a member, it will be snapped on the partition points. The partition is displayed as frac-
tion on the pointer. 
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Distance 

 

Figure 11.42: Connecting a member in a defined distance 

Use this option to enter a distance d for the member division. Then, when you move the point-
er along a member, it will be snapped at the defined distance from the member start as wells 
as member end. The distance symbol appears on the pointer. 

Guidelines 

 

Figure 11.43: Snapping guidelines at intersection point 

When you move the pointer near the intersection point of two guide lines (see chapter 11.3.7, 
page 290), it will be snapped. The intersection symbol appears on the snap point. 

Background layers 

 

Figure 11.44: Snapping background layers on intersection point 

Use this function to set nodes on intersection points of background layers (see chapter 11.3.7, 
page 290). The intersection symbol appears on the snap point. 
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Line grid 

 

Figure 11.45: Snapping points of line grid 

Use this function to place objects into the intersection points of a line grid (see chapter 11.3.8, 
page 294). 

11.3.4 Coordinate Systems 
User-defined coordinate systems make entering inclined parts of a model easier. Normally, 
these systems have nothing do to with the axis systems of members, unless they are defined 
graphically by the axes of particular members (see chapter 11.3.1, page 277). 

To open the dialog box Coordinate System, 

select Coordinate System on the Tools menu 

or use the toolbar button shown on the left. 

 
Figure 11.46: Button Coordinate System 

You can also use the dialog box Work Plane and Grid/Snap (see Figure 3.15, page 26) where you 
find the [New] button for creating a user-defined system of coordinates. 

 
Figure 11.47: Dialog box Coordinate System 

The Standard coordinate system that refers to the global axes X,Y,Z and the origin is preset. 
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Create a new coordinate system 
Click the [New] button shown in Figure 11.47 to open the following dialog box. You find the 
same button in the dialog box Work Plane and Grid/Snap (see Figure 3.15, page 26). 

 
Figure 11.48: Dialog box Define New Coordinate System 

Enter a Name for the new coordinate system. Then, define the axis system with the help of 
three parameters in the dialog section UVW Coordinate System Related to XYZ CS: 

• Origin (zero point of new coordinate system) 

• Point on positive U-axis (first axis) 

• Point in positive UW-plane (rotation of plane about axis U) 

Specify three points that you can enter directly or select graphically. The points must not be 
defined on a straight line. 

You can use the buttons shown on the left to select the three points one after the other in the 
work window (please observe the sequence when defining points 0 to 2). With the left button 
you can select only Nodes, with the right button you can select any Points. The difference be-
comes especially significant when a node representing a definition point of the coordinate  
system is changed. Then, the coordinate system will be adjusted automatically. In case of any 
points, the system of coordinates is fixed. 

If a user-defined work plane is defined with the help of three points (see chapter 11.3.1, page 
276), RSTAB creates automatically a new coordinate system with the name Generated. 
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Edit or delete a coordinate system 
Only user-defined coordinate systems can be edited or deleted. Use the following two buttons 
available in the Coordinate System dialog box. 

 
Modifies selected coordinate system 

 
Deletes selected coordinate system 

Table 11.4: Buttons in the dialog box Coordinate System 

Example: 
In a frame joint, a new coordinate system is defined for the diagonal lying in the plane of the 
roof. The Origin is set in corner node 6. End node 4 of the diagonal member is selected as Point 
on positive U-Axis. Base node 5 of the column is selected as Point in positive UW-Plane. 

 
Figure 11.49: User-defined coordinate system UVW in a frame joint 

Now, the grid refers to the work planes UV, VW and UW where you can define new objects (see 
chapter 11.3.1, page 275). 
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11.3.5 Dimensions 
It is possible to add user-defined dimension lines to the model. 

To apply dimensioning functions, 

point to Dimensions on the Insert menu 

or use the corresponding toolbar buttons. 

 
Figure 11.50: New Dimension buttons 

The following dimension options can be selected: 

Dimension Dimensioned Objects 

Linear Lengths between two or several nodes 

Angular Angles between three nodes or two members 

Slope Inclination angle between a member and a global plane 

Height Height level of a node 

Table 11.5: Dimensioning functions 

The dialog box New Dimension opens. The appearance of the dialog box depends on your  
selection. 

 
Figure 11.51: Dialog box New Linear Dimension 

Use the pointer displayed with a selection symbol and click the objects representing the di-
mensioning's reference points one after the other. In the dialog section Reference, you can  
select the real length or the projection in one of the global axis directions. 

In the dialog section to the right, you determine the Plane where the dimension line is applied. 
The setting refers to the axes of the global coordinate system XYZ, respectively the user-
defined system of coordinates UVW. If you switch the plane and move the pointer in the 
graphic, you can see the effect of both selection fields. 
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Use the four check boxes in the dialog section Options to define the information appearing on 
the values. When you select Symbol, you can enter a dimensioning symbol. It is also possible to 
select it from the list. Tick Hide value to switch off the measured value so that only the symbol 
appears. 

The Offset determines the distance of the dimension line from the first selected node. The dis-
tance can be defined also graphically by using the mouse pointer. To finally define the dimen-
sion line, click into the work window or use the button [Set Dimension] shown on the left. 

To define a chain dimensioning with equal offset, click the individual nodes one after the oth-
er, and then specify the offset. 

To set the display of dimension lines, use the Display navigator or the general context menu 
(right-click into an object-free area of the work window). 

 

Figure 11.52: Display navigator (Guide Objects → Dimensions) and general context menu 

When the model geometry is modified, dimensions will be adjusted automatically. 

To open the dialog box Edit Dimension, double-click the relevant dimension. In this way, you 
can subsequently adjust the offset. However, if you want to relate the dimension line to other 
nodes or members, delete the dimension first. Then you can redefine it. 
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11.3.6 Comments 
There are two types of comments: 

• Comments in dialog boxes and tables (see chapter 11.1.4, page 262) 

• Comments in work window 

This chapter describes how comments are set graphically. 

You can place comments in reference to nodes and centers of members. They can be placed 
also anywhere in the current work plane or a global plane. 

To open the dialog box for applying comments,  

select Comments on the Insert menu 

or use the toolbar button shown on the left. 

 
Figure 11.53: Button New Comment 

The dialog box New Comment opens. 

 
Figure 11.54: Dialog box New Comment 

Enter the comment text into the dialog section Text. The appearance of the comment concern-
ing colors and [Fonts] can be adjusted in the dialog section Options. Optionally, the comment 
is Framed by a rectangle or circle. 

The Rotation of the comment allows you to user-define the comment text arrangement. 

If the check box in the dialog section Offset is ticked, the comment will be arranged in a speci-
fied distance to the object. You can define the distance also graphically: First, click the object 
after entering the comment text. Then, use the pointer to locate the appropriate position 
where you enter the comment text with another mouse click. RSTAB displays the current work 
plane so that you can place the comment correctly. If necessary, you can change the work 
plane before placing the comment. 

To set the display of comments, use the Display navigator or the general context menu (right-
click into an object-free area of the work window, see figure below). 
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Figure 11.55: Display navigator (Guide Objects → Comments) and general context menu 

When the model geometry is modified, comments will be adjusted automatically. 

Comment texts including offset can be edited subsequently: Double-click the comment in the 
work window or its entry in the Data navigator. 

You can shift comments by using the drag-and-drop function (for copying: hold down the [Ctrl] 
key). Please note the following: When you "grab" the arrow of the graphical comment at its 
head, you shift the entire comment. When you "grab" it on the text, the arrowhead continues 
to point to the object so that the position of the comment text can be adjusted in the work 
plane.  
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11.3.7 Guidelines 
Guidelines represent a grid of axes and rows underneath the graphical workspace. The inter-
section points of guidelines are as well snap points for graphical input, provided that the snap 
function for Guidelines-Intersections is active in the object snap (see chapter 11.3.3, page 282). 

Guidelines do not need to be parallel to the axes of the global coordinate system XYZ. Angles 
can be specified freely. You can even define a polar arrangement of guidelines. Also spacings 
among guidelines may be arbitrary. 

 

Figure 11.56: Grid of guidelines 

Create guidelines 
Dialog input 

To open the dialog box for creating a new guideline, 

point to Guidelines on the Insert menu, and then select Dialog Box 

or use the context menu in the Data navigator. 

 
Figure 11.57: Context menu of Guidelines in Data navigator 
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The following dialog box appears: 

 
Figure 11.58: Dialog box New Guideline 

The No. of the guideline is allocated by the program but can be adjusted, if necessary. 

With the options in the dialog section Type you decide how the guideline will be created. 

Type Explanation 

II to X / Y / Z 
(parallel to global axis X, Y 
or Z) 

The guideline is created parallel to one of the global axes.  
Specify the distances x1 / y1 / z1 of the respective global axes in the 
dialog section Parameters. 

Bias by 2 points In the dialog section Parameters, enter the coordinates of two 
points in the current work plane to define the guideline. 

Bias by angle and point The coordinates of a point and a rotation angle must be specified 
in the Parameters dialog section. The guideline will be created in 
the current work plane. 

Polar In the Parameters dialog section, the center point and the radius 
for the circular guideline must be specified. 

Table 11.6: Types of guidelines 

Enter the individual parameters into the input fields, or determine them graphically in the work 
window by using the [] function. 

When the check box Description is ticked, you can enter a description for the guideline into the 
input field. You can also select a description from the list. 
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Graphical input 

To define a guideline graphically, 

• point to Guidelines on the Insert menu, and then select Graphically, 

• use the button [New Guideline Graphically] shown on the left or 

• grab an axis of the work plane and move it in a parallel direction (only possible if 
guidelines are not locked, see below). 

 
Figure 11.59: Creating a guideline graphically 

The dialog box New Guideline is described above. 

Edit and delete guidelines 
To open the dialog box for editing guidelines, double-click a guideline in the graphic or its en-
try in the Data navigator. 

If the guideline cannot be selected in the graphic, it is locked (see below). Guidelines can be 
unlocked quickly in the following way: Right-click in an empty space of the work window and 
deactivate the option Lock Guidelines in the context menu. 

Another possibility to edit guidelines is to select Work Plane, Grid/Snap, Object Snap, Guidelines 
on the Tools menu, or to use the toolbar button shown on the left. A dialog box opens where 
you can use the Guidelines tab not only for activating the snap but for editing, deleting or hid-
ing and displaying guidelines as well as creating new guidelines (see figure below). 
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Context menu of guidelines 

 
Figure 11.60: Dialog box Work Plane and Grid/Snap, dialog tab Guidelines 

Guidelines can be deleted in both the work window and the Data navigator: Right-click the 
guideline, and then select Delete or Delete Guideline in the context menu. 

Lock guidelines 
When guidelines are locked, they cannot be selected, edited or moved. In this way, they do not 
affect the graphical input of objects. Nevertheless, the snap function on the intersection points 
remains active. 

To lock or unlock all guidelines,  

• right-click a guideline and select Lock Guidelines in the context menu, 

• point to Guidelines on the Edit menu, and then select Lock or 

• right-click Guidelines in the navigator and select Lock Guidelines in the context menu.  

Copy and move guidelines 
Guidelines are normal graphical objects for which you can use all common editing functions. 

To move or copy a guideline, select the guideline first. Then, you can apply the function de-
scribed in chapter 11.4.1 on page 301. 



11  Tools 

 

 

294 Program RSTAB © 2013 Dlubal Engineering Software 

Show guidelines 
The Display navigator controls the graphical representation of guidelines in detail. 

 
Figure 11.61: Guideline settings in the Display navigator 

11.3.8 Line Grid 
User-defined line grids help you to model structures consisting of girder grillages or grids.  
The intersection points of the grid represent definition points for nodes and members. 

It is possible to use several line grids in one model. 

Create line grid 
To open the dialog box for creating a new line grid, 

select Line Grid on the Insert menu 

or use the context menu in the Data navigator. 

 
Figure 11.62: Context menu of Line Grid in Data navigator 
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The dialog box Line Grid appears where you can define the new grid. 

 
Figure 11.63: Dialog box Line Grid 

The Global Position of Insert Point defines the origin of the line grid. The coordinates can be en-
tered or selected in the work window by using the [] function. 

The dialog section Type below the dialog graphic offers the following options to define the 
grid system before entering further data: 

• Cartesian 

• Spherical 

• Oblique (grid that can be rotated for each axis about any rotation angle γ) 

• Cylindrical 

The small graphic to the right is interactive with the type specification. 

In the dialog sections Line Grid in X-/Y-/Z-Direction, enter the distances d and the Number of 
spans for each direction. The Name is preset but can be adjusted. It is also possible to enter the 
Coordinates of the distances or to adjust them subsequently. 

The options Positive and Negative determine in which direction of the global axis the line grid 
will be created. 

With the dialog section Rotation in the right bottom corner you have the possibility to rotate 
the line grid about an axis: First, select the Sequence determining the order of the local grid ax-
es X', Y' and Z'. Then, enter the angle of rotation about the global axes X, Y and Z in the input 
fields for Rotated about. You can also use the field buttons [] to define the support rotation 
graphically. 

A great part of the dialog box is covered by a graphic window where input is immediately rep-
resented graphically. The buttons below the window are familiar RSTAB functions used to con-
trol the display for dimensioning, numbering, axes and view. It is also possible to use the 
mouse control options for the big dialog graphic (see chapter 3.4.9, page 33). 
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Each line grid can be saved as template and reused later. Both buttons shown on the left are 
used to [Save] and [Load] grid data. 

After closing the dialog box, you can set objects on the grid nodes. Make sure that the object 
snap is active (see chapter 11.3.3, page 279). 

11.3.9 Visual Objects 
Visual objects are 3D objects used for example in architectural design programs to represent 
model designs close to reality (for example people, cars, trees, textures etc.). You can also inte-
grate 3D objects into the RSTAB model to demonstrate the model's proportions. 

Load visual object 
To open the dialog box for importing a visual object, 

select Visual Object on the Insert menu 

or use the context menu in the Data navigator. 

 

Figure 11.64: Context menu in the Data navigator, Guide Objects → Visual Objects 

The dialog box New Visual Object opens where you have to specify the Description and File 
Name. 

 
Figure 11.65: Dialog box New Visual Object 
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The visual object must be available in the format .3ds. Use the [Browse] button to select the file 
in the Windows dialog box Open. 

Define the Position of the object in the model by entering coordinates. You can also use the [] 
function to define it graphically in the work window. The reference point of the 3D object is in-
dicated by the selection color in the graphic to the right. 

In addition, it is possible to define a Rotation of the object or to Scale the object. 

Click [OK] to insert the object into the model. 

The edit dialog box of a visual object can be accessed by double-clicking the object in the 
graphic or in the Data navigator. 

11.3.10  Background Layers 
A DXF file can be imported as background layer and used for the graphical input of objects. In 
contrast to the DXF import (see chapter 12.5.2, page 403) where the complete model is loaded 
being converted into nodes and lines, background layers represent some sort of transparent 
sheets for specific modeling. 

It is possible to use several background layers in a model. 

Create background layer 
To open the dialog box for creating a new background layer, 

select Background Layer on the Insert menu 

or use the context menu in the Data navigator. 

 
Figure 11.66: Context menu of Background Layers in the Data navigator 

The Windows dialog box Open appears (see figure below). Enter the directory and the name of 
the DXF file. 
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Figure 11.67: Dialog box Open 

Click the [Open] button to access the dialog box Background Layer. 

 
Figure 11.68: Dialog box Background Layer 

The No. of the layer is allocated by the program. In the dialog section Background Layer Descrip-
tion, you can enter any name making the assignment easier later. 

Use the [Edit] button shown on the left to access more settings for the DXF import. Details on 
the dialog box can be found in Figure 12.49 on page 403.  

After clicking [OK] RSTAB imports the layer which appears gray in the background of the work 
window. In the gray line model, you can define nodes and members now. 

 

Figure 11.69: Defining members with background layer 
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Make sure that the object snap for background layers is activated so that you can arrange ob-
jects on the points available in the layer. To activate the object snap for DXF points, use the 
[DXF] button in the status bar. Alternatively, select Work Plane, Grid/Snap, Object Snap, Guide-
lines on the Tools menu, or use the toolbar button shown on the left. 

The dialog box Work Plane and Grid/Snap opens. In the dialog tab Background Layers, you can-
not only activate the snap but edit, delete or hide and display layers as well as create new lay-
ers. 

 
Figure 11.70: Dialog box Work Plane and Grid/Snap, tab Background Layers (dialog section) 

Edit, delete or copy background layer 
To open the edit dialog box, double-click the background layer or the relevant entry in the  
Data navigator (see Figure 11.66, page 297). You can also use the dialog tab Background Layers 
available in the dialog box for work plane settings (see Figure 11.70): After selecting the layer 
in the list, you can [Edit] it. 

Deleting a background layer is also possible in the Data navigator. 

To move, copy or mirror a background layer, select the layer first. Then, you can apply the func-
tion described in chapter 11.4.1 on page 301. 

Display of background layers 
The Display navigator controls the representation of background layers in detail. 

 
Figure 11.71: Background layer settings in the Display navigator 
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Buttons of menu item Select View 

11.3.11  Margins and Stretch Factors 
In most cases, it is not required to change the full screen arrangement or the scaling of the 
model in the work window. But if you have to adjust the global display parameters, 

select Display Margins and Stretch Factors on the Options menu 

to open a dialog box managing the default settings. 

 
Figure 11.72: Dialog box Display Margins and Stretch Factors 

Settings in the dialog section Graphic Margins determine the minimum distances that are kept 
for the representation of the model on the four sides of the work window's margins. The values 
are set in percentage and refer to the total height or width of the work window. They have an 
impact when using the buttons of the menu item Select View on the View menu (see figure on 
the left) or the function Show Whole Model [F8] for the window-filling graphical representation. 

To display the model in a distorted view, you can define factors unequal to 1 for the global di-
rections in the dialog section Compress or Stretch Model. However, customizing settings in this 
dialog section may be required only in exceptional cases. They affect only the display of the 
model but not the actual geometry. To produce a distortion of the model, use the Scale func-
tion available on the Edit menu (see chapter 11.4.5, page 307). 

11.4 Edit Functions 
Use the graphical editing functions to modify objects previously selected in the graphic. The 
selected objects can be 

• moved 

• copied 

• rotated 

• mirrored 

• projected 

• scaled 

• extruded 

• sheared. 

No selection is needed for the CAD functions described in chapter 11.3. The functions described 
in the following help you to model new objects. 

In addition, the present chapter describes how members can be divided, comments placed or 
numberings changed. 
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Context menu of selected objects 

11.4.1 Move and Copy 
To move or copy selected objects, 

select Move/Copy on the Edit menu 

or use the context menu of the corresponding object. You can also use the toolbar button 
shown on the left. 

 
Figure 11.73: Button Move and/or Copy 

The following dialog box appears: 

 
Figure 11.74: Dialog box Move or Copy - Copy 

When the Number of copies is set to 0, the selected objects will be moved. Otherwise, the en-
tered number of copies will be generated. 

With the options in the dialog section Reference to Coordinate System you decide whether the 
objects are moved or copied in the global coordinate system XYZ or in a user-defined system 
of coordinates UVW (see 11.3.4, page 283). The user-defined coordinate system can be select-
ed in the list or created with the [New] button. 

The Displacement Vector is specified by the distances dX, dY and dZ, or du, dv and dw for a user-
defined coordinate system. The vector can also be determined in the work window by using 
the [] function or by clicking two grid points or nodes. 

If copies are created, you can influence the numbering of new nodes and members in the dia-
log section Numbering Increment for. 

Click the [Edit] button shown on the left to open another dialog box offering useful options for 
copying. The same dialog box is used also for other functions such as mirroring, rotating etc. 
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Detail settings 

 
Figure 11.75: Dialog box Detail Settings for Move/Rotate/Mirror 

Connecting 

You can create new members between the selected nodes and their copies. 

 
Figure 11.76: Copy with connecting members 

When a Template member is selected in the list or graphic by using the [] function, its proper-
ties are used for the connecting members. 

Local coordinate system 

You can adjust the local member coordinate system to the new position when rotating and 
mirroring. 

The automatic adjustment of local axes often becomes important when mirroring objects. The 
function proves to be useful as well for rotating a vertical member as its axis y is oriented paral-
lel to the global Y-axis (see chapter 4.7, page 80). 

Moreover, the function adjusts eccentric connections that are defined in direction of the glob-
al axes X, Y and Z. 
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Load cases 

If the check box for Copy including loading is ticked, the loads acting on the selected objects 
will be transferred to the copies. Please note that the loads of all load cases will be copied, not 
only the loads of the currently selected load case. 

Nodal loads can be defined only in direction of the global axes X,Y,Z. If you want to influence 
the direction of nodal loads when copying members, use the check box Adjust nodal loads 
when rotating or mirroring. When it is ticked, RSTAB will convert the loads like local concentrat-
ed loads to the new position. In this case, make sure that the members are selected together 
with the nodal loads before rotating or mirroring. If the check box is clear, the global load di-
rection will be kept. 

 
Figure 11.77: Adjusted nodal loads when rotating two times about 45° 

Duplicity 

Double members may be created when copying. Use the check box to decide if overlapping 
members are allowed or merged to be one member. 

Auto connect 

Use the check box to decide if the copies of members will be connected automatically to the 
already existing members. When the box is ticked, a node will be created in the point of inter-
section. 
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Context menu of selected objects 

11.4.2 Rotate 
To rotate selected objects about an axis,  

select Rotate on the Edit menu 

or use the context menu of the corresponding object. You can also use the toolbar button 
shown on the left. 

 
Figure 11.78: Button Rotate 

The following dialog box appears: 

 
Figure 11.79: Dialog box Rotate - Copy 

When the Number of copies is set to 0, the selected objects will be rotated. Otherwise, the en-
tered number of copies will be generated.  

Enter the rotation angle in the dialog section Rotation. The angle refers to a coordinate system 
that is clockwise-oriented. 

The Axis of Rotation can be defined in two ways: 

• The rotation axis runs parallel to an axis of the global axis system XYZ. In this case, activate 
the first option and select the relevant axis from the list to the right. Then, in the dialog 
section Definition of the Axis of Rotation, specify a point through which the rotation axis is 
running. 

• The rotation axis lies anywhere in the work plane. In this case, activate the second option. 
Then, in the dialog section Definition of the Axis of Rotation, specify two points defining the 
rotation axis. 

If copies are created, you can influence the numbering of new objects in the dialog section 
Numbering Increment for. 

Use the [Edit] button shown on the left to open another dialog box with useful options that 
are described in chapter 11.4.1 on page 302.  
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Context menu of selected objects 

11.4.3 Mirror 
To mirror selected objects on a plane, 

select Mirror on the Edit menu 

or use the context menu of the corresponding object. You can also use the toolbar button 
shown on the left. 

 
Figure 11.80: Button Mirror 

The following dialog box appears: 

 
Figure 11.81: Dialog box Mirror - Copy 

To maintain the original object, tick the check box for Create copy. 

The Mirroring Plane can be defined in two ways: 

• The mirroring plane runs parallel to a plane that is spanned by the axes of the global axis 
system XYZ. In this case, activate the first option and select the relevant plane from the list 
to the right. Then, in the dialog section Mirroring Plane, enter a point lying in the plane set 
above. 

• The mirroring plane lies anywhere in the work plane. In this case, activate the second op-
tion. Then, in the dialog section Mirroring Plane, enter three points that define the plane. 

If a copy is created, you can influence the numbering of new objects in the dialog section 
Numbering Increment for. 

Use the [Edit] button shown on the left to open another dialog box with useful options that 
are described in chapter 11.4.1 on page 302.  
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Context menu of selected objects 

11.4.4 Project 
Use this function to project selected objects on a plane. Thus, you can adjust for example the 
inclination angle of horizontal beams or rafter members. 

Example: 

A member is projected in direction X on the plane YZ. 

 

Figure 11.82: Original member and projected copy on plane YZ 

To open the dialog box for entering the projection parameters, 

select Project on the Edit menu 

or use the context menu of the selected objects. 

 
Figure 11.83: Dialog box 3D Project - Copy 
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To maintain the original object, tick the check box for Create copy. 

In the dialog section Projection Direction, you can decide whether the objects will be projected 
in the direction of a global axis (X, Y or Z) or perpendicular to a target plane. 

The Target Plane can be defined in the following three ways: 

• The target plane runs parallel to a plane that is spanned by the axes of the global axis sys-
tem XYZ. In this case, activate the first option and select the relevant plane from the list to 
the right. Then, in the dialog section Point Coordinates of Target Plane, enter a point that 
lies in the plane set above. 

• The target plane runs parallel to a plane that is spanned by the axes of the global axis sys-
tem XYZ but is additionally rotated about one of the axes. In this case, activate the second 
option. In the list to the right, select the relevant plane and specify the axis and angle of 
rotation. Then, in the dialog section Point Coordinates of Target Plane, enter a point that 
lies in the plane set above. 

• The target plane lies anywhere in the work plane. In this case, activate the third option. 
Then, in the dialog section Point Coordinates of Target Plane, define the plane by entering 
three points. 

If a copy is created, you can influence the numbering of new objects in the dialog section 
Numbering for Increment. 

Use the [Edit] button shown on the left to open another dialog box with useful options that 
are described in chapter 11.4.1 on page 302. 

11.4.5 Scale 
Use this function to scale selected objects in relation to a point. 

Example: 

A member is equally scaled starting from the origin in all three directions by the factor 2. 

 

Figure 11.84: Original member and scaled copy 

To open the dialog box for entering the scale parameters, 

select Scale on the Edit menu 

or use the context menu of the selected objects (see figure in the margin to the left of Figure 
11.82). 
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Context menu of background layers 

 
Figure 11.85: Dialog box Scale - Copy 

When the Number of copies is set to 0, the selected objects will be scaled. Otherwise, the en-
tered number of copies will be generated. 

The dialog section Scale by manages the scaling factor k (see graphic in the dialog box). 

Three possibilities are available for selection to define the Direction of Scaling: 

Equally in X,Y,Z All object coordinates (X, Y and Z) will be scaled in relation to the 
starting point defined in the dialog section Coordinates. 

In direction: X / Y / Z You define one of the global axis. Only the object's coordinates of 
the selected global axis will be scaled in relation to the starting 
point defined in the Coordinates dialog section. 

In direction that is defined 
by two points 

In the dialog section Coordinates, specify a vector by entering 
two points. Objects will be scaled into the vector direction. 

Table 11.7: Dialog section Direction of Scaling 

If a copy is created, you can influence the numbering of new objects in the dialog section 
Numbering Increment for. 

Use the [Edit] button shown on the left to open another dialog box with useful options that 
are described in chapter 11.4.1 on page 302. 

It is also possible to scale background layers. To open the corresponding dialog box, 

point to Background Layers on the Edit menu, and then select Stretch 

or use the context menu of background layers in the Data navigator. 

In the dialog box Select Background layer, specify the relevant layer first. Then, you can define 
the scaling factor in the dialog box Stretch Background Layer. 

 
Figure 11.86: Dialog box Stretch Background Layer 
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Context menu of selected objects 

11.4.6 Shear 
The function rotates objects about an axis and adjusts only the coordinates of one single direc-
tion. You can use the shear function for example to shift horizontal members into the inclina-
tion plane of a roof. The member lengths will be adjusted, the horizontal components of the 
coordinates remain unchanged. 

Before you use the function, select the members together with the nodes that belong to them. 

To open the dialog box for entering the shearing parameters, 

select Shear on the Edit menu 

or use the context menu of the selected objects. 

 
Figure 11.87: Dialog box 3D Shearing 

In the dialog section Slope, enter the rotation angle in [°] or [%]. 

The parameters for Shearing can be defined in two ways: 

• The rotation axis runs parallel to a plane that is spanned by the axes of the global axis sys-
tem XYZ. In this case, activate the option About axis and select the relevant axis of rotation 
from the list to the right. Then, in the list In direction, select the global axis that is relevant 
for adjusting the node coordinates. Finally, in the dialog section Starting Plane, enter the 
point of rotation. 

• The rotation axis lies anywhere in the work plane. In this case, activate the second option. 
Then, in the dialog section Starting Plane, define both points of the rotation axis and an-
other point for determining the plane. You can select the points also graphically by using 
the [] buttons. 
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11.4.7 Divide Members 
Members can be divided quickly: Right-click the member and select Divide Member in the con-
text menu. 

 

Figure 11.88: Context menu Divide Member 

The menu item offers three division options. 

Graphically 

 
Figure 11.89: Dialog box Divide Member 

The dialog box Divide Member opens. When you move the pointer along the member, it will be 
snapped at the distances specified in the dialog section Step. Click to define the division point. 
The Reference of the division spacings can be set in absolute distances or relatively to the total 
length. 

It is also possible to enter the Division Spacing directly. Before, define the member that you 
want to divide in the input field Member No.. Then, enter the number of the new member in 
the input field New No.. If you want to relate the division spacing to the member end, you can 
change the member orientation with the check box Reverse orientation. 
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n Intermediate Nodes 

 
Figure 11.90. Dialog box Divide Member Using n Intermediate Nodes 

Use this function to divide the member equally into several member parts. In the dialog sec-
tion Number of, you can define the number of Intermediate nodes needed for the line division. 

In the dialog section Numbering Starts with, you can influence the numbering of new nodes 
and members. 

Distance 

 
Figure 11.91: Dialog box Divide Member Using Distance 

Use this function to generate a division node on a particular location of the member. 

Settings in the dialog section Distance Relative to control the reference of the division distance. 
The distance can be related to the real member length (normal case) or to a projection. 

The Distance Between New Node and start or end node of the member is to be specified as ab-
solute value or relatively to the total length. The four input fields are interactive. 

For entering the distance it is important to know the member orientation. The orientations 
and axis systems of members can be switched on and off in the context menu or the Display 
navigator (see Figure 4.70, page 79 and Figure 4.72, page 80). 

The dialog section Numbering Starts with controls the numbering of new objects. 
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11.4.8 Connect Members 
Use this function to connect members that cross each other but do not have a common node. 

 

Figure 11.92: Original on the left (intersecting, unconnected members) and result on the right (connected members) 

To access the corresponding function, 

select Connect Members on the Tools menu 

or use the toolbar button shown on the left. 

 
Figure 11.93: Button Connect Members 

Go into the work window and draw a window across the zone where you want to connect the 
members. It is not necessary to catch the objects completely. 

The Auto Connect function is preset for the graphical definition of new members, as shown in 
the figure below. But connection nodes will only be created when members are connected to 
other members, that means when members end on members. So, when you define crossing 
diagonals, no intersection node will be generated. 

In the New Member dialog box appearing when members are defined graphically, you can use 
the [Details] button to determine if members are connected automatically when they are gen-
erated. 

 
Figure 11.94: Dialog box New Member - Details 
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Member context menu 

11.4.9 Merge Members 
Members connected to one another can be unified to be one single member. This function is 
only available in the context menu of division nodes. Right-click the division node to open its 
context menu. 

 

Figure 11.95: Context menu items Delete Node → Merge Joined Members with result (right) 

The context menu offers extended options for the function Delete Node whereas the [Del] key 
simply deletes the selected node and consequently the joined members. But these special op-
tions are only provided for nodes to which exactly two members are connected. 

In case the members do not lie on a straight line, RSTAB will create a new member between 
the edge nodes when merging. 

11.4.10  Extend Members 
Use this function to adjust the length of a member or to extend the member until it reaches 
another one. 

To access this editing function, use the member context menu shown on the left. 

The dialog box Extend Member opens. 

 
Figure 11.96: Dialog box Extend Member 
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The dialog section Extend Method offers three options: 

• Extend to L changes the total length of the member to a dimension that you specify in the 
input field. 

• Extend by ∆ extends one member side or both member sides by a specified value, or 
shortens the side(s) if the value in the input field is negative. 

• Select To Next Member to extend the member to the nearest member that will produce an 
intersection with the extended straight line of the member. When the check box for Divide 
target member is ticked, the members will be connected automatically. 

Specify the direction of extension in the dialog section below: The option On both ends results 
in an extension at both ends of the member. With this setting you can either refer the total 
length L to the member center, or extend the member on both sides by the value ∆ or until the 
next two members are reached. Alternatively, use the options On member start i and On mem-
ber end j to adjust the length of the member on only one end. 

Use the Display navigator or the context menu of the member to display the member orienta-
tions (see Figure 4.70, page 79). 

11.4.11  Join Members 
Contrary to connecting members (see chapter 11.4.8, page 312), the function does not require 
a common point of intersection. Thus, free members available in a certain distance to a mem-
ber can be joined to the nodes of this member. However, if you want to connect the member 
by extending the member, use the function Extend Member (see chapter 11.4.10). 

To access the corresponding function, 

select Join Members on the Tools menu. 

The following dialog box appears: 

 
Figure 11.97: Dialog box Join Members 

In the dialog section Settings, enter the number of the member to whose nodes you want to 
join the free members. You can select the member also graphically with the [] function. The 
input field below specifies the distance, that means the circumference where RSTAB looks for 
free member ends. If the check box for Also select other connected members is ticked, RSTAB will 
include also members that are connected with an already selected member into the member 
list of the input field above. 

In the dialog section How to Connect Free Member Ends, you decide how RSTAB will join the free 
member ends to the selected members: You can either move them to the nodes of the select-
ed members or connect them by eccentric connections. 
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11.4.12  Insert a Node 
Use this function to create a new node between any two nodes. In this way, you do not need 
to define a member and divide it by an intermediate node (see chapter 11.4.7, page 310). 

To access the corresponding function, 

point to Model Data on the Insert menu, select Nodes and then click Node Between 
Two Points 

or use the list button [New Node] in the toolbar. 

Select the two points (nodes, grid points, any points) one after the other in the work window. 
Then, the following dialog box appears: 

 
Figure 11.98: Dialog box Node Between Two Points 

The Distance from Point can be defined in absolute or relative values. The work window shows 
you modifications immediately. To create the new node, click [OK]. 
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11.4.13  Insert a Member 
It is possible to define on an existing member a section that has different cross-section proper-
ties. The original member will be divided by two intermediate nodes. 

To access the corresponding function, 

point to Model Data on the Insert menu, then select Members and Graphically  
and click Inserted Member. 

After selecting the relevant member in the work window, the following dialog box appears: 

 
Figure 11.99: Dialog box New Inserted Member 

Define both division points by mouse clicks in the work window. A cross on the pointer posi-
tion indicates the current division point on the member. The distances shown when moving 
the pointer along the member are controlled by the input field Step. 

The x-locations of the start and end node are displayed in the input fields of the dialog section 
Inserted Member where they can be modified, if necessary. The Length of the intermediate 
member appears below. 

With the options in the dialog section Reference you decide whether the division spacings are 
related to the absolute lengths or to the relative distances from the member start. 

The Cross-section can either be accepted or assigned as a new one selected from the list of al-
ready defined cross-sections. With the buttons shown on the left you can create a [New] cross-
section or select a cross-section from the [Library]. 

The dialog section Numbering Starts with controls the numbering of new objects. 
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11.4.14  Assign Member Properties Graphically 
Use this function to transfer the definition criteria of members for cross-section, release and 
eccentricity graphically to already created members. 

To access the corresponding function, 

select Model Data on the Insert menu, point to Members and select  
Assign Member Properties to Members Graphically or 

open the Edit menu, point to Model Data and Members, and then select  
Assign Member Properties to Members Graphically. 

The following dialog box appears: 

 
Figure 11.100: Dialog box Assign Member Properties to Members Graphically 

Select the Cross-Section from the list or use the buttons shown on the left to select the cross-
section from the [Library] or to create a [New] one. If necessary, you can define the Member End 
Release with a list, but it is also possible to create a [New] release type (see chapter 4.4, page 
64). 

You can relate the Member Eccentricity to the local member axis system xyz or the global coor-
dinate system XYZ. If needed, define the eccentricity in the corresponding input fields (see 
chapter 4.5, page 70).  

With the options in the dialog section Status, you decide if a member eccentricity is removed 
(Delete) or assigned as new (Set). Choose Keep original to change only the cross-section and the 
member end release but not any existing eccentricity. 

After clicking [OK] you can see that the members are divided graphically at one-third division 
points (see Figure 4.50, page 65). Now, you can click the member sides to which you want to 
apply the selected properties (for example a release). To assign the release or the eccentricity 
to both member ends, click the member in its center. 
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11.4.15  Round Corners 
Corners in the model may result in moment peaks. To open the dialog box for modeling cor-
ners close to reality using fillet members, 

select Create Round or Angled Corner on the Tools menu. 

It is not necessary to select both members previously. The following dialog box appears: 

 
Figure 11.101: Dialog box Create Round or Angled Corner 

In the dialog section Corner Type, you decide if the corner zone will be made Round or Angled. 
Depending on the selection, you have to enter the fillet radius r or a reduction by the lengths l1 
and l2 in the dialog section Parameters. 

When rounding corners, use the dialog section Options where you can define the number of 
members n required to represent the rounding as a polygonal chain (minimum 3). If the check 
box for Delete corner is ticked, RSTAB deletes the corner nodes together with the extensions of 
the original members overlapping in the corner zone. 

Select both corner members by mouse-click in the work window without closing the dialog 
box. You can see the member numbers shown in the dialog section Create Between Members 
No. 

11.4.16 Change Numbering 
A regular, structured numbering proves to be useful for modeling as well as evaluations. How-
ever, graphical input and subsequent modifications may rearrange the numbering. 

There are three options for adjusting the order of the numbering subsequently. To access the 
corresponding functions, 

select Renumber on the Tools menu. 

Loads are no problem when changing the numbering because the assigned loading will be 
transferred automatically to the new numbers of the objects. 
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Singly 

 
Figure 11.102: Dialog box Renumber - Singly 

In the dialog section Object to Renumber, you decide whether nodes, members or other model 
objects selected from the list will be renumbered. Specify the start number of the new num-
bering as well as the increment in the dialog section Renumbering. 

After closing the dialog box with the [Close] button, you can select the relevant objects one af-
ter the other in the work window. Please note that RSTAB can allocate only free numbers that 
are not yet assigned. 

Automatically 
First, select the nodes and members (see chapter 11.2.1, page 271) whose numbering you 
want to adjust. Then, open the following dialog box. 

 
Figure 11.103: Dialog box Renumber - Automatically for nodes and members 

Specify the Priority of the global directions X, Y and Z for the new numbering. In addition, you 
have to decide if the ascending numbering will be applied in Direction of the respective posi-
tive or negative axis. 

In the example above, the nodes (as well as members) with the smallest X-coordinates receive 
new numbers first. The nodes are processed in the positive direction X. If two nodes have iden-
tical X-coordinates, the second priority decides which node will receive the lower number: This 
will be the node with the smaller Y-coordinate. The third priority will be decisive in case the Y-
coordinates are identical as well. 
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The dialog section Selected Objects controls which nodes and members will be renumbered 
and which start numbers and increments will be used for the renumbering. Already allocated 
numbers must not be assigned again. However, RSTAB allows the use of numbers that have 
been allocated before changing the numbers but will become vacant during the renumbering. 

Shift 
First, select the objects whose numbering you want to adjust. Then, open the following dialog 
box by pointing to Renumber on the Tools menu. 

 
Figure 11.104: Dialog box Renumber - Shift 

In the dialog section Selected Objects, define the objects that you want to renumber: In addi-
tion to nodes and members you can select other objects of the model in a list. In the Increment 
column to the right, you can specify a value by which the numbers of the selected objects will 
be upgraded. Use negative increments to degrade the numbering. Make sure that no number 
will be smaller than 1. 

In the dialog section Load Cases and Combinations, you can adjust the numbering of load cas-
es, load and result combinations. Specify their numbers in the form of a list entered in the col-
umns No. from and No. to. The Increment column to the right controls the value by which the 
numbers of the load objects are respectively upgraded. 

After clicking [OK] the numbers will be shifted. Please note that only free, not yet assigned 
numbers can be allocated to the various model and load objects. 
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11.5 Table Functions 

11.5.1 Editing Functions 

The editing functions are tools making the data input in tables easier (see chapter 3.4.4, page 
24). In contrast to the selection functions described in the following chapter 11.5.2, it is not 
necessary to select cells previously. The editing functions only affect the cell in which the 
pointer is placed. 

To turn the tables on and off, 

select Display on the Table menu 

or use the toolbar button shown on the left. 

Access to editing functions 
To enable the editing functions for the table, place the pointer into a table cell. To access the 
editing functions,  

point to Edit on the Table menu. 

Some editing functions are available in the toolbar of the table. 

 
Figure 11.105: Buttons for several editing functions in the table toolbar 

Alternatively, use the context menu in the table to access the functions. 

 
Figure 11.106: Editing functions in the table context menu 
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Functions and commands 

Function Effect 

Cut [Ctrl+X] Removes content of cell and saves it in clipboard 

Copy [Ctrl+C] Copies cell content to clipboard 

Paste [Ctrl+V] Inserts contents of clipboard into cell 

If the clipboard contents are bigger than the cell, the cells of the 
subsequent table columns and rows will be overwritten. A warn-
ing is displayed before. 

Copy row [Ctrl+2] Overwrites subsequent row with contents of current row 

Empty row [Ctrl+Y] 

 

Deletes contents of row without deleting the row itself 

Insert row [Ctrl+I] 

 

Inserts a new, empty row. The subsequent rows will be moved 
downwards. 

Delete row [Ctrl+R] 

 

Deletes the current row. The subsequent rows will be moved  
upwards. 

Find [Ctrl+F] Searches a number or string within the table 

Replace [Ctrl+H] Searches a number or string within the table and replaces it by 
another entry 

Empty table Deletes contents of current table completely without a warning 

Empty all tables Deletes contents of all tables  

Select [F7] Opens a list for selection in cell 

Update graphics 

 

Transfers modifications entered in table to graphic 

Edit in dialog box Opens a dialog box where data of current row can be entered. 

Table 11.8: Editing functions 
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11.5.2 Selection Functions 
The selection functions are tools making the data input in tables easier. In contrast to the edit-
ing functions described in chapter 11.5.1, you have to mark several, connected cells as a Selec-
tion first. 

 
Figure 11.107: Selection 

It is not important whether the cells are empty or filled with content. A selection function mod-
ifies the contents of selected cells altogether. 

Access to selection functions 
First, mark a selection as a block of contiguous cells in the table: Move the mouse across sever-
al cells while holding the left mouse button down. A click into a table header (A, B, C ...) selects 
the whole table column. To select the entire table row, click the row number on the left. 

To access the selection functions, 

select Selection on the Table menu. 

Some selection functions are available in the toolbar of the table. 

 
Figure 11.108: Buttons for several selection functions in the table toolbar 

Alternatively, use the context menu in the table to access the functions. 

 
Figure 11.109: Selection functions in the table context menu 
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Functions and commands 

Function Effect 

Deselect [Ctrl+D] Cancels selection of row or column 

Cut [Ctrl+X] Removes content of selected cells and saves it in clipboard 

Copy [Ctrl+C] Copies content of selection to clipboard 

Paste [Ctrl+V] Inserts content of clipboard into table 

The command is only available if the clipboard contains appropriate 
data (for example from Excel). 

Delete [Ctrl+Del] 

 

Deletes all contents of selected cells 

Add 

 

Adds value to or subtracts value from cells with numerical values 

Multiply 

 

Multiplies cells with numerical values by a factor 

Divide 

 

Divides cells with numerical values by a divisor 

Set Assigns value of topmost selected cell to all cells in selection 

Generate [Ctrl+G] Used for cells with numerical values. Generates cells between first 
and last selected cell by interpolation of both basic values (see ex-
ample below). 

Save Saves selection as file  

Import Imports selection saved as file 

Table 11.9: Selection functions 

Example: Generating cell values 

Use this function to fill empty cells quickly. The intermediate values are determined by a linear 
interpolation from the start value of the top cell (in example 6.000) and the end value of the 
bottom cell (in example 30.000). 

 
Figure 11.110: Context menu of selection 
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After the Generate function has been applied, the intermediate cells are filled with interpolated 
values. 

 
Figure 11.111: Result 

11.5.3 View Functions 
The table display can be adjusted by different view functions improving the data overview in 
the table. 

Access to view functions 
To access the view functions, select 

View on the Table menu as well as 

Optimize Load Data on the Table menu. 

Some of the view functions can be accessed in the toolbar of the table. 

 
Figure 11.112: Buttons for several view functions in the table toolbar 

Functions 

Function Effect 

Only filled rows 

 

Hides all empty table rows 

Marked rows only 

 

Shows only selected rows 

Selected objects only 

 

Shows only objects selected in graphic 

Select load and related objects 

 

In addition to loads, the associated model objects (mem-
bers, nodes, sets of members) are selected in the graphic. 
Only available in loads tables 3. 

Compress data 

 

Summarizes objects with same loads in one single table row 
in loads tables  

Decompress data 

 

Lists loads for each object individually 
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Result filter 

 

Table output can be restricted to particular result types  
(see chapter 11.5.5, page 328). 

Info about cross-section 

 

Shows characteristic values of current cross-section 

Show result diagrams 

 

Displays results of selected member graphically in new 
window (see chapter 9.5, page 208) 

Colored relation scales 

 

Switches display of red and blue bars in table on and off 

Title bar Switches title bar on and off 

Toolbar Switches toolbar on and off 

Column bar Switches column headings (A, B, C, ...) on and off 

Status bar Switches status bar of table on and off 

Highlight table row The table row where the pointer is placed is highlighted 
with colors or won't be marked. 

Table 11.10: View functions 

Example: Only filled rows 
A table contains empty rows disturbing the clear table overview. 

 
Figure 11.113: Table with empty rows 

Use the button Only Filled Rows to hide all empty rows. 

 
Figure 11.114: Table without empty rows 
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11.5.4 Table Settings 
The font and color settings used in the tables can be adjusted individually. Moreover, it is pos-
sible to synchronize the selection in the graphic with the one in the table. 

Access to table settings 
To access the setting options, 

select Settings on the Table menu. 

To activate and deactivate the synchronization of the selection, you can also use the table 
toolbar buttons. 

 
Figure 11.115: Buttons Selection Synchronization 

Functions 

Function Effect 

Colors Opens the dialog box Colors (see Figure 11.116). Colors of 
individual table objects can be adjusted separately. 

Fonts Opens the dialog box Font (see Figure 11.116). Font, style 
and font size can be modified globally for all table objects. 

Select current object in graphic 

 

Function is set active by default: Object of table row where 
pointer is placed is selected also in work window. 

Show selected object in tables 

 

Function is set active by default: Objects selected in work 
window are highlighted with colors also in table. 

Table 11.11: Table settings 

  
Figure 11.116: Dialog boxes Colors and Font 
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11.5.5 Filter Functions 
Various filter functions allow you to evaluate specifically internal and contact forces as well as 
deformations in the member results tables. In addition, filter options are available for nodal 
support forces of result combinations (see chapter 8.4, page 194). 

Access to filter functions 
To access the filter functions, 

point to View on the Table menu and select Result Filter 

or use the button in the table toolbar shown on the left. 

 
Figure 11.117: Button Result Filter 

The following dialog box appears: 

 
Figure 11.118: Dialog box Table Filter 

Select the relevant results table in the dialog section Tables to Display. Then, use the dialog tab 
on the right to determine which values will be shown numerically. 

When the table for internal forces of members is set, you can define for Load Cases / Load Com-
binations and Result Combinations separately whether Nodal values (member start and mem-
ber end), Member division values (intermediate points of user-defined member division, see 
chapter 4.6) and Extreme values of members are shown in the table. You have to tick at least 
one of the six check boxes for internal forces. The selected internal forces are shown on the  
locations of the result values that are activated by a check mark above. 

Two result values appear on each location for result combinations – the minimum and maxi-
mum internal forces with the corresponding internal forces. 
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Use the buttons shown on the left to transfer the filter criteria from one dialog section to the 
other. 

Example: 
A member division with two intermediate points has been defined for member 11 that has a 
length of 6.70 m. The filter settings for result combinations shown in Figure 11.118 result in the 
following results table 4.1 Members - Internal Forces. 

 
Figure 11.119: Results filtered by nodal values, division points and extreme values My 

Table column H shows the maximum and minimum bending moments My on the nodes and 
division points as well as locations of the absolute extreme values in bold. The latter appear 
with a capitalized initial letter as Max My and Min My at the end of the list (see marked cells in 
figure above). The values in the remaining columns represent the corresponding internal forc-
es of the respective maximum and minimum values. 

11.5.6 Import and Export of Tables 
A table from MS Excel or Open Office.org Calc can be imported directly into the current RSTAB 
input table. The programs involved must be opened. It is also possible to export the current 
RSTAB table all or part to Excel or Open Office.org Calc. 

Access to import and export function 
To apply the import or export function, click the button [Export/Import Table] in the table tool-
bar. 

 
Figure 11.120: Button Export/Import Table in the table toolbar 

Use this button to open the Export table and Import table dialog box (see figures below). 
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Figure 11.121: Dialog box Import table 

 
Figure 11.122: Dialog box Export table 

Import table 
The workbook from MS Excel or OpenOffice must have been opened before the import starts. 
If headers exists in the worksheets, tick the check box for Including table header. Then, the 
headers will be ignored during the import. Only the lists will be imported into the RSTAB ta-
bles. 

In the dialog section Application, you can select between the spreadsheets of Microsoft Excel 
and OpenOffice.org Calc. 

The dialog section Transfer Parameters specifies whether the active workbook or only the ac-
tive worksheet will be imported. When you import a complete workbook, the order and struc-
ture of worksheets must be completely consistent with the RSTAB tables. 

In the dialog section Formulas and Parameters, you can decide if formulas stored in Excel or 
OpenOffice will be imported as well when exchanging data. 

Click [OK] to start the import. 

If you want to import only particular parts of the worksheet, the copy function is recommend-
ed: Select the relevant area in the Excel table and copy it to the clipboard with [Ctrl]+[C]. Then, 
place the pointer into the corresponding cell of the RSTAB table and insert the contents of the 
clipboard with [Ctrl]+[V]. 
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Export table 
To export RSTAB tables, MS Excel or Open Office.org Calc do not need to run in the back-
ground. 

In the dialog section Application, you can select between the spreadsheets Microsoft Excel and 
OpenOffice.org Calc. In addition, it is possible to create a file in the general spreadsheet CSV 
(see chapter 4.3, page 63). 

In the dialog section Table Parameters, specify if the headers will be exported, too. When the 
check box for Export table header is ticked, the result in Excel looks like below: 

 
Figure 11.123: Excel table with exported headers 

When you clear the check box, only the table contents will be transferred to Excel. 

With the option Only marked cells, you can export selected table contents (see chapter 11.5.2, 
page 323). 

Use the check box for Only selected objects to export data or results of selected row numbers. 
The selection is made easier by the synchronization of the selection between graphic and ta-
ble (see chapter 11.5.4, page 327). 

The option Only filled rows controls the way how empty rows are treated for the export. 

In the dialog section Transfer Parameters, you can define the target tables where data will be 
written. When the first check box is clear, RSTAB will create a new workbook. With the option 
Export table to active worksheet it is possible to use the current worksheet of the spreadsheet. If 
the check box for Rewrite existing worksheet is ticked, RSTAB will search in the workbook for a 
table with the same name as in RSTAB and will overwrite it then. 

Using the check boxes in the dialog section Formulas and Parameters, you can decide if and 
how formulas saved in RSTAB will be exported. 

To start the export of the current RSTAB table, click [OK]. 

To transfer several tables all at once to Excel or OpenOffice.org Calc, it is recommended to se-
lect Export on the File menu (see chapter 12.5.2, page 401). Then, you can select the relevant 
tables in a dialog box. 
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11.6 Parameterized Input 

11.6.1 Concept 

The parameterized input for model and load data makes use of variables (for example length, 
width, traffic load etc.) which are called "parameters" and stored in a parameter list. 

The parameters can be used in formulas to determine a numerical value. The formulas are ed-
ited in the Formula Editor. If a parameter is modified in the parameters list, the results of all 
formulas using this parameter will be adjusted. 

The parameterized input is useful for projects where many changes are expected. The stored 
formulas are easy to follow and bring more clarity to complex models. The parameter-con-
trolled input is also quite suitable when editing recurring models that are similar in design: 
Simply open a template file and adjust the parameters. 

11.6.2 Parameter List 
The parameter list manages all parameters required for modeling. 

Access to parameter list 
To access the parameter list, click the [Edit Parameters] button: 

• in the toolbar of an input table 

 
Figure 11.124: Button Edit Parameters in the table toolbar 

• in the Formula Editor. 

 
Figure 11.125: Button Edit Parameters in the Formula Editor 

Description 
The dialog box Edit Parameters appears. 
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Figure 11.126: Dialog box Edit Parameters 

Each table row manages a Parameter. In column A, enter a name that consists of ASCII signs. 
The name must not contain any spaces. The description is used to refer to the parameter in the 
formulas. Each parameter name can be assigned only once. 

In table column B, define the Unit Type to determine if the parameter represents a length, load, 
density etc. The unit types are predefined. To access the selection list available in the column, 
use the context button [] or the keyboard key [F7]. 

In column C, define the numerical Value of the parameter. 

Specify the Unit in table column D. To access the selection list of units available in the column, 
use the context button [] or the keyboard key [F7]. 

In column E, you can enter a Formula to determine the value of the parameter for table column 
C. In addition to common mathematical operations, IF-THEN statements and max/min func-
tions are available. With the $-reference you can refer to a particular table (for example 
$1.1(A1) uses the value of cell A1 from table 1.1). 

Examples: 

if(A<B;10;B) If parameter A is smaller than parameter B, the value 10 is applied.  
Otherwise, parameter B will be used. 

max(A;B) The larger value of both parameters A and B will be applied. 

min(max(A;B);C) The larger value of parameters A and B is determined which will then 
be compared to the value of parameter C. The smallest value will finally 
be applied. 

Use the button [...] in table column E to access a List of operators and functions. 
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Figure 11.127: Dialog box List of operators and functions 

In table column F, you can define a Range of Values to control the values of column C. 

Column G is reserved for entering any Comment. 

Input functions 
The parameters can be entered cell by cell. 

Several tools for efficient input are available in the context menu that you open with a click of 
the right mouse button. The editing functions (empty row or insert row, replace etc.) are de-
scribed in chapter 11.5.1 on page 321). 

When several cells are marked as a selection, the following context menu appears. 

 
Figure 11.128: Context menu of a selection in parameter list 

Find a description of the menu functions in chapters 11.5.1 and 11.5.2, page 321. 
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Buttons 
In addition to the default buttons, the following functions are available in the parameter list. 

Button Description 

 
Saves parameter list in a file 

 
Loads a saved parameter list 

 
Exports parameter list to MS Excel 

 
Imports data from opened Excel table 

 
Opens calculator and imports its result 

 
Deletes entire contents of parameters list 

 
Shows cross-section details of cross-sections used in model 

Table 11.12: Dialog box Edit Parameters: Buttons 

11.6.3 Formula Editor 
The Formula Editor manages the equations of the parameterized input. 

Access to Formula Editor 
To open the Formula Editor, 

• use the button in the table toolbar shown on the left 

 
Figure 11.129: Button Edit Formulas in the table toolbar 

• click the yellow or red corner of the table cell (a red corner indicates an error in the formula) 
or 

 
Figure 11.130: Marked cell corners in table 1.1 Nodes 

• use the function buttons next to the input fields in dialog boxes (see Figure 11.135). 

 
Figure 11.131: Function buttons with context menu in dialog box Edit Node 
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It is also possible to import formulas saved in Excel and to export formulas from RSTAB to Excel. 
For more information about the data exchange with Excel, see chapter 12.5.2 on page 401. 

Description 

 
Figure 11.132: Dialog box Edit Formulas 

In the input field Formula, any formula can be entered manually. When you use the calculator, 
its results will be transferred automatically. 

The formula may consist of constant numerical values, parameters or functions. The result of 
the equation appears in the field below. Use the button [] at the end of the Formula line to 
select an entry from the list of already entered formulas. 

Click the button [] to apply the formula to the table cell or input field of the dialog box. De-
lete the formula line with the [] button. In case of misentries, formulas are displayed red in 
the Formula input field. 

Contents of other cells can be used in formulas by means of references. 

 
Figure 11.133: Formula Editor with a reference 

A reference is introduced by an exclamation point (!). The reference cell is set in brackets. As 
shown in the figure above, the content of cell D3 is three times the value of cell D2. 

By means of a prefixed equal sign you can enter formulas also directly into table cells (for ex-
ample =2.5*PI). If values are used (for example =22.1 + A*H), they are integrated in SI units 
with [m] or [N] into the formula. 
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The following functions are available in the calculator of the Formula Editor: 

Function Description 

 Sine 

 Cosine 

 Tangent 

 Cotangent 

 Square root 

 Power 

 Natural logarithm 

 Logarithm to the base 10 

 Absolute value 

 Integer, for example int(5.638) = 5 

 Clear formula line 

 Inverse, for example inv sqrt(5) means 52 

 Hyperbolic function 

Table 11.13: Calculator functions 

The dialog section List of Parameters in the Formula Editor lists all parameters with the current 
values. To transfer a particular parameter to the Formula line, double-click the entry, or select 
the entry and use the button [Apply Selected Parameter] shown on the left. 

Click the [Edit Parameters] button (see chapter 11.6.2, page 332) to open the parameter list 
where you can modify or complete the parameters. 

Buttons 
The buttons available in the Formula Editor are reserved for the following functions: 

Button Description 

 
Applies formula to table cell or dialog field 

 
Deletes formula input 

 
Saves contents of Formula Editor as a file 

 
Loads a saved file 

   Displays or hides calculator and parameter list 

Table 11.14: Dialog box Edit Formulas: Buttons 
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11.6.4 Formulae in Tables and Dialog Boxes 
The equations stored in the Formula Editor can be used in both the cells of tables and the in-
put fields of dialog boxes. As tables and dialog boxes are interactive, you can access the formu-
las in both input modes. 

Formulas in tables 
When cells are marked by a yellow or red flag (triangle) in the upper left corner, a formula has 
been linked (see Figure 11.130, page 335). Click the flag to open the Formula Editor. 

To link a "normal" cell with a formula, place the pointer into the cell and open the Formula Edi-
tor by using the button shown on the left. 

 
Figure 11.134: Button Edit Formulas in the table toolbar 

A red flag means that there is an error in the definition of the formula. This flag corresponds to 
the red formula line in the Formula Editor. It is recommended to correct the formula. 

Formulas in dialog boxes 
The parameterized input has been developed primarily for the application in tables. However, 
it is also possible to use formulas in dialog boxes. 

A function button to the right of the input fields in dialog boxes indicates that they can be 
linked with formulas. 

 
Figure 11.135: Dialog box with linked formula and function button 

When the input field has already been linked with a formula, it is marked like a cell by a yellow 
flag (or red flag in case of incorrect input). 

Click the function button to open the context menu shown in Figure 11.131 on page 335 
where you can access the Formula Editor. 
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11.7  Model Generators 
A variety of tools help you to create models or parts of structural systems. In addition to copy 
and extrude functions, RSTAB provides special dialog boxes for generating member models. 

11.7.1 Copies and Extrusions 

11.7.1.1 Set Parallel Member 

It is easy to copy selected members graphically: Move the objects to the desired place in the 
workspace by holding down the [Ctrl] key. The function follows the general standards for Win-
dows applications. 

If you want to create parallel members, you can enter specific settings in a dialog box. To ac-
cess the corresponding function, 

select Set Parallel Member on the Tools menu 

or use the context menu of the member (see Figure 4.72, page 80). 

 
Figure 11.136: Dialog box New Parallel Member with Offset 

The selected member appears in the List of Members. If necessary, other members can be add-
ed by clicking them in the work window. All members of the list must lie in one plane. 

In the dialog section Offset Distance, you specify the copy's distance to the original. 

When several members are copied by parallel offset, you have several possibilities offered in 
the dialog section Outer Corners to adjust the copied members. The figure above shows the 
copied members (represented without axes) extended to the common point of intersection. 
Moreover, both ends are connected with the original members by the ticked check box Close 
ends. 

The settings in the dialog section Offset Direction define the side on which the members will be 
copied. The directions +y and -y are directly displayed in the work window. They are especially 
used for this dialog box and do not depend on the currently set work plane. Thus, they do not 
necessarily reflect the member axes. Due to the input field Rotation about x, it is possible to 
copy the objects out of the plane. 
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11.7.1.2 Extrude Member into Grid 

By extruding members you can quickly create grids or grillages. But if you want to generate an 
irregular grid using extended specifications, it is recommended to use the dialog box Generate 
Grid (see chapter 11.7.2, page 344). 

To access the corresponding function, 

select Extrude Member into Grid on the Tools menu 

or use the context menu of the member (see Figure 4.72, page 80). 

 
Figure 11.137: Dialog box Extrude Member into Grid 

The selected member appears in the List of Members. If necessary, other members can be add-
ed by clicking them in the work window. All members of the list must lie in one plane. 

In the dialog section Parameters of Perpendicular Members, enter the cross-section of the verti-
cal members and the depth as the value for the total height of the grid. Optionally, specify an 
eccentricity in order to connect the members by eccentric connection (see chapter 4.5, page 
70). 

Settings in the dialog section Number of Member Divisions control the division into a uniform 
grid consisting of parallel and vertical members. Furthermore, you have the Option to do with-
out the generation of external vertical members. 

In the dialog section Extrude in Direction, define the global or local direction where grid mem-
bers will be created. The input field Rotation about x allows for copying objects out of the 
plane. 
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11.7.2 Model Generators 
To access the dialog boxes for creating model objects, 

select Generate Model on the Tools menu. 

 

Figure 11.138: Menu Tools → Generate Model 

In the following, the functions are described in detail. However, you won't find a detailed de-
scription of the single generator dialog boxes. The dialog graphics illustrate the parameters 
adequately. 

Each dialog input can be saved as a template and reused later. Both buttons shown on the left 
are used to save and load the generator data. 
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Continuous beam 

 
Figure 11.139: Dialog box Generate Continuous Beam 

RSTAB creates a continuous beam with uniform cross-section, supports and irregular spans. 
Optionally, load cases and result combinations are created, too. 

2D frame 

 
Figure 11.140: Dialog box Generate 2D Frame 

Before you enter geometrical data and cross-section properties, select the Frame Type. The 
columns of the planar frame receive equal support conditions. 
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Tapered 2D frame 

 
Figure 11.141: Dialog box Generate Tapered 2D Frame 

The planar frame must be defined by its Geometry and Cross-Sections. You can create tapers, 
craneway consoles and eccentric connections. Loads can be generated additionally. The [Set-
tings] buttons offer you access to the generator parameters. The Frame location is important 
for the load determination. 

 
Figure 11.142: Dialog box Settings - Wind Loads 
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2D truss 

 
Figure 11.143: Dialog box Generate 2D Truss 

First, define the Type of the truss and the arrangement of the Diagonals. Then, you can define 
the Parameters, Cross-Sections and Member Types. 

Grid 

 
Figure 11.144: Dialog box Generate Grid 

Use this generator to create models that have a uniform grid (for example gratings). They don't 
need to be designed with right angles as shown in the dialog graphic above. Any kind of spa-
tial quadrangle model with four corner points is possible. To generate a "real" girder grillage, it 
is recommended to set the Type of Model to 2D - in XY in the model's General Data dialog box 
(see chapter 12.2, page 386). 

To generate irregular grids, use the button [Edit Advanced Settings] shown on the left. 
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Column 

 
Figure 11.145: Dialog box Generate Column 

In the dialog section Type, you decide whether a center or corner column will be generated. In 
case you want to generate Loads, you have to specify their Effective Widths and Correction Fac-
tors. For generating a gable column the Span a is required for the influence range in the longi-
tudinal direction of the hall. The factors f1 and f2 are used to scale the geometric widths b1 and 
b2 for the structural model, or to consider special standard requirements (for example load in-
crement factors for individual designs). 

Roof generators 
The menu item Roof provides three roof generators which you can select to generate planar 
roof systems including loads (see figures below). 

The [Settings] buttons available in the roof dialog boxes help you to determine wind and snow 
loads (see Figure 11.142, page 343). 
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Collar roof 

 
Figure 11.146: Dialog box Generate Collar Roof 

Rafter roof 

 
Figure 11.147: Dialog box Generate Rafter Roof 
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Purlin roof 

 
Figure 11.148: Dialog box Generate Purlin Roof 

Fish-bellied girder 

 
Figure 11.149: Dialog box Generate Fish-bellied Girder 

For the generation of fish-bellied girders commonly used in timber construction the rectangu-
lar and ITS cross-section types (symmetric I-beams) are available for selection in the Cross-
section type list. 
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3D frame 

 
Figure 11.150: Dialog box Generate 3D Frame 

Use this generator to create regular frame models. The columns of the frame receive equal 
support conditions. 

3D hall 

 
Figure 11.151: Dialog box Generate 3D Hall 

This complex generator creates a complete hall including loads. Four dialog tabs are provided: 
Geometry/Supports manages the system geometry, Partitioning/Bracing controls irregular grid 
spacings and the arrangement of bracings. In the remaining two tabs, the Cross-Sections and 
Loads are defined. 
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3D truss 

 
Figure 11.152: Dialog box Generate 3D Truss 

Use this generator to create a spatial load-bearing structure according to the Bernauer system 
(www.raumtragwerke.de). 

3D cell 

 
Figure 11.153: Dialog box Generate 3D Cell 

http://www.raumtragwerke.de/englisch/basicidea/grundgedanke.html
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The generator creates a spatial cell with several fields. Use the button [Edit grid spacing and 
openings] to open another dialog box where you can define openings as well as the grid ar-
rangement for irregular field spacings. 

Stairway 

 
Figure 11.154: Dialog box Generate Stairway 

In the list, select the Type controlling the remaining parameters. 

Spiral stairway 

 
Figure 11.155: Dialog box Generate Spiral Stairway 
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Straight line 

 
Figure 11.156: Dialog box Generate Straight Line 

This function allows for generating straight lines based on new or already existing nodes. It is 
also possible to create only nodes placed on an imaginary straight line.  

Arc 

 
Figure 11.157: Dialog box Generate Arc 

First, define the Type of Arc: circle, parabola, hyperbola or catenary. Points A and B represent 
both edge nodes of the arc, point C determines its arrangement. The Arch rise defines the sag. 
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The length of a catenary is defined by the parameter L. The heights h1, h2 and h3 are interactive 
values. The Parameter describes the constant a in the following equation of the catenary curve: 

y
x v

a
vx

cosha)x(y +





 −

⋅=  where vx or vy : displacements in x or y 

Equation 11.1 

The larger the number of members is, the more precisely the arc will be modeled as a polygonal 
chain. 

Circle 

 
Figure 11.158: Dialog box Generate Circle Arc 

The circle or circle arc is defined by Radius and angles. The object will be created around a cen-
ter point that can be selected anywhere in one of the global planes. 

Sphere 

 
Figure 11.159: Dialog box Generate Sphere 

The larger the Number of planes and meridians is, the rounder the shape of the sphere will be. 
Polygonal chains approximate the spherical form with each member representing a segment. 
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Bracing in cells 

 
Figure 11.160: Dialog box Generate Bracing in Cells 

Cells are defined by four corner nodes, enclosed by members on all sides and placed in one 
plane. In the generator dialog box, specify the Members of Bracing and the Cells for Bracing. You 
can also use the [] function to select them in the work window by clicking the cell crosses. 

Furthermore, Virtual lines make it possible to close cells so that bracings can be created as well 
for example between wall supports. 
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11.8 Load Generators 
The second group of generators helps you to apply member loads: On the one hand, it is pos-
sible to convert area loads (for example snow, wind) acting on the structural system into mem-
ber loads. On the other hand, you can convert free line loads and coating loads due to frost in-
to member loads. 

To open the dialog boxes for generating member and area loads, 

select Generate Loads on the Tools menu. 

11.8.1 General Features 

Settings for load generation 
Many generator dialog boxes offer you the [Settings] button (see Figure 11.167, page 357) that 
opens the dialog box Settings for Load Generation used to control the tolerance for the integra-
tion of nodes in the load plane and to correct the generated loads. 

 
Figure 11.161: Dialog box Settings for Load Generation via Plane 

Specifications in the settings dialog box are valid for all member load generators. The Tolerance 
determines the conditions under which members or nodes are considered to be belonging to a 
plane or line. Settings are possible by entering an angle or a distance. If nodes are lying within 
the defined thresholds, RSTAB will recognize the cells and generate loads. 

The dialog section Correction of Generated Loads allows for a comparison of the available area 
loads with the determined member loads. The check sums are displayed in the dialog boxes 
that appear after load generation and before the final conversion into member loads will be 
performed (see Figure 11.171, page 360). In case of minor differences, it is recommended to 
correct the distribution according to the moment equilibrium. 

The following applies: 

( ) ∫∫ =+
cellcell SL

correctmember qdSdLqq  Equilibrium of forces 

( ) ∫∫ =+
cellcell SL

correctmember qrdSrdLqq  Moment equilibrium 

where    r = (x, y)  Distance to centroid of cell 
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When correcting the generated loads according to the moment equilibrium the moment is 
formed from the area loads to the centroid and then compared with the moment from the 
member loads to the centroid. As a simplification, you may imagine the moment correction to 
be a recalculation of the support forces. This support force will then be applied as line load to 
the member. Take advantage of this correction option to create for example trapezoidal mem-
ber loads from variable area loads. 

Settings in the dialog section Usage of Non-loaded Members for Cell Generation primarily con-
cern members that lie in an inclined position within the model. In the course of the load gen-
eration, the total area to be loaded will be determined first. Then, RSTAB finds out which mem-
bers are enclosing cells. Next, the cells are subtracted from the total area. When excluding a 
member from the loading (option Remove Influence from members, see below), RSTAB will re-
locate its load to the remaining members of the plane or cell. 

Now, the three options are explained by an example of a platform construction. We want to 
apply only traffic loads to members running in direction X. Like the Y-parallel members the  
inclined member is excluded from the load application, but depending on the setting it does 
affect the creation of member loads. 

 
Figure 11.162: Platform construction with cells for load generation 

• Do not use any member: 
The load is applied uniformly to the edge members and the intermediate members. With 
this setting all excluded members are ignored, which means applied internally for load 
distribution. After calculating the cell area, the load is distributed to the allowed members 
of the cell. 

 
Figure 11.163: Result for Do not use any members 
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• Use all members: 
All unloaded members are excluded for the load generation. There is still a small problem 
in the load distribution because of the large, generated cell 2. 

 
Figure 11.164: Result for Use all members 

• Use members parallel to boundary: 
In this way, it is possible to exclude members lying in an inclined position. If the limit  
angle between members φb is restricted to 40.55° in the Settings dialog box (see Figure 
11.161, page 354), the load will be generated as expected. 

 
Figure 11.165: Result for Use members parallel to boundary 

Modify generated loads subsequently 
After confirming a generator dialog box you find the generated loads transferred to load table 
3.5. The additional entry Generated Loads appears in the Data navigator (see Figure 6.29, page 
162). The generator parameters won't be lost because the original dialog boxes remain acces-
sible as input objects for changes. To open the initial dialog box again, double-click one of the 
entries in the navigator. You can also double-click a generated load in the work window. The 
original dialog box appears where you can adjust the parameters. 

But if you want to treat the generated loads as isolated load objects, you have to release the 
loads from the overall concept and split them into their components. Access to this function is 
available in the load context menu that you open by right-clicking a generated load. Select 
Disconnect Generated Load in the context menu to create the individual loads (see figure be-
low). 
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Figure 11.166: Context menu of generated load 

You can also use the context menu of the generated load in the Data navigator. 

11.8.2 Member Loads from Area Loads 

11.8.2.1 Member Loads From Area Load via Plane 

 
Figure 11.167: Dialog box Convert Area Loads to Member Loads via Planes 

Area load direction 

Decide whether the load acts perpendicular to the plane or globally related to the real or pro-
jected area. The dialog graphic in the right corner illustrates the selected load direction. 
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Member load direction 

The generated member loads can be set to be global or local loads (see chapter 6.2, page 153). 
The difference is especially significant for non-linear calculations. 

Area of load application 

You have two selection options. Select Full closed plane when a surface exists in the load plane 
between the members (for example wall or roof surface) which is not represented in the RSTAB 
model. In this case, RSTAB converts the area load that acts on the entire plane to the members. 
But if the construction consists only of members (for example lattice tower), select the option 
Empty, on members only. Then, RSTAB charges only the effective or projected area that is pro-
vided by the member cross-sections as "load application surface". The load will be applied in 
consideration of the member orientation. 

Load distribution type 

You decide how the area load components will be assigned to the members. Select Axes of  
angles for polygons that do not have a reflex angle. The intersection points of the bisecting 
lines will be connected in such a way that application areas are created as shown in the picture 
on the left. In this way, it is possible to distribute the area load clearly to the members without 
ambiguity. 

The angle axes method is not applicable for planes with reflex angles or for polygons. In such 
cases, set the load distribution type to Constant. In addition to the angle bisectors, RSTAB will 
also determine the centroid of the plane. If the intersection points of the bisecting lines lie in 
front of the centroid, triangular application areas will be generated. If they lie behind the cen-
troid, a line that is parallel to the member will be drawn through the centroid, forming an ap-
plication area with both angle bisectors. 

 
Figure 11.168: Load distribution type Constant 

Using this method results in the fact that areas are either not taken into account or applied 
twice. The missing or remaining amount will be multiplied by a constant so that the sum of the 
area and member loads is equal. 

The Combined option determines the application areas of triangles, quadrangles and polygons 
according to the angle axes method, where possible. If the method cannot be used, RSTAB 
switches automatically to the constant load distribution. Therefore, the combined method is 
set by default; RSTAB will select the appropriate method automatically. 

Area load distribution 

The load can act on the area as Uniform or Linear variable load. It is also possible to define area 
loads acting freely Varying in direction of a global axis (for example height-dependent wind 
load). Use the [Edit] button to open a dialog box where you can define the load parameters as 
a function of the height levels. 
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Figure 11.169: Dialog box Varying Area Load 

In the left table column, enter the global ordinates of the Level. Assign the respective values of 
the Area Load to the right. The graphic illustrates the current state of input. 

When freely variable loads are set, you have to select the correction of the distribution accord-
ing to the moment equilibrium in the Settings dialog box (see Figure 11.161, page 354). Other-
wise, constant member loads will be generated. 

Area load magnitude 

When the load acts uniformly on the area, enter the load value into the enabled input field. For 
linearly variable loads specify three node numbers with the respective loads. You can also use 
the [] function to select the nodes graphically in the work window. 

Boundary of area load plane 

The boundary is set by the corner nodes of the plane. Use the [] function and click the rele-
vant nodes one after the other in the work window. The plane will be marked in the selection 
color. The completely entered plane will appear in cyan color. At least three nodes are required 
for defining a plane. The area does not need to be enclosed by members on all sides. 

It is possible to define different planes which appear then in the list Corner nodes. 

If the dialog box is opened repeatedly, the last entered planes may be preset in the Corner 
nodes list. To avoid assigning double loads unintentionally to these planes, it is recommended 
to empty the list in this case with the button [Delete all area load planes]. 

Remove influence from 

In the dialog section Remove Influence from, you can exclude members from the load applica-
tion (for example purlins or bracings). The selection is carried out member by member or by 
entering a member template that is parallel to the load-free members. Again, it is recom-
mended to use the [] function for graphical selection. 

Click the [Settings] button shown on the left to open the dialog box Settings for Load Genera-
tion (see Figure 11.161, page 354). Then, you can adjust the tolerance for the integration of 
nodes in the load plane or correct the generated loads. 

Use the button [Assign load correction factors] to scale the loads for particular members. In 
this way, you can consider for example the effects of continuity of a roof sheathing on the 
edge rafters in order to generate reduced member loads there. The following dialog box 
opens. 
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Figure 11.170: Dialog box Assign Correction Factors to Members 

Use the [] buttons to select the members in the work window. Then, you can scale them  
with a Factor. 

Click [OK] to start the generation of member loads. An overview appears with information 
about the cells and loads. 

 
Figure 11.171: Dialog box Info About Conversion of Area Load to Member Loads 

If inadmissible cells are listed, RSTAB was not able to assign the loads without ambiguity. Use 
the eye button [Show Current Inadmissible Cell] to highlight the cell in the graphic. To show a 
list of reasons why the cells are invalid, click the [Info] button. Often, removed borders of the 
cell (that means edge members excluded from load application) or crossing members that are 
not connected are responsible for problems occurring when converting loads. 

In the dialog section Total Moment to Origin, the determined member loads are compared with 
the applied area loads. In case of differences, you can use the [Back] button to access the initial 
dialog box where you can change parameters. Specifications are to be adjusted in the dialog 
box Settings for Load Generation (see Figure 11.161, page 354) that you can access by using the 
[Settings] button. 

The buttons at the bottom left in the info window are reserved for the following functions: 

Button Description 

 
The dialog box Convert Area Loads to Member Loads opens again and you can adjust 
the generation parameters. 

 
RSTAB shows you the work window where you can change the view (view mode).  
To return to the Info window, right-click into the work window or use the [Esc] key. 

Table 11.15: Buttons in Info window for converted member loads 
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11.8.2.2 Member Loads From Area Load via Cells 

 
Figure 11.172: Dialog box Convert Area Loads to Member Loads via Cells 

This dialog box is similar to the dialog box Convert Area Loads to Member Loads via Planes de-
scribed on page 357. RSTAB already checks the existence of cells in the model when opening 
the dialog box. Available cells are represented by cell crossings. Cells are zones defined by 
three or more corner nodes, enclosed by members on all sides and placed in one plane. 

The load generator via cells cannot be used for wind loads, for example on a hall wall with col-
umns: RSTAB does not recognize any cells because members are missing between the foot-
ings. In such a case, you can create Virtual lines by clicking the start and end node using the [] 
function. In this way, cells are closed artificially and can be recognized by the generator. 

The Nodes of cell can be selected with [] one after the other in the graphic. After the genera-
tion an overview with information about cells and loads appears. 

Click the [Settings] button shown on the left to open the dialog box Settings for Load Generation 
(see Figure 11.161, page 354). Then, you can adjust the tolerance for the integration of nodes in 
the load plane or correct the generated loads. 
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11.8.3 Other Loads 

11.8.3.1 Member Loads from Free Line Load 

 
Figure 11.173: Dialog box Convert Free Line Load to Member Loads 

Use this dialog box to define free line loads for example for girder grillages in order to prorate 
the loads to the members. 

The correct load assignment requires specifications for Line Load Direction and Member Load 
Direction, where applicable. These dialog sections as well as the option for Remove Influence 
from is described for the function "Member Loads From Area Load via Plane" on page 357. 

The Line Load Magnitudes can be defined constantly or linearly. The Line Load Position can be 
defined graphically with the [] function by clicking the start and end node. If the line load is 
directed perpendicular to the plane, enter the help node C additionally. 

Click the [Settings] button shown on the left to open the dialog box Settings for Load Generation 
(see Figure 11.161, page 354). 

11.8.3.2 Member Loads from Coating 

 
Figure 11.174: Dialog box Convert Coating Load to Member Loads 
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Members with Coating Load can be entered directly or determined graphically with []. The Coat-
ing is to be defined by the thickness and the specific weight. 

Use the [Info] button shown on the left to check the coating areas AS of the selected member 
cross-sections to be applied for determining the ice load. The areas are related to the center 
lines of the ice load as shown in the dialog graphic (Figure 11.174). Thus, loads will be deter-
mined correctly even for small cross-sections with many edges. 

11.8.3.3 Loads from Movements 

 
Figure 11.175: Dialog box Generate Loads from Movements 

The generator creates loads as a result of an acceleration acting on particular members. The 
mass is determined from the self-weight. 

In the dialog section Objects with Load, enter the numbers of the relevant members. You can 
select them also graphically with the [] function. 

Specify the acceleration in the dialog section Vector of acceleration. You can also use the but-
ton shown on the left to [Open] a separate dialog box where the acceleration can be deter-
mined from the velocities available on two points. 

In the dialog section Definition of the vector of acceleration, you decide if the vector is related to 
a global axis or defined by two points. The vector can be defined graphically by using the [] 
buttons. 

Click [OK] to create the loads for the currently set load case. 
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11.8.4 Snow Loads 

11.8.4.1 Flat/Monopitch Roof 

 
Figure 11.176: Dialog box Generate Snow Loads - Flat/Monopitch Roof 

Flat and monopitch roofs are managed together in one dialog box. The shape coefficients for 
flat roofs or roofs with one-sided inclination are taken into account according to EN 1991-1-3 
and DIN 1055-5. 

First, define the standard and, if necessary, the national annex in the dialog section Snow Load 
Parameters. The setting controls the input fields enabled for access. 

Use the [Info] button to open a map where the snow load zone Z can be selected graphically. 
Based on your specifications, RSTAB determines the characteristic value of the snow load sk on 
the ground, taking account of the altitude A (see level). 

Use the three check boxes in the dialog section Additional Snow Loads to decide if other snow 
loads are considered: 

• Snow accumulations because of snow drift 
• Snow overhang on eaves 
• Snow loads on snow guards 

Use the [Edit] buttons to define the parameters for snow overhang and snow guard. 

If required, you can adjust the exposure coefficient Ce (EN 1991-1-3, table 5.1) as well as the 
thermal coefficient Ct (EN 1991-1-3, clause 5.2 (8)) in the dialog section Coefficients. 

Define the Roof Geometry by means of the roof corner nodes A to D in accordance with the dia-
log graphic. You can also use the [] function to determine them graphically in the work win-
dow. The plane will be marked in the selection color. At least three nodes are required for de-
fining a plane. The area does not need to be enclosed by members on all sides. 

The Position of Drifted Snow Load can be defined by the edge nodes of the roof area. 
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In the dialog sections Load Case to Generate and Load Case for Drifted Snow Load, you specify 
the load case numbers for the load generation. Snow load cases can be created with the [New] 
button. 

The dialog sections Load Distribution Type and Remove Influence from are described for the 
generator function "Member Loads From Area Load via Plane" on page 358. 

Click the [Settings] button shown on the left to open the dialog box Settings for Load Genera-
tion (see Figure 11.161, page 354). 

Use the button [Assign load correction factors] to scale the loads for particular members. Spec-
ifications will be entered in a separate dialog box (see Figure 11.170, page 360). 

After confirming the generator dialog box with [OK], RSTAB shows you the results of the load 
generation for all load cases in an overview. Thus, the acting area loads can be compared with 
the converted loads. Before the loads are transferred to RSTAB, you can click the [Back] button 
to access the initial dialog box where you can change the parameters of the loads. 

11.8.4.2 Duopitch Roof 

 
Figure 11.177: Dialog box Generate Snow Loads - Duopitch Roof 

First, define the standard and, if necessary, the national annex in the dialog section Snow Load 
Parameters. The setting controls the input fields enabled for access. 

Specify the parameters as described in the previous chapter. The Roof Geometry of a duopitch 
roof is defined by the roof's corner nodes A to F in accordance with the dialog graphic. You can 
also use the [] function to determine the nodes graphically in the work window. 
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In the dialog sections Load Cases to Generate and Load Cases for Drifted Snow Load, you specify 
the load case numbers for the load generation. Alternative load cases will be created when 
additional snow loads (for example DIN 1055-5, figure 4) or shape coefficients (for example  
EN 1991-1-3, figure 5.3) are taken into account. The relevant snow load cases can be created 
with the [New] button. 

11.8.5 Wind Loads 

11.8.5.1 Vertical Walls 

 
Figure 11.178: Dialog box Generate Wind Loads - Vertical Walls (roof geometry: Duopitch roof) 

First, define the standard and, where applicable, the national annex in the dialog section  
Velocity Pressure. The setting controls the input fields enabled for access. 

Wind zone and terrain category can be selected graphically in a map that you open with the 
[Info] button. The structure height h is not taken over automatically from the model but must 
be specified. Based on your settings, RSTAB determines the basic value of the fundamental 
wind velocity vb,0. 

Click the [Edit] button shown on the left to access more coefficients used to determine wind 
loads. 
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Figure 11.179: Dialog box Coefficients for Wind Load Generation 

The walls are determined by the Base Geometry (nodes I to L for base area, bottom) and the 
Roof Type and Geometry (nodes A to D or F for roof planes, up). In case of roof overhangs, speci-
fy the upper wall nodes, not the roof nodes. As shown in the dialog graphic, wind loads can be 
generated for building objects closed on all sides with a quadrilateral base area. Please note 
when entering geometry that the start nodes I and A must lie upon each other. Moreover, the 
direction of clicking nodes must be consistent when determining the base and roof area. You 
can also use the [] buttons to define base and roof geometry graphically. 

In the dialog section Load Cases to Generate, enter the load case number for the load genera-
tion. With the [New] button you can create a wind load case. 

The wind direction is defined in the dialog section Set Wind on Side. The wind acts perpendicu-
lar to the specified line. 

The dialog sections Load Distribution Type and Remove Influence from are described for the 
generator function "Member Loads From Area Load via Plane" on page 358. 

Click the [Settings] button shown on the left to open the dialog box Settings for Load Generation 
(see Figure 11.161, page 354). 

After confirming the generator dialog box with [OK], RSTAB shows you the results of the load 
generation in an overview. Thus, the acting area loads can be compared with the converted 
loads. Before the loads are transferred to RSTAB, you can click the [Back] button to access the 
initial dialog box where you can change the parameters of the loads. 
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11.8.5.2 Flat Roof 

 
Figure 11.180: Dialog box Generate Wind Loads - Flat Roof 

RSTAB considers a roof to be a flat roof if the roof inclination is α < 5°. 

First, define the standard and, where applicable, the national annex in the dialog section  
Velocity Pressure. The setting controls the input fields enabled for access.  

Specify the parameters as described in the previous chapter. The dialog section Eaves Type is 
linked to the interactive dialog graphics to the right illustrating the individual settings. 

As described for example in EN 1991-1-4, table 7.2, several load cases must be taken into ac-
count for a flat roof. In the dialog section Load Cases to Generate, specify the load case numbers 
for the load generation. The compression loads are created in the load case LC w+. The suction 
loads are generated in LC w-. The relevant load cases can be created with the [New] button. 

After confirming the generator dialog box with [OK], RSTAB shows you the results of the load 
generation for all load cases in an overview (see Figure 11.183, page 371). The dialog tabs rep-
resent an important checking option because you can see for each load case the external pres-
sure coefficient cpe,10 and the external pressure we displayed by zones. 
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11.8.5.3 Monopitch Roof 

 
Figure 11.181: Dialog box Generate Wind Loads - Monopitch Roof 

First, define the standard and, where applicable, the national annex in the dialog section  
Velocity Pressure. The setting controls the input fields enabled for access.  

Specify the parameters as described in chapter 11.8.5.1. The Monopitch Roof Parameters are  
determined automatically from the roof geometry and the side where the wind blows. 

As described for example in EN 1991-1-4, table 7.3a, several load cases must be taken into ac-
count for a monopitch roof. In the dialog section Load Cases to Generate, specify the load case 
numbers for the load generation. The compression loads are created in the load case LC w+. 
The suction loads are generated in LC w-. The relevant load cases can be created with the 
[New] button. 

Use the button [Assign load correction factors] to scale the loads for particular members. In 
this way, you can consider for example the effects of continuity of a roof sheathing on the 
edge rafters in order to generate reduced member loads. Specifications will be entered in a 
separate dialog box (see Figure 11.170, page 360). 
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11.8.5.4 Duopitch/Troughed Roof 

 
Figure 11.182: Dialog box Generate Wind Loads - Duopitch/Troughed Roof 

First, define the standard and, where applicable, the national annex in the dialog section  
Velocity Pressure. The setting controls the input fields enabled for access.  

Specify the parameters as described in chapter 11.8.5.1 on page 366. The Duopitch Roof  
Parameters are determined automatically from the roof geometry and the side where the  
wind blows. 

As described for example in EN 1991-1-4, table 7.4a, several load cases must be taken into ac-
count for a duopitch roof. In the dialog section Load Cases to Generate, specify the load case 
numbers for the load generation. The compression loads are created in the load case LC w+. 
The suction loads are generated in LC w-. Combinations (compression on one side of the roof 
and suction on other side) are defined as LC w-/+ and LC w+/-. The relevant load cases can be 
created with the [New] button. 

After confirming the generator dialog box with [OK], RSTAB shows you the results of the load 
generation for all load cases in an overview. The dialog tabs represent an important checking 
option because you can see for each load case the external pressure coefficient cpe,10 and the 
external pressure we displayed by zones. 
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Figure 11.183: Dialog box Info About Generation of Wind Loads - Duopitch/Troughed Roof 

Before the loads are transferred to RSTAB, you can click the [Back] button to access the initial 
dialog box where you can change the parameters of the loads.  
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11.8.5.5 Vertical Walls with Roof 

 
Figure 11.184: Dialog box Generate Wind Loads - Vertical Walls with Roof (roof geometry: Duopitch roof) 

First, define the standard and, where applicable, the national annex in the dialog section  
Velocity Pressure. The setting controls the input fields enabled for access.  

Specify the parameters as described in chapter 11.8.5.1 on page 366.  

As described for example in EN 1991-1-4, table 7.4a, several load cases must be taken into ac-
count for a duopitch roof. In the dialog section Load Cases to Generate, specify the load case 
numbers for the load generation. The compression loads are created in the load case LC w+. 
The suction loads are generated in LC w-. Combinations (compression on one side of the roof 
and suction on other side) are defined as LC w-/+ and LC w+/-. The relevant load cases can be 
created with the [New] button. 

Use the button [Assign load correction factors] to scale the loads for particular members. Spec-
ifications will be entered in a separate dialog box (see Figure 11.170, page 360). 

After confirming the generator dialog box with [OK], RSTAB shows you the results of the load 
generation for all load cases in an overview (see Figure 11.183, page 371). The dialog tabs rep-
resent an important checking option because you can see for each load case the external pres-
sure coefficient cpe,10 and the external pressure we displayed by zones. 
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12.  File Management 
This chapter explains how data is organized in the Project Manager and how recurring model 
components are managed in blocks. In addition, the chapter describes the data import and 
export with the integrated interfaces for exchanging data with other programs. 

12.1 Project Manager 
In structural analysis, a project is often subdivided into several models. The Project Manager 
helps you to organize data of your Dlubal applications. You can also use it for managing RSTAB 
models within the network (see chapter 12.3, page 393). 

The Project Manager can be left open as a stand-alone application when working in RSTAB. 

To open the Project Manager, select Project Manager on the File menu, or use the toolbar 
button shown on the left. 

 
Figure 12.1: Button Project Manager in the toolbar 

It is also possible to access the Project Manager in the model's General Data dialog box. 

 
Figure 12.2: Button Project Manager in the dialog box General Data 

When you open the Project Manager, the following multi-part window appears. It has its own 
menu and toolbar. 
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Figure 12.3: Project Manager 

Project navigator 

A navigator listing all projects in a tree structure is displayed on the left. The current project is 
set bold. To select another project, double-click the relevant entry or use the list Current Project 
in the toolbar. The table to the right of the navigator lists the models contained in the selected 
project. 

Table of models 

The models are arranged in several tabs, sorted by Dlubal applications. The RSTAB tab lists all 
RSTAB models contained in the selected project. The Model Name and Description as well as 
significant model and file information including the name of the user who created and edited 
the model are displayed respectively. 

To adjust the column display, select Manage Register Columns on the View menu of the  
Project Manager, or use the toolbar button shown on the left (see page 383). 

Details 

This part of the window shows all information available for the model that is selected in the 
window section above. 

Preview 

The selected model is displayed in a preview. The size of the preview window can be adjusted 
by moving the upper edge of the window. 

Thumbnails 

The bottom area of the Project Manager offers you a graphical overview about the models 
contained in the selected project. The thumbnail images are interactive with the table above. 

Use the pins to minimize particular window parts. They will be docked as tabs in the footer. 
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12.1.1 Project Management 

Create a new project 
To create a new project, 

• select New on the Project menu of the Project Manager or 

• click the button [New Project] in the toolbar shown on the left. 

 
Figure 12.4: Button New Project 

The dialog box Create New Project opens where you enter the Name of the new project. Then, 
select the Folder in which you want to save the models. Use the [Browse] button shown on the 
left to set the directory. You can also add a short project Description. It will be shown in the 
header of the printout report and has no further relevance. 

 
Figure 12.5: Dialog box Create New Project 

It is also possible to create sub-projects in the Project Manager by selecting a project in the list 
Place project under. The new project will be displayed as sub-project in the navigator. If you do 
not want to use this setting, select the list entry Projects on the top of the list. Then, the project 
will appear as main entry in the navigator. 

After clicking [OK], a new folder with the project name will be created on the local or network 
drive. 

Connect existing folder 
To integrate a folder containing already several RSTAB models as a project, 

• select Connect Folder on the Project menu of the Project Manager or 

• use the button [Connect Folder] in the toolbar shown on the left. 

 
Figure 12.6: Button Connect Folder 

It is irrelevant on which local or network drive the folder that you want to connect is located.  
It will be included into the file management and left at its location – similar to the creation of  
a shortcut on the desktop. The information is saved in the ASCII file PRO.DLP in the folder 
ProMan (see chapter 12.1.4.3, page 385). 
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A dialog box opens that is similar to the dialog box shown in Figure 12.5. Enter the Name and 
Description of the project, and use the [Browse] button to set the directory for the relevant 
Folder. If a project is specified in the list Place project under, the connecting folder must be con-
tained within the directory of this project. The folder will then be managed as a sub-project. 
But if you want the folder to appear as an independent project in the Project Manager, select 
Projects on the top of the list. 

Tick the option Connect folder including all subfolders to connect all folders contained in the se-
lected folder at once with the management of the Project Manager. 

By connecting folders it is possible to integrate projects of the program versions RSTAB 5 and 
RSTAB 6 into the Project Manager. 

Disconnect a folder 
To disconnect a folder integrated in the project management, 

• select Disconnect on the Project menu of the Project Manager (project must have been 
previously selected) or 

• use the project's context menu in the navigator. 

 
Figure 12.7: Context menu of a project 

The project will be removed only from the internal management. The folder on the hard disk 
and its contents will be kept. 

Delete a project 
To delete a project, 

• select Delete on the Project menu of the Project Manager (project must have been  
previously selected) 

• click the [Delete] button in the toolbar shown on the left 

• use the Delete entry in the projcet's context menu available in the navigator (see figure 
above). 

 
Figure 12.8: Button Delete 

The folder including its contents will be completely deleted from the hard disk. 
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If the folder contains also files from other programs, only the files of Dlubal applications will be 
deleted. The folder itself will be preserved. 

To undo the deletion of projects, 

select Restore from Dlubal Recycle Bin on the Edit menu of the Project Manager. 

The Dlubal recycle bin is described in chapter 12.1.4.2 on page 384. 

In case files stored on a network drive are deleted, they are copied via network into the Dlubal 
recycle bin on the hard disk, which is different to the Windows standard where data is irrecov-
erable. In this way, you can restore files, deleted on network drives, from the relevant comput-
er. If you don't want the files to be copied into the recycle bin, we recommend to simply dis-
connect the project (see above). Then, you can delete the data from the network drive manual-
ly. 

Copy a project 
To copy a project, 

• select Copy on the Project menu of the Project Manager (project must have been  
previously selected) or 

• use the Copy entry in the project's context menu in the navigator (see Figure 12.7). 

 
Figure 12.9: Dialog box Copy Project 

Enter the Name, Description and the location of the new project in the Project Manager, and 
define the Folder that will be created by the copy function. 

It is also possible to copy the project with the Windows-Explorer. Then, you can integrate the 
new folder as a connected folder into the management of the Project Manager (see chapter 
Figure 12.6, page 375). 
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Rename a project / change description 
To change the description of a project subsequently, 

• select Properties on the Project menu of the Project Manager (project must have been 
previously selected) or 

• use the Properties entry in the project's context menu in the navigator (see Figure 12.7). 

The dialog box Project Properties opens where you can change the Name and Description of the 
project. The Folder of the project is also displayed. 

 
Figure 12.10: Dialog box Project Properties 

Import a project folder 
After changing the computer, you can restore the complete directory tree of the Project Man-
ager without copying the file PRO.DLP (see chapter 12.3, page 393). All projects included in a 
folder will be entered in the project management (which means that this folder must contain 
projects, not models). In this way, the projects do not need to be connected individually. 

To open the dialog box for importing a project folder, 

select Import Folder on the Project menu of the Project Manager. 

 
Figure 12.11: Dialog box Import folder 

In the list Place projects under, define the way how you want to integrate the project folder into 
the management. If you want the folders to appear as independent projects in the Project 
Manager, select the list entry Projects on the top of the list. Use the [Browse] button shown on 
the left to set the directory for the Folder to be linked. 

Tick the option Connect folders including all subfolders to integrate all subfolders of the folders 
into the management of the Project Manager. 
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12.1.2 Model Management 

Open a model 
To open a model out of the Project Manager, 

• double-click the model name or its thumbnail image, 

• select Open on the Model menu of the Project Manager (model must have been  
previously selected) 

• or use the context menu of the model. 

 
Figure 12.12: Context menu Model 

Use the context menu option Open With shown on the left to select a particular Dlubal applica-
tion with which you want to open the model. 

It is possible to open files from RFEM directly in RSTAB. 

Shift / copy a model 
To copy a model to another project, 

• select Copy on the Model menu (model must have been previously selected), 

• use the Copy entry in the model's context menu (see figure above) or 

• use the drag-and-drop function by holding down the [Ctrl] key. 

 
Figure 12.13: Dialog box Copy Model 
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In the dialog box Copy Model, specify the target project and enter the Name and Description for 
the copy of the model. 

To shift a model, hold the left mouse button down when moving it into another folder. 

Rename a model 
To rename a model, 

• select Properties on the Model menu of the Project Manager (model must have been 
previously selected) 

• use the Properties entry in the model's context menu (see Figure 12.12). 

 
Figure 12.14: Dialog box Model Properties 

In the dialog box Model Properties, you can change the Name and Description of the model. The 
File name and the model's directory are also displayed. 

If the model contains also results and printout reports, you can remove such additional Data 
from the data record by using the [Delete] button. 

Delete a model 
To delete a model, 

• select Delete on the Model menu of the Project Manager (model must have been  
previously selected) 

• click the [Delete] button in the toolbar shown on the left 

• use the Delete entry in the model's context menu (see Figure 12.12). 

In the context menu, it is also possible to Delete Results and/or to Delete Printout Reports of the 
model specifically. In both cases, input data remains available. 

To undo the deletion of models, 

select Restore from Dlubal Recycle Bin on the Edit menu of the Project Manager. 

The Dlubal recycle bin is described in chapter 12.1.4.2 on page 384. 

Show the history 
To check the history of a model, 

• select History on the Model menu of the Project Manager (model must have been  
previously selected) 

• use the History entry in the model's context menu (see Figure 12.12). 
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Figure 12.15: Info window History of Model 

A dialog box appears showing you information about the users who created, opened or modi-
fied the model. The overview includes also the time when the individual actions were carried 
out. 

Remarks listed in the Comment column are based on the model's general data. Corresponding 
entries in the dialog box General Data are managed in the dialog tab History. Take advantage 
of comments to describe the respective structural processing (see chapter 12.2.3, page 392). 

12.1.3 Data Backup 

Archive data 
You can back up selected models or even an entire project folder in a compressed backup file. 
The original models remain available. 

To start the archiving, 

• select Make Archive on the Archive Data menu of the Project Manager (model or  
project must have been previously selected) 

• use the context menu of the project (see Figure 12.7) or model (see Figure 12.12). 

 
Figure 12.16: Dialog box Archive 
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The backup file can be generated with or without results and printout reports. Further options 
allow for the integration of subprojects and files that do not belong to any of the Dlubal appli-
cations. 

When the Name and Folder of the archive file are defined, you can create a ZIP file by clicking 
[OK]. 

Extract from archive 
To extract data from the archive, 

select Extract Project/Models from Archive on the Archive Data menu of the Project 
Manager. 

The Windows dialog box Open appears where you can select the ZIP backup file. After clicking 
[OK], the contents are displayed. 

 
Figure 12.17: Dialog box Extract Project with Models from Archive 

In the dialog section Select Models to Extract, select the models that you want to restore. They 
can be unpacked with either the original project settings or as new project. In the list Place pro-
ject under, you can define the ranking in the management structure of the Project Manager.  
Alternatively, you can create a new directory by means of the [Browse] button. 
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12.1.4 Settings 

12.1.4.1 View 

Show thumbnails and details 
The window area below the model table can be adjusted according to your preferences. You 
can choose two options for additional windows that can be activated independently of each 
other. 

To set the display options, 

select Pictures Preview of All Models on the View menu and 

select Details of Current Models on the View menu of the Project Manager, 

or use the respective toolbar buttons. 

Button Function 

 
Shows thumbnail images of all models in the project 

 
Shows model details and preview of model 

Table 12.1: Buttons for setting the view 

Sort models 
The arrangement of models in the table can be adjusted: As usual with Windows applications, 
you can sort the list in an ascending or descending order by clicking into the column titles.  
Alternatively, you can 

select Sort Models on the View menu. 

Adjust columns 
To arrange the columns according to your needs, 

• select Manage Register Columns on the View menu of the Project Manager 

• or use the button [Manage Register Columns] in the Manager toolbar shown on the left. 

 
Figure 12.18: Dialog box Manage Register Columns 

First, define the Register whose columns you want to adjust (for example RSTAB). Now, you  
can select relevant entries in the list Columns - Available to transfer them to the list Columns - 
To Display. Use the arrow buttons [] for the transfer. You can also double-click the items.  
Columns that you don't want to be displayed can be hidden with the [] buttons. 
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The order of columns in the models list can be changed by using the buttons [] and [] in 
the list Columns - To Display. Click them to shift a selected entry up and down. 

To optimize the column widths in the models list, select Arrange Automatically on the View 
menu of the Project Manager. You can also use the toolbar button shown on the left. 

12.1.4.2 Recycle Bin 
To restore deleted projects and models, 

select Restore from Dlubal Recycle Bin on the Edit menu of the Project Manager. 

A dialog box appears where all deleted models are listed by projects. 

 
Figure 12.19: Dialog box Restore Models from Dlubal Recycle Bin 

The models to be restored can be selected by mouse click. With the button [Select all] you can 
tick the entries all at once. Click the button [Restore Selected Models] to insert the deleted 
models into the original project folders. 

To delete objects stored in the Dlubal recycle bin, 

select Empty Dlubal Recycle Bin on the Edit menu of the Project Manager. 

Before the hard delete is performed, a security query is displayed. 

To adjust the settings for the Dlubal recycle bin, 

select Settings for Dlubal Recycle Bin on the Edit menu of the Project Manager. 

A dialog box appears where the settings for storage location and memory size are managed. 

 
Figure 12.20: Dialog box Settings for Dlubal Recycle Bin 
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12.1.4.3 Directories 

The directories of the Project Manager (and Block Manager) can be checked in the Program  
Options. To open the corresponding dialog box, 

select Program Options on the Edit menu of the Project Manager. 

 
Figure 12.21: Dialog box Settings 

The Category manages the settings separately for both the Project and the Block Manager.  
The folder and the file name are displayed in the input field below where they can be adjusted, 
if necessary. The projects are managed in the file PRO.DLP which can normally be found in 
folder C:\ProgramData\Dlubal\ProMan (Windows 7) or C:\Documents and Settings\All Users\ 
Application Data\Dlubal\ProMan (Windows XP). The [Browse] button helps you to set another 
path. 

As the Project Manager is network-compatible, it is possible to organize the data management 
for models contained in the Project Manager in a central place: Set the directory for the PRO.DLP 
file on the server (see chapter 12.3, page 393).  

The dialog section Options offers you general settings for handling RSTAB files: Usually, a mes-
sage appears when opening a file out of the Explorer, an e-mail program etc. when the related 
folder is not integrated in the management of the Project Manager. The message can be deac-
tivated. Moreover, you can decide which program version you want to use to create or open 
model files. 
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12.2 Creating a New Model 
To create a model, 

• select New on the RSTAB File menu 

• click the toolbar button [New Model] shown on the left 

• point to New With on the Model menu of the Project Manager, and then select RSTAB 8. 

 
Figure 12.22: Button New Model 

The dialog box New Model - General Data opens offering three tabs. 

 
Figure 12.23: Dialog box New Model – General Data, tab General 

When you want to edit the model's general data later, 

• point to Model Data on the Edit menu, and then select General Data 

• use the context menu of the model in the Data navigator. 

 
Figure 12.24: Context menu of model 
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12.2.1 General 
The first dialog tab (see Figure 12.23) manages basic model parameters. 

Model name / description 
Enter a name into the input field for Model Name. At the same time, it is used as the model's file 
name. By entering a Description you can describe the model in detail. It appears in the printout 
report but has no further relevance. 

 

Figure 12.25: Model description in printout report 

Project name / description 
In the Project Name list, you can select the project folder where the model will be created. The 
current project is preset. If required, you can change the presetting in the Project Manager (see 
chapter 12.1, page 373) that you can access with the dialog button to the right. 

The Description and Folder of the selected project are displayed for information. 

Type of model 
Among the model's general data, you have to specify if your structure is a spatial or planar 
model. In case of 2D models, the effort for input is reduced due to the limited coordinates and 
degrees of freedom. 

Type 1D - in X represents a continuous beam. The use of type 2D - in XZ is recommended for 
planar frame structures where moments are taken into account only about the strong member 
axes. Option 2D - in XY is appropriate for girder grillages with loads acting perpendicular to the 
area plane. 

It is possible to change the selected type of model subsequently. Please note that such a modifi-
cation may result in data loss, for example when a 3D model is reduced to a grillage. 

Classification of load cases and combinations 
Loading is to be applied by load cases. Load cases may be for example self- weight, snow or 
live load. 

The individual standards define rules for how to combine load cases. It is therefore important 
to assign load cases to particular action categories (see chapter 5.1, page 100). Thus, when cre-
ating load and result combinations, RSTAB is able to provide the load cases automatically with 
correct partial safety factors and combination coefficients. 

According to standard 

The list According to Standard contains a variety of rules and standards describing the princi-
ples for ultimate limit state, serviceability and resistance of structural systems. With the selec-
tion of the standard the rules for creating load and result combinations in RSTAB are defined. 
This specification is especially significant for the automatic creation of combinations by RSTAB 
(see chapter 5.2, page 103 to chapter 5.4, page 116). 

When None is set, no combination will be created automatically, which corresponds to the de-
fault setting in RSTAB 7. In this case, load cases must be superimposed manually (see chapter 
5.5.1, page 121 and chapter 5.6.1, page 128). 
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When changing the standard subsequently it is required to reclassify the load cases and to  
adjust the combination. A corresponding warning appears. 

 
Figure 12.26: Warning when changing the standard 

National annex 

When the standard EN 1990 is selected, an additional picklist appears: Though combination 
rules are defined in the Eurocode standard, countries are allowed to specify partial safety fac-
tors and combination coefficients themselves. 

The list offers you a choice among national annexes of different countries. When the option 
CEN is set, the factors recommended by the European Commission are applied. 

Use the dialog button [Edit] to check the partial safety factors and combination coefficients of 
the currently set standard. When a user-defined standard is set, you can even adjust them. 

The factors are organized in several tabs in the dialog box Coefficients. The first tab manages 
the Partial Safety Coefficients γ for the design situations "static equilibrium" and "ultimate limit 
state". 

 
Figure 12.27: Dialog box Coefficients, tab Partial Safety Coefficients 
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The dialog tab Combination Coefficients (see Figure 5.22, page 118) controls the factors ψ and 
ξ. In the tab Factors of Construction, that is available for EN 1990, you can define the reliability 
factor KFI. 

Create combinations automatically 

The check box is clear by default so that both options below are not enabled for access. Thus, 
the required load and result combinations must be created manually like in RSTAB 7 (see chap-
ter 5.5.1, page 121 and chapter 5.6.1, page 128). When combining load cases, the specified 
standard ensures that the partial safety and combination factors are assigned automatically. 

As an alternative, you can Create combinations automatically. Then, additional dialog tabs are 
available in the dialog box Edit Load Cases and Combinations as well as separate entries in the 
Data navigator. In addition, tables 2.2. to 2.4 are enabled. Generating combinations is de-
scribed in detail in chapter 5.2, page 103 to chapter 5.4, page 116. 

The automatic superposition is based on the concept of the add-on module RSCOMBI 2006. 
Find additional information about combinatorics in the module's manual that is available for 
download at www.dlubal.com. 

During the automatic superpositioning RSTAB creates either Load combinations or Result com-
binations. The difference between both combination possibilities is described in chapters 5.5 
on page 120 and 5.6 on page 128. 

Positive orientation of global axis Z 
This dialog section controls the orientation of the global axis Z. In CAD programs, the Z-axis  
is usually directed upwards. In programs used for structural analysis, it is normally directed 
downwards. The specification is irrelevant for the calculation. 

If Z is defined Upward and the self-weight is specified with factor 1.0 in direction Z in the base 
data of the load case, the self-weight acts upwards. Where necessary, the self-weight factor 
must be changed to –1.0. 

It is possible to change the orientation of the Z-axis subsequently. You also have the possibility 
to adjust the coordinates and global loads so that the view of the model will be kept. If the axis 
direction is modified, the following query appears: 

 
Figure 12.28: Query when changing the Z direction 

 

 

 

http://www.dlubal.com/
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Template 

The model can be created according to a template that has been saved in another model. To 
access the save function, 

select Save As Template on the File menu. 

 
Figure 12.29: Dialog box Save as Template 

In general, the templates are stored in the Dlubal folder for template models called Base.  
Access is also available in the navigator of the Project Manager by selecting Default under 
Templates (see Figure 12.3, page 374). 

After ticking the check box in the dialog box New Model - General Data, you can select the rel-
evant template model from the list. 

Click the button shown on the left to open an overview with preview pictures helping you to 
choose among the templates. 

 
Figure 12.30: Dialog box Select Template 

Comment 
You can enter a text into the input field or select a text from the list to add a short description 
to the general data. The comment appears in the printout report, too. 
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The buttons in the General Data dialog box are reserved for the following functions: 

Button Description Explanation 

 Comment  chapter 11.1.4, page 262 

 Units and Decimal Places  chapter 11.1.3, page 261 

 MS Excel 
Option for additional explanations in the 
form of XLS file saved in RSTAB file 

 MS Word 
Option for additional explanations in the 
form of DOC file saved in RSTAB file 

Table 12.2: Dialog box General Data, buttons 

12.2.2 Options 
With the second tab of the dialog box New Model - General Data you decide if additional func-
tions are displayed in the load case and combination dialog boxes.  

 
Figure 12.31: Dialog box New Model - General Data, tab Options 

If the check box for Advanced options of load cases and load combinations is ticked, additional 
dialog tabs can be accessed in the dialog box Edit Load Cases and Combinations: 

• Modify stiffness (see chapter 7.2.1.2, page 173) 

• Extra options (see chapter 7.2.1.3, page 174) 

In the additional tabs, you can adjust the stiffnesses of materials, cross-sections, supports and 
releases. Moreover, you can take account of the initial deformations from another load case. 
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12.2.3 History 
The third dialog tab keeps record of processing in the form of a History.  

 
Figure 12.32: Dialog box Edit Model - General Data, tab History 

The table shows information about the point of time when a User has Opened and Saved the 
model. 

In the topmost table row, you can enter a Comment describing the current state of model pro-
cessing. The remark will be effective for the history when saving the model next time. The 
comment appears not only in the History tab but is also available in the Project Manager (see 
Figure 12.15, page 381). 

To delete the history, click the button [X]. In this way, it is possible to remove personal infor-
mation from the file.  



12  File Management 

 393 Program RSTAB © 2013 Dlubal Engineering Software 

 

12.3 Network Management 
When several users are working on the same projects, model management can be organized 
by the Project Manager, provided that the models are stored in a folder that is accessible on 
the network. 

First, connect the network folder to the internal project management. Please find a description 
in chapter 12.1.1 on page 375. Now, you can directly access the models of this folder in the 
Project Manager, which means that you can open or copy the models, check their history or 
provide them with a write protection. 

If another user is already working on the model that you want to open, a warning appears. In 
this case, you can open the model as a copy. 

 
Figure 12.33: Query when opening a write-protected model 

An automatic data synchronization of modifications is not possible. 

Information about the projects registered in the Project Manager is stored in the file PRO.DLP. 
This is an ASCII file which is by default located under C:\Documents and Settings\All Users\Appli-
cation Data\Dlubal\ProMan (Windows XP) or C:\ProgramData\Dlubal\ProMan (Windows 7).  

By copying the PRO.DLP file to another computer you can avoid connecting folders project by 
project. In addition, the file can be edited by an editor. This facilitates the import of all relevant 
project folders into the internal file management of the Project Manager, especially after new 
installations. As an alternative, you can use the function Import Folder (see chapter 12.1.1, page 
378). 

Before copying the PRO.DLP file – like before uninstalling Dlubal applications – it is recom-
mended to save the existing file. 

The Project Manager is network-compatible. The file management can be organized in a cen-
tral place so that all users are integrated in one common project management. To define the 
network settings, 

select Program Options on the Edit menu of the Project Manager. 

A dialog box opens where you can define the storage location for the file PRO.DLP (see Figure 
12.21, page 385). 

The Project Manager runs on every local computer, but each is using the central server file 
PRO.DLP. In this way, all users can carry out modifications to the project structure at the same 
time. For write access to the PRO.DLP file, the file is locked only for a short time and is unlocked 
immediately afterwards. 
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12.4 Block Manager 
The Block Manager manages model blocks by cross-project management: Selected objects can 
be saved as blocks and reimported to other models. A multitude of typified elements is prede-
fined in the Block Manager's Catalog. 

To open the Block Manager, select Block Manager on the File menu in RSTAB, or use the 
toolbar button shown on the left. 

 
Figure 12.34: Button Block Manager in the toolbar 

When you open the Block Manager, a multi-part window appears. Like the Project Manager 
(see chapter 12.1) it has its own menu and toolbar. 

 
Figure 12.35: Block Manager 

Block navigator 

On the left, you see the navigator with the Catalog of all block categories. The current category 
is set bold. To select another category, double-click the relevant entry or use the list Current 
Category in the Manager toolbar. The table to the right of the navigator lists the objects filed in 
the selected category. The following categories can be used for RSTAB: 

• Members - 2D 

• Members - 3D 

• Towers 

Table of blocks 

The blocks of the selected category are listed one by one. The Block Name and Description as 
well as significant object and file information are shown respectively. 

To adjust the displayed columns, select Manage Register Columns on the View menu of the 
Block Manager, or use the toolbar button shown on the left (see chapter 12.1.4.1, page 383).  
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Details 

The window section shows you detailed information about the selected block. 

Preview 

The selected block is displayed in a preview. The size of the preview window can be adjusted 
by moving the upper edge of the window. 

Thumbnails 

The bottom area of the Block Manager offers you a graphical overview about the blocks con-
tained in the selected category. The thumbnail images are interactive with the table above. 

Use the pins to minimize particular window parts. They will be docked as tabs in the footer. 

12.4.1 Create a Block 
To create a block from particular objects, select the relevant objects in the current RSTAB 
model in the work window. A multiple selection is possible by drawing a window with the 
mouse button. You can also click several elements by holding down the [Ctrl] key. 

To create a new block, 

select Save as Block on the File menu in RSTAB. 

The following dialog box appears. 

 
Figure 12.36: Dialog box Save as Block 

Define the Block Name and Category Name under which you want to save the block. The cate-
gory can be selected in the list. The Description is an optional entry used to describe the block 
shortly. 

The directory of the block is indicated in the dialog field Folder. 

In case loads are defined, they can be saved together with the block. In addition, you can use 
the settings in the dialog section Option to decide if all loads or only selected load cases are 
relevant. 
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To create a new block category, use the button [New Category] shown on the left. 

 
Figure 12.37: Dialog box Create New Category 

The creation of a block is similar to the creation of a new project in the Project Manager (see 
chapter 12.1.1, page 375). 

12.4.2 Import a Block 
To import a block into the current RSTAB model, open the Block Manager (see Figure 12.34, 
page 394). First, select the category in the catalog. Then, you can select the relevant block with 
a mouse click in the RSTAB tab. 

To start the import, 

• select Insert Block on the Block menu 

• use the context menu of the block. 

 
Figure 12.38: Context menu of block 

You can also double-click the block in the table. The following dialog box opens. 
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Figure 12.39: Dialog box Insert Block 

Specify the Insert Point of Block (the "snap point") and the Global Position of Reference Point in 
the dialog box. The points can be selected also graphically in the block model or RSTAB model. 

Geometric Parameters can be modified as well as Material and Cross-Sections. A click into the 
relevant input field enables buttons that you can use to select items from a list or to open li-
braries. 

For user-defined blocks it is even possible to import loads: The Active Load can be selected in 
the list. 

Click the [Edit] button shown on the left to access specific import settings that can be defined 
in another dialog box. 

 
Figure 12.40: Dialog box Detail Settings 
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With the options available in the dialog box Detail Settings you determine how objects will be 
aligned with the existing model elements. Moreover, you can influence the Numbering. 

Click the [Select] button to open a new dialog box where you can select the load cases, load 
and result combinations for the import. 

 
Figure 12.41: Dialog box Select Loading 

12.4.3 Delete a Block 
To delete a block, 

• select Delete on the Block menu of the Block Manager (block must have been previous-
ly selected) 

• click the [Delete] button in the toolbar shown on the left 

• use the context menu of the block (see Figure 12.38). 

 
Figure 12.42: Button Delete 

After confirming the security query, the block will be put into the Dlubal recycle bin. 
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12.5 Interfaces 
RSTAB offers you the possibility to exchange data with other programs. Thus, you can use for 
example CAD templates created in other applications. Furthermore, results of structural calcu-
lations from construction or design software can be made available. 

Exporting the printout report as RTF file and to VCmaster is described in chapter 10.1.11 on 
page 244. 

In addition, RSTAB can be run externally using a programmable interface based on COM tech-
nology (for example Visual Basic). With RS-COM which can be acquired as RSTAB add-on mod-
ule you can use customized input macros and follow-up programs. 

12.5.1 Direct Data Exchange 
RSTAB provides an interface to software programs developed by the DLUBAL company. Input 
data of all previous RSTAB versions can be imported without problems. Furthermore, you can 
directly open files created with the finite element program RFEM (surfaces and solid elements 
will be ignored during the import). In the same way, you can open files created with RSTAB 8 in 
RFEM 5 where you can add surfaces and solids. 

RSTAB has a direct connection to CAD programs from Tekla Structures and Autodesk Auto-
CAD (but not for LT versions). In this way, it is possible to take advantage of BIM (Building In-
formation Modeling) with RSTAB because data models can be exchanged directly for digital 
planning processes. 

To start the direct data exchange, 

select Import or Export on the File menu in RSTAB 

or use the toolbar buttons shown on the left. 

The dialog box shown in Figure 12.43 or Figure 12.44 on page 400 opens where you can select 
the relevant CAD program in the dialog section Direct Imports or Direct Exports. 

The buttons in the RSTAB toolbar Export/Import are reserved for the following functions: 

 
Direct import from Tekla Structures 

 
Direct export to Tekla Structures 

 
Direct import from AutoCAD 

 
Direct export to AutoCAD 

Table 12.3: Buttons of toolbar Export/Import 

Find descriptions for the interfaces with Tekla Structures and Autodesk AutoCAD Revit at 
www.dlubal.com/manuals-for-category-interfaces.aspx. 

• RX-Tekla 

• RX-Revit 

 

http://www.dlubal.com/manuals-for-category-interfaces.aspx
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12.5.2 File Formats for Data Exchange 
If CAD programs or programs for structural analysis can create files of the types *.stp, *.dxf, 
*.fem, *.asf, *.dat, *.cfe or *.ifc, corresponding data can be used as template for RSTAB. Vice 
versa, RSTAB is able to create files in formats appropriate for other programs. 

To open the dialog box for importing a file, 
select Import on the File menu. 

 
Figure 12.43: Dialog box Import 

When the option Import as background layer is ticked, RSTAB will show you only a line model 
that can be used to set nodes, members etc. (see chapter 11.3.10, page 297). 

To start the export of a RSTAB file, 
select Export on the File menu. 

 
Figure 12.44: Dialog box Export 
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File formats for frameworks 

DSTV format *.stp 

When using the product interface from DSTV (German Steel Construction Association), transfer 
is not performed with framework files reduced to line models but files contain all model and 
load data that is necessary for efficient processing. DLUBAL, like many other software develop-
ers, work on the development of the product interface. So it is possible to exchange data with 
a variety of programs like Bentley ProStructure, Tekla Structures, Intergraph Frameworks, Advance 
Steel, CIS/2 CIMSteel, SEMA or cadwork. You can select the programs also directly in the import 
and export dialog boxes. 

The interface covers structural and CAD data in general. RSTAB, however, supports only the 
structural format with specific “entities” that can be found in a description (German only, PDF 
download of Standardbeschreibung Produktschnittstelle Stahlbau). 

The interface transfers information of nodes, members and cross-sections including member 
eccentricities and cross-section rotations. Furthermore, nodal supports, load cases, load and 
result combinations with nodal and member loads as well as imperfections are transferred. The 
results of the calculation can be stored in the exchange file as well. 

More settings for data exchange can be defined in the dialog tab DSTV (.stp). 

 
Figure 12.45: Dialog box Export, tab DSTV (.stp) 

File formats for spreadsheet 

MS Excel format *.xls 

RSTAB is able to import and create tables as *.xls files. Exchanging data with MS Excel is de-
scribed in chapter 11.5.6 on page 329. However, the described exchange option is only availa-
ble for the active RSTAB table. The function described in the following covers data of the mod-
el all at once. Thus, user-defined external generators for model and load data can be used. 

To import an XLS file, open the file in MS Excel first. Then, you can use the option Microsoft  
Excel in the RSTAB import dialog box (see Figure 12.43) to open the following dialog box. 

http://www.dlubal.de/download/pss_dstv.pdf
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Figure 12.46: Dialog box Import from Microsoft Excel - Settings 

Select the Workbook and Worksheets that you want to import. Descriptions, sequence and 
structure of worksheets must match exactly the data of RSTAB so that imported data can be 
written correctly into the RSTAB tables. If you are not quite sure, try to create an XLS file from 
the current RSTAB file for test purposes. 

In the Options tab, specify if worksheets will be imported with or without headers and how 
formulas will be represented in the worksheets.  

When exporting a file, it is not necessary to open MS Excel. The spreadsheet program starts 
automatically.  

 
Figure 12.47: Dialog box Export to Microsoft Excel - Settings 

In the dialog section Export of Tables, select the tables that you want to export. When you acti-
vate the option Only selected tables, RSTAB enables the respective [Select] button shown on 
the left. Click the button to open another dialog box for specific settings. 
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Figure 12.48: Dialog box Tables to Export - Results Data 

In the dialog section Formulas and Parameters of the initial export dialog box (Figure 12.47), 
you can decide if stored formulas will also be transferred from RSTAB to MS Excel during the 
data exchange. 

OpenOffice format *.ods 

This interface is only available when OpenOffice.org Calc and RSTAB 8  32-bit are installed. 

The import and export options are similar to the data exchange between RSTAB and MS Excel 
described in detail above. 

General file formats for CAD programs 

ASCII format *.dxf 

The DXF format transfers only general information concerning lines used in the model. RSTAB 
is able to import a line model created for example in AutoCAD and to create a DXF file from the 
current model. A layer will be used for each cross-section. Nodal supports, loads etc. cannot be 
taken over. 

More settings for data exchange can be defined in the dialog tab ASCII Format DXF (*.dxf). It is 
recommended to check the parameters especially before the import. 

 
Figure 12.49: Dialog box Import, tab ASCII Format DXF (*.dxf) 

Check the length units of the DXF template. Optionally, you can enter an Offset to place the 
DXF model in a certain distance to the origin. 

If you want to Import a file from a specific layer, use the button [Select DXF File] shown on the 
left to select the DXF file. Then, the individual layers are available for selection in the list.  
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In most CAD programs, the Z-axis is directed upwards. In RSTAB, however, it is normally di-
rected downwards. Now, when you switch to the second dialog tab Detail Settings in the im-
port dialog box, and set Down in the list for the Z axis, weight loads can be entered positively 
in RSTAB. 

 
Figure 12.50: Dialog box Import, tab Detail Settings 

For the DXF export it is also recommended to check the orientation of the Z axis. 

IFC format *.ifc 

The Industry Foundation Classes (IFC) are a global standard for exchanging data for model-
based approaches in the construction industry. They have been developed by the IAI (Inter-
national Alliance for Interoperability). The IFC are structured in domains (architecture, design, 
structural analysis, electrical engineering etc.). DLUBAL software supports the domain for struc-
tural engineering which allows for the transfer of model data like nodes, members, supports, 
load cases and loads. The IFC are still under development. 

Please find a description of the interface at www.buildingsmart.org. 

When you export an RSTAB model as IFC model, an analytical model is created in the version 
IFC 2 x Edition 3. 

Bentley format *.ism.dgn, *.dgn 

The interface makes it possible to exchange data with the CAD product MicroStation. RSTAB is 
able to import model data as well as to export RSTAB files, using the possibilities of interoper-
ability. Thus, a connection to all Bentley applications such as ProSteel is given on the basis of 
ISM (Integrated Structural Modeling). 

SDNF format *.dat 

The SDNF format (Steel detailing neutral file) is used to exchange geometrical data like nodes, 
cross-sections and members with INTERGRAPH. 

File formats for structural analysis programs 

Scia format *.xml 

It is possible to import model data from the structural analysis program SCIA by NEMETSCHEK to 
RSTAB, provided that data is available in the *.xml format. 

Dlubal RSTAB format *.000 

Use this interface to import DOS files created with RSTAB 3.xx/4.xx. Set the directory of the INP 
folder including input data in the Open dialog box. 

 
IAI logo 

http://www.buildingsmart.org/
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General Dlubal formats *.xml, *st8 
To save RSTAB files as XML files or templates, 

select Save As on the File menu. 

In the Windows dialog box Save As, use the list to set the relevant file type in the dialog field 
Save as type. 

 
Figure 12.51: Dialog box Save As 

With the ST8 format you save the model as a template which can be imported later when cre-
ating a new file (see Figure 12.23, page 386). 

When you save the model with the file type RSX, tabular data will be converted into an XML 
format. The remaining data will be saved in binary format. Data is stored in a compressed file 
that can be opened like a ZIP archive file. In this way, it is possible to create files for CAD pro-
grams. 
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12.5.3 RF-LINK Import *.step, *.iges, *.sat 
With the add-on module RF-LINK (not contained in RSTAB) it is possible to import data in STEP, 
IGES or ACIS format. The file formats are mainly used in mechanical engineering, allowing for a 
transfer of model geometry in the form of boundary lines. 

To import model files available in one of the formats mentioned above, 

select Import on the File menu. 

 
Figure 12.52: Dialog box Import 

In the dialog section Extra Formats of the Import dialog box, you can define the relevant file 
format: 

• Standard for the Exchange of Product Model Data (*.stp, *.step) 

• Initial Graphics Exchange Specification (*.igs, *.iges) 

• Standard Acis Text format (*.sat) 

Access to the options is only available when RF-LINK has been installed. The installation re-
quires a separate installation process. 

In the dialog tab Import (*.sat, *.step, *.iges), you can specify detailed settings for units and the 
treatment of lines. 

Export options of RSTAB files in the STEP, IGES or SAT format are currently not available.
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